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CHAPTER 1

Préambule

Ce document est le guide utilisateur original du logiciel décrit QGIS. Le logiciel et le matériel décrit dans ce
document sont la plupart du temps des marques enregistrées et sont donc soumis aux lois en vigueur. QGIS est
sous licence GNU General Public License. Vous pouvez trouver plus d’information sur la page principale de QGIS
http://www.qgis.org.

Les détails, données et résultats inclus dans ce document ont été écrits et vérifiés au mieux des connaissances des
auteurs et des éditeurs. Néanmoins, il est possible que des erreurs subsistent.

Ainsi l’ensemble des données ne saurait faire l’objet d’une garantie. Les auteurs et les éditeurs ne sauraient être
responsables de tout dommage direct, indirect, secondaire ou accessoire découlant de l’utilisation de ce manuel.
Les éventuelles corrections sont toujours les bienvenues.

Ce document a été rédigé en utilisant reStructuredText. Il est disponible sous forme de code source reST via github
et en ligne en HTML et PDF via http://www.qgis.org/fr/docs/. Les versions traduites de ce document peuvent être
téléchargées dans différents formats via la zone de documentation du projet QGIS. Pour plus d’information pour
contribuer à ce document et à sa traduction, allez sur http://qgis.org/fr/site/getinvolved/index.html.

Références de ce document

Ce document contient des références internes et externes sous forme de lien. Cliquer sur un lien interne provoque
un déplacement dans le document, tandis que cliquer sur un lien externe ouvrira une adresse internet dans le
navigateur choisi par défaut. Dans le PDF, les liens internes et externes sont indiqués en bleu et sont gérés par le
navigateur du logiciel. En HTML, le navigateur affiche et gère les deux types de liens de la même façon.

Auteurs et éditeurs :
Tara Athan Radim Blazek Godofredo Contreras Otto Dassau Martin Dobias
Peter Ersts Anne Ghisla Stephan Holl N. Horning Magnus Homann
Werner Macho Carson J.Q. Farmer Tyler Mitchell K. Koy Lars Luthman
Claudia A. Engel Brendan Morely David Willis Jürgen E. Fischer Marco Hugentobler
Larissa Junek Diethard Jansen Paolo Corti Gavin Macaulay Gary E. Sherman
Tim Sutton Alex Bruy Raymond Nijssen Richard Duivenvoorde Andreas Neumann
Astrid Emde Yves Jacolin Alexandre Neto Andy Schmid Hien Tran-Quang

Copyright (c) 2004 - 2014 QGIS Development Team

Internet : http://www.qgis.org

Licence de ce document

La permission de copier, distribuer, modifier ce document est accordée sous les termes de la GNU Free Docu-
mentation License, dans sa version 1.3 ou plus récente telle que publiée par la Free Software Foundation; sans
modification de son contenu, sans ajouts la précédant ou la suivant. Une copie de la licence est incluse dans la
section Licence GNU de documentation libre.
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CHAPTER 2

Conventions

Cette section décrit les styles utilisés uniformément dans ce manuel.

2.1 Conventions pour les éléments d’interface

Les conventions de styles de l’interface (GUI) dans le texte ressemblent autant que possible à l’apparence du
logiciel. En général, le style reflètera l’apparence des éléments lorsque la souris ne passe pas dessus, l’objectif
étant de permettre à l’utilisateur de repérer plus facilement les éléments mentionnés dans les instructions.

• Options du menu : Couches → Ajouter une couche raster ou Préférences → Barre d’outils → Numérisation

• Outil : Ajouter une couche raster

• Bouton : [Sauvegarder par défaut]

• Titre de boîte de dialogue : Propriétés de la couche

• Onglet : Général

• Case à cocher : Rendu

• Bouton radio : Postgis SRID EPSG ID

• Sélection d’un chiffre :

• Sélection d’une ligne :

• Parcourir un fichier :

• Sélection d’une couleur :

• Barre coulissante :

• Zone de saisie de texte :

Une ombre indique un élément de l’interface qui peut être cliqué.

2.2 Text or Keyboard Conventions

Le manuel utilise également des styles pour le texte, les commandes du clavier et le code pour désigner différents
éléments tels que des classes et des méthodes. Ces styles ne correspondent pas à l’apparence réelle dans QGIS.

• Liens hypertexte : http://qgis.org

• Combinaisons de touches : appuyez sur Ctrl+B, signifie qu’il faut rester en appui sur la touche Contrôle
(Ctrl) tout en pressant la touche B.

3
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• Nom d’un fichier : lakes.shp

• Nom d’une classe : NewLayer

• Méthode : classFactory

• Serveur : myhost.de

• Texte pour l’utilisateur : qgis --help

Les lignes de code sont indiquées comme suit :

PROJCS["NAD_1927_Albers",
GEOGCS["GCS_North_American_1927",

2.3 Instructions spécifiques à un système d’exploitation

Une séquence d’interface peut être exprimée sur une ligne : Cliquez sur Fichier QGIS → Quitter pour
fermer QGIS. Ceci indique que sur Linux, Unix et Windows, vous devez cliquer sur le menu Fichier puis sur
Quitter, alors que sur Macintosh OS X, vous devez cliquer sur le menu QGIS puis sur Quitter.

Les textes plus longs seront formatés comme des listes :

• Faites ceci

• Faites cela

• Faites autre chose

ou comme des paragraphes :

Faites ceci et cela. Puis cela et ceci pour obtenir ça, etc.

Faites ceci et cela. Puis cela et ceci pour obtenir ça, etc.

Les copies d’écrans ont été prises sous différentes plateformes, un icône à la fin de la légende de la figure indique
le système en question.
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CHAPTER 3

Avant-propos

Bienvenue dans le monde merveilleux des Systèmes d’Informations Géographiques (SIG) !

QGIS est un logiciel SIG libre qui a débuté en mai 2002 et s’est établi en tant que projet sur SourceForge en juin
2002. Nous avons travaillé dur pour faire de ce logiciel SIG un choix accessible et viable pour toute personne
ayant un ordinateur (qui sont traditionnellement des logiciels propriétaires assez coûteux). QGIS est utilisable sur
la majorité des Unix, Mac OS X et Windows. QGIS utilise la bibliothèque logicielle Qt (http://qt.digia.com) et le
langage C++, ce qui se traduit par une interface graphique simple et réactive.

QGIS se veut être un logiciel SIG simple à utiliser, fournissant des fonctionnalités courantes. L’objectif initial
du projet était de fournir un visionneur de données SIG. QGIS a, depuis, atteint un stade dans son évolution où
beaucoup y recourent pour leurs besoins quotidiens. QGIS gère un grand nombre de formats raster et vecteur,
avec le support de nouveaux formats facilité par l’architecture basée sur les extensions.

QGIS est distribué sous la licence GNU GPL (General Public License). Ceci signifie que vous pouvez étudier et
modifier le code source, tout en ayant la garantie d’avoir accès à un programme SIG non onéreux et librement
modifiable. Vous devez avoir reçu une copie complète de la licence avec votre exemplaire de QGIS, que vous
pouvez également trouver dans l’Annexe licence GNU General Public License.

Astuce: Documentation à jour
La dernière version de ce document est disponible dans la section documentation du site de QGIS :
http://www.qgis.org/fr/docs/.
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CHAPTER 4

Fonctionnalités

QGIS offre beaucoup d’outils SIG standards par défaut, et via les extensions de multiples contributeurs. Voici
un bref résumé en six catégories de fonctionnalités et extensions, suivi d’un premier aperçu de la console Python
intégrée.

4.1 Visualiser des données

Vous pouvez afficher et superposer des couches de données rasters et vecteurs dans différents formats et projections
sans avoir à faire de conversion dans un format commun. Les formats supportés incluent :

• Les tables spatiales et les vues PostGIS, SpatiaLite, MS SQL Spatial et Oracle Spatial, les formats vecteurs
supportés par la bibliothèque OGR installée, ce qui inclut les shapefiles ESRI, MapInfo, SDTS, GML et
beaucoup d’autres. voir Les données vectorielles.

• Les formats raster supportés par la bibliothèque GDAL (Geospatial Data Abstraction Library) tels que
GeoTIFF, ERDAS IMG, ArcInfo ASCII GRID, JPEG, PNG et beaucoup d’autres, voir section Les données
raster.

• Les formats raster et vecteur provenant des bases de données GRASS. Voir section Intégration du SIG
GRASS.

• Les données spatiales en ligne diffusées comme services web de l’OGC qui incluent le WMS, WMTS,
WCS, WFS et WFS-T. Voir la section Les données OGC.

4.2 Parcourir les données et créer des cartes

Vous pouvez créer des cartes et les parcourir de manière interactive avec une interface intuitive. Les outils
disponibles dans l’interface sont :

• Explorateur QGIS

• La reprojection à la volée

• DB Manager

• La composition de carte

• Le panneau d’aperçu

• Les signets géospatiaux

• Les outils d’annotation

• L’identification et la sélection des entités

• L’affichage, l’édition et la recherche de données attributaires

• Les étiquettes définies par les valeurs des données attributaires
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• Les outils de style définis par les données vecteur et raster

• Création d’atlas avec des couches de carroyage

• La flèche indiquant le nord, la barre d’échelle et l’étiquette de droits d’auteur

• Gestion de la sauvegarde et de la restauration des projets

4.3 Créer, éditer, gérer et exporter des données

Vous pouvez créer, éditer, gérer et exporter des couches vectorielles et raster de nombreux formats. QGIS permet
notamment :

• Numérisation pour les formats gérés par OGR et les couches vectorielles de GRASS

• Création et édition des shapefiles et des couches vectorielles de GRASS

• Extension de géoréférencement pour géoréférencer des images

• Outils GPS pour importer et exporter des données GPX et convertir d’autres formats GPS vers le GPX ou
l’envoi, la réception directement vers une unité GPS (pour Linux, le port USB a été ajouté à la liste des ports
utilisables).

• Visualisation et édition des données OpenStreetMap

• Création de tables de base de données à partir de shapefiles avec l’extension DB Manager

• Amélioration de la gestion des tables spatiales issues de bases de données

• Outils pour la gestion des tables d’attributs des couches vectorielles

• Possibilité d’enregistrer des captures d’écran en tant qu’images géoréférencées

• Outil Export-DXF avec capacités améliorées pour exporter les styles et des extensions fournissant des fonc-
tions similaires à celle d’une CAO.

4.4 Analyser des données

Vous pouvez réaliser des analyses de données spatiales sur des bases de données spatiales ou tout autre format géré
par OGR. QGIS propose pour le moment des analyses vectorielles, des outils de rééchantillonage, de traitements
spatiaux, et de gestion des géométries et des bases de données. Vous pouvez également utiliser les outils intégrés de
GRASS, ce qui inclut les fonctionnalités complètes de GRASS avec plus de 400 modules (voir section Intégration
du SIG GRASS). Ou bien travailler avec l’extension de Traitements, qui fournit un espace de travail puissant
d’analyse géospatiale pour appeler des algorithmes natifs tiers à partir de QGIS, comme GDAL, SAGA, GRASS,
fTools et plus (voir section Introduction).

4.5 Publier des cartes sur Internet

QGIS peut servir de client WMS, WMTS, WMS-C ou WFS et WFS-T ou de serveur WMS, WCS ou WFS (voir
section Les données OGC). QGIS peut aussi être employé pour publier vos données sur Internet via un serveur
web employant UMN MapServer ou GeoServer.

4.6 Étendre les fonctionnalités de QGIS à l’aide d’extensions

QGIS peut être adapté à vos propres besoins du fait de son architecture extensible à base de modules. QGIS fournit
des bibliothèques qui peuvent être employées pour créer des extensions, vous pouvez même créer de nouvelles
applications en C++ ou Python !
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4.6.1 Extensions principales

Les extensions principales sont :

1. Saisie de coordonnées (Enregistrer les coordonnées du pointeur de la souris dans un SCR différent)

2. DB Manager (Edition et visualisation des couches et des tables, execution de requêtes SQL).

3. Convertisseur Dxf2Shp (Convertir des fichiers DXF en shapefiles)

4. eVIS (Visualiser des événements)

5. fTools (Analyser et gérer des données vectorielles)

6. GDALTools (intègre les outils GDAL dans QGIS)

7. Géoréférenceur GDAL (Ajouter une projection à un raster via GDAL)

8. Outils GPS (Importer et exporter des données GPS)

9. GRASS (Intégration du SIG GRASS)

10. Carte de chaleur (Générer des cartes de chaleur raster à partir de données ponctuelles)

11. Extension d’interpolation (Interpoler une surface en utilisant une couche vectorielle de points)

12. Client MetaSearch pour les Services de Catalogage

13. Édition hors connexion (Éditer hors connexion et synchroniser avec une base de données)

14. GeoRaster d’Oracle Spatial

15. Traitements (anciennement SEXTANTE)

16. Analyse de terrain raster (Analyser des rasters de données d’élévation)

17. Extension de Graphe routier (Analyser le chemin le plus court sur un réseau)

18. Extension de requête spatiale

19. Vérificateur de topologie (Chercher des erreurs de topologie dans les couches vectorielles)

20. Extension de statistiques zonales (Calculer le nombre, la somme et la moyenne d’un raster pour chaque
entité d’une couche de polygones)

4.6.2 Extensions Python externes

QGIS offre un nombre croissant d’extensions en Python fournies par la communauté. Ces extensions sont en-
treposées dans le Dépôt d’Extensions officiel et peuvent être facilement installées en utilisant le Gestionnaire
d’extensions Python. Voir section La fenêtre des Extensions.

4.7 Console Python

Il est possible de tirer partie d’une console Python intégrée pour créer des scripts et les exécuter. La console
peut être ouverte grâce au menu : Extensions → Console Python. La console s’ouvre en fenêtre d’utilitaire non
modale. On peut communiquer avec l’environnement QGIS grâce à la variable qgis.utils.iface qui est
une instance de QgsInterface. Cette interface permet d’accéder au canevas de cartes, aux menus, aux barres
d’outils et aux autres éléments de l’application QGIS. Vous pouvez créer un script, puis le glisser-coller dans la
fenêtre QGIS et il sera automatiquement exécuté.

Pour de plus amples informations sur la console Python et la programmation d’extensions et d’applications QGIS,
référez-vous à PyQGIS-Developer-Cookbook.
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4.8 Problèmes connus

4.8.1 Limite du nombre de fichiers ouverts

Si vous ouvrez un gros projet QGIS et êtes sûrs que toutes les couches sont valides, mais que certaines sont
signalées comme mauvaises, vous faites probablement face à ce problème. Linux (et d’autres OSs, d’ailleurs) a
une limite de fichiers ouverts par processus. Les limites de ressource sont par processus et héritées. La commande
ulimit, qui est intégrée dans l’interpréteur de commandes, change les limites seulement pour le processus en
cours de l’interpréteur; la nouvelle limite sera héritée par n’importe quel processus enfant.

Vous pouvez voir toutes les infos ulimit en cours en tapant

user@host:~$ ulimit -aS

Vous pouvez voir le nombre actuellement autorisé de fichiers ouverts par processus avec la commande suivante
dans une console

user@host:~$ ulimit -Sn

Pour modifier les limites d’une session existante, vous devriez pouvoir utiliser quelque chose comme ceci

user@host:~$ ulimit -Sn #number_of_allowed_open_files
user@host:~$ ulimit -Sn
user@host:~$ qgis

Pour le régler définitivement

Sur la plupart des systèmes Linux, les limites des ressources sont définies à la connexion par le module
pam_limits conformément aux paramètres contenus dans le fichier /etc/security/limits.conf ou
/etc/security/limits.d/*.conf. Vous devriez pouvoir éditer ces fichiers si vous avez le droit root
(aussi possible via sudo), mais il vous faudra vous reconnecter avant que ces modifications ne prennent effet.

Plus d’infos :

http://www.cyberciti.biz/faq/linux-increase-the-maximum-number-of-open-files/ http://linuxaria.com/article/open-
files-in-linux?lang=en
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CHAPTER 5

Nouveautés dans QGIS 2.14

Cette version contient de nouvelles fonctionnalités et étend l’interface de programmation par rapport aux anciennes
versions. Nous recommandons d’utiliser cette version préférentiellement aux précédentes.

Cette version inclut des centaines de corrections de bugs et de nombreuses nouvelles fonctionnalités et amélio-
rations apportées depuis la version 2.8. Chacune d’elles sera décrite dans ce manuel. Vous pourrez également
consulter le journal des modifications à:

• http://qgis.org/fr/site/forusers/visualchangelog210/index.html

• http://qgis.org/fr/site/forusers/visualchangelog212/index.html

• http://qgis.org/fr/site/forusers/visualchangelog214/index.html
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CHAPTER 6

Premiers Pas

Ce chapitre donne un bref aperçu de l’installation de QGIS, de quelques jeux de données provenant du site Internet
et du lancement d’une première session d’affichage de couches rasters et vectorielles.

6.1 Installation

L’installation de QGIS est très simple. Des installateurs sont disponibles pour les systèmes d’exploitation MS
Windows et Mac OS X. Beaucoup de distributions de GNU/Linux mettent à disposition des fichiers binaires
précompilés (.rpm ou .deb) ou des dépôts sources via leurs interfaces de gestion de logiciels. Vous pouvez obtenir
les dernières informations concernant les paquets binaires sur le site de QGIS sur http://download.qgis.org.

6.1.1 Installation à partir des sources

Si vous souhaitez compiler QGIS à partir des sources, veuillez vous référer aux instructions d’installation. Elles
sont distribuées avec le code source de QGIS dans un fichier appelé INSTALL. Vous pouvez aussi le trouver en
ligne à http://htmlpreview.github.io/?https://raw.github.com/qgis/QGIS/master/doc/INSTALL.html

6.1.2 Installation sur un support amovible

QGIS vous permet de définir un dossier --configpath qui se substitue au chemin par défaut de l’utilisateur
(par exemple, ~/.qgis2 sous Linux) et force également QSettings à utiliser ce dossier. Cela vous permet de
transporter par exemple une installation de QGIS sur un lecteur flash ainsi que toutes les extensions et paramètres.
Voir section Menu Système pour plus d’informations.

6.1.3 Échantillon de données

Le guide de l’utilisateur contient des exemples basés sur le jeu de données échantillon inclus dans QGIS.

L’installateur Windows possède une option qui permet de télécharger le jeu de données échantillon QGIS. Si
vous la cochez, les données seront téléchargées dans votre répertoire intitulé Mes Documents et placées dans
un répertoire GIS Database. Vous pouvez utiliser l’explorateur Windows pour vous déplacer à partir de ce
répertoire vers un autre répertoire de votre choix. Si vous ne cochez pas cette option durant l’installation QGIS,
vous pouvez :

• Utiliser des données que vous possédez déjà.

• Télécharger des données exemples sur http://qgis.org/downloads/data/qgis_sample_data.zip

• Désinstaller et réinstaller QGIS en cochant, cette fois, la case de téléchargement (uniquement si les solutions
proposées ci-dessus ne fonctionnent pas).

13

http://download.qgis.org
http://htmlpreview.github.io/?https://raw.github.com/qgis/QGIS/master/doc/INSTALL.html
http://qgis.org/downloads/data/qgis_sample_data.zip


QGIS User Guide, Version 2.14

Sur GNU/Linux et Mac OS X, il n’y a pas encore de jeux de données exemples disponibles à l’installation
en rpm, deb ou dmg. Afin d’utiliser ce jeu de données, téléchargez le fichier ZIP qgis_sample_data depuis
le lien http://qgis.org/downloads/data/ et décompressez-le sur votre système.

Le jeu de données Alaska inclut toutes les données SIG qui sont utilisées comme exemple et comme aperçus
dans le guide de l’utilisateur mais aussi une petite base de données GRASS. La projection du jeu de données à
renseigner dans QGIS est Alaska Albers Equal Area avec comme unités le pied. Le code EPSG est 2964.

PROJCS["Albers Equal Area",
GEOGCS["NAD27",
DATUM["North_American_Datum_1927",
SPHEROID["Clarke 1866",6378206.4,294.978698213898,
AUTHORITY["EPSG","7008"]],
TOWGS84[-3,142,183,0,0,0,0],
AUTHORITY["EPSG","6267"]],
PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],
UNIT["degree",0.0174532925199433,
AUTHORITY["EPSG","9108"]],
AUTHORITY["EPSG","4267"]],
PROJECTION["Albers_Conic_Equal_Area"],
PARAMETER["standard_parallel_1",55],
PARAMETER["standard_parallel_2",65],
PARAMETER["latitude_of_center",50],
PARAMETER["longitude_of_center",-154],
PARAMETER["false_easting",0],
PARAMETER["false_northing",0],
UNIT["us_survey_feet",0.3048006096012192]]

Si vous envisagez d’utiliser QGIS comme une interface graphique de GRASS, vous pouvez trouver des
échantillons de données (par exemple Spearfish ou South Dakota) sur le site officiel de GRASS GIS :
http://grass.osgeo.org/download/sample-data/.

6.2 Ouvrir QGIS

6.2.1 Démarrer et arrêter QGIS

Démarrer QGIS se fait comme pour n’importe quelle application sur votre ordinateur. Vous pouvez lancer QGIS :

• en tapant qgis dans une console, en supposant que QGIS a été ajouté à votre PATH ou que vous êtes dans
le répertoire d’installation

• en utilisant le menu Applications s’il s’agit d’une version précompilée, le menu Démarrer ou le
Dock

• en double-cliquant sur l’icône dans votre répertoire d’Applications ou sur un raccourci sur le bureau

• en double-cliquant sur un fichier de projet QGIS (.qgs) existant. Notez que cela ouvrira le projet dans
QGIS.

Pour arrêter QGIS :

• cliquez sur le menu Projet → Fermer QGIS ou utilisez le raccourci clavier Ctrl+Q

• cliquez sur QGIS → Quit QGIS ou utilisez le raccourci clavier Cmd+Q

• ou utilisez la croix rouge située au coin supérieur droit de l’interface principale.
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6.2.2 Options de ligne de commande

Dans le paragraphe précédent vous avez appris comment démarrer QGIS. Vous allez voir ici que QGIS propose
d’autres options de démarrage en ligne de commande.

QGIS supporte un certain nombre d’options lorsqu’il est lancé par une ligne de commande. Pour obtenir une liste
de ces options, entrez qgis --help dans votre console. Le message qui en résulte est :

qgis --help
QGIS - 2.6.0-Brighton ’Brighton’ (exported)
QGIS is a user friendly Open Source Geographic Information System.
Usage: /usr/bin/qgis.bin [OPTION] [FILE]
OPTION:

[--snapshot filename] emit snapshot of loaded datasets to given file
[--width width] width of snapshot to emit
[--height height] height of snapshot to emit
[--lang language] use language for interface text
[--project projectfile] load the given QGIS project
[--extent xmin,ymin,xmax,ymax] set initial map extent
[--nologo] hide splash screen
[--noversioncheck] don’t check for new version of QGIS at startup
[--noplugins] don’t restore plugins on startup
[--nocustomization] don’t apply GUI customization
[--customizationfile] use the given ini file as GUI customization
[--optionspath path] use the given QSettings path
[--configpath path] use the given path for all user configuration
[--authdbdirectory path] use the given directory for authentication database
[--code path] run the given python file on load
[--defaultui] start by resetting user ui settings to default
[--dxf-export filename.dxf] emit dxf output of loaded datasets to given file
[--dxf-extent xmin,ymin,xmax,ymax] set extent to export to dxf
[--dxf-symbology-mode none|symbollayer|feature] symbology mode for dxf output
[--dxf-scale-denom scale] scale for dxf output
[--dxf-encoding encoding] encoding to use for dxf output
[--dxf-preset visiblity-preset] layer visibility preset to use for dxf output
[--help] this text
[--] treat all following arguments as FILEs

FILE:
Files specified on the command line can include rasters,
vectors, and QGIS project files (.qgs):
1. Rasters - supported formats include GeoTiff, DEM

and others supported by GDAL
2. Vectors - supported formats include ESRI Shapefiles

and others supported by OGR and PostgreSQL layers using
the PostGIS extension

Astuce: Exemple utilisant des options de ligne de commande
Vous pouvez démarrer QGIS en spécifiant un ou plusieurs fichiers de données. Par exemple, si vous êtes placé dans
le répertoire qgis_sample_data vous pouvez démarrer QGIS avec une couche vectorielle et un fichier raster
dès le démarrage avec la commande suivante : qgis ./raster/landcover.img ./gml/lakes.gml

Option de ligne de commande --snapshot

Cette option permet de créer une capture d’écran de l’affichage courant au format PNG. C’est pratique quand vous
avez une longue série de projets et que vous voulez générer un aperçu de vos données.

L’image est créée au format PNG et fait 800x600 pixels. Cette commande peut être adaptée en utilisant les
arguments --width pour la largeur et --height pour la hauteur. Un nom de fichier peut être ajouté après
--snapshot.

Option de ligne de commande --lang
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QGIS se base sur votre environnement linguistique par défaut pour définir la langue de l’interface. Si vous voulez
en changer, vous devez le spécifier en saisissant un code. Par exemple, qgis --lang it lancera QGIS en
Italien.

Option de ligne de commande --project

Démarrer QGIS avec un projet existant est possible, il suffit d’ajouter l’option --project suivie du nom de
votre projet et QGIS se lancera avec toutes les couches définies dans ce fichier.

Option de ligne de commande --extent

Pour démarrer avec une étendue cartographique spécifique, utilisez cette option. Vous devez ajouter les limites de
votre étendue dans l’ordre suivant en les séparant par une virgule :

--extent xmin,ymin,xmax,ymax

Option de ligne de commande --nologo

Cette commande dissimule l’écran de démarrage qui apparaît lors du lancement de QGIS.

Option de ligne de commande --noversioncheck

Ne pas vérifier la disponibilité d’une nouvelle version de QGIS au démarrage.

Option de ligne de commande --noplugins

Si vous avez un problème au démarrage lié à une extension, cette option permet de lancer QGIS sans les
charger. Elles seront toujours accessibles dans le Gestionnaire d’extension. Option en ligne de commande
--customizationfile

Utiliser cette commande vous permettra de définir un fichier de personnalisation de l’interface dès le démarrage.

Option de ligne de commande --nocustomization

Utiliser cette commande empêchera la personnalisation de l’interface au démarrage.

Option de ligne de commande --optionspath

Vous pouvez avoir plusieurs configurations et décider laquelle utiliser en lançant QGIS avec cette option. Lisez
la section Options pour savoir où votre système d’exploitation entrepose les fichiers de préférences. Il n’y pas
pour l’instant de possibilité de spécifier dans quel fichier écrire ces préférences, vous devrez donc faire une copie
du fichier original et le renommer. Cette option spécifie le chemin vers le répertoire contenant la configuration.
Par exemple, pour utiliser le fichier de configuration /chemin/vers/config/QGIS/QGIS2.ini, utilisez
l’option :

--optionspath /path/to/config/

Option de ligne de commande --configpath

Cette option est similaire à la précédente, mais va plus loin en changeant le chemin par défaut de la configura-
tion utilisateur (~/.qgis2) et oblige QSettings à utiliser ce nouveau répertoire. Cela permet par exemple de
transporter QGIS sur une clé USB avec tous les paramètres et extensions.

Option de ligne de commande --authdbdirectory

Encore une fois, cette option est similaire à la précédente mais permet de définir le chemin vers le répertoire où
est stockée la base de données d’authentification.

Option en ligne de commande --code

Cette option permet de lancer un code python directement après le lancement de QGIS.

Par exemple si vous avez un fichier python nommé load_alaska.py et avec le contenu suivant :

from qgis.utils import iface
raster_file = "/home/gisadmin/Documents/qgis_sample_data/raster/landcover.img"
layer_name = "Alaska"
iface.addRasterLayer(raster_file, layer_name)
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Si vous êtes dans le répertoire où se situe le fichier load_alaska.py, vous pouvez lancer QGIS, charger le
fichier raster landcover.img et donner à cette couche le nom ‘Alaska’ en utilisant la commande suivante :
qgis --code load_alaska.py

Option en ligne de commande --dxf-*
Ces options peuvent être utilisées lors d’un export du projet QGIS au format DXF. Plusieurs options sont pro-
posées:

• –dxf-export: le nom du fichier DXF dans lequel les couches seront exportées;

• –dxf-extent: l’emprise du fichier DXF;

• –dxf-symbology-mode: several values can be used here: none (no symbology), symbollayer (Symbol layer
symbology), feature (feature symbology);

• –dxf-scale-deno: the scale denominator of the symbology;

• –dxf-encoding: l’encodage du fichier;

• –dxf-preset: choose a visibility preset. These presets are defined in the layer tree, see Le panneau Couches.

6.3 Session test : Charger des couches rasters et vectorielles

Maintenant que vous avez installé QGIS avec l’échantillon de données disponible, nous aimerions vous faire une
courte démonstration. Nous allons visualiser une couche raster et une couche vectorielle. Nous allons utiliser :

• la couche raster landcover (occupation du sol) : qgis_sample_data/raster/landcover.img

• et la couche vectorielle lakes (lacs) : qgis_sample_data/gml/lakes.gml.

1. Démarrez QGIS comme vu dans Démarrer et arrêter QGIS

2. Cliquez sur l’icône Ajouter une couche Raster.

3. Parcourez le dossier qgis_sample_data/raster/, sélectionnez le fichier ERDAS IMG
landcover.img et cliquez sur [Ouvrir].

4. Si le fichier n’est pas listé, vérifiez si le type de fichier dans la liste déroulante Types de fichier en bas
de la fenêtre est le bon, dans ce cas-ci il s’agit de Erdas Imagine Images (*.img *.IMG).

5. Maintenant cliquez sur l’icône Ajouter une couche vecteur.

6. Fichier devrait être sélectionné comme Type de source dans la fenêtre Ajouter une couche vecteur qui
apparaît. Maintenant cliquez sur [Parcourir] pour sélectionner la couche vecteur.

7. Parcourez le répertoire qgis_sample_data/gml/, sélectionnez Geography Markup Language
[GML] [OGR] (*.gml *.GML) à partir de la liste déroulante Type de fichier , sélectionnez le fichier
GML lakes.gml et cliquez sur [Ouvrir]. Dans la fenêtre Ajouter une couche vecteur, cliquez sur [OK].
La fenêtre Sélectionneur de système de coordonnées de référence s’ouvre avec la projection NAD27 / Alaska
Alberts sélectionnée. Cliquez sur [OK].

8. Zoomez sur une zone de votre choix avec quelques lacs.

9. Double-cliquez sur la couche lakes dans la liste des couches pour ouvrir la fenêtre Propriétés des couches.

10. Cliquez sur l’onglet Style et sélectionnez le bleu comme couleur de remplissage.

11. Cliquez sur l’onglet Étiquettes et sélectionnez Montrer les étiquettes pour cette couche dans la liste
déroulante qui active l’étiquetage. Puis, dans Étiqueter avec , choisissez le champ NAMES qui contient
le texte des étiquettes.

12. Pour améliorer la lisibilité des étiquettes, vous pouvez ajouter un halo autour d’elles, en cliquant sur Tampon

dans la liste à gauche puis sur Afficher un tampon. Choisissez 3 comme taille du tampon.

13. Cliquez sur [Appliquez]. Vérifiez si le résultat est satisfaisant et enfin cliquez sur [OK].
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Vous pouvez constater combien il est facile d’afficher des couches raster ou vecteur dans QGIS. Passons aux
sections suivantes pour en apprendre plus sur les autres fonctionnalités, caractéristiques et paramètres disponibles
et sur la façon de les utiliser.

6.4 Les projets

L’état de votre session QGIS est considéré comme étant un projet. QGIS ne peut travailler que sur un projet à
la fois. Les propriétés sont considérées comme étant assignées soit à un projet soit par défaut pour les nouveaux
projets (voir Options). QGIS peut enregistrer l’état de votre travail dans un fichier de projet en utilisant le menu

Projet→ Sauvegarder le projet ou Projet→ Sauvegarder le projet sous.... Si un fichier de projet chargé a
été modifié, par défaut QGIS vous demandera si vous souhaitez écraser les modifications faites dans le fichier de

projet. Ce comportement se définit en cochant la case Demander de sauver le projet et les sources de données
quand nécessaire dans le menu Préférences → Options → Général.

Pour charger un projet dans une session QGIS, aller dans Projet→ Ouvrir ou Projet→ Ouvrir un projet récent.

Au démarrage, une liste de captures d’écran accompagnées du nom et du chemin vers chacun des derniers projets
(jusqu’à dix) s’affiche en lieu et place de la carte blanche. Il est alors rapide et pratique de voir à quoi correspon-
dent chaque projet. Ils s’ouvrent en double-cliquant dessus. Si vous souhaitez créer un nouveau projet, ajoutez
simplement de nouvelles couches de données et la liste des projets disparaitra.

Si vous souhaitez revenir à une session vierge, aller sur Projet→ Nouveau. Chacune de ces options vous
demandera si vous désirez enregistrer le projet dès lors que des changements auront été effectués depuis son
ouverture ou sa dernière sauvegarde.

Les types d’informations enregistrées dans un projet sont :

• les couches ajoutées,

• les couches qui peuvent être interrogées,

• les propriétés des couches comprenant notamment les symboles associés et leur style,

• la projection de la carte,

• l’étendue de la dernière zone de visualisation,

• les compositions d’impression,

• les éléments des compositions d’impression ainsi que leurs paramètres,

• les paramètres des atlas parmi les compositions d’impression,

• les paramètres d’édition,

• les relations de tables,

• les macros du projet,

• les styles par défaut du projet,

• les paramètres des extensions,

• les paramètres de QGIS Server définis dans l’onglet Serveur OWS des propriétés du projet,

• les requêtes stockées dans le Gestionnaire de base de données.

Le fichier de projet est enregistré au format XML, il est donc possible de l’éditer en dehors de QGIS si vous
savez ce que vous faites. Le format a été modifié à plusieurs reprises depuis les versions antérieures de QGIS. Les
fichiers enregistrés sous ces versions peuvent ne plus fonctionner correctement avec les versions ultérieures. Pour
être averti dans ce genre de cas, allez dans l’onglet Général du menu Préférences → Options, vous devez cocher

la case Avertir lors de l’ouverture d’un fichier projet sauvegardé dans une version précédente de QGIS.

Quand un projet est sauvegardé dans QGIS, une sauvegarde de l’ancien projet est conservée dans un fichier portant
l’extension .qgs~.
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6.5 Sortie graphique

Plusieurs sorties graphiques sont possibles depuis votre session. Nous en avons déjà vue une dans la section Les
projets : sauvegarder dans un fichier de projet. Voici d’autres manières de produire une sortie graphique :

• L’option de menu Projet → Enregistrer comme image... ouvre une fenêtre où vous devez saisir le
nom, le chemin et le type d’image (PNG, JPEG ou de nombreux autres formats). Un fichier “worldfile”
avec le même nom et avec l’extension PNGW ou JPGW est enregistré dans le même dossier que l’image,
géoréférence celle-ci.

• Dans le menu Projet → Export DXF..., on peut choisir certains paramètres pour l’export en DXF : le mode
et l’échelle de la symbologie. De plus, on peut sélectionner les couches vecteurs à exporter. L’option ‘Mode
de symbologie’ permet d’exporter avec fidélité les symboles utilisés dans le projet QGIS d’origine.

• L’option de menu Projet → Nouveau composeur d’impression ouvre une fenêtre où vous pouvez faire
une mise en page et imprimer la vue active de la carte (voir section Composeur d’Impression).
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CHAPTER 7

Interface de QGIS

Quand QGIS démarre, l’interface se présente à vous sous la forme affichée ci-dessous (les nombres de 1 à 5 dans
les cercles jaunes se réfèrent aux cinq zones principales de l’interface décrites ici).

Figure 7.1: Interface de QGIS avec les données d’exemple sur l’Alaska

Note: Le style des fenêtres peut apparaître différemment en fonction de votre système d’exploitation et de votre
gestionnaire de fenêtres.

L’interface de QGIS est divisée en cinq zones distinctes :

1. Barre de Menu

2. Barres d’outils

3. Panneaux

4. Affichage de la carte

5. Barre d’état

Ces cinq composants sont décrits dans les sections suivantes. Deux autres sections présentent les raccourcis clavier
et l’aide contextuelle.
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7.1 Barre de Menu

La barre de menu donne accès aux différentes fonctionnalités de QGIS par le biais de menus hiérarchiques. Les
entrées du menu de niveau supérieur et un résumé de certaines options sont listés ci-dessous, avec les icônes
des outils correspondants dans la barre d’outils et leurs raccourcis clavier. Les raccourcis clavier présentés ici
sont ceux définis par défaut mais il peuvent également être configurés manuellement via le menu Préférences →
Configurer les raccourcis....

Bien que les options de menu aient des outils qui leur correspondent et vice-versa, les menus ne sont pas organisés
comme les barres d’outils. La barre contenant l’outil est affichée sous chaque option de menu en tant que case
à cocher. Certaines entrées n’apparaissent que lorsque les extensions correspondantes sont activées. Pour plus
d’informations sur les outils et les barres d’outils, veuillez lire la section Barres d’outils.

Note: QGIS est un logiciel multi-plateforme mais, bien qu’il fournisse les mêmes outils, il se peut qu’ils soient
accessibles via différents menus selon le système d’exploitation. La liste suivante présente les emplacements les
plus courants et précise lorsqu’il y a des variations.

7.1.1 Projet

Barre de Menu Raccourci Référence Barre d’outils

Nouveau Ctrl+N voir Les projets Projet

Ouvrir Ctrl+O voir Les projets Projet
Nouveau depuis un modèle → voir Les projets
Ouvrir un projet récent → voir Les projets

Enregistrer Ctrl+S voir Les projets Projet

Enregistrer sous... Ctrl+Shift+S voir Les projets Projet

Enregistrer comme image... voir Sortie graphique
Export DXF voir Sortie graphique

Propriétés du projet... Ctrl+Shift+P voir Les projets

Nouveau composeur d’impression Ctrl+P voir Composeur d’Impression Projet

Gestionnaire de composition ... voir Composeur d’Impression Projet
Composeurs d’impression → voir Composeur d’Impression

Fermer QGIS Ctrl+Q

Under Mac OSX, the Exit QGIS command corresponds to QGIS → Quit QGIS (Cmd+Q).
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7.1.2 Éditer

Barre de Menu Raccourci Référence Barre d’outils

Annuler Ctrl+Z voir Numérisation avancée Numérisation
avancée

Refaire Ctrl+Shift+Zvoir Numérisation avancée Numérisation
avancée

Couper des entités Ctrl+X voir Numériser une couche
existante

Numérisation

Copier les entités Ctrl+C voir Numériser une couche
existante

Numérisation

Coller les entités Ctrl+V voir Numériser une couche
existante

Numérisation

Coller les entités comme → voir Travailler avec la table
d’attributs

Ajouter une entité Ctrl+. voir Numériser une couche
existante

Numérisation

Déplacer l’entité voir Numériser une couche
existante

Numérisation

Supprimer les entités sélectionnées voir Numériser une couche
existante

Numérisation

Pivoter l’entité voir Numérisation avancée Numérisation
avancée

Simplifier l’entité voir Numérisation avancée Numérisation
avancée

Ajouter un anneau voir Numérisation avancée Numérisation
avancée

Ajouter une partie voir Numérisation avancée Numérisation
avancée

Remplir l’anneau voir Numérisation avancée Numérisation
avancée

Effacer un anneau voir Numérisation avancée Numérisation
avancée

Effacer une partie voir Numérisation avancée Numérisation
avancée

Remodeler les entités voir Numérisation avancée Numérisation
avancée

Décalage X,Y voir Numérisation avancée Numérisation
avancée

Séparer les entités voir Numérisation avancée Numérisation
avancée

Séparer les parties voir Numérisation avancée Numérisation
avancée

Fusionner les entités sélectionnées voir Numérisation avancée Numérisation
avancée

Fusionner les attributs des entités
sélectionnées

voir Numérisation avancée Numérisation
avancée

Outil de nœud voir Numériser une couche
existante

Numérisation

Rotation des symboles de points voir Numérisation avancée Numérisation
avancée
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L’activation du mode Basculer en mode édition pour une couche active une icône de création d’entité dans le menu
Éditer qui dépend du type de couche (point, ligne ou polygone).

7.1.3 Éditer (selon le type de couche)

Barre de Menu Raccourci Référence Barre d’outils

Ajouter une entité voir Numériser une couche existante Numérisation

Ajouter une entité voir Numériser une couche existante Numérisation

Ajouter une entité voir Numériser une couche existante Numérisation
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7.1.4 Affichage de la carte

Barre de Menu Raccourci Référence Barre d’outils

Se déplacer dans la carte voir Zoomer et se déplacer Navigateur de
carte

Déplacer la carte jusqu’à la
sélection

Navigateur de
carte

Zoom + Ctrl++ voir Zoomer et se déplacer Navigateur de
carte

Zoom - Ctrl+- voir Zoomer et se déplacer Navigateur de
carte

Sélection → voir Sélectionner et désélectionner
des entités

Attributs

Identifier les entités Ctrl+Shift+Ivoir Identifier les entités Attributs
Mesure → voir Mesurer Attributs

Résumé statistique voir Statistical Summary Panel Attributs

Zoom sur l’emprise totale Ctrl+Shift+F Navigateur de
carte

Zoom sur la couche Navigateur de
carte

Zoom sur la sélection Ctrl+J Navigateur de
carte

Zoom précédent Navigateur de
carte

Zoom suivant Navigateur de
carte

Zoomer à la résolution
native

Navigateur de
carte

Décorations → voir Décorations
Mode d’affichage →

Infobulles voir Onglet Infobulles Attributs

Nouveau signet... Ctrl+B voir Signets spatiaux Attributs

Liste des signets Ctrl+Shift+Bvoir Signets spatiaux Attributs

Rafraîchir F5 Navigateur de
carte

Panneaux → voir Panneaux et barres d’outils
Barres d’outils → voir Panneaux et barres d’outils
Basculer en mode plein écran F11

Under Linux KDE, Panels →, Toolbars → and Toggle Full Screen Mode are rather placed in Settings menu.

Preview mode → is not available under Mac OS X.
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7.1.5 Couche

Barre de Menu Raccourci Référence Barre
d’outils

Créer une couche → voir Créer de nouvelles couches
vecteur

Contrôle des
couches

Ajouter une couche → voir Formats de données gérés Contrôle des
couches

Intégrer des couches et des groupes voir Inclusion de projets
Ajouter depuis un fichier de
Définition de Couche (.qlr)

Copier le style voir Sauvegarder et Partager les
propriétés d’une couche

Coller le style voir Sauvegarder et Partager les
propriétés d’une couche

Ouvrir la table d’attributs voir Travailler avec la table
d’attributs

Attributs

Basculer en mode édition voir Numériser une couche existante Numérisation

Enregistrer les modifications de
la couche

voir Numériser une couche existante Numérisation

Éditions en cours → voir Numériser une couche existante Numérisation
Enregistrer sous... voir Save layer into file
Enregistrer en tant que Fichier de
définition de couche...

Supprimer la couche/groupe Ctrl+D

Dupliquer une couche(s)
Définir l’échelle de visibilité
Définir le SCR des couches Ctrl+Shift+C
Définir le SCR du projet depuis cette
couche
Propriétés voir Fenêtre Propriétés d’une couche

vecteur
Filtrer voir Constructeur de requête

Étiquetage voir Onglet Étiquettes

Ajouter dans l’aperçu Ctrl+Shift+O Contrôle des
couches

Tout ajouter dans l’aperçu

Enlever tout de l’aperçu

Afficher toutes les couches Ctrl+Shift+U Contrôle des
couches

Cacher toutes les couches Ctrl+Shift+H Contrôle des
couches

Afficher les couches
sélectionnées

Cacher les couches
sélectionnées
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7.1.6 Préférences

Barre de Menu Rac-
courci

Référence Barre
d’outils

Projection
personnalisée...

voir Système de Coordonnées de Référence
personnalisé

Gestionnaire de
symboles...

voir Le Gestionnaire de style

Configurer les
raccourcis...

Personnalisation voir Personnalisation
Options... voir Options

Options d’accrochage voir Définir le rayon de tolérance d’accrochage et
de recherche

Under Linux KDE, you’ll find more tools in Settings menu such as Project Properties, Panels →, Toolbars →
and Toggle Full Screen Mode.

7.1.7 Extensions

Barre de Menu Raccourci Référence Barre d’outils

Installer/Gérer les extensions voir La fenêtre des Extensions
Console Python Ctrl+Alt+P

Les extensions principales ne sont pas toutes chargées lorsque vous démarrez QGIS pour la première fois.

7.1.8 Vecteur

Barre de Menu Raccourci Référence Barre d’outils
Open Street Map → voir Charger des vecteurs OpenStreetMap

Outils d’analyse → voir Extension fTools

Outils de recherche → voir Extension fTools

Outils de géotraitement → voir Extension fTools

Outils de géométrie → voir Extension fTools

Outils de gestion de données → voir Extension fTools

Les extensions principales ne sont pas toutes chargées lorsque vous démarrez QGIS pour la première fois.

7.1.9 Raster

Barre de Menu Raccourci Référence Barre d’outils
Calculatrice raster... voir Calculatrice Raster
Aligner des Rasters... voir Alignement de rasters

Les extensions principales ne sont pas toutes chargées lorsque vous démarrez QGIS pour la première fois.

7.1.10 Base de données

Barre de Menu Raccourci Référence Barre d’outils
Base de données → voir Extension DB Manager Base de données

Les extensions principales ne sont pas toutes chargées lorsque vous démarrez QGIS pour la première fois.
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7.1.11 Web

Barre de Menu Raccourci Référence Barre d’outils
Metasearch voir Client MetaSearch pour les Services de Catalogage Internet

Les extensions principales ne sont pas toutes chargées lorsque vous démarrez QGIS pour la première fois.

7.1.12 Traitement

Barre de Menu Raccourci Référence Barre d’outils

Boîte à outils voir La boîte à outils

Modeleur graphique... voir Le modeleur graphique

Historique et Journal... voir Le gestionnaire d’historique

Options... voir Configurer le Module de Traitements

Visualiseur de résultats... voir Configuration des applications tierces

Ligne de commande Ctrl+Alt+M voir La ligne de commande QGIS

Les extensions principales ne sont pas toutes chargées lorsque vous démarrez QGIS pour la première fois.

7.1.13 Aide

Barre de Menu Raccourci Référence Barre d’outils

Table des matières de l’aide F1 Aide

Qu’est-ce que c’est ? Shift+F1 Aide
Documentation de l’API
Signaler un problème
Besoin de support commercial ?

Site officiel de QGIS Ctrl+H

Vérifier la version de QGIS

À propos

Sponsors de QGIS

7.1.14 QGIS

This menu is only available under Mac OS X and contains some OS related commands.

Barre de Menu Raccourci Référence
Preferences
À propos de QGIS
Hide QGIS
Show All
Hide Others
Quit QGIS Cmd+Q

Preferences and About QGIS are the same commands as Settings → Options and Help → About. Quit QGIS
corresponds to Project → Exit QGIS under the other platforms.
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7.2 Panneaux et barres d’outils

Depuis le menu Vue (Préférences sous KDE), vous pouvez activer ou désactiver les panneaux (Panneaux →) ou
les barres d’outils (Barres d’outils →) QGIS. Vous pouvez (dés)activer chacun d’entre eux en faisant un clic-droit
sur une barre de menu ou d’outils puis sélectionner les éléments à afficher. Chaque panneau ou barre d’outils peut
être déplacer au sein de l’interface de QGIS. À cette liste, d’autres éléments peuvent venir s’ajouter en activant
des Extensions principales ou externes.

7.2.1 Barres d’outils

La barre d’outils fournit un accès à la majorité des fonctions des menus en plus d’outils additionnels destinés à
interagir avec la carte. Chaque outil dispose d’une bulle d’aide qui s’affiche lorsque vous placez votre curseur
au-dessus. Celle-ci affiche une courte description du rôle de l’outil.

Chaque barre d’outils peut être déplacée selon vos besoins. Vous pouvez les désactiver à partir du menu contextuel
qui s’affiche d’un clic droit de la souris sur la barre d’outils.

Figure 7.2: Le menu Barres d’outils

Astuce: Restaurer des barres d’outils
Si vous avez accidentellement masqué une barre d’outils, vous pouvez la retrouver via le menu Vue → Barres
d’outils → (ou Préférences → Barres d’outils → sous Linux KDE). Si, pour une raison ou pour une autre, une
barre d’outils (ou n’importe quel autre élément d’interface) a complètement disparu de l’interface, vous trouverez
des conseils pour la retrouver dans Restaurer facilement l’IHM initiale de QGIS.

7.2.2 Panneaux

QGIS provides by default many panels to work with.
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Figure 7.3: The Panels menu

Some of these panels are described below while others may be found in different parts of the document, namely:

• the Browser Panel

• the Advanced Digitizing Panel

• the Spatial Bookmarks Panel

• the GPS Information Panel

• the Tile Scale Panel

• le Panneau Identifier Panel

• the User Input Panel

Le panneau Couches

Le panneau Couches liste l’ensemble des couches du projet. La case à cocher présente à gauche du nom de chaque
couche permet de l’afficher ou de la cacher. La barre d’outils de ce panneau permet de :

• Ajouter un groupe

• Contrôler la visibilité des couches : gérer la visibilité des couches et enregistrer des réglages

• Filter Legend by Map Content: only the layers that are set visible and whose features intersect the current map
canvas have their style rendered in the layers panel. Otherwise, a generic NULL symbol is applied to the
layer. Based on the layer symbology, this is a convenient way to identify which kind of features from which
layers cover your area of interest.

• Filter Legend by Expression: helps you apply an expression to remove from the selected layer tree styles that
have no feature satisfying the condition. This can be used for example to highlight features that are within
a given area/feature of another layer. From the drop-down list, you can edit and clear the expression set.
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• Expand All or Collapse All layers and groups in the layers panel.

• Supprimer la couche/groupe sélectionné.

The button allows you to add Presets views in the legend. Presets are a way to save and easily restore a
combination of layers with their current style. To add a preset view, just set visible the layers you want, with their
desired symbology, and click on button. Choose Add Preset... from the drop-down menu and give a name to
the preset. The added preset is listed at the bottom of the drop-down menu and is recalled by clicking on it.

The Replace Preset → option helps you overwrite a preset content with the current map view while the Remove
Current Preset button deletes the active preset.

Toutes les vues prédéfinies ajoutées sont également présentes dans le composeur de carte pour vous permettre de
créer une mise en page de carte basée sur des vues spécifiques (consultez Propriétés principales).

Note: Tools to manage the layers panel are also available to layout the map and legend items of the print composer

Une couche peut être sélectionnée et glissée vers le haut ou le bas dans la légende pour modifier l’ordre
d’empilement des couches. Une couche se situant au sommet de la liste de cette légende sera affichée au-dessus
de celles qui se situent plus bas dans la liste.

Note: Ce comportement peut être supplanté par le panneau Layer Order.

Les couches peuvent être organisées en groupe. Il y a deux manières de procéder :

1. Appuyez sur l’icône pour ajouter un nouveau groupe. Renseignez un nom pour le groupe et appuyez
sur Entrée. Cliquez maintenant sur une couche existante et déplacez-là à l’intérieur du groupe.

2. Sélectionnez des couches, faites un clic droit dans la légende et choisissez Grouper la sélection. Les couches
sélectionnées seront automatiquement placées dans un nouveau groupe.

Pour retirer une couche d’un groupe, il suffit de pointer votre curseur sur elle, de la glisser-déposer en dehors ou
de faire un clic droit et de choisir Mettre l’objet au-dessus. Un groupe peut contenir d’autres groupes.

La case à cocher d’un groupe permet d’afficher ou de cacher toutes les couches du groupe en un seul clic.

Le contenu du menu contextuel affiché par un clic droit varie si la couche sélectionnée est de type raster ou

vecteur. Pour les couches vectorielles GRASS Basculer en mode édition n’est pas disponible. Veuillez lire la section
Numérisation et édition de couche vectorielle GRASS pour plus d’informations sur l’édition de couches vecto-
rielles GRASS.

Below are listed available options in context menu depending on the selected item.
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Option Couche vecteur Couche
raster

Groupe de
couches

Zoomer sur la couche / le groupe

Montrer dans l’aperçu

Zoomer à la résolution native (100%)

Zoom sur l’emprise courante

Supprimer

Dupliquer

Définir l’échelle de visibilité

Définir le SCR de cette couche / du groupe

Définir le SCR du projet depuis cette couche

Styles →
Copier le style

Copier le style

Ouvrir la table d’attributs

Basculer en mode édition

Éditions en cours → (en mode
Édition)

Enregistrer sous...

Enregistrer en tant que Fichier de définition de
couche...

Filtrer

Montrer le décompte des entités

Propriétés...

Monter au premier-plan

Renommer

Grouper la sélection

Propriétés...

Définir les données associées au groupe WMS

Groupe mutuellement exclusif

Ajouter un groupe

Enabling the Mutually Exclusive Group option you can make a group have only one layer visible at the same
time. Whenever a layer within the group is set visible the others will be toggled not visible.

Il est possible de sélectionner plus d’une couche ou groupe à la fois en tenant appuyée la touche Ctrl pendant
que vous sélectionnez les couches avec le bouton gauche de la souris. Vous pouvez alors déplacer en une fois
toutes les couches sélectionnées dans un nouveau groupe.

Vous pouvez également supprimer plus d’une couche ou d’un groupe à la fois en les sélectionnant avec la touche
Ctrl puis en tapant sur Ctrl+D. Toutes les couches et les groupes sélectionnés seront supprimés de la légende.

Editing vector layer style

From the Layers panel, you have shortcuts to easily and quickly edit the layer rendering. Right-click on a vector
layer and select Styles –> in the list in order to:
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• see the currently applied styles to the layer. In case you defined many styles for the layer, you can switch
from one to another and have your layer rendering automatically updated in the map canvas.

• copy the current style, and when applicable, paste a copied style from another layer

• rename the current style, add a new one (which is actually a copy of the current one) or delete the current
style (when multiple styles available).

Note: The previous options are also available for raster layer.

Whether the features in the vector layer have all the same unique symbol or they are classified (in that case, the
layer is displayed in a tree structure with each class as sub-item), the following options are available at layer level
or class level:

• a Edit Symbol... button to open the Le Créateur de symboles dialog and update any property (symbol, size,
color...) of the layer or feature symbol. Double-clicking on a feature does also open the Symbol Selector
dialog.

• a Color Selector widget with a Color Wheel from which you can click a color and have it automatically
update the symbol fill color. For convenience, Recent colors are available at the bottom of the color wheel.

• a Show All Items and Hide All Items to toggle on or off the visibility of all the classes of features.
This avoids (un)checking items one by one.

Astuce: Quickly share a layer style
From the context menu, copy the style of a layer and paste it to a group or a selection of layers: the style is applied
to all the layers that are of the same type (vector vs raster) as the original layer and, in case of vector, have the
same geometry type (point, line or polygon).

Travailler avec un ordre des couches dans la légende indépendant du rendu cartographique

Un panneau permet de définir un ordre d’affichage des couches dans la légende indépendant de l’ordre de super-
position sur la carte. Vous pouvez l’activer via le menu Vue → Panneaux → Ordre des couches. Ceci vous permet,
par exemple, d’ordonner vos couches par ordre d’importance et garder une superposition correcte sur la carte (voir

figure_layer_order). Cochez la case Contrôler l’ordre de rendu sous la liste des couches permet de revenir au
comportement initial.

Statistical Summary Panel

This panel can show some statistics on a specific vector layers. The panel allows users to choose:

• the vector layer;

• the column or the expression;

• filter statistics to selected features;

• refresh the informations;

• the statistics information to display with the bottom right button;

QGIS Overview Panel

Dans QGIS, vous avez la possibilité de visualiser la totalité de l’étendue de couches en les ajoutant à l’aperçu.
Au sein de celui-ci un rectangle représente l’étendue de la carte. Cela permet de savoir quelle région de la carte
vous êtes en train de visualiser. Les étiquettes ne sont pas affichées dans l’aperçu même si les couches visibles
ont l’étiquetage activé. Si vous cliquez et déplacez le rectangle rouge qui montre votre emprise actuelle, la vue
principale se mettra à jour en conséquence.
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Figure 7.4: Définir un ordre des couches dans la légende indépendant du rendu cartographique

Log Messages Panel

When loading or processing some operations, you can track and follow messages that appear in different tabs

using the Log Messages Panel. It can be activated using the most right icon in the bottom status bar.

Undo/Redo Panel

For each layer being edited, this panel shows the list of actions done, allowing to quickly undo a set of actions by
simply selecting the action listed above.

7.3 Affichage de la carte

Également appelé Canevas de la carte, c’est la partie centrale de QGIS puisque les cartes y sont affichées ! Le
contenu qui s’affiche dépend des couches de types raster et vecteur que vous avez choisies de charger (lire les
sections suivantes pour plus d’informations sur comment charger une couche). L’emprise de la carte peut être
modifiée en portant le focus sur une autre région, ou en zoomant en avant ou en arrière. Plusieurs opérations
peuvent être effectuées sur la carte comme il est expliqué dans les descriptions des label_toolbars. La carte et la
légende sont étroitement liées — la carte reflète les changements que vous opérez dans la légende.

Astuce: Zoomer sur la carte avec la molette de la souris
Vous pouvez utiliser la molette de la souris pour changer le niveau de zoom de la carte. Placez votre curseur dans
la zone d’affichage de la carte et faites rouler la molette vers l’avant pour augmenter l’échelle, vers vous pour la
réduire. La vue sera recentrée sur la position du curseur de la souris. Vous pouvez modifier le comportement de la
molette de la souris en utilisant l’onglet Outils cartographiques dans le menu Préférences → Options.

Astuce: Se déplacer sur la carte avec les flèches et la barre espace
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Vous pouvez utiliser les flèches du clavier pour vous déplacer sur la carte. Placez le curseur sur la carte et appuyez
sur la flèche droite pour décaler la vue vers l’Est, la flèche gauche pour la décaler vers l’Ouest, la flèche supérieure
vers le Nord et la flèche inférieure vers le Sud. Vous pouvez aussi déplacer la carte en gardant la touche espace
appuyée et en bougeant la souris ou encore simplement en gardant la molette de la souris appuyée.

7.4 Barre d’état

The status bar provides you with general information about the map view, and actions processed or available and
offers you tools to manage the map view.

On the left side of the status bar, you can get a summary of actions you’ve done (such as selecting features in
a layer, removing layer) or a long description of the tool you are hovering over (not available for all tools). On
startup, the bar status also informs you about availability of new or upgradeable plugins (if checked in Plugin
Manager settings).

In case of lengthy operations, such as gathering of statistics in raster layers or rendering several layers in map
view, a progress bar is displayed in the status bar to show the current progress of the action.

The Coordinate option shows the current position of the mouse, following it while moving across the map
view. You can set the unit (and precision) to use in the project properties, General tab. Click on the small button

at the left of the textbox to toggle between the Coordinate option and the Extents option that displays in map
units, the coordinates of the current lower leftmost and upper rightmost points of the map view, as you pan and
zoom in and out.

Next to the coordinate display you will find the Scale display. It shows the scale of the map view. If you zoom in
or out, QGIS shows you the current scale. There is a scale selector, which allows you to choose among predefined
and custom scales to assign to the map view.

À droite de l’affichage de l’échelle, vous pouvez définir un angle de rotation horaire en degrés à appliquer à la
carte.

On the right side of the status bar, there is a small checkbox which can be used to temporarily prevent layers being
rendered to the map view (see section Rendu).

To the right of the render functions, you find the Current CRS: icon with the EPSG code of the current project
CRS. Clicking on this lets you Enable ‘on the fly’ CRS transformation properties for the current project and apply
another CRS to the map view.

Finally, the Messages button opens the Log Messages Panel which informs you on underlying process (QGIS
startup, plugins loading, processing tools...)

Astuce: Calculer l’échelle correcte de la carte
When you start QGIS, the default CRS is WGS 84 (epsg 4326) and units are degrees. This means that QGIS
will interpret any coordinate in your layer as specified in degrees. To get correct scale values, you can either
manually change this setting, e.g. to meters, in the General tab under Project → Project Properties, or you can

use the Current CRS: icon seen above. In the latter case, the units are set to what the project projection specifies
(e.g., +units=us-ft).

Note that CRS choice on startup can be set in Settings → Options → CRS.
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CHAPTER 8

Outils généraux

8.1 Raccourcis clavier

QGIS fournit des raccourcis claviers par défaut pour de nombreuses fonctionnalités. Vous les trouverez dans la
section Barre de Menu. Le sous-menu Préférences → Configurer les raccourcis... permet de personnaliser ces
raccourcis clavier et d’en définir pour les autres fonctionnalités de QGIS listées.

Figure 8.1: Définir les options des raccourcis

La configuration est très simple. Sélectionnez juste un élément de la liste et cliquez sur :

• [Changement] puis tapez la nouvelle combinaison de touches que vous souhaitez assigner à ce raccourci

• [Ne rien mettre] pour supprimer un raccourci déjà défini

• ou [Définir par défaut] pour enregistrer une valeur par défaut pour le raccourci.

Lorsque vous avez terminé, vous pouvez sauver la configuration dans un fichier XML en vue de charger cette
dernière dans un autre environnement d’exécution de QGIS (sur un autre ordinateur par exemple).

8.2 Aide contextuelle

Lorsque vous avez besoin d’aide sur un sujet spécifique, vous pouvez accéder à l’aide contextuelle via le bouton
[Aide] disponible dans la plupart des fenêtres — notez que les extensions additionnelles peuvent pointer vers des
pages web dédiées.

37



QGIS User Guide, Version 2.14

8.3 Rendu

Par défaut, QGIS effectue le rendu de toutes les couches visibles à chaque fois que l’affichage de la carte est mis
à jour. Les évènements qui déclenchent ce rafraîchissement incluent :

• l’ajout d’une couche

• le déplacement ou le zoom

• le redimensionnement de la fenêtre de QGIS

• la modification de la visibilité d’une ou plusieurs couches

QGIS vous laisse contrôler le processus de rendu de plusieurs manières.

8.3.1 Rendu dépendant de l’échelle

Le rendu dépendant de l’échelle permet de spécifier des échelles minimale et maximale auxquelles la couche doit
être visible. Pour définir une échelle de rendu, ouvrez la fenêtre de Propriétés en double-cliquant sur une couche

dans la légende et dans l’onglet Général, cochez la case Visibilité dépendante de l’échelle puis saisissez les
valeurs voulues.

Vous pouvez déterminer les valeurs d’échelle en zoomant au niveau que vous voulez utiliser et en notant les valeurs
de la barre d’état.

8.3.2 Contrôler le rendu

Le rendu de la carte peut être contrôlé de différentes manières, décrites ci-dessous.

Suspendre le rendu

Pour suspendre le rendu, cliquez sur la case Rendu dans le coin inférieur droit de la barre de statut. Quand
cette case n’est pas cochée, QGIS ne redessine pas la carte en réponse aux évènements décrits dans la section
Rendu. Voici quelques cas pour lesquels vous pourriez souhaiter ce comportement :

• Ajouter plusieurs couches et réaliser leur symbologie avant de les afficher

• Ajouter une ou plusieurs couches et définir leur dépendance d’échelle avant de les afficher

• Ajouter une ou plusieurs couches et zoomer à une vue spécifique avant de les afficher

• N’importe quelle combinaison des éléments précédents

Cocher la case Rendu activera de nouveau le rendu et provoquera un rafraîchissement immédiat de la carte.

Définir les options d’ajout de couche

Il est possible de définir une option qui chargera toutes les nouvelles couches sans les dessiner, elles seront ajoutées
à la carte, mais la case de visibilité sera décochée par défaut. Pour définir cette option, sélectionnez l’option

Préférences → Options et cliquez sur l’onglet Rendu. Décochez la case Par défaut les couches supplémentaires
sont affichées. Les nouvelles couches ajoutées à la carte seront invisibles par défaut.

Arrêter le rendu

Pour arrêter le rendu de la carte, appuyez sur la touche ESC. Ceci stoppera le rafraîchissement de la vue de la
carte et laissera la carte partiellement dessinée. Il est possible qu’il y ait un délai entre le moment où la touche est
pressée et le moment où le rendu de la carte est effectivement arrêté.
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Note: Il n’est maintenant plus possible d’arrêter le rendu — cela a été désactivé dans Qt4 à cause de problèmes
et de crashes dans l’interface utilisateur (IHM).

Influencer la qualité du rendu

QGIS dispose d’une option qui permet d’influencer la qualité du rendu de la carte. Dans le menu Préférences →
Options puis l’onglet Rendu, sélectionnez ou désélectionnez la case Les lignes semblent moins déchiquetées
aux dépends d’une certaine vitesse d’exécution.

Accéler le rendu

Il y a plusieurs manières d’améliorer la rapidité du rendu de la carte. Dans le menu Préférences → Options puis
onglet Rendu, sélectionnez ou désélectionnez les cases suivantes :

• Utiliser le cache du rendu si possible pour accélérer l’affichage

• Rendu des couches en parallèle en utilisant plusieurs cœurs du processeur puis définissez le Nombre
de cœurs à utiliser.

• The map renders in the background onto a separate image and each Map Update interval, the content
from this (off-screen) image will be taken to update the visible screen representation. However, if rendering
finishes faster than this duration, it will be shown instantaneously.

• With Enable Feature simplification by default for newly added layers, you simplify features’ geometry
(less nodes) and as a result, they quickly display. Be aware that you can also face rendering inconsistencies.

8.4 Color Selector

The select color dialog will appear whenever you push the icon to choose a color. The
features of this dialog depends on the state of the Use native color chooser dialogs parameter checkbox in Settings
→ Options → General menu. When checked, the color dialog used is the one of the OS being used. Otherwise,
QGIS custom color chooser is used.

This dialog has four different tabs which allow you to select colors by color ramp, color wheel, color swatches

or color picker (not available under ).

Whatever method you use, the selected color is always described through color sliders for HSV (Hue, Saturation,
Value) and RGB (Red, Green, Blue) values. There is also an opacity slider to set transparency level. On the lower
left part of the dialog you can see a comparison between the current and the new color you are presently selecting
and on the lower right part you have the option to add the color you just tweaked into a color slot button.

Astuce: Dynamically change the color with the live-updating option
Check the Use live-updating color chooser dialogs option in the General Settings to have the color applied to your
items as you change color parameters in the QGIS custom color chooser dialog.

With color ramp or with color wheel, you can browse to all possible color combinations. There are other

possibilities though. By using color swatches you can choose from a preselected list. This selected list is populated
with one of three methods:

• Recent colors,

• Standard colors, a user-defined list of colors set under Settings → Options → Colors menu

• or Project colors, a user-defined list of colors set under Project → Project Properties → Default Styles.
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Figure 8.2: Color selector ramp tab

Figure 8.3: Color selector switcher tab
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Another option is to use the color picker which allows you to sample a color from under your mouse pointer at
any part of QGIS or even from another application by pressing the space bar. Please note that the color picker is
OS dependent and is currently not supported by OSX.

Astuce: quick color picker + copy/paste colors
You can quickly choose from Recent colors, from Standard colors or simply copy or paste a color by clicking the

drop-down arrow that follows the color box.

Figure 8.4: Quick color selector menu

8.5 Modes de fusion

QGIS propose différentes options concernant les effets de rendu, options que vous connaissez peut-être des logi-
ciels de dessin. Les Modes de fusion peuvent être appliqués sur les couches, les entités mais également sur les
objets du composeur d’impression.

• Normal : il s’agit du mode de fusion standard qui utilise la valeur de transparence (canal alpha) du pixel
supérieur pour le fusionner avec le pixel sous-jacent, les couleurs ne sont pas mélangées.

• Éclaircir : Sélectionne le maximum entre chaque composante depuis les pixels du premier-plan et de
l’arrière-plan. Soyez attentif au fait que le résultat obtenu peut présenter un aspect dur et crénelé.

• Filtrer : Les pixels lumineux de la source sont affichés par dessus la destination, alors que les pixels sombres
ne le sont pas. Ce mode est utile pour mélanger la texture d’un élément avec un autre (par ex. vous pouvez
utiliser un relief ombré pour texturer une autre couche).

• Éviter : Ce mode va éclaircir et saturer les pixels sous-jacents en se basant sur la luminosité du pixel au-
dessus. La brillance des pixels supérieurs vont donc provoquer une augmentation de la saturation et de la
brillance des pixels inférieurs. Cela fonctionne mieux si les pixels supérieurs ne sont pas lumineux, sinon
l’effet sera trop prononcé.

• Addition : Ce mode de fusion ajoute simplement les valeurs de pixels d’un élément avec un autre. Dans le
cas de valeurs obtenues au-dessus de un (en ce qui concerne le RVB), du blanc sera affiché. Ce mode est
approprié pour mettre en évidence des entités.

• Assombrir : Ce mode créé un pixel résultant qui conserve le plus petit composants parmi les pixels du
premier-plan et de l’arrière-plan. Comme avec le mode éclaircir, le résultat peut présenter un aspect dur et
crénelé.

• Multiplier : Dans ce cas, les valeurs pour chaque pixel de l’élément supérieur sont multipliées par celles
des pixels correspondants de l’élément inférieur. Les images obtenues sont plus sombres.

• Découper : Les couleur sombres de l’élément supérieur provoquent un obscurcissement des éléments in-
férieurs. Découper peut être utilisé pour ajuster et teinter les couches inférieures.

• Revêtement : Ce mode combine les modes multiplier et filtrer. Dans l’image résultante, les parties lu-
mineuses deviennent plus lumineuses et les parties sombres plus sombres.
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• Lumière douce : Ce mode est très similaire au mode revêtement, mais au lieu d’utiliser multiplier/filtrer il
utilise découper/éviter. Il est censé émuler une lumière douce rayonnante dans l’image.

• Lumière dure : Ce mode est lui aussi très similaire au mode revêtement. Il est censé émuler une lumière
très intense projetée dans l’image.

• Différencier : Ce mode soustrait le pixel supérieur au pixel inférieur et vice-versa, de façon à toujours
obtenir une valeur positive. Le mélange avec du noir ne produit aucun changement, étant donné que toutes
les couleurs sont nulles.

• Soustraire : Ce mode soustrait les valeurs de pixel d’un élément avec un autre. En cas de valeurs négatives
obtenues, du noir est affiché.

8.6 Zoomer et se déplacer

QGIS fournit des outils pour zoomer et se déplacer vers une zone d’intérêt.

En plus d’utiliser les boutons Se déplacer dans la carte et Zoom + / Zoom - de la barre d’outils avec la souris, la
navigation peut également se faire avec la molette de la souris, la barre espace et les flèches du clavier.

8.6.1 Zoomer et se déplacer avec la molette de la souris

Vous pouvez appuyer sur la molette de la souris pour vous déplacer dans la fenêtre principale et la faire rouler
pour zoomer sur la carte. Pour vous rapprocher, placez le curseur sur la carte et faites rouler la molette vers l’avant
tandis que si vous voulez vous éloigner vous devrez la faire rouler vers vous. La position du curseur sera le centre
la zone affichée. Vous pouvez personnaliser le zoom via l’onglet Outils cartographiques du menu Préférences →

Options.

8.6.2 Se déplacer avec les flèches du clavier

Il est possible de se déplacer sur la carte en utilisant les flèches du clavier. Placez votre curseur sur la carte et
appuyez sur la flèche de droite pour vous déplacer vers l’Est, la flèche de gauche pour aller à l’Ouest, la flèche du
haut pour le Nord et celle du bas pour le Sud.

Vous pouvez utiliser la barre d’espace pour que les mouvements de la souris se traduisent par un déplacement sur
la carte. Les touches PgUp et PgDown vous permettront de zoomer.

8.7 Mesurer

QGIS propose quatre moyens de mesurer des géométries :

• les outils interactifs de mesure ,

• les mesures via la Calculatrice de champs,

• les mesures dérivées via l’outil Identifier les entités,

• et un outil d’analyse de couches vecteur : Vecteur → Outils de géométrie → Exporter/ajouter des colonnes
de géométrie.

Les mesures fonctionnent pour les systèmes de coordonnées projetés (par ex. UTM) et non projetés. Les trois
premiers outils de mesure utilisent les mêmes options, globales au projet :

Si la transformation de SCR “à la volée” est activée, la mesure se fera, à la différence de la plupart des autres
logiciels SIG, sur un ellipsoïde défini dans Projet → Propriétés du projet → Général. Cela se vérifie lorsqu’à
la fois des systèmes de coordonnées géographiques et des systèmes projetés sont utilisés dans le projet. Si vous
voulez calculer une superficie ou une distance projetée / planimétrique en utilisant les mathématiques cartésiennes,
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l’ellipsoïde de mesure doit être défini à “Aucun / Planimétrique”. Cependant, si un SCR géographique (non
projeté) est défini pour les données et le projet, les mesures de superficies et de distances se feront sur un ellipsoïde.
Si la transformation de SCR “à la volée” est désactivée, les mesures se feront de manière planimétrique pour un
projet dont le système de coordonnées est projeté et, pour un projet dont le système de coordonnées est non projeté
/ géographique, les mesures se baseront sur un ellipsoïde.

However, neither the identify tool nor the field calculator will transform your data to the project CRS before
measuring. If you want to achieve this, you have to use the vector analysis tool: Vector → Geometry Tools →
Export/Add Geometry Columns. Here, measurement is by default planimetric except if you choose the ellipsoidal
measure.

8.7.1 Mesurer des longueurs, des aires et des angles interactivement

All measuring modules use the snapping settings from the digitizing module. This is useful, if you want to measure
along lines or areas in vector layers.

Pour choisir un outil de mesure, cliquez sur et sélectionnez l’outil que vous souhaitez utiliser.

By default, Measure Line: QGIS measures real distances between given points according to a defined ellipsoid.
You can define a rubberband color and your preferred measurement units (meters or feet) and angle units (degrees,
radians and gon) in the menu option Settings → Options → Map Tools. The tool then allows you to click points
on the map. Each segment length, as well as the total, shows up in the measure window. To stop measuring,
click your right mouse button. Note that you can interactively change the measurement units in the measurement
dialog. It overrides the Preferred measurement units in the options. There is an info section in the dialog that
shows which CRS settings are being used during measurement calculations.

Figure 8.5: Mesure de distance

Mesurer une aire : les aires peuvent aussi être mesurées. Dans la fenêtre de mesure la surface totale mesurée
apparaît. En complément, l’outil de mesure s’accrochera à la couche sélectionnée à partir du moment où celle-ci
a un seuil d’accrochage défini (voir section Définir le rayon de tolérance d’accrochage et de recherche). Donc
si vous voulez mesurer avec exactitude le long d’une ligne ou autour d’un polygone, spécifiez d’abord un seuil
d’accrochage puis sélectionnez la couche. Avec l’outil de mesure, chaque clic de souris (se situant dans ce seuil
de tolérance) s’accrochera aux entités de cette couche.

Figure 8.6: Mesure d’une aire

Mesurer un angle : vous pouvez aussi mesurer des angles. Le curseur adopte une forme en croix. Cliquez pour
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dessiner le premier côté de l’angle à mesurer puis bougez le curseur pour dessiner l’angle désiré. La mesure est
affichée dans une fenêtre.

Figure 8.7: Mesure d’un angle

8.8 Sélectionner et désélectionner des entités

La barre d’outils fournit plusieurs outils de sélection d’entités à partir du canevas de la carte. Pour sélectionner

une ou plusieurs entités, cliquez sur et choisissez l’outil :

• Select Features by area or single click to select feature(s) either by simple click or by rectangle

• Sélection d’entités avec un polygone

• Sélection d’entités à main levée

• Sélection d’entités selon un rayon

Pour désélectionner toutes les entités, cliquez sur Désélectionner toutes les entités.

Sélectionner une entité en utilisant une expression permet à l’utilisateur de sélectionner des entités en utilisant la boîte de
dialogue des expressions. Consultez le chapitre Expressions pour des exemples.

Users can save selected features into a New Memory Vector Layer or a New Vector Layer using Edit → Copy
Features and Edit → Paste Features as in the wanted format.

8.9 Data defined override setup

Beside many options in the vector layer properties dialog or settings in the print composer, you can find a
Data defined override icon. Thanks to expressions based on layer attributes or item settings, prebuild or custom functions
and variables, this tool allows you to set dynamic value for the concerned parameter. When enabled, the value
returned by this widget is applied to the parameter regardless its normal value (checkbox, textbox, slider...).

Clicking the Data defined override icon shows:

• a Description ... that indicates if it is enabled, which input expected, valid input type and the current
definition,

• an entry to list the Field type available,

• an entry to list the Variable available,

• Edit ... button to create or edit the expression to use,

• Paste and Copy buttons,

• Clear button to remove the setup.
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Astuce: When the data-defined override option is setup correctly the icon is yellow or ; if it is broken,
the icon is red or .

Parameters that can be used with data-defined tools are:

• Style and symbols parameters

• Labels parameters

• Composer parameters

8.10 Identifier les entités

L’outil Identifier les entités vous permet d’interagir avec le canevas de la carte et d’afficher des informations sur
les entités dans un menu contextuel. Pour identifier une entité, utilisez Vue → Identifier les entités ou Ctrl +

Shift + I ou encore cliquez sur l’icône Identifier les entités dans la barre d’outils Attributs.

QGIS offers two ways to identify features with the Identify features tool:

• left click will identify features according to the mode set in the Identify results panel

• right click will fetch all the snapped features from all the visible layers. This will open a context menu,
allowing the user to choose more precisely the features to identify.

If you click on feature(s), the Identify results dialog will list information about the clicked feature(s). The default
view is a tree view where the first item is the name of the layer and its children are its identified feature(s). Each
feature is described by the name of a field along with its value. This field is the one set in Properties → Display.
Then follows all the other information about the feature.

Cette fenêtre se personnalise pour afficher les champs choisis mais par défaut, trois types d’information sont
affichés :

• Actions: Actions can be added to the identify feature windows. The action is run by clicking on the action
label. By default, only one action is added, namely view feature form for editing. You can define
more actions in the layer’s properties dialog.

• Derived: This information is calculated or derived from other information. This includes the feature id,
its length or perimeter and area in map units depending on its geometry, the count of spatial parts and the
number of the clicked part in case of multi-geometry, the count of vertices in the feature and the number of
the closest one to the point clicked. It also reports the X and Y (and Z/M if available) coordinate values of
both clicked point and feature closest vertex.

• Data attributes: This is the list of attribute fields and values for the feature that has been clicked.

Figure 8.8: Fenêtre d’identification des entités
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En haut de la fenêtre, vous avez sept icônes :

• Déplier

• Replier

• Default behavior to define whether next identified features information should be collapsed or expanded

• Voir le formulaire d’entité

• Clear Results

• Copier les entités sélectionnées dans le presse papier

• Imprimer la réponse HTML sélectionnée

At the bottom of the window, you have the Mode and View comboboxes. With the Mode combobox you can define
from which layers features should be identified:

• ‘Current layer’ : only features from the selected layer are identified. The layer may not be visible in the
canvas.

• ‘Top down, stop at first’: for only features from the upper visible layer.

• ‘Top down’: for all features from the visible layers. The results are shown in the panel.

• and ‘Layer selection’: opens a context menu where the user selects the layer to identify features from.
Operates like a right-click. Only the chosen features will be shown in the result panel.

The View can be set as ‘Tree’, ‘Table’ or ‘Graph’. ‘Table’ and ‘Graph’ views can only be set for raster layers.

The identify tool allows you to auto open a form. If checked, each time a single feature is identified QGIS will
open a form showing its attributes. This is a handy way to quickly edit a feature’s attributes.

D’autres fonctions peuvent être trouvées dans le menu contextuel d’un élément identifié, via un clic droit. Par
exemple, depuis le menu contextuel, vous pouvez :

• Voir le formulaire d’entité

• Zoomer sur l’entité

• Copier l’entité : copie toute la géométrie et les attributs d’une entité

• Toggle feature selection: Adds identified feature to selection

• Copier les valeurs d’attributs : copie uniquement les valeurs d’attributs de l’entité identifiée

• Copy feature attributes: Copy the attributes of the feature

• Lâcher les résultats : la fenêtre de résultats est vidée

• Masquer la surbrillance : la surbrillance des entités identifiées sur la carte est retirée

• Tout mettre en surbrillance

• Mettre la couche en surbrillance

• Activer une couche : Choisir la couche à activer

• Propriétés : ouvre la fenêtre des propriétés de la couche

• Tout déplier

• Tout replier
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8.11 Outils d’annotation

The Text Annotation tool in the attribute toolbar provides the possibility to place formatted text in a balloon on the
QGIS map canvas. Use the Text Annotation tool and click into the map canvas.

Figure 8.9: La fenêtre d’annotation de texte

Un double clic sur l’annotation ouvre une fenêtre avec diverses options. Il y a un éditeur de texte pour entrer du
texte formaté et d’autres options notamment la possibilité de figer la position de l’annotation dans la carte (montré
par un symbole de marqueur) ou d’avoir la position de l’annotation relativement à l’écran (non liée à la carte). La
position de l’élément peut être déplacé sur la carte (en déplaçant le marqueur de carte) ou en déplaçant seulement
la bulle. Les icônes font partie du thème SIG et sont utilisées par défaut dans les autres thèmes, aussi.

The Move Annotation tool allows you to move the annotation on the map canvas.

8.11.1 Annotations HTML

The Html Annotation tools in the attribute toolbar provides the possibility to place the content of an html file in a
balloon on the QGIS map canvas. Using the Html Annotation tool, click into the map canvas and add the path to
the html file into the dialog.

8.11.2 Annotations SVG

The SVG Annotation tool in the attribute toolbar provides the possibility to place an SVG symbol in a balloon on
the QGIS map canvas. Using the SVG Annotation tool, click into the map canvas and add the path to the SVG file
into the dialog.

8.11.3 Formulaire d’annotation

Additionally, you can also create your own annotation forms. The Form Annotation tool is useful to display
attributes of a vector layer in a customized Qt Designer form (see figure_custom_annotation). This is similar
to the designer forms for the Identify features tool, but displayed in an annotation item. Also see this video
https://youtu.be/0pDBuSbQ02o?t=2m25s from Tim Sutton for more information.
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Figure 8.10: Customized qt designer annotation form

Note: Si vous pressez les touches Ctrl+T alors que l’outil Annotation est activé (déplacement d’annotation,
annotation de texte ou formulaire d’annotation), les annotations sont automatiquement cachées ou, inversement,
rendues visibles.

8.12 Signets spatiaux

Spatial Bookmarks allow you to “bookmark” a geographic location and return to it later. Bookmarks are saved on
the computer, meaning that they are available from any project in the same computer.

8.12.1 Créer un signet

Pour créer un signet :

1. Déplacez-vous sur la zone concernée.

2. Select the menu option View → New Bookmark or press Ctrl-B. The Spatial Bookmark panel opens with
the newly created bookmark.

3. Entrez un nom pour décrire le signet (jusqu’à 255 caractères).

4. Press Enter to add the bookmark or click elsewhere.

Notez que vous pouvez avoir plusieurs signets portant le même nom.

8.12.2 Travailler avec les signets

To use or manage bookmarks, select the menu option View → Show Bookmarks. The Spatial Bookmarks panel
allows you to:

• Zoom to a Bookmark: select the desired bookmark and then click Zoom To Bookmark. You can also zoom
to a bookmark by double-clicking on it.

• Delete a Bookmark: select the bookmark and click Delete Bookmark. Confirm your choice.
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• Import or Export a bookmark: To share or transfer your bookmarks between computers you can use the
Import/Export Bookmarks pull down menu in the Spatial Bookmarks dialog. All the bookmarks are trans-
ferred.

8.13 Inclusion de projets

Si vous souhaitez inclure dans votre projet QGIS des couches ou des groupes de couches issus d’un autre projet,
utilisez le menu Couches → Intégrer des couches et des groupes.

8.13.1 Intégrer des couches

La fenêtre suivante vous permet d’intégrer des couches provenant d’autres projets QGIS :

1. Press to look for a project from the Alaska dataset.

2. Select the project file relations.qgs. You can see the content of the project (see figure_embed_dialog).

3. Press Ctrl and click on the layers airports and regions. Press [OK]. The selected layers are em-
bedded in the map legend and the map view now.

Figure 8.11: Select layers and groups to embed

Bien que les couches intégrées soient éditables, vous ne pouvez pas en modifier le style et l’étiquetage.

8.13.2 Supprimer des couches intégrées

Right-click on the embedded layer and choose Remove.

8.14 Décorations

The Decorations of QGIS include the Grid, the Copyright Label, the North Arrow and the Scale Bar. They are
used to ‘decorate’ the map by adding cartographic elements.

8.14.1 Grille

Grille vous permet d’ajouter un graticule et des coordonnées à la carte.

1. Sélectionnez via le menu Vue → Décorations → Grille. La fenêtre s’affiche (voir figure_decorations_1).

2. Cochez la case Activer la grille et définissez les paramètres de la grille en fonction des couches chargées
dans le canevas de carte.
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Figure 8.12: La fenêtre Grille

3. Cochez la case Dessiner une annotation et définissez les propriétés de l’annotation en fonction des
couches chargées dans le canevas de carte.

4. Click [Apply] to verify that it looks as expected or [OK] if you’re satisfied.

8.14.2 Étiquette de Copyright

Étiquette de Copyright ajoute une zone de texte permettant de spécifier le Copyright de la carte.

Figure 8.13: La fenêtre de Copyright

1. Sélectionnez via le menu Vue → Décorations → Étiquette de Copyright. La fenêtre s’affiche (voir fig-
ure_decorations_2).

2. Assurez-vous que la case Activer l’étiquette des droits d’auteur est cochée.

3. Entrez le texte que vous souhaitez afficher sur la carte. Vous pouvez utiliser du code HTML comme le
montre l’exemple.

4. Choisissez l’emplacement de l’étiquette dans la liste déroulante Position .
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5. You can refine the placement of the item by setting a Horizontal and/or Vertical Marging from (Canvas)
Edge. These values can be a distance in Millimeter or Pixels or set as Percentage of the width or height of
the map canvas.

6. You can change the color to apply.

7. Click [Apply] to verify that it looks as expected or [OK] if you’re satisfied.

Dans l’exemple ci-dessus, proposé par défaut, QGIS place un symbole de copyright suivi de la date dans le coin
inférieur droit de la carte.

8.14.3 Flèche du nord

North Arrow places a simple north arrow on the map canvas. Currently, there is only one style available. You can
adjust the angle of the arrow or let QGIS set the direction automatically. If you choose to let QGIS determine the
direction, it makes its best guess as to how the arrow should be oriented. For placement of the arrow, you have
four options, corresponding to the four corners of the map canvas. You can refine the placement of the arrow by
setting a Horizontal and/or Vertical Marging from (Canvas) Edge. These values can be a distance in Millimeter
or Pixels or set as Percentage of the width or height of the map canvas.

Figure 8.14: La fenêtre de flèche du nord

8.14.4 Échelle graphique

Échelle graphique ajoute une simple barre d’échelle sur la carte. Vous choisissez le style, l’emplacement ainsi que
les étiquettes de la barre.

Figure 8.15: La fenêtre de barre d’échelle
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QGIS permet uniquement d’afficher l’échelle dans la même unité que celle de la carte. Donc, si l’unité est le
mètre, vous ne pouvez créer une échelle en pieds. De la même manière, si vous utilisez les degrés décimaux, vous
ne pouvez afficher une échelle en mètres.

Pour ajouter une échelle graphique :

1. Sélectionnez le menu Vue → Décorations → Échelle graphique. Une fenêtre s’affiche (voir fig-
ure_decorations_4).

2. Assurez-vous que la case Activer l’échelle graphique est cochée.

3. Choisissez le style dans la liste déroulante Style de la barre d’échelle .

4. Sélectionnez la couleur dans Couleur de la barre ou laissez le noir défini par défaut.

5. Définissez la Taille de la barre .

6. Optionally, check Automatically snap to round number on resize to display values easy-to-read.

7. Choisissez l’emplacement dans la liste déroulante Emplacement .

8. You can refine the placement of the item by setting a Horizontal and/or Vertical Marging from (Canvas)
Edge. These values can be a distance in Millimeter or Pixels or set as Percentage of the width or height of
the map canvas.

9. Click [Apply] to verify that it looks as expected or [OK] if you’re satisfied.

Astuce: Paramètre des décorations
Lorsque vous sauvegardez un projet .qgs, toutes modifications faites sur le Carroyage, la Flèche du Nord, la
Barre d’Échelle et le Copyright seront sauvées dans le fichier de projet et restaurées à la prochaine ouverture du
projet.

8.15 Authentification

QGIS has facility to store/retrieve authentication credentials in a secure manner. Users can securely save cre-
dentials into authentication configurations, which are stored in a portable database, can be applied to server or
database connections, and safely referenced by their ID tokens in project or settings files. For more information
see Système d’authentification.

A master password needs to be set up when initializing the authentication system and its portable database.

8.16 Save layer into file

Layers (raster or vector) can be saved in another format with the Save As... feature in the layer contextual menu
(by right-clicking in the layer in the layer tree) or in the Layer → Save As... menu.

The Save As dialog shows several parameters to change the behaviour when saving the layer. Common parameters
(raster and vector) are:

• Format

• Filename

• SCR

• Add save file to map to add the new layer to the canvas

• Extent (possible values are layer, Map view or custom extent)

• Create (for raster), Layer or Custom (for vector) Options which allow you to change some advanced options.
Advanced user can see the driver documentation in gdal-ogr documentation.
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However, some parameters are specific to raster and vector formats:

• Raster specific parameters:

– Resolution (horizontal and vertical)

– Pyramid creation

– Output mode (raw data or rendered image)

• Vector specific parameters:

– Encodage

– Save only selected features

– Skip attribute creation

– Symbology export: can be used mainly for DXF export and for all file formats who manage OGR
feature styles (see note below) as DXF, KML, tab file formats:

* No symbology: default style of the application that reads the data

* Feature symbology: save style with OGR Feature Styles (see note below)

* Symbol Layer symbology: save with OGR Feature Styles (see note below) but export the same
geometry multiple times if there are multiple symbology symbol layers used

– Geometry:

* force to multi-geometry,

* add z-dimension,

* add or remove a geometry column with the drop-down list. This is not linked with the current
geometry type of the layer. You can add an empty geometry column to an attribute table, remove
the geometry column of a spatial layer.

Note: OGR Feature Styles are a way to store style directly in the data as a hidden attribute. Only some format
can handle this kind of information. KML, DXF and TAB files format are such format. For advanced user, you
can read the OGR Feature Styles specification document.

Note: À propos des fichiers DXF
Vector layers can be exported to DXF files using another tool, the DXF Export ... in Project. The windows allow
the user to choose the layer file, the symbology mode (see the note above), the symbology scale, the encoding, the
visibility preset and the layers to include in the DXF file.

As an option, you can Use the layer title as name if set or Export features intersecting the current map extent.

8.17 Use of variables for dynamic content

You can define custom variables for use in expressions. Variables can be defined at the application global level,
project level, layer level and composition level. Just like CSS cascading rules, variables can be overwritten - eg,
a project level variable will overwrite any application level variables set. You can use these variables to build
text strings or other custom expressions using @ character before the variable name. For example in composer
creating a label with this content:

This map was made using QGIS [% @qgis_version %]. The project file for this
map is: [% @project_path %]

Will render the label like this:

This map was made using QGIS 2.14. The project file for this map is:
/gis/qgis-user-conference-2015.qgs
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You can manage global variables from the Settings → Options menu, and project level variables from Project
properties (including adding your own custom variables).

Figure 8.16: Edit variable at the project level

Note: you can read more information and find examples here Exploring variables in QGIS 2.12, part 1, part 2
and part 3.
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CHAPTER 9

Configuration de QGIS

QGIS se configure via le menu Préférences, qu’il s’agisse des Propriétés du projet, des Options ou de la Person-
nalisation.

Note: QGIS follows desktop guidelines for the location of options and project properties item. Consequently
related to the OS you are using, location of some of items described below could be in the Project or the Settings
menu.

9.1 Propriétés du projet

Dans la fenêtre des propriétés du projet du menu Préférences → Propriétés du projet (kde) ou Projet→
Propriétés du projet (Gnome, OS X ou Windows), vous pouvez définir les options spécifiques à un projet.

• In the General menu, the general settings let you:

– give a title to the project beside the project file path

– choose the color to use for features when they are selected

– choose the background color: the color to use for the map canvas

– set whether the path to layers in the project should be saved as absolute (full) or as relative to the
project file location. You may prefer relative path when both layers and project files can be moved or
shared or if the project is accessed from computers on different platforms.

– choose to avoid artifacts when project is rendered as map tiles. Note that checking this option can lead
to performance degradation.

Calculating areas and distances is a common need in GIS. However, these values are really tied to the
underlying projection settings. The Measurements frame lets you control these parameters. You can indeed
choose:

– the ellipsoid to use: it can be an existing one, a custom one (you’ll need to set values of the semi-major
and semi-minor axis) or None/Planimetric.

– the units for distance measurements for length and perimeter and the units for area measurements.
These settings, which default to the units set in QGIS options but then overrides it for the current
project, are used in:

* Attribute table field update bar

* Field calculator calculations

* Identify tool derived length, perimeter and area values

* Default unit shown in measure dialog
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The Coordinate display allows you to choose and customize the format of units to use to display the mouse
coordinate in the status bar and the derived coordinates shown via the identify tool.

Finally, you can define a project scale list, which overrides the global predefined scales.

Figure 9.1: General tab of Project Properties dialog

• Le menu SCR vous permet de choisir le Système de Coordonnées de Référence pour le projet et d’activer la
projection à la volée des couches raster et vecteur définies dans un SCR différent.

• With the Identify layers menu, you set (or disable) which layers will respond to the identify tool. By default,
layers are set queryable.

• The Default Styles menu lets you control how new layers will be drawn when they do not have an existing
.qml style defined. You can also set the default transparency level for new layers and whether symbols
should have random colors assigned to them. There is also an additional section where you can define
specific colors for the running project. You can find the added colors in the drop down menu of the color
dialog window present in each renderer.

• The tab OWS Server allows you to define information about the QGIS Server WMS and WFS capabilities,
extent and CRS restrictions.

• Le menu Macros permet d’éditer des modules Python pour les projets. Actuellement, seules trois macros
sont disponibles : openProject(), saveProject() et closeProject().

• L’onglet Relations permet de définir des relations 1:n. Les relations sont définies dans la fenêtre des pro-
priétés du projet. Une fois les relations définies sur une couche, un nouvel élément apparaît dans la vue
formulaire de cette couche (par exemple, lors de l’identification d’une entité et l’ouverture du formulaire
associé) et vous liste les entités qui lui sont reliées. Ceci fournit un moyen puissant d’exprimer, par exemple,
l’historique d’inspection le long d’une pipeline ou d’un tronçon de route. Vous trouverez de plus amples
informations sur les relation 1:n dans la section Créer des relations un à plusieurs.
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Figure 9.2: Paramètres des macros dans QGIS

9.2 Options

Quelques options basiques peuvent être sélectionnées dans la fenêtre Options via le menu Préférences →
Options. Les onglets dans lesquels vous pouvez configurer les options sont décrits ci-dessous.

9.2.1 Onglet Général

Application

• Sélectionnez Style (redémarrage de QGIS nécessaire) et choisissez entre ‘Oxygen’, ‘Windows’, ‘Mo-
tif’, ‘CDE’, ‘Plastique’ ou ‘Cleanlooks’ ( ).

• Définissez le Thème d’Icône . Actuellement seul le thème ‘default’ est disponible.

• Définissez la Taille de l’icône .

• Définissez la Police et choisissez entre Défaut Qt et une police de votre choix.

• Changez le Délai d’abandon pour les messages ou les fenêtres .

• Cacher l’écran de démarrage

• Montrer les astuces au démarrage

• Titre des groupes de couches en gras

• Style QGIS pour les groupes de couches

• Utiliser les fenêtres natives de choix de couleur

• Fenêtres de choix de couleur avec mise à jour dynamique

• Style personnalisé de la barre latérale

• Rotation du canevas de la carte (expérimental, redémarrage requis)

Fichiers projet
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• Ouverture du projet au démarrage (choisissez entre ‘Nouveau’, ‘Dernier utilisé’ et ‘Spécifique’).

Lorsque vous choisissez ‘Spécifique’, utilisez le bouton pour sélectionner un projet.

• Créer les nouveaux projets à partir du projet par défaut. Vous pouvez choisir d’Utiliser le projet courant
comme défaut ou de Réinitialiser le projet par défaut. Vous pouvez parcourir vos fichiers et sélectionner
le répertoire où sont stockés vos modèles de projets personnalisés. Cela créera une nouvelle entrée dans le

menu Projet → Nouveau depuis un modèle si vous cochez Créer les nouveaux projets à partir du projet
par défaut et sauvegardez un projet dans le répertoire de modèles de projets spécifié.

• Demander de sauver le projet et les sources de données quand nécessaire

• Demander une confirmation lorsqu’une couche va être supprimée

• M’avertir lors de l’ouverture d’un fichier projet sauvegardé avec une version précédente de QGIS

• Activer les macros . Cette option a été créée pour gérer les macros devant exécuter des actions sur des
événements du projet. Vous pouvez choisir entre ‘Jamais’, ‘Demander’, ‘Uniquement pour cette session’ et
‘Toujours (non recommandé)’.

9.2.2 Menu Système

Environnement

Les variables d’environnement Système peuvent maintenant être visualisées et configurées pour certains dans
le groupe Environnement (voir figure_environment_variables). Ceci est pratique sur certaines plateformes, no-
tamment sur Mac, ou une application avec interface graphique n’hérite pas nécessairement des paramètres de
l’environnement en ligne de commande de l’utilisateur. Ceci est aussi utile pour paramétrer/visualiser les variables
d’environnement des outils externes contrôlés par la boîte à outils de traitement (par exemple SAGA, GRASS) et
activer les sorties de débogage pour des sections spécifiques du code source.

• Utiliser des variables personnalisées (redémarrage requis - inclure des séparateurs). Vous pouvez
[Ajouter] et [Supprimer] des variables. Les variables d’environnement déjà définies sont affichées dans

Variables d’environnement courantes, et il est possible de les filtrer en activant Afficher uniquement les
variables liées à QGIS.

Chemins vers les extensions

[Ajouter] ou [Supprimer] un ou des Chemin(s) vers des extensions C++ supplémentaires

9.2.3 Onglet Sources de données

Attributs et tables

• Ouvrir la table d’attributs dans une fenêtre intégrée (redémarrage requis)

• Copier la représentation WKT de la géométrie depuis la table attributaire. Lorsque vous utilisez
Copier les lignes choisies dans le presse-papier depuis la fenêtre Table attributaire, cette option permet de recopier aussi
les coordonnées des points ou des vertex dans le presse-papier.

• Attribute table behavior . There are three possibilities: ‘Show all features’, ‘Show selected features’
and ‘Show features visible on map’.

• Attribute table row cache . This row cache makes it possible to save the last loaded N attribute rows
so that working with the attribute table will be quicker. The cache will be deleted when closing the attribute
table.

• Représentation des valeurs NULL permet de définir une valeur par défaut pour les champs contenant la
valeur NULL.

Gestion des sources de données
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Figure 9.3: Variables d’environnement Système dans QGIS

9.2. Options 59



QGIS User Guide, Version 2.14

• Scan for valid items in the browser dock . You can choose between ‘Check extension’ and ‘Check file
contents’.

• Scan for contents of compressed files (.zip) in browser dock . ‘No’, ‘Basic scan’ and ‘Full scan’ are
possible.

• Demande à l’ouverture s’il y a des sous-couches raster. Certains rasters comportent des sous-couches
- appelées sous-jeux de données dans GDAL. Par exemple les fichiers netCDF - s’il y a de nombreuses
variables netCDF, GDAL considérera chaque variable comme un sous-jeux de données. L’option vous
permet de choisir comment traiter les sous-jeux de données quand un fichier avec des sous-couches est
ouvert. Vous avez les choix suivants :

– ‘Toujours’ : Demande toujours (s’il existe des sous-couches)

– ‘Si nécessaire’ : Demande si la couche n’a pas de bande, mais qu’elle possède des sous-couches

– ‘Jamais’ : Ne demande jamais, mais ne charge rien

– ‘Charger tout’ : Ne demande jamais, mais charge toutes les sous-couches

• Ignore shapefile encoding declaration. If a shapefile has encoding information, this will be ignored by
QGIS.

• Ajouter des couches PostGIS avec un double-clic et sélectionner en mode étendu

• Ajouter les couches Oracle par double-clic et sélection en mode étendu

• Execute expressions on server-side if possible

• create transaction groups automatically whenever possible (Experimental). When this mode is turned
on, all (postgres) layers from the same database are synchronised in their edit state, i.e. when one layer is
put into edit state, all are, when one layer is committed or one layer is rolled back, so are the others. Also,
instead of buffering edit changes locally, they are directly sent to a transaction in the database which gets
committed when the user clicks save layer.

Hidden Browser Path

This widget lists all the folder you chose to hide from the Browser panel. Removing a folder from the list will
make it available in the Browser panel.

9.2.4 Onglet Rendu

Rendering behavior

• Par défaut les couches supplémentaires sont affichées

• Utiliser le cache du rendu si possible pour accélérer l’affichage

• Rendu des couches en parallèle en utilisant plusieurs cœurs du processeur

• Nombre de cœurs à utiliser

• Intervalle de rafraîchissement de l’affichage de la carte (par défaut de 250 ms)

• Enable feature simplification by default for newly added layers

• Seuil de simplification

• Réaliser la simplification par le prestataire de service lorsque c’est possible

• Échelle maximale à partir de laquelle la couche doit être simplifiée

Qualité du rendu

• Les lignes semblent moins déchiquetées aux dépends d’une certaine vitesse d’exécution
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Rasters

• Avec la Sélection de bande RVB, vous pouvez définir la valeur des bandes Rouge, Verte et Bleue.

Amélioration du contraste

• Single band gray . A single band gray can have ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip
to MinMax’ and also ‘Clip to MinMax’.

• Multi band color (byte/band) . Options are ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip to
MinMax’ and ‘Clip to MinMax’.

• Multi band color (>byte/band) . Options are ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip to
MinMax’ and ‘Clip to MinMax’.

• Limits (minimum/maximum) . Options are ‘Cumulative pixel count cut’, ‘Minimum/Maximum’,
‘Mean +/- standard deviation’.

• Limite de découpe pour le comptage cumulé de pixels

• Multiplicateur de l’écart-type

Déboggage

• Actualisation de la carte

9.2.5 Onglet couleurs

Cet onglet vous permet d’ajouter des couleurs personnalisées supplémentaires que vous pouvez trouver dans
chaque fenêtre de dialogue des rendus de couleur. Vous verrez un jeu de couleurs prédéfinies dans l’onglet :
vous pouvez supprimer ou éditer chacune d’entre elles. Vous pouvez également ajouter la couleur que vous voulez
et effectuer une opération de copier-coller. Finalement, vous pouvez importer ou exporter un jeu de couleurs
comme fichier gpl.

9.2.6 Onglet Carte et légende

Apparence de la carte par défaut (écrasée par les propriétés du projet si définies)

• Définir la Couleur de la sélection et la Couleur de fond.

Légende des couches

• Double click action in legend . You can either ‘Open layer properties’ or ‘Open attribute table’ with
the double click.

• Les Styles des objets de la légende peuvent être :

– Noms de couches en majuscules

– Noms de couches en gras

– Noms de groupes de couches en gras

– Afficher le nom du champ de classification

– Créer des icônes raster dans la légende (lent)

9.2.7 Onglet Outils cartographiques

This menu offers some options regarding the behavior of the Identify tool.
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• Rayon de recherche pour identifier les entités et afficher les infobulles est un facteur de tolérance exprimé
comme un pourcentage de la largeur de la carte. Cela signifie que l’outil identifier illustrera les résultats tant
que vous cliquez à l’intérieur de cette tolérance.

• Couleur de surbrillance vous permet de choisir avec quelle couleur les entités qui devraient être identifiées
sont en surbrillance.

• Buffer determines a buffer distance to be rendered from the outline of the identify highlight.

• Minimum width determines how thick should the outline of a highlighted object be.

Outils de mesure

• Définir la Couleur du trait des outils de mesure

• Définir le Nombre de décimales

• Keep base unit to not automatically convert large numbers (e.g., meters to kilometers)

• Preferred distance units (‘Meters’, ‘Feet’, ‘Nautical Miles’, ‘Degrees’ or ‘Map Units’ )

• Preferred area units (‘Square meters’, ‘Square feet’, ‘Square yards’, ‘Hectares’, ‘Map Units’ ...)

• Preferred angle units (‘Degrees’, ‘Radians’, ‘Gon/gradians’, ‘Minutes of arc’ ...)

Déplacement et zoom

• Define Mouse wheel action (‘Zoom’, ‘Zoom and recenter’, ‘Zoom to mouse cursor’, ‘Nothing’)

• Définir le Facteur de zoom pour la molette de la souris

Échelles prédéfinies

Here, you find a list of predefined scales. With the and buttons you can add or remove your personal
scales. You can also import or export scales from/to a .XML file. Note that you still have the possibility to remove
your changes and reset to the predefined list.

9.2.8 Onglet Composeur d’impression

Valeurs par défaut pour les compositions

Vous pouvez définir une Police par défaut ici.

Apparence de la grille

• Define the Grid style (‘Solid’, ‘Dots’, ‘Crosses’)

• Définir la Couleur de la grille

Grille et guide par défaut

• Define the Grid spacing

• Define the Grid offset for x and y

• Define the Snap tolerance

9.2.9 Onglet Numérisation

Création d’entités

• Supprimer les fenêtres d’avertissements lors de la création de chaque entité

• Réutiliser la dernière valeur attributaire saisie
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• Validate geometries. Editing complex lines and polygons with many nodes can result in very slow rendering.
This is because the default validation procedures in QGIS can take a lot of time. To speed up rendering, it is
possible to select GEOS geometry validation (starting from GEOS 3.3) or to switch it off. GEOS geometry
validation is much faster, but the disadvantage is that only the first geometry problem will be reported.

Contours d’édition

• Définissez la Largeur de ligne et la Couleur de ligne du trait lors de l’édition.

Accrochage

• Ouvrir les options d’accrochage dans une fenêtre intégrée (redémarrage de QGIS requis)

• Define Default snap mode (‘To vertex’, ‘To segment’, ‘To vertex and segment’, ‘Off’)

• Définir Tolérance d’accrochage par défaut en unités de carte ou en pixels

• Définir le Rayon de recherche pour l’édition des sommets en unités de carte ou en pixels

Symbole des sommets

• Montrer les symboles uniquement pour les entités sélectionnées

• Define vertex Marker style (‘Cross’ (default), ‘Semi transparent circle’ or ‘None’)

• Définir la Taille du marqueur des sommets

Outil de décalage de courbe

The next 3 options refer to the Offset Curve tool in Numérisation avancée. Through the various settings, it is
possible to influence the shape of the line offset. These options are possible starting from GEOS 3.3.

• Style de jointure

• Segments de quadrant

• Limite de la pointe

9.2.10 Onglet GDAL

GDAL est une bibliothèque qui permet de gérer les fichiers raster. Dans cet onglet, vous pouvez Modifier les
options des pyramides et Modifier les options de création des différents formats raster ainsi que définir quel pilote
GDAL utiliser dans le cas où plus d’un est disponible.

9.2.11 Onglet SCR

SCR par défaut pour les nouveaux projets

• Ne pas activer la reprojection à la volée

• Activer automatiquement la projection à la volée si les couches ont des SCR différents

• Activer la reprojection ‘à la volée’ par défaut

• Sélectionner un SCR et Toujours lancer ce SCR pour les nouveaux projets

SCR pour les nouvelles couches

Cet espace vous permet de définir une action à faire lorsqu’une nouvelle couche est créée ou lorsqu’une couche
sans SCR est chargée.

• Demander le SCR

• Utiliser le SCR du projet

• Utiliser ce SCR par défaut
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Transformations géodésiques par défaut

• Demander un datum pour la conversion de coordonnées lorsque aucun n’est défini par défaut

• Si vous avez utilisé la ‘projection à la volée’, vous pouvez visualiser les transformations effectuées en
bas de la fenêtre. Vous y trouverez des informations sur le ‘SCR source’ et le ‘SCR cible’ ainsi que la
‘Transformation géodésique source’, appliquée au SCR source, et la ‘Transformation géodésique cible’,
appliquée au SCR cible.

9.2.12 Onglet Langue

• Écraser la langue du système et la Langue à utiliser

• Informations sur les paramètres de langue du système

9.2.13 Authentification

In the Authentication tab you can set authentication configurations and manage PKI certificates. See Système
d’authentification for more details.

9.2.14 Onglet Réseau

Général

• Définir l’Adresse de recherche WMS, par défaut : http://geopole.org/wms/search?search=\%1\&type=rss

• Définir le Délai d’abandon pour les requêtes réseaux (ms) - la valeur par défaut est 60000

• Définir le Délai d’expiration pour les tuiles WMSC/WMTS (en heures)- la valeur par défaut est 24

• Définir le Nombre d’essais maximum lors d’une erreur de requête vers une tuile

• Définir le User-Agent

Paramètres du cache

Définir le Répertoire et la Taille du cache.

• Utiliser un proxy pour l’accès internet et définir l’‘Hôte’, le ‘Port’, l’‘Utilisateur’, et le ‘Mot de passe’.

• Set the Proxy type according to your needs.

– Default Proxy : le proxy est déterminé sur la base du proxy de l’application

– Socks5Proxy : proxy générique pour tout type de connexion. Supporte le TCP, UDP, binding à un port
(connexions entrantes) et l’authentification.

– HttpProxy : implémenté avec la commande “CONNECT” , supporte uniquement les connexions TCP
sortantes, supporte l’authentification.

– HttpCachingProxy : implémenté via les commandes HTTP normales, utile uniquement dans un con-
texte de requêtes HTTP.

– FtpCachingProxy : implémenté avec un proxy FTP, utile uniquement dans un contexte de requêtes
FTP.

Vous pouvez exclure certaines adresses en les ajoutant dans la zone de texte sous les paramètres de proxy (voir
Figure_Network_Tab).

Si vous avez besoin d’informations plus détaillées sur les différents paramètres de proxy, référez-vous au manuel
de la bibliothèque sous-jacente QT : http://doc.trolltech.com/4.5/qnetworkproxy.html#ProxyType-enum.

Astuce: Utiliser les proxy
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Figure 9.4: Proxy-settings in QGIS
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L’utilisation de proxy peut se révéler difficile. Il est utile de tester les types de proxy décrits ci-dessus et vérifier
s’ils conviennent.

Vous pouvez modifier les options selon vos besoins. Certaines modifications peuvent nécessiter un redémarrage
de QGIS pour qu’elles soient effectives.

• Les paramètres sont sauvegardés dans un fichier texte : $HOME/.config/QGIS/QGIS2.conf

• Les paramètres se trouvent dans: $HOME/Library/Preferences/org.qgis.qgis.plist

• Les paramètres sont stockés dans la base de registre, sous:
HKEY\CURRENT_USER\Software\QGIS\qgis

9.3 Personnalisation

The customization dialog lets you (de)activate almost every element in the QGIS user interface. This can be very
useful if you want to provide your end-users with a ‘light’ version of QGIS, containing only the icons, menus or
panels they need.

Note: Pour que les modifications soient appliquées, vous devrez redémarrer QGIS.

Figure 9.5: La fenêtre de personnalisation (Paramétrage)

Cocher Autoriser la modification est la première étape pour personnaliser l’IHM de QGIS. Cela active la barre
d’outils et le panneau permettant de sélectionner/désélectionner les éléments d’IHM.

Les éléments personnalisables sont :

• un Menu ou des sous-menus de la Barre de Menu

• un Panel complet (voir Panneaux et barres d’outils)

• la Barre d’état décrite dans label_statusbar ou certains de ses éléments

• une Toolbar: complète, ou certains des boutons

• or any widget from any dialog in QGIS: label, button, combobox...

With Switch to catching widgets in main application, you can click on an item in QGIS interface that you want to be hidden
and QGIS automatically unchecks the corresponding entry in the Customization dialog.

Once you setup your configuration, click [Apply] or [Ok] to validate your changes. This configuration becomes
the one used by default by QGIS at the next startup.

The modifications can also be saved in a .ini file using Save To File button. This is a handy way to share a

common QGIS interface among multiple users. Just click on Load from File from the destination computer in
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order to import the .ini file. You can also run command line tools and save various setups for different use cases
as well.

Astuce: Restaurer facilement l’IHM initiale de QGIS
La configuration initiale de l’IHM de QGIS peut être restaurée par l’une des méthodes ci-dessous :

• décocher Autoriser la modification option dans la boite de dialogue Paramétrage ou cliquer
Sélectionner tout

• cliquer le bouton [Réinitialiser] dans le cadre QSettings accessible par le menu Préférences → Options,
onglet Système

• démarrer QGIS en ligne de commande avec la commande suivante qgis --nocustomization

• setting to false the value of UI → Customization → Enabled variable under Settings → Options menu,
Advanced tab.

Dans la plupart des cas, vous aurez à redémarrer QGIS pour que les modifications soient prises en compte.
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CHAPTER 10

Utiliser les projections

QGIS permet à l’utilisateur de définir un système de coordonnées de référence (SCR) par défaut et pour l’ensemble
des projets, pour les couches démunies de SCR prédéfini. Il lui permet également de définir des systèmes de
coordonnées de référence personnalisés et autorise la projection à la volée (AVL) de couches vecteur et raster.
Toutes ces fonctionnalités permettent à l’utilisateur d’afficher des couches avec différents SCR et de les superposer
correctement.

10.1 Aperçu de la gestion des projections

QGIS gère approximativement 2 700 SCR connus. Les définitions pour chacun d’entre eux sont stockées dans une
base de données SQLite qui est installée avec QGIS. Normalement vous n’avez pas besoin de manipuler cette base
de données directement. En fait, cela peut poser des problèmes de gestion de projections. Les SCR personnalisés
y sont stockés dans une base de données utilisateur. Reportez-vous à la section Système de Coordonnées de
Référence personnalisé pour avoir des informations sur la gestion de vos systèmes de coordonnées de référence
personnalisées.

Les SCR disponibles dans QGIS sont basés sur ceux définis par l’EPSG (European Petroleum Search Group)
et l’Institut National Géographique (IGNF) et sont en grande partie extraits des tables spatiales de référence de
GDAL. Les identifiants EPSG sont présents dans la base de données et peuvent être utilisés pour définir un SCR
dans QGIS.

Pour utiliser la projection à la volée, soit vos données contiennent des informations sur leur système de coordon-
nées de référence soit vous avez défini un SCR global, par projet, ou bien par couche. Pour les couches PostGIS,
QGIS utilise l’identifiant de référence spatiale qui a été défini quand la couche a été créée. Pour les données gérées
par OGR, QGIS utilise un moyen spécifique au format pour définir le SCR. Dans le cas du shapefile, il s’agit d’un
fichier contenant une spécification well-known text (WKT) (WKT) de la projection. Le fichier de projection a le
même nom que le fichier shape et une extension .prj. Par exemple, un shapefile nommé alaska.shp aura un
fichier de projection correspondant nommé alaska.prj.

Lorsque vous sélectionnez un nouveau SCR, les unités des couches seront automatiquement changées dans
l’onglet Général de la fenêtre des Propriétés du projet du menu Projet (Gnome, OS X, Windows) ou
Préférences (KDE).

10.2 Spécification globale d’une projection

QGIS assigne à chaque nouveau projet la projection globale définie par défaut. Par défaut il s’agit du EPSG:4326
- WGS 84 (proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs). Ce SCR par défaut peut être
modifié via le bouton [Sélection...] dans la première partie de l’onglet qui permet de définir le système de co-
ordonnées de référence par défaut pour les nouveaux projets, voir figure_projection_1. Ce choix est sauvegardé
pour toutes les sessions QGIS suivantes.
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Figure 10.1: Onglet SCR de la fenêtre d’Options de QGIS

Lorsque vous utilisez des couches qui sont dépourvues de SCR, vous devez contrôler et définir le choix de la
projection pour ces couches. Cela peut être réalisé globalement ou par projet dans l’onglet SCR dans le menu
Préférences → Options.

Les options montrées sur figure_projection_1 sont :

• Demander le SCR

• Utiliser le SCR du projet

• Utiliser le SCR par défaut affiché ci-dessous

Si vous voulez définir le système de coordonnées de référence pour certaines couches sans information de pro-
jection, vous pouvez également faire cela dans l’onglet Général de la fenêtre de propriétés des couches raster et
vecteur (voir Onglet Général pour les rasters et Onglet Général pour les vecteurs). Si votre couche a déjà une
projection définie, elle sera affichée comme indiqué dans la figure Onglet Général de la fenêtre de Propriétés
d’une couche vecteur.

Astuce: SCR depuis la légende de la carte
Un clic-droit sur une couche dans la légende (section Le panneau Couches) propose deux raccourcis concernant
les SCR. Définir le SCR de la couche ouvre directement la fenêtre de sélection de SCR (voir figure_projection_2).
Définir le SCR du projet depuis cette couche applique le SCR de la couche au projet.
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10.3 Définir la projection à la volée

QGIS gère la projection à la volée pour les rasters et les vecteurs. Par contre elle n’est pas activée par défaut. Pour

utiliser la projection à la volée, vous devez cocher la case Activer la projection ‘à la volée’ du SCR (AVL) dans

l’onglet SCR de la fenêtre de Propriétés du projet.

Il y a trois manières de le faire :

1. Sélectionner Propriétés du projet depuis le menu Projet (Gnome, OSX, Windows) ou Préférences
(KDE).

2. Cliquer sur l’icône Statut de la projection depuis le coin inférieur droit de la barre d’état.

3. Choisir d’activer la projection à la volée par défaut en cochant la case Activer la reprojection ‘à la volée’
par défaut dans l’onglet SCR de la fenêtre des Options ou Activer automatiquement la projection à la volée
si les couches ont des SCR différents.

Si vous avez déjà chargé une couche, et désirez activer la projection à la volée, la meilleure façon de faire est
d’ouvrir l’onglet SCR de la fenêtre des Propriétés du projet, de sélectionner le SCR de la couche chargée, et de

cocher la case Activer la projection ‘à la volée’. L’icône Statut de la projection ne sera plus grisé et toutes les
couches chargées plus tard seront projetées à la volée dans le SCR défini qui apparait à gauche de l’icône.

Figure 10.2: Fenêtre Propriétés du projet

L’onglet SCR de la fenêtre de Propriétés du projet contient cinq composants importants, comme indiqué sur la
figure Figure_projection_2 et décrit ci-dessous :

1. Activer la projection ‘à la volée’ — Cette case à cocher est utilisée pour activer ou désactiver la projection
à la volée. Lorsqu’elle est décochée, chaque couche est dessinée en utilisant les coordonnées lues dans la
source de données et les composants décrits ci-dessous sont inactifs. Lorsqu’elle est activée, les coordonnées
de chaque couche sont projetées dans le système de coordonnées de référence défini pour la carte.

2. Rechercher — Si vous connaissez le code EPSG, l’identifiant ou le nom d’un système de coordonnées de
référence, vous pouvez utiliser la fonction rechercher pour le retrouver. Entrez le code EPSG, l’identifiant
ou le nom à chercher.
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3. système de coordonnées de référence récemment uilisés — Si vous utilisez certains SCR fréquemment
dans vos travaux quotidiens, ils seront affichés dans cette liste. Cliquez sur l’un d’entre eux pour sélectionner
le SCR du projet.

4. Liste des SCR mondiaux — C’est une liste de tous les SCR gérés par QGIS, incluant les systèmes de
coordonnées de référence géographiques, projetés et personnalisés. Pour utiliser un SCR, sélectionnez-le
dans la liste en dépliant le nœud approprié et en choisissant le système de coordonnées. Le SCR actif est
présélectionné.

5. Texte PROJ.4 — C’est la liste des paramètres décrivant le SCR telle qu’elle est utilisée par le moteur de
projection Proj4. Ce texte est en lecture seule et est fourni à titre informatif.

Astuce: Fenêtre Propriétés du projet
Si vous ouvrez la fenêtre Propriétés du projet à partir du menu Projet, vous devez cliquer sur l’onglet SCR pour
voir les définitions des SCR.

Ouvrir la fenêtre à partir de l’icône Statut de la projection vous amènera directement dans l’onglet Système
de Coordonnées de Référence.

10.4 Système de Coordonnées de Référence personnalisé

Si QGIS ne fournit pas le système de coordonnées de référence dont vous avez besoin, vous pouvez en définir

un. Pour cela, sélectionnez Projection personnalisée... à partir du menu Préférences. Les SCR personnalisés
sont stockés dans votre base de données utilisateur de QGIS. En plus de ceux-ci, cette base de données contient
également vos signets spatiaux et autres données personnalisées.

Définir un SCR personnalisé dans QGIS nécessite une bonne compréhension de la bibliothèque de projection
PROJ.4. Pour commencer, référez vous aux “Procédures de Projection Cartographique pour l’environnement
UNIX - Un manuel d’utilisateur” de Gerald I. Evenden, U.S. Geological Survey Open-File Report 90-284, 1990
(disponible sur : ftp://ftp.remotesensing.org/proj/OF90-284.pdf).

Ce manuel décrit l’utilisation de proj.4 et les applications en lignes de commandes liées. Les paramètres
cartographiques utilisés avec proj.4 sont décrit dans le manuel utilisateur et sont les mêmes que ceux utilisés
par QGIS.

La fenêtre Définir un système de coordonnées de référence personnalisé nécessite seulement deux paramètres pour
définir un SCR personnalisé :

1. Un nom descriptif

2. Les paramètres cartographiques au format PROJ.4.

Pour créer un nouveau SCR, cliquez sur le bouton Ajouter un nouveau SRC et entrez un nom descriptif et les
paramètres du SCR.

Remarquez que les Paramètres doivent débuter par un bloc +proj= pour représenter le nouveau système de
coordonnées de référence.

Vous pouvez tester vos paramètres de SCR pour voir s’ils produisent des résultats valides. Entrez des latitude et
longitude connues en WGS 84 dans les champs Nord et Est respectivement. Cliquez sur le bouton [Calculer] et
comparez les résultats avec les valeurs connues dans votre système de coordonnées de référence.

10.5 Transformations géodésiques par défaut

La projection à la volée dépend de la capacité à transformer les données dans un ‘SCR par défaut’ et QGIS utilise
ici le WGS84. Pour certains SCR, plusieurs méthodes de transformation sont disponibles. QGIS vous permet de
choisir laquelle utiliser, sinon une transformation par défaut sera utilisée.
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Figure 10.3: Fenêtre de SCR personnalisé
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Dans l’onglet SCR dans le menu Préférences → Options... vous pouvez :

• faire en sorte que options vous demande lorsqu’il faut définir une transformation en choisisant Demander
un datum pour la conversion de coordonnées lorsqu’aucun n’est défini par défaut,

• éditer une liste de transformations par défaut de l’utilisateur.

QGIS demande quelle transformation utiliser en ouvrant une fenêtre qui affiche au format texte PROJ.4 les trans-
formations de la source et de la cible. De plus amples informations s’affichent au passage de la souris sur une
transformation. Les transformations à utiliser par défaut sont sauvegardées en cochant Se souvenir de la
sélection.
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Explorateur QGIS

• Le panneau QGIS Explorateur
• L’Explorateur QGIS comme application indépendante

L’explorateur QGIS est disponible en tant qu’application indépendante et en tant que panneau au sein de QGIS
Desktop. Il permet de parcourir facilement vos répertoires et gérer vos données géographiques. Vous avez accès
aux fichiers vecteur courants (par exemple ESRI shapefile ou MapInfo), aux bases de données (par exemple Post-
GIS, Oracle, SpatiaLite ou MS SQL Spatial) et aux connexions OWS/WCS|WMS|WFS. Vous pouvez également
visualiser vos données GRASS (voir Intégration du SIG GRASS pour importer ces données dans QGIS).

11.1 Le panneau QGIS Explorateur

Pour afficher le panneau Explorateur dans QGIS, faites un clic-droit sur une barre d’outils et cochez Explo-
rateur ou sélectionnez le depuis le menu Vue → Panneaux (ou Préférences → Panneaux pour KDE). Dans le
panneau Explorateur, vous pouvez naviguer parmi vos fichiers, bases de données et services web et charger vos
données sur la carte avec un simple double-clic ou un glisser-déposer.

Vous pouvez également ouvrir un projet QGIS directement depuis l’Explorateur en double-cliquant sur son nom
ou en faisant un glisser-déposer du fichier de projet sur la carte.

En haut du panneau, vous trouverez quelques outils qui vous permettront de :

• Ajouter les couches sélectionnées. Vous pouvez également ajouter les données à la carte en choisissant
Ajouter la couche ou Ajouter les couches sélectionnées depuis le menu contextuel qui s’affiche par clic-
droit.

• Actualiser l’arborescence

• Chercher une donnée spécifique. Entrez un mot de filtrage ou un joker et l’Explorateur filtrera
l’arborescence pour ne montrer que les chemins qui correspondent, les autres données seront masquées.
Voir l’exemple de l’Explorateur (2) sur figure_browser_panels. La recherche peut être sensible à la casse.
Elle peut également être définie comme suit :

– Normal : renvoie tous les éléments qui contiennent la chaîne de texte cherchée

– Joker : optimise la recherche en utilisant les caractères ? et/ou * pour spécifier la position de la chaîne
recherchée

– Expression régulière

• Replier tout
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• Activer ou désactiver le panneau des propriétés. Lorsqu’il est activé, un nouveau panneau s’affiche et
montre, si possible, les métadonnées de l’élément sélectionné.

Faire un clic-droit sur un élément de l’arborescence vous permez de :

• Dans le cas d’un fichier ou une table, afficher les métadonnées ou l’ouvrir dans votre projet. Les tables
peuvent également être renommées, supprimées ou tronquées.

• Dans le cas d’un répertoire, l’ajouter aux favoris, le masquer de l’arborescence de l’Explorateur. La liste
des répertoires masqués se gère dans Préférences → Options → Sources de données.

• actualiser, renommer ou supprimer un schéma de base de données.

Vous pouvez également importer des fichiers dans les bases de données ou copier des tables d’un schéma / d’une
base à une autre via un glisser-déposer. Vous pouvez afficher un deuxième panneau Explorateur pour faciliter les
manipulations. Sélectionnez juste le fichier et déplacez-le d’un panneau à l’autre.

Figure 11.1: Les deux panneaux de l’Explorateur QGIS côte à côte

11.2 L’Explorateur QGIS comme application indépendante

Vous pouvez aussi lancer l’Explorateur QGIS en tant qu’application indépendante. Tout comme le panneau dans
QGIS, il vous permet de naviguer à travers vos répertoires et gérer vos données géographiques. Il permet égale-
ment de les visualiser, d’en créer et de les ouvrir dans une projet QGIS en les faisant glisser.

Lancer l’explorateur QGIS

• Tapez “qbrowser” dans une console.

• Démarrer l’Explorateur QGIS en utilisant le menu Démarrer ou un raccourci placé sur le Bureau.

• L’Explorateur QGIS est accessible depuis votre répertoire Applications.

Vous pouvez voir sur figure_browser_standalone_metadata les fonctionnalités avancées de l’Explorateur QGIS.
L’onglet Paramètres fournit les détails des connexions aux bases de données telles que PostGIS ou MSSQL Spa-
tial. L’onglet Metadonnées fournit les informations générales sur les fichiers (voir Onglet Métadonnées). L’onglet
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Figure 11.2: L’Explorateur QGIS comme application indépendante

Prévisualisation permet d’avoir un aperçu de vos fichiers sans avoir à les importer à votre projet QGIS. Il est
également possible de prévisualiser les attributs de vos fichiers via l’onglet Attributs.
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CHAPTER 12

Les données vectorielles

12.1 Formats de données gérés

QGIS utilise la bibliothèque OGR pour lire et écrire des données vectorielles incluant les formats ESRI shapefiles,
MapInfo et MicroStation; les bases de données AutoCAD DXF, PostGIS, SpatiaLite, Oracle Spatial et MS SQL
Spatial et de nombreux autres formats. Les données vectorielles GRASS et PostgreSQL sont gérées par des
extensions natives de QGIS. Les données vectorielles peuvent également être lues depuis des archives zip ou gzip.
À ce jour, 69 formats de données vectorielles sont gérés par la bibliothèque OGR (voir OGR-SOFTWARE-SUITE
dans Bibliographie). La liste complète est disponible sur http://www.gdal.org/ogr/ogr_formats.html.

Note: Tous les formats listés ne fonctionnent par dans QGIS, pour différentes raisons. Par exemple, certains re-
quièrent des bibliothèques externes payantes ou encore lorsque l’installation de QDAL/OGR n’a pas été effectuée
correctement sur votre système pour le format demandé. Seuls les formats qui ont été testés apparaissent dans la
liste des types de fichiers proposés au moment de charger un vecteur dans QGIS. Les autres formats peuvent être
chargés en sélectionnant *.*.

Le travail sur des couches vectorielles GRASS est décrit dans la Section Intégration du SIG GRASS.

Cette section décrit comment travailler avec les formats les plus communs : les shapefiles ESRI, les couches
PostGIS, SpatiaLite et les données au format texte CSV. Beaucoup de fonctionnalités de QGIS fonctionnent,
de par sa conception, de la même manière quel que soit le format vecteur des données sources. Il s’agit des
fonctionnalités d’identification, de sélection, d’étiquetage et de gestion des attributs.

Note: QGIS supports (multi)point, (multi)line, (multi)polygon, CircularString, CompoundCurve, CurvePolygon,
MultiCurve, MultiSurface feature types, all with Z and/or M values.

You should note also that some driver doesn’t support some of these feature types like CircularString, Compound-
Curve, CurvePolygon, MultiCurve, MultiSurface feature type. QGIS will convert them to (multi)polygon feature.

12.1.1 Charger une couche à partir d’un fichier

To load a layer from a file (like a Shapefile, a Mapinfo or a dxf layer), click on the Add Vector Layer toolbar
button; or type Ctrl+Shift+V. This will bring up a new window (see figure_vector_1).

Cliquez sur Fichier puis sur le bouton [Parcourir]. L’outil ouvre alors une fenêtre de dialogue standard (voir
figure_vector_2) qui vous permet de naviguer dans les répertoires et les fichiers, et charger le shapefile ou tout

autre format géré. La boîte de sélection Fichiers de type vous permet de présélectionner un format de fichier
géré par OGR.

Si vous le souhaitez, vous pouvez également sélectionner le type d’encodage du fichier.

Sélectionner un fichier dans la liste puis cliquer sur [Ouvrir] le charge dans QGIS. Figure_vector_3 montre QGIS
après avoir chargé le fichier alaska.shp.
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Figure 12.1: Fenêtre d’ajout d’une couche vectorielle

Figure 12.2: Fenêtre d’ouverture de données vectorielles dont le format est géré par OGR
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Figure 12.3: QGIS après avoir chargé le Shapefile de l’Alaska

Astuce: Couleur des couches
Quand vous ajoutez une couche sur une carte, une couleur aléatoire lui est assignée. En ajoutant plusieurs couches
en une fois, différentes couleurs sont assignées à chacune des couches.

Une fois le fichier chargé, vous pouvez zoomer dessus en utilisant les outils de navigation sur la carte. Pour
changer la symbologie d’une couche, ouvrez la fenêtre Propriétés de la Couche en double-cliquant sur le nom
de la couche ou en faisant un clic droit sur son nom dans la légende et en choisissant Propriétés dans le menu
qui apparait. Pour plus de détails sur les paramètres de la symbologie des couches vectorielles, référez-vous à la
section Onglet Style.

Astuce: Charger une couche et un projet depuis un lecteur externe sous OS X
Sous OS X, les lecteurs portables qui sont montés à côté du disque dur primaire n’apparaissent pas dans Fichier
→ Ouvrir un Projet. Nous travaillons sur le support des fenêtres d’ouverture/enregistrement natives d’OS X pour
résoudre ce problème. Pour y pallier, vous pouvez taper /Volumes dans la boîte Nom de fichier et appuyer sur
Entrée. Vous pouvez ensuite parcourir les lecteurs externes et réseaux montés.

Note: DXF files containing several geometry types (point, line and/or polygon), the name of the layer will be
made from <filename.dxf> entities <geometry type>.

Note: You can also drag and drop the file(s) into the Layers Panel from either the files browser or the QGIS
Browser panel. If the layer contains several geometry types, a new windows will ask you to select the sublayer.
This often occurs with GPX, Mapinfo or DXF files format.
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Loading specific directory based layer

To load some specific format like ArcInfo Binary Coverage, UK. National Transfer Format, as well as the raw

TIGER format of the US Census Bureau or OpenfileGDB, click on the Add Vector Layer toolbar button or press
Ctrl+Shift+V to open the Add Vector Layer dialog. Select Directory as Source type. Change the file type

filter Files of type to the format you want to open, for example ‘Arc/Info Binary Coverage’. Navigate to the
directory that contains the coverage file or the file, and select it.

Shapefiles ESRI

Le format shapefile ESRI est encore l’un des formats de fichier vecteur le plus utilisé dans QGIS. Il est géré à
travers la bibliothèque OGR Simple Feature Library (http://www.gdal.org/ogr/).

Un shapefile est en réalité composé de plusieurs fichiers. Les trois suivants sont requis :

1. .shp fichier contenant la géométrie des entités.

2. .dbf fichier contenant les attributs au format dBase.

3. .shx fichier d’index.

Un shapefile inclus également un fichier ayant l’extension .prj qui contient les informations sur le système
de coordonnées. Bien que ces informations soient très utiles elles ne sont pas obligatoires. Il peut y avoir
encore d’autres fichiers associés aux données shapefile. Si vous souhaitez avoir plus de détails, nous vous
recommandons de vous reporter aux spécifications techniques du format shapefile, qui se trouve notamment sur
http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf.

Améliorer les performances d’affichage des Shapefiles

Pour améliorer les performances de dessin d’un shapefile, vous pouvez créer un index spatial. Un index spatial
améliorera à la fois la vitesse d’exécution du zoom et du déplacement panoramique. Les index spatiaux utilisés
par QGIS ont une extension .qix.

Voici les étapes de création d’un index spatial :

• Chargez un shapefile en cliquant sur le bouton Ajouter une couche vecteur de la barre d’outils ou en pressant
les touches Ctrl+Shift+V.

• Ouvrez la fenêtre Propriétés de la Couche en double-cliquant sur le nom de la couche dans la légende ou
en faisant un clic droit et en choisissant Propriétés dans le menu qui apparait.

• Dans l’onglet Général, cliquez sur le bouton [Créer un index spatial].

Problème de chargement de fichier .prj

Si vous ouvrez un shapefile disposant d’un fichier .prj et que QGIS ne parvient pas à lire le système de coor-
données de référence, vous allez devoir le définir manuellement via l’onglet Général de la fenêtre de Propriétés
de la Couche en cliquant sur le bouton [Specifier...]. Cela est dû au fait que ce fichier .prj ne fournit pas les
paramètres complets de la projection requis par QGIS et listés dans la fenêtre SCR.

C’est pour la même raison que lorsque vous créez un nouveau shapefile avec QGIS, deux fichiers de projection
différents sont créés. Un fichier .prj contenant un nombre limité de paramètres, compatible avec les logiciels
ESRI et un fichier .qpj, fournissant la totalité des paramètres du SCR utilisé. Chaque fois que QGIS trouve un
fichier .qpj, il l’utilisera à la place du fichier .prj.

12.1.2 Fichiers de Texte Délimité

Les données séparées par des tabulations sont utilisées très couramment pour leur simplicité et leur lisibilité, les
données pouvant être lues et modifiées dans un éditeur de texte basique. Les données séparées par un délimiteur
sont écrites par lignes dans lesquelles les données sont séparées par un caractère défini (virgule, point-virgule,
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espace, etc) La première ligne contient généralement le nom des colonnes. Le CSV (Comma Separated Values =
Données Séparées par une Virgule) est très courant.

De tels fichiers de données peuvent aussi contenir des informations de positionnement dans deux formes dif-
férentes :

• Avec des coordonnées de points en colonnes séparées

• Avec une représentation well-known text (WKT) de la géométrie

QGIS vous permet de charger un fichier texte délimité en tant que couche ou simple table. Mais il faut d’abord
vérifier les points suivants :

1. Le fichier doit avoir une ligne d’entête délimitée avec les noms des champs. Il doit s’agir de la première
ligne du fichier.

2. La ligne d’entête doit contenir un ou plusieurs champs stockant la géométrie. Ils peuvent porter n’importe
quel nom.

3. Les coordonnées X et Y doivent être de type numérique (si la géométrie est définie par des coordonnées).
Le système de coordonnées n’est pas important.

Comme exemple de fichier texte valide, nous pouvons importer le fichier point d’élévation elevp.csv fourni
avec le jeu de données échantillon de QGIS (voir section Échantillon de données) :

X;Y;ELEV
-300120;7689960;13
-654360;7562040;52
1640;7512840;3
[...]

Notons les points suivants à propos du fichier texte :

1. Le fichier texte d’exemple utilise le ; comme délimiteur. N’importe quel caractère peut être utilisé comme
délimiteur de champ.

2. La première ligne est la ligne d’entête. Elle contient les champs X, Y et ELEV.

3. Aucun guillemet (") n’est utilisé pour délimiter les champs textes.

4. Les coordonnées X sont stockées dans le champ X.

5. Les coordonnées Y sont stockées dans le champ Y.

Others valuable informations for advanced users

Features with curved geometries (CircularString, CurvePolygon and CompoundCurve) are supported. Here are
three examples of such geometry types as a delimited text with WKT geometries:

Label;WKT_geom
CircularString;CIRCULARSTRING(268 415,227 505,227 406)
CurvePolygon;CURVEPOLYGON(CIRCULARSTRING(1 3, 3 5, 4 7, 7 3, 1 3))
CompoundCurve;COMPOUNDCURVE((5 3, 5 13), CIRCULARSTRING(5 13, 7 15,

9 13), (9 13, 9 3), CIRCULARSTRING(9 3, 7 1, 5 3))

Delimited Text supports also Z and M coordinates in geometries:

LINESTRINGM(10.0 20.0 30.0, 11.0 21.0 31.0)

Charger un fichier texte délimité

Appuyez sur l’icône Ajouter une couche de texte délimité de la barre d’outils Contrôle des couches pour ouvrir la
boîte de dialogue Créer une couche depuis un fichier à texte délimité comme montré dans la figure fig-
ure_delimited_text_1.
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Figure 12.4: Fenêtre d’ajout de couche depuis un fichier texte délimité

Sélectionnez d’abord le fichier à importer (par exemple, qgis_sample_data/csv/elevp.csv) en ap-
puyant sur le bouton [Parcourir...]. Une fois le fichier sélectionné, QGIS tente d’analyser le fichier en utilisant le
dernier délimiteur utilisé. Afin que QGIS puisse analyser correctement le fichier, il est important de sélectionner
le bon délimiteur. Vous pouvez spécifier un délimiteur en cochant délimiteurs personnalisés, ou en cochant

expression régulière et en saisissant un texte dans le champ Expression. Par exemple, pour changer et utiliser
le délimiteur tabulation, utilisez \t (c’est l’expression en vigueur pour indiquer le caractère tabulation).

Une fois le fichier analysé, procédez à la Définition de la géométrie en sélectionnant Point et renseignez
les champs X et Y à l’aide des listes déroulantes correspondantes. Si les coordonnées sont définies en de-

grés/minutes/secondes, cochez la case Coordonnées DMS.

Enfin, choisissez un nom de couche (par exemple, elevp) comme montré dans figure_delimited_text_1. Pour
ajouter la couche à la carte, appuyez sur [OK]. Le fichier texte délimité se comporte maintenant dans QGIS comme
n’importe quelle autre couche de la carte.

Il y a aussi une option qui vous aide à supprimer les espaces de début et de fin des champs, à savoir Réduire

les champs. Vous pouvez aussi Ignorer les champs vides dans chaque enregistrement ou si nécessaire, définir

la Virgule en séparateur décimal.

Si l’information spatiale est représentée en WKT, activez l’option Well Known Text et sélectionnez le champ
contenant la définition WKT des objets point, ligne ou polygone. Si le fichier ne contient pas d’information
spatiale, cochez Pas de géométrie (juste la table) et le fichier sera chargé comme une table ordinaire.

En complément, vous pouvez activer :

• Index spatial pour améliorer les performances d’affichage et de sélection spatiale des entités.

• Index des sous-ensembles.

• Surveiller le fichier pour surveiller les changements apportés au fichier par d’autres applications pendant
que QGIS tourne.
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12.1.3 Données OpenStreetMap

Ces dernières années, le projet OpenStreetMap (OSM) a gagné en popularité, car dans beaucoup de pays, aucune
donnée géographique sous licence libre, telle que par exemple le réseau routier, n’est disponible. L’objectif du
projet OSM est de créer une base de données géographiques libre sur le monde entier et qui est éditable par tous à
partir de données GPS, de photographies aériennes ou tout simplement des connaissances locales du terrain. Pour
soutenir ce projet, QGIS fournit une extension qui permet aux utilisateurs de travailler avec les données OSM.

Charger des vecteurs OpenStreetMap

QGIS intègre nativement des fonctions d’import de données OpenStreetMap.

• Pour vous connecter au serveur OSM et télécharger des données, ouvrez le menu Vecteur → OpenStreetMap
→ Télécharger des données OSM.... Vous pouvez ignorer cette étape si vous avez déjà obtenu un fichier
XML .osm à l’aide du logiciel JOSM, de l’Overpass API ou de toute autre source.

• Le menu Vecteur → OpenStreetMap → Importer la topologie depuis un XML... convertira votre fichier .osm
en une base de données Spatialite, et créera la connexion à la base.

• Le menu Vecteur → OpenStreetMap → Exporter la topologie vers SpatiaLite vous permet ensuite de vous
connecter à la base de données, sélectionner le type de données que vous souhaitez (points, lignes, poly-
gones) et choisir les tags OSM à importer. Ceci crée une couche géométrique SpatiaLite que vous pouvez

par la suite ajouter à votre projet en cliquant sur le bouton Ajouter une couche SpatiaLite de la barre d’outils ou

en sélectionnant l’option Ajouter une couche SpatiaLite... du menu Couche (voir la Section Couches
SpatiaLite).

12.1.4 Couches PostGIS

Les couches PostGIS sont stockées dans une base de données PostgreSQL. Les avantages de PostGIS sont les
possibilités d’indexation spatiale, de filtre et de requête qu’il fournit. En utilisant PostGIS, les fonctions vecteur
telles que la sélection ou l’identification fonctionnent avec plus de précision qu’avec les couches OGR dans QGIS.

Créer une connexion enregistrée

La première fois que vous utilisez des données PostGIS, vous devez créer une connexion vers la base Post-

greSQL qui contient les données. Cliquez tout d’abord sur le bouton Ajouter une couche PostGIS de la barre d’outils

ou sélectionnez l’option Ajouter une couche PostGIS... du menu Couche ou encore, tapez Ctrl+Shift+D.
Vous pouvez aussi ouvrir la fenêtre Ajouter une couche vecteur et sélectionnez Base de données. La fenêtre
Ajouter une ou plusieurs tables PostGIS apparaît. Pour accéder au gestionnaire de connexion, cliquez sur le bou-
ton [Nouveau] pour faire apparaitre la fenêtre Créer une nouvelle connexion PostGIS. Les paramètres requis pour
la connexion sont :

• Nom : Un nom pour cette connexion. Il peut être identique à Base de données.

• Service: Service parameter to be used alternatively to hostname/port (and potentially database). This can
be defined in pg_service.conf. Check the Service connection file section for more details.

• Hôte : Nom pour l’hôte de la base de données. Il doit s’agir d’un nom existant, car il sera utilisé pour ouvrir
une connexion Telnet ou interroger l’hôte. Si la base de données est sur le même ordinateur que QGIS,
mettez simplement ‘localhost’.

• Port : numéro de port que le serveur de base de données PostgreSQL écoute. Le port par défaut est 5432.

• Base de données : nom de la base de données.

• Mode SSL : Comment sera négociée la connexion SSL avec le serveur. Notez qu’une importante accéléra-
tion du rendu des couches PostGIS peut être obtenue en désactivant le SSL dans l’éditeur de connexion. Les
options suivantes sont proposées :
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– Désactive : Essaye uniquement une connexion SSL non cryptée.

– Permet : Essaye une connexion non-SSL. En cas d’échec, essaye une connexion SSL.

– Préfère (par défaut) : Essaye une connexion SSL. En cas d’échec, essaye une connexion non-SSL.

– Requiert : Essaye uniquement une connexion SSL.

• Nom d’utilisateur : Nom d’utilisateur utilisé pour se connecter à la base de données.

• Mot de passe : mot de passe associé au Nom d’utilisateur pour se connecter à la base de données.

Vous pouvez également activer les options suivantes :

• Enregistrer le nom d’utilisateur

• Enregistrer le mot de passe

• Ne regarder que dans la table geometry_columns

• Ne pas résoudre le type pour les géométries non restreintes (GEOMETRY)

• Ne regarder que dans le schéma ‘public’

• Lister les tables sans géométrie

• Utiliser la table des métadonnées estimées

Une fois que tous les paramètres et les options sont définis, vous pouvez tester la connexion en cliquant sur le
bouton [Test la connexion].

Astuce: Utiliser la table de métadonnées estimées pour accélérer les opérations
When initializing layers, various queries may be needed to establish the characteristics of the geometries stored
in the database table. When the Use estimated table metadata option is checked, these queries examine only a
sample of the rows and use the table statistics, rather than the entire table. This can drastically speed up operations
on large datasets, but may result in incorrect characterization of layers (eg. the feature count of filtered layers
will not be accurately determined) and may even cause strange behaviour in case columns that are supposed to be
unique actually are not.

Charger une couche PostGIS

Une fois qu’une ou plusieurs connexions sont définies, vous pouvez charger des couches de la base de données
PostgreSQL. Bien sûr, cela nécessite d’avoir des données dans PostgreSQL. Référez-vous à la section Importer
des données dans PostgreSQL pour plus de détails concernant l’importation de données dans la base de données.

Pour charger une couche PostGIS, suivez ces étapes :

• Si la fenêtre Ajouter une ou plusieurs tables PostGIS n’est pas ouverte, cliquez sur le bouton
Ajouter une couche PostGIS... depuis le menu Couche ou tapez Ctrl+Shift+D pour afficher la fenêtre.

• Choisissez la connexion dans la liste déroulante et cliquez sur [Connecter].

• Cochez ou décochez selon votre besoin Lister les tables sans géométrie

• Utilisez si besoin des Options de recherche pour définir quelles entités charger ou utilisez le bouton
[Construire une requête] pour ouvrir la fenêtre Construction de requête.

• Trouvez la ou les couches que vous souhaitez ajouter dans la liste des couches disponibles.

• Sélectionnez-la en cliquant dessus. Vous pouvez sélectionner plusieurs couches en maintenant la touche
Shift enfoncée quand vous cliquez. Référez-vous à la section Constructeur de requête pour plus
d’informations sur l’utilisation du Constructeur de requête de PostgreSQL pour mieux définir la couche.
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• Cliquez sur le bouton [Ajouter] pour ajouter la couche à la carte.

Astuce: Couches PostGIS
Normalement, une couche PostGIS est définie par une entrée dans la table geometry_columns. Depuis la version
0.9.0, QGIS peut charger des couches qui n’ont pas d’entrée dans la table geometry_columns. Ceci concerne
aussi bien les tables que les vues. Définir une vue spatiale fournit un moyen puissant pour visualiser vos données.
Référez-vous à votre manuel PostgreSQL pour plus d’informations sur la création des vues.

Service connection file

The service connection file allows PostgreSQL connection parameters to be associated with a single service name.
That service name can then be specified by a client and the associated settings will be used.

It’s called .pg_service.conf under *nix systems (GNU/Linux, macOS etc.) and pg_service.conf on
Windows.

The service file looks like:

[water_service]
host=192.168.0.45
port=5433
dbname=gisdb
user=paul
password=paulspass

[wastewater_service]
host=dbserver.com
dbname=water
user=waterpass

Note: There are two services in the above example: water_service and wastewater_service. You can
use these to connect from QGIS, pgAdmin etc. by specifying only the name of the service you want to connect to
(without the enclosing brackets). If you want to use the service with psql you need to do something like export
PGSERVICE=water_service before doing your psql commands.

Note: Vous trouverez tous les paramètres ici

Note: If you don’t want to save the passwords in the service file you can use the .pg_pass option.

On *nix operating systems (GNU/Linux, macOS etc.) you can save the .pg_service.conf file in the user’s
home directory and the PostgreSQL clients will automatically be aware of it. For example, if the logged user is
web, .pg_service.conf should be saved in the /home/web/ directory in order to directly work (without
specifying any other environment variables).

You can specify the location of the service file by creating a PGSERVICEFILE environment variable (e.g. run
the export PGSERVICEFILE=/home/web/.pg_service.conf command under your *nix OS to tem-
porarily set the PGSERVICEFILE variable)

You can also make the service file available system-wide (all users) either by placing it at pg_config
--sysconfdir‘‘**/.pg_service.conf** or by adding the ‘‘PGSYSCONFDIR environ-
ment variable to specify the directory containing the service file. If service definitions with the same name exist
in the user and the system file, the user file takes precedence.
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Warning: There are some caveats under Windows:
• The service file should be saved as pg_service.conf and not as .pg_service.conf.
• The service file should be saved in Unix format in order to work. One way to do it is to open it with

Notepad++ and Edit -> EOL Conversion -> UNIX Format -> File save.
• After adding an environment variable you may also need to restart the computer.

Quelques éléments de détail à propos des couches PostgreSQL

Cette section fournit quelques détails sur la manière dont QGIS accède aux couches PostgreSQL. La plupart du
temps, QGIS devrait simplement fournir une liste des tables de la base de données qui peuvent être chargées et il
les chargera à la demande. Cependant, si vous avez des problèmes pour charger une table PostgreSQL dans QGIS,
les informations données ci-dessous peuvent vous aider à comprendre les messages de QGIS et vous donner une
indication sur comment changer la table ou la vue PostgreSQL pour qu’elle se charge dans QGIS.

QGIS demande que les couches PostgreSQL aient un champ pouvant être utilisé comme clé unique pour la couche.
Pour les tables, cela signifie qu’elles doivent avoir une clé primaire ou un champ ayant une contrainte d’unicité. De
plus, QGIS impose que cette colonne soit de type int4 (un entier de 4 octets). Alternativement, la colonne ctid peut
être utilisée comme clé primaire. Si une table ne respecte pas ces conditions, le champ oid sera utilisé à la place.
Les performances seront améliorées si le champ est indexé (notez que les clés primaires sont automatiquement
indexées dans PostgreSQL).

Si la couche PostgreSQL est une vue, les mêmes conditions s’appliquent, mais elles n’ont pas de clé primaire ou
de champ ayant une contrainte d’unicité. Dans ce cas, vous devez définir une clé primaire (de type entier) avant
de charger la vue. Si aucun champ ne convient, QGIS ne chargera pas la vue. Si cela arrive, la solution est de
modifier la vue de sorte qu’elle inclue un champ qui convient (de type entier et qui soit une clé primaire ou ayant
une contrainte d’unicité, de préférence indexé).

QGIS propose une case à cocher Sélectionner par identifiant qui est activée par défaut. Cette option permet de
récupérer les identifiants sans les attributs, ce qui est plus rapide dans la plupart des cas. Ça peut avoir du sens de
désactiver cette option lorsque vous utilisez des vues coûteuses.

Astuce: Sauvegarde d’une base de données PostGIS ayant des couches sauvées par QGIS
Si vous voulez faire une sauvegarde de votre base de données PostGIS en utilisant les commandes pg_dump et
pg_restore et que les styles par défaut des couches sauvés par QGIS ne sont pas restaurés, vous devez utiliser
DOCUMENT comme option XML et la restauration fonctionnera.

QGIS allows to filter features already on server side. Check the Execute expressions on postgres server-side if
possible (Experimental) checkbox to do so. Only supported expressions will be sent to the database. Expressions
using unsupported operators or functions will gracefully fallback to local evaluation.

12.1.5 Importer des données dans PostgreSQL

Différents outils, notamment le Gestionnaire de bases de données ou les outils en ligne de commande comme
sh2pgsql ou ogr2ogr, permettent d’importer les données dans une base de données PostgreSQL/PostGIS.

DB Manager

QGIS est distribué avec une extension nommée DB Manager. Elle peut être utilisée pour charger des shapefile
et d’autres formats de données, et inclut le support des schémas. Voir section Extension DB Manager pour plus
d’informations.
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shp2pgsql

PostGIS intègre un utilitaire nommé shp2pgsql qui peut être utilisé pour importer des shapefiles dans une base
de données PostgreSQL/PostGIS. Par exemple, pour importer un shapefile nommé lakes.shp dans une base
PostgreSQL nommé gis_data, utilisez la commande suivante :

shp2pgsql -s 2964 lakes.shp lakes_new | psql gis_data

Ceci crée une nouvelle couche nommée lakes_new dans la base de données gis_data. La nouvelle couche
aura l’identifiant de référence spatiale (SRID) 2964. Référez-vous à la section Utiliser les projections pour plus
d’informations sur les systèmes de référence spatiale et les projections.

Astuce: Exporter des jeux de données depuis PostGIS
De la même manière que l’outil d’importation shp2pgsql, il y a également un outil d’exportation de jeux de
données PostGIS en shapefile : pgsql2shp. Cet outil est inclus dans la distribution de PostGIS.

ogr2ogr

En plus de shp2pgsql et DB Manager, un autre outil est fourni pour importer des données géographiques dans
PostGIS : ogr2ogr. Il est inclus dans GDAL.

Pour importer un shapefile dans PostGIS, lancez la commande suivante :

ogr2ogr -f "PostgreSQL" PG:"dbname=postgis host=myhost.de user=postgres
password=topsecret" alaska.shp

Ceci va importer le shapefile alaska.shp dans la base de données PostGIS nommée postgis en utilisant
l’utilisateur postgres avec le mot de passe topsecret sur l’hôte myhost.de.

Notez qu’OGR doit être compilé avec PostgreSQL pour gérer PostGIS. Vous pouvez le vérifier en tapant (sous
):

ogrinfo --formats | grep -i post

Si vous préférez utiliser la commande COPY de PostgreSQL au lieu de la méthode INSERT INTO par défaut,

vous pouvez exporter la variable d’environnement suivante (au moins sur et ):

export PG_USE_COPY=YES

ogr2ogr ne crée pas d’index spatial comme le fait shp2pgsl. Vous devez donc effectuer une étape supplémentaire
en le créant manuellement avec la commande SQL classique CREATE INDEX (comme détaillé dans la section
suivante Améliorer les performances).

Améliorer les performances

Récupérer des entités depuis une base de données PostgreSQL peut être long, surtout par un réseau. Vous pouvez
améliorer les performances d’affichage de couches PostgreSQL en vous assurant qu’un index spatial PostGIS
existe pour chaque couche dans la base de données. PostGIS gère la création d’un index index GiST (Generalized
Search Tree) pour accélérer les recherches spatiales sur les données (les informations sur l’index GiST sont issues
de la documentation de PostGIS disponible sur http://postgis.net).

Astuce: You can use the DBManager to create an index to your layer. You should first select the layer and click
on Table > Edit table, go to Indexes tab and click on [Add spatial index].

La syntaxe pour créer un index GiST est la suivante :

CREATE INDEX [indexname] ON [tablename]
USING GIST ( [geometryfield] GIST_GEOMETRY_OPS );
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Notez que pour de grandes tables, créer un index peut prendre du temps. Une fois cet index créé, vous devriez
faire une VACUUM ANALYZE. Référez-vous à la documentation de PostGIS (POSTGIS-PROJECT Bibliographie)
pour plus d’informations.

Voici un exemple de création d’un index GiST :

gsherman@madison:~/current$ psql gis_data
Welcome to psql 8.3.0, the PostgreSQL interactive terminal.

Type: \copyright for distribution terms
\h for help with SQL commands
\? for help with psql commands
\g or terminate with semicolon to execute query
\q to quit

gis_data=# CREATE INDEX sidx_alaska_lakes ON alaska_lakes
gis_data-# USING GIST (the_geom GIST_GEOMETRY_OPS);
CREATE INDEX
gis_data=# VACUUM ANALYZE alaska_lakes;
VACUUM
gis_data=# \q
gsherman@madison:~/current$

12.1.6 Couches vectorielles dépassant les 180° de longitude

Beaucoup de logiciels de SIG ne traitent pas les cartes vecteurs ayant un système de référence géographique
(en lat/lon) dépassant la ligne des 180 degrés de longitude (http://postgis.refractions.net/documentation/manual-
2.0/ST_Shift_Longitude.html). Il en résulte que sous QGIS, pour une telle carte, on verra deux emplacements
distincts et éloignés qui devraient être proches l’un de l’autre. Sur Figure_vector_4, le petit point tout à gauche de
la carte (Chatham Island) devrait être dans la grille, à droite des îles principales de Nouvelle-Zélande.

Figure 12.5: Carte en lat/lon dépassant la ligne des 180° longitude

Une solution est de transformer les valeurs longitudinales en utilisant PostGIS et la fonction ST_Shift_Longitude.
Cette fonction lit chaque point/sommet de chacune des entités dans une géométrie et si la coordonnée de longitude
est inférieure à 0°, elle lui ajoute 360°. Le résultat est une version 0° - 360° des données sur une carte centrée à
180°.

Usage

• Importer des données dans PostGIS (Importer des données dans PostgreSQL) en utilisant, par exemple,
l’extension DB Manager.

• Utiliser l’interface en ligne de commande PostGIS pour exécuter la commande suivante (dans cet
exemple, “TABLE” est bien le nom de votre table PostGIS): gis_data=# update TABLE set
the_geom=ST_Shift_Longitude(the_geom);

• Si tout s’est bien passé, vous devriez recevoir une confirmation sur le nombre d’entités qui ont été mises à
jour. Ensuite, vous pouvez charger la carte et voir la différence (Figure_vector_5).

90 Chapter 12. Les données vectorielles

http://postgis.refractions.net/documentation/manual-2.0/ST_Shift_Longitude.html
http://postgis.refractions.net/documentation/manual-2.0/ST_Shift_Longitude.html


QGIS User Guide, Version 2.14

Figure 12.6: Traversée de la longitude 180° en utilisant la fonction ST_Shift_Longitude

12.1.7 Couches SpatiaLite

La première fois que vous chargerez une base Spatialite, commencez par cliquer sur le bouton
Ajouter une couche SpatiaLite ou sélectionner l’option Ajouter une couche SpatiaLite... depuis le menu Couche ou
en tapant Ctrl+Shift+L. Ceci fait apparaitre une fenêtre qui vous permet soit de vous connecter à une base
SpatiaLite déjà connue de QGIS et sélectionnable dans une liste déroulante, soit de définir une nouvelle connex-
ion. dans le second cas, cliquez sur le bouton [Nouveau] et utilisez le navigateur de fichier pour pointer votre base
SpatiaLite qui se termine par une extension .sqlite.

Si vous souhaitez sauvegarder une couche vecteur au format SpatiaLite, vous pouvez le faire par un clic-droit sur
la couche dans la légende. Cliquez ensuite sur Enregistrer sous..., définissez le nom du fichier et le SCR en sortie,
choisisez ‘SpatiaLite’ comme format. Vous pouvez également sélectionner ‘SQLite’ comme format et ajouter
SPATIALITE=YES comme source de données dans les options OGR de création. OGR crée alors une base de
données SpatiaLite. Voir également http://www.gdal.org/ogr/drv_sqlite.html.

QGIS gère également les vues SpatiaLite éditables.

Créer une nouvelle couche SpatiaLite

Si vous souhaitez créer une nouvelle couche SpatiaLite, référez-vous à la section Créer une nouvelle couche
SpatiaLite.

Astuce: Extensions de gestion de données SpatiaLite
Pour gérer des données SpatiaLite, vous pouvez également utiliser diverses extensions Python : QSpatiaLite,
SpatiaLite Manager ou Gestionnaire de base de données (extension principale, recommandée). Elles peuvent
toutes être téléchargées et installées via le Gestionnaire d’extensions.

12.1.8 Couches MSSQL Spatial

QGIS gère également en natif MS SQL. La première fois que vous chargez une donnée géographique MSSQL,

commencez par cliquer sur le bouton Ajouter une couche MSSQL de la barre d’outils ou sélectionnez Ajouter une
couche MSSQL... depuis le menu Couche ou encore tapez Ctrl+Shift+M.
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12.1.9 Couches Oracle Spatial

Les fonctionnalités spatiales dans Oracle Spatial aident les utilisateurs dans la gestion des données localisées et
géographiques sous forme native d’une base de données Oracle. QGIS gère maintenant ces couches.

Créer une connexion enregistrée

La première fois que vous utilisez des données Oracle Spatial, vous devez créer une connexion vers la base

qui contient les données. Cliquez tout d’abord sur le bouton Ajouter une couche Oracle Spatial de la barre d’outils ou

sélectionnez l’option Ajouter une couche Oracle Spatial du menu Couche ou encore, tapez Ctrl+Shift+O.
Pour accéder au gestionnaire de connexion, cliquez sur le bouton [Nouveau] pour faire apparaitre la fenêtre Créer
une nouvelle connexion Oracle Spatial. Les paramètres requis pour la connexion sont :

• Nom : Un nom pour cette connexion. Il peut être identique à Base de données.

• Base de données : SID ou SERVICE_NAME de l’instance Oracle.

• Hôte : Nom pour l’hôte de la base de données. Il doit s’agir d’un nom existant, car il sera utilisé pour ouvrir
une connexion Telnet ou interroger l’hôte. Si la base de données est sur le même ordinateur que QGIS,
mettez simplement ‘localhost’.

• Port : numéro de port que le serveur de base de données Oracle écoute. Le port par défaut est 1521.

• Nom d’utilisateur : Nom d’utilisateur utilisé pour se connecter à la base de données.

• Mot de passe : mot de passe associé au Nom d’utilisateur pour se connecter à la base de données.

Vous pouvez également activer les options suivantes :

• Enregistrer le nom d’utilisateur indique s’il faut ou non sauvegarder le nom de l’utilisateur de la base
de données dans la configuration de la connexion.

• Enregistrer le mot de passe indique s’il faut ou non sauvegarder le mot de passe de connexion à la base
de données dans les paramètres de connexion.

• Chercher uniquement dans la table de métadonnées restreint la liste des tables affichées à celles qui sont
dans la vue all_sdo_geom_metadata. Ceci peut accélerer l’affichage initial des tables spatiales.

• Chercher uniquement les tables de l’utilisateur limite la recherche des tables spatiales à celles dont
l’utilisateur est propriétaire.

• Lister les tables sans géométries indique que les tables sans géométrie seront aussi listées par défaut.

• Utilisez la table de métadonnées estimées quand la couche est définie, plusieurs métadonnées sont
nécessaires pour la table Oracle. Cela inclut des informations sur le nombre de lignes de la table, le type
de géométrie et l’étendue spatiale des données pour la colonne géométrique. Si cette table contient un
grand nombre de lignes, déterminer cette métadonnée est coûteuse en temps. En activant cette option, les
opérations rapides suivantes sur les métadonnées de la table sont réalisées : le décompte des lignes est
réalisé à partir de all_tables.num_rows. Les étendues des tables sont toujours déterminées avec la
fonction SDO_TUNE.EXTENTS_OF même si un filtre est appliqué sur la couche. La géométrie de la table
est déterminée à partir des 100 premières lignes dans la table.

• Seulement les types de géométrie existants liste seulement les types géométriques existants et ne permet
pas d’ajouter les autres.

Warning: In the Authentication tab, saving username and password will keep unprotected credentials in
the connection configuration. Those credentials will be visible if, for instance, you shared the project file
with someone. Therefore, it’s advisable to save your credentials in a Authentication configuration instead
(configurations tab). See Système d’authentification for more details.
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Une fois que tous les paramètres et les options sont définis, vous pouvez tester la connexion en cliquant sur le
bouton [Test la connexion].

Astuce: Paramètres utilisateur de QGIS et Sécurité
Selon le système d’exploitation que vous utilisez, stocker les mots de passe dans vos paramètres QGIS peut
présenter un risque vis-à-vis de la sécurité. Les mots de passe sont sauvegardés en clair dans votre système et dans
les fichiers de projet ! Voici, selon le système d’exploitation, comment les paramètres QGIS sont stockés :

• Les paramètres sont stockés dans votre répertoire home dans ~/.qgis2.

• Les paramètres sont stockés dans la base de registre.

Charger une couche Oracle Spatial

Une fois une ou plusieurs connexions définies, vous pouvez charger des couches de la base de données Oracle.
Bien sûr, cela nécessite d’avoir des données dans la base Oracle.

Pour charger une couche Oracle Spatial, suivez ces étapes :

• Si la fenêtre Ajouter des tables Oracle Spatial n’est pas déjà ouverte, cliquez sur le bouton
Ajouter une couche Oracle Spatial de la barre d’outils.

• Choisissez la connexion dans la liste déroulante et cliquez sur [Connecter].

• Cochez ou décochez selon votre besoin Lister les tables sans géométrie

• Utilisez si besoin des Options de recherche pour définir quelles entités charger ou utilisez le bouton
[Construire une requête] pour ouvrir la fenêtre Construction de requête.

• Trouvez la ou les couches que vous souhaitez ajouter dans la liste des couches disponibles.

• Sélectionnez-la en cliquant dessus. Vous pouvez sélectionner plusieurs couches en gardant la touche Shift
enfoncée quand vous cliquez. Référez-vous à la section Constructeur de requête pour plus d’informations
sur l’utilisation du Constructeur de requête d’Oracle pour mieux définir la couche.

• Cliquez sur le bouton [Ajouter] pour ajouter la couche à la carte.

Astuce: Couches Oracle Spatial
Normalement, une couche Oracle Spatial est définie par une entrée dans la table USER_SDO_METADATA.

12.2 Le Gestionnaire de symboles

12.2.1 Le Gestionnaire de style

The Symbol Library is the place where users can manage and create generic symbols to be used in several QGIS
projects. You can open it with the Settings → Style Manager or from the Style tab in the vector layer’s Properties.
It allows users to:

• ajouter, éditer et supprimer des symboles

• organize symbols in custom groups

• export and import symbols.
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Figure 12.7: Le Gestionnaire de style

Groupes et groupes intelligents

You can organize symbols into different categories. These categories, listed in the panel at the left, can be static
(called Group) or dynamic (named Smart Group). A group is smart when its symbols are dynamically fetched
according to conditions set. See figure_symbol_2:

To create a group, right click on an existing group or on the main Groups directory in the left of the dialog. You

can also select a group and click the Add Group button. The new group will be a sub-group of the selected one.

Create Smart Group is similar to creating group, but instead select Smart Groups. The dialog box allows user
to choose the expression to select symbols in order to appear in the smart group (contains some tags, member of
a group, have a string in its name, etc.). Any symbol that satisfies the entered condition(s) is automatically added
to the smart group.

Figure 12.8: Creating a Smart Group

To remove a group or a smart group, right click on the group and select Remove Group or select it and push
Remove Group button.

Unlike the smart groups that automatically fetch their belonged symbols, simple groups are filled by the user. To
add a symbol into a group, you can either right click on a symbol, choose Apply Group and then the group name.

There is a second way to add several symbols into a group: just select the group, click and choose Group
Symbols. All symbols display a checkbox that allows you to add the symbol into the selected groups. When
selection is finished, you can click the same button, and choose Finish Grouping.

All the symbols that are not placed under a custom group belong to a default group named Ungrouped.

94 Chapter 12. Les données vectorielles



QGIS User Guide, Version 2.14

Ajouter, éditer et supprimer des symboles

Selecting a group returns in the right panel, if applicable, the list of symbols of the group (including its subgroups).
These symbols are organized in four different tabs:

• Marker for point symbols

• Line for linear symbols

• Fill for surface symbols

• and ‘Color Ramp‘_

To delete a symbol you no longer need, just select it and click Remove item (also available through right-click).
The symbol will be deleted from the local symbols database.

The symbol list can be modified by adding new symbols with Add item button or modifying existing ones with
Edit item. See ‘The Symbol Selector‘_ for further information.

Partager des symboles

The Share item tool, at the right bottom of the Style Library dialog, offers options to easily share symbols with
others: users can indeed export their symbols and import symbols to their library.

Exporting symbols

You can export the selected symbols to PNG, SVG or XML file formats. Exporting to PNG or SVG (both not
available for color ramp symbols) creates a file for each selected symbol, and the SVG folder can be added to
SVG Paths in Settings → Options to e.g. share these symbols on a network. The XML format generates a single
file containing all the selected symbols. This file can then be imported in another user’s style library.

Importing symbols

You can extend your symbols library by importing new symbols. Just select Import from the drop-down list
at the right bottom of the dialog. In the new dialog, you’ll need to :

• indicate the source of the symbols (it can be a .xml file on the disk or an url),

• give the name of the group under which the symbols will be put

• select the symbols you want to add to your library

• and press Import.

Note that import and export options are also available through right-click.

Palettes de couleur

The Color ramp tab in the Style Manager presents different types of color ramps you can use to style layers.

To create a custom color ramp, activate the Color ramp tab and click the Add item button. The button reveals a
drop-down list to choose the ramp type: Gradient, Random, colorBrewer, or cpt-city.

The first three have options for number of steps and/or multiple stops in the color ramp. You can use the Invert
option while classifying the data with a color ramp. See figure_symbol_4 for an example of custom color ramp
and figure_symbol_4a for the cpt-city dialog.

Le type cpt-city ouvre une fenêtre qui permet de choisir parmi des centaines de palettes prédéfinies.
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Figure 12.9: Importer des symboles

Figure 12.10: Exemple de personnalisation de palette de couleurs graduées avec arrêts multiples
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Figure 12.11: Fenêtre cpt-city et ses centaines de palettes de couleur
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12.2.2 Le Créateur de symboles

The Symbol selector is the main dialog to design a symbol. You can create or edit Marker, Line or Fill Symbols.

Figure 12.12: Créer un symbole ponctuel

Pour chaque type de symboles, vous trouverez toujours le même type de fenêtre :

• at the top left side a dynamic symbol representation, updated as soon as symbol properties evolve

• under the symbol representation, the symbol tree shows symbol layers that are combined afterwards to shape
a new global symbol. A symbol can consist of several Symbol layers. Settings will be shown later in this
chapter.

• at the right you can setup some parameters that apply to the global symbol:

– unit: it can be millimeter, pixel or map unit

– transparency

– color: when this parameter is changed by the user, its value is echoed to all unlocked sub-symbols
color

– size and rotation for marker symbol

– width for line symbol

Note that the Data-defined override button beside the last layer-related parameters is inactive until the
symbol is applied to a layer. Once the symbol is connected to a layer, this button offers access to the size
assistant dialog which helps to create proportional or multivariate analysis rendering.

• under these parameters are displayed items of the symbols library you can choose from. This list of symbols
can be filtered by selecting a group in the drop-down list just above.

According to the level selected in the symbol tree, you’ll get enabled different tools at the bottom of the dialog to
:

• add new symbol layer: you can imbricate as many symbols as you want

• remove the selected symbol layer

• lock colors of symbol layer: a locked color stays unchanged when user changes the color at the global
(or upper) symbol level
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• duplicate a (group of) symbol layer(s)

• move up or down the symbol layer

• apply special effects to the symbol layer

• save the designed symbol into your symbol library

• or choose in the Advanced drop-down list, to clip features to canvas extent.

Astuce: Note that once you have set the size in the lower levels of the Symbol layers dialog, the size of the whole
symbol can be changed with the Size (for marker symbol) or the Width (for line symbol) menu in the first level
again. The size of the lower levels changes accordingly, while the size ratio is maintained.

More detailed settings can be made when clicking on the lower level in the Symbol tree. You can change each
Symbol layers properties and according to the symbol type, you get different settings.

Symboles ponctuels

Les symboles ponctuels peuvent être de plusieurs types :

• Symbole d’ellipse

• Symbole de police

• Symbole simple (par défaut)

• Symbole SVG

• Symbole de champ vectoriel

For each marker symbol, you can set the following properties:

• Type de symbole : Vous avez le choix entre Symbole d’ellipse, Symbole de police, Symbole simple, Symbole
SVG et Symbole de champ vectoriel.

• Couleurs

• Taille

• Style de bordure externe

• Largeur de bordure externe

• Angle

• Décalage X,Y : vous pouvez déplacer les symboles en x ou y.

• Point d’ancrage

• Source de définition des propriétés ...

Symboles de ligne

Les symboles de ligne n’ont que de deux types possibles :

• Ligne de symboles

• Ligne simple (par défaut)

The default symbol layer type draws a simple line whereas the other display a marker point regularly on the line.
You can choose different location: vertex, last and first vertex, interval, central point or on every curve point.
Marker line can have offset along the line or offset line. Finally, rotation allows you to change the orientation of
the symbol.

The following settings are available:

• couleur
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• Épaisseur

• Décalage

• Style de ligne

• Style de jointure

• Style de fin de ligne

• Utiliser un modèle de tiret personnalisé

• Unité du tiret

• Source de définition des propriétés ...

Symboles de polygone

Les symboles de polygones peuvent également être de plusieurs types :

• Remplissage de centroïde

• Remplissage en dégradé

• Motif de ligne

• Motif de point

• Remplissage image raster

• Remplissage SVG

• Remplissage dégradé suivant la forme

• Remplissage simple (par défaut)

• Bordure : Ligne de symboles (même principe que pour les symboles de ligne)

• Bordure : Ligne simple (même principe que pour les symboles de ligne)

The following settings are available:

• Couleurs : pour la bordure et le remplissage.

• Style de remplissage

• Style de la bordure

• Largeur de bordure

• Décalage X, Y

• Source de définition des propriétés ...

Avec les boutons de couleur, vous pouvez faire glisser une couleur depuis un bouton vers un autre, copier-coller
une couleur, piocher une couleur, choisir une couleur dans une palette ou dans une liste de couleurs récentes ou
standard. Vous pouvez également directement choisir un remplissage transparent. En cliquant sur le bouton, vous
ouvrez la fenêtre de sélecteur de couleur. Notez que vous pouvez importer une couleur depuis un autre logiciel
comme GIMP.

Avec le ‘Remplissage image par raster’ vous pouvez remplir les polygones avec une image raster tuilée. Les
options comprennent le nom de fichier, l’opacité, la taille de l’image (en pixels, mm ou unités cartographiques),
le mode de coordonnées (entité ou vue) et la rotation (toutes pouvant être définies par les données).

L’option ‘Remplissage en dégradé’ du Type de symbole vous permet de choisir une configuration sur Deux

couleurs ou sur une Palette de couleurs. Vous pouvez utiliser Centroïde de l’entité comme Point de
référence. Tous les remplissages de Type de symbole sont également accessibles via le menu Symbole du rendu
Catégorisé ou Gradué et via les Propriétés de la règle du rendu Ensemble de règles.
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Other possibility is to choose a ‘shapeburst fill’ which is a buffered gradient fill, where a gradient is drawn from the
boundary of a polygon towards the polygon’s centre. Configurable parameters include distance from the boundary
to shade, use of color ramps or simple two color gradients, optional blurring of the fill and offsets.

Il est possible de ne tracer les bordures d’un polygone qu’à l’intérieur du polygone. En utilisant ‘Bordure : Ligne

simple’ sélectionnez Dessiner la ligne seulement dans le polygone.

Note: When geometry type is polygon, you can choose to disable the automatic clipping of lines/polygons to the
canvas extent. In some cases this clipping results in unfavourable symbology (eg centroid fills where the centroid
must always be the actual feature’s centroid).

12.3 Fenêtre Propriétés d’une couche vecteur

La fenêtre de Propriétés d’une couche vectorielle permet d’accéder aux paramètres généraux pour gérer
l’apparence des entités de la couche sur la carte (style, étiquetage, diagrammes) et les interactions avec la souris
(actions, infobulles, formulaires). Elle fournit également des informations sur la couche.

Pour ouvrir la fenêtre de Propriétés d’une couche, double-cliquez sur son nom dans la légende ou faites un clic-
droit puis sélectionnez Propriétés dans le menu qui apparaît.

Astuce: Passer rapidement d’un style de représentation d’une couche à un autre
Using the Styles → Add combobox at the bottom of the Layer Properties dialog, you can save as many combi-
nations of layer properties settings (symbology, labeling, diagram, fields form, actions...) as you want. Then,
simply switch between styles from the context menu of the layer in Layers Panel to automatically get different
representations of your data.

12.3.1 Onglet Général

Utilisez cet onglet pour définir les paramètres généraux de la couche vecteur. Plusieurs options sont
disponibles :

Informations sur la couche

• Changez le nom affiché de la couche dans Nom de la couche

• Définissez le fichier Source de la couche vectorielle

• Définissez l’Encodage de la source des données pour spécifier le type d’encodage utilisé dans les données
source et pour pouvoir les lire correctement

Système de Coordonnées de Référence

• Sélectionner le SCR, système de coordonnées de référence. Ici vous pouvez visualiser ou modifier le SCR
de la couche.

• Créer un index spatial (uniquement pour les formats gérés par OGR),

• Mettre à jour l’emprise dans les informations de la couche,

• Voir ou modifier la projection de la couche vecteur en cliquant sur Sélectionner le SCR
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Visibilité dépendante de l’échelle

You can set the Maximum (inclusive) and Minimum (exclusive) scale, defining a range of scale in which features

will be visible. Out of this range, they are hidden. The Set to current canvas scale button helps you use the current
map canvas scale as boundary of the range visibility.

Figure 12.13: Onglet Général de la fenêtre de Propriétés d’une couche vecteur

Constructeur de requête

Under the Provider Feature Filter frame, the Query Builder allows you to define a subset of the features in the
layer using a SQL-like WHERE clause and to display the result in the main window. As long as the query is
active, only the features corresponding to its result are available in the project. The query result can be saved as a
new vector layer.

Le Constructeur de requête est accessible via le bouton du même nom en bas de l’onglet Général de la fenêtre
des Propriétés. Dans Filtre d’entité du fournisseur de données, cliquez sur le bouton [Constructeur de requête]
pour ouvrir la fenêtre. Par exemple si vous avez une couche regions avec un champ TYPE_2, vous pouvez
sélectionner uniquement les régions de type borough dans la partie Expression de filtrage spécifique au four-
nisseur. Figure_vector_general_2 montre un exemple de requête sur la couche regions.shp de l’échantillon
de données QGIS. Les zones Champs, Valeurs et Opérateurs permettent de vous aider à la construction d’une
requête de type SQL.

La liste des champs contient tous les attributs de la table d’attributs pouvant être parcourus par la recherche. Pour
ajouter un attribut à la clause WHERE, double-cliquez sur son nom dans la liste. Vous pouvez cliquez sur les
différents champs, valeurs et opérateurs qui composent votre requête ou bien les écrire directement.
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Figure 12.14: Constructeur de requête

La liste des valeurs recense toutes les valeurs d’un attribut. Pour en lister la totalité, sélectionnez l’attribut dans
la liste de champs puis cliquez sur le bouton [Tout]. Pour lister uniquement les 25 premières valeurs, sélectionnez
l’attribut puis cliquez sur [Échantillon]. Pour ajouter une valeur à la requête, il vous suffit de faire un double-clic
dessus.

La liste des opérateurs contient toutes les opérations possibles sur une recherche. Pour ajouter un opérateur à la
clause WHERE de la requête SQL, cliquez sur le bouton approprié. Les opérateurs relationnels ( = , > , ...), les
opérateurs de comparaison (LIKE) et les opérateurs logiques (AND, OR, ...) sont disponibles.

Le bouton [Tester] affiche une fenêtre comptabilisant le nombre d’entités correspondant à votre requête, vous
permettant de savoir si votre requête fonctionne au fil de sa construction. Le bouton [Effacer] nettoie le texte de
la clause ‘SQL WHERE’. Le bouton [OK] ferme la fenêtre et effectue la sélection en fonction de la recherche
définie. Le bouton [Annuler] clôt la fenêtre, sans modifier la sélection en cours.

QGIS traite le sous-ensemble comme s’il s’agissait d’une couche complète. Par exemple si vous appliquez un filtre
sur la couche des régions de type ‘Borough’, vous n’allez pas pouvoir afficher, requêter, sauvegarder ou éditer la
région d’Anchorage parce qu’il s’agit d’une ‘Municipality’ et qu’elle ne fait donc pas partie du sous-ensemble.

La seule exception est que, à moins que votre couche fasse partie d’une base de données, utiliser un sous-ensemble
ne vous permettra pas d’éditer la couche.

12.3.2 Onglet Style

The Style menu provides you with a comprehensive tool for rendering and symbolizing your vector data. You
can use tools that are common to all vector data, as well as special symbolizing tools that were designed for the
different kinds of vector data. However all types share the following dialog structure: in the upper part, you have
a widget that helps you prepare the classification and the symbol to use for features and at the bottom the Rendu
de couche widget.

Astuce: Exporter le style d’une couche vecteur
Vous avez la possibilité d’exporter la symbologie d’une couche vecteur de QGIS vers les fichiers *.kml de Google,
*.dxf et *.tab de MapInfo. Il suffit d’un clic droit sur la couche, puis de cliquer sur Enregistrer sous → pour spé-
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cifier le nom du fichier de sortie et son format. Dans la boîte de dialogue, utilisez l’option Exporter la symbologie
pour enregistrer la symbologie comme Symbologie de l’entité ou comme Symbologie de la couche de symboles.
Si vous avez utilisé des couches de symboles, il est recommandé d’utiliser le deuxième paramètre.

Rendu d’entités

The renderer is responsible for drawing a feature together with the correct symbol. Regardless layer geometry
type, there are four common types of renderers: single symbol, categorized, graduated and rule-based. For point
layers, there are a point displacement and a heatmap renderers available while polygon layers can also be rendered
with the inverted renderer.

There is no continuous color renderer, because it is in fact only a special case of the graduated renderer. The
categorized and graduated renderers can be created by specifying a symbol and a color ramp - they will set the
colors for symbols appropriately. For each data type (points, lines and polygons), vector symbol layer types are
available. Depending on the chosen renderer, the dialog provides different additional sections.

Note: Si, en travaillant sur le style d’une couche vectorielle, vous changez de mode de rendu, les changements
effectués sur le symbole sont mémorisés. Notez que cela ne fonctionne qu’une seule fois. Si vous changez à
nouveau de mode de rendu, les paramètres seront perdus.

Rendu Symbole Unique

Le mode Symbole Unique est utilisé pour représenter toutes les entités d’une couche de manière identique,
à l’aide d’un symbole unique défini par l’utilisateur. Voir Le Créateur de symboles pour plus d’informations sur
l’utilisation des symboles.

Figure 12.15: Propriétés “Symbole Unique” de ligne

Astuce: Modifier la symbologie depuis le panneau Couches
If in your Layers Panel you have layers with categories defined through categorized, graduated or rule-based style
mode, you can quickly change the fill color of the symbol of the categories by right-clicking on a category and

choose the color you prefer from a color wheel menu. Right-clicking on a category will also give you access to
the options Hide all items, Show all items and Edit symbol.
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Rendu Catégorisé

Le rendu Catégorisé est utilisé pour représenter toutes les entités d’une couche classées par catégorie qui
dépend d’un des attributs de l’entité. Le rendu Catégorisé permet de sélectionner :

• L’attribut (en utilisant la liste déroulante de Colonne ou la fonction Définir une expression de colonne,
voir Expressions)

• The symbol (using the Le Créateur de symboles dialog) which will be used as default for each class

• The range of colors (using the Color ramp listbox) from which color applied to the symbol is selected

Cliquez ensuite sur le bouton Classer pour générer les classes pour toutes les valeurs différentes trouvées dans le
champ de la table attributaire. Chaque classe peut être désactivée en décochant la case située à gauche du symbole
de classe.

Pour changer le symbole, la valeur et / ou la légende, double-cliquez sur l’élément à modifier.

Un clic-droit vous propose de Copier / Coller, Modifier la couleur, Modifier la transparence, Modifier l’unité
de sortie ou Modifier la taille.

L’exemple de la figure figure_symbology_2 montre le rendu des catégories de la couche des rivières de
l’échantillon de données de QGIS.

Figure 12.16: Options du mode de rendu Catégorisé

Astuce: Sélectionner et modifier plusieurs symboles
Il est possible de sélectionner plusieurs symboles, de faire un clic-droit dessus et de changer en une seule opération
leur couleur, leur transparence, leur taille ou leur épaisseur.

Astuce: Match categories to symbol name
In the [Advanced] menu, under the classes, you can choose one of the two first actions to match symbol name to
a category name in your classification. Matched to saved symbols match category name with a symbol name from
your Style Manager. Match to symbols from file match category name to a symbol name from an external file.
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Rendu Gradué

Le rendu Gradué est utilisé pour afficher toutes les entités d’une couche, en utilisant un symbole de couche
défini par l’utilisateur dont la couleur ou la taille reflètera la plage d’appartenance d’une valeur d’un attribut.

De la même manière que le rendu catégorisé, le rendu Gradué permet de faire varier l’angle de rotation et la taille
des symboles selon les valeurs des champs spécifiés.

De la même façon que le rendu Catégorisé, il vous permet de choisir :

• L’attribut (en utilisant la liste déroulante de Colonne ou la fonction Définir une expression de colonne)

• le symbole (en utilisant la fenêtre de Sélection de symbole)

• Le format de la légende et la précision des valeurs numériques

• La méthode à utiliser pour modifier la couleur ou la taille des symboles

• Les couleurs (en utilisant la liste des palettes de couleur), si la méthode couleur est sélectionnée

• La taille (en choisissant une plage de valeurs et les unités)

Ensuite vous pouvez utiliser l’onglet histogramme qui permet d’afficher un histogramme interactif des valeurs du
champ ou de l’expression utilisé pour le rendu. Les classes peuvent être définies ou ajoutées depuis l’histogramme.

Note: Vous pouvez utiliser le panneau Statistique pour obtenir plus d’information sur votre couche vecteur. Voir
Statistical Summary Panel.

De retour dans l’onglet Classes, vous pouvez choisir le nombre de classes et la méthode de classification (depuis
la liste déroulante Mode). Les modes disponibles sont :

• Intervalles égaux : toutes les classes sont de même taille (par exemple, avec des valeurs allant de 0 à 16 et
4 classes, chaque classe aura une taille de 4);

• Quantile : toutes les classes auront le même effectif (même principe que pour les boîtes à moustache);

• Ruptures naturelles (Jenks) : la variance de chaque classe est minimale tandis que la variance entre les
différentes classes est maximale;

• Écart-type : les classes sont construites en fonction le l’écart-type calculé sur l’ensemble des valeurs;

• Pretty Breaks: Computes a sequence of about n+1 equally spaced nice values which cover the range of the
values in x. The values are chosen so that they are 1, 2 or 5 times a power of 10. (based on pretty from the
R statistical environment http://astrostatistics.psu.edu/datasets/R/html/base/html/pretty.html)

La zone de liste dans la partie centrale du menu Style répertorie les classes ainsi que leurs étendues, étiquettes et
symboles de rendu.

Cliquez sur le bouton Classer pour générer les classes selon le mode choisi. Chaque classe peut être désactivée
en décochant la case située à gauche du symbole de classe.

Pour changer le symbole, la valeur et / ou la légende, double-cliquez sur l’élément à modifier.

Un clic-droit vous propose de Copier / Coller, Modifier la couleur, Modifier la transparence, Modifier l’unité
de sortie ou Modifier la taille.

L’exemple de la figure figure_symbology_3 montre le rendu gradué de la couche des rivières de l’échantillon de
données de QGIS.

Astuce: Cartes thématiques utilisant une expression
Les cartes thématiques faites avec le rendu Catégorisé ou Gradué peuvent être créées en utilisant le résultat d’une
expression. Dans la fenêtre Propriétés des couches vectorielles, le sélecteur de colonne accueille une fonction
Définir une expression de colonne. Vous n’avez donc pas besoin d’écrire l’attribut de la classification dans une
nouvelle colonne de votre table si vous souhaitez que l’attribut de classification soit un composite de plusieurs
champs, ou une formule quelconque.
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Figure 12.17: Options du mode de rendu Gradué

Symboles Proportionnels et Analyse Multivariée

Proportional Symbol and Multivariate Analysis are not rendering types available from the Style rendering drop-
down list. However with the Size Assistant options applied over any of the previous rendering options, QGIS
allows you to display your point and line data with such representation. Créer des Symboles Proportionnels

Proportional rendering is done by first applying to the layer the Rendu Symbole Unique. Once you set the symbol,

at the upper level of the symbol tree, the Data-defined override button available beside Size or Width options
(for point or line layers respectively) provides tool to create proportional symbology for the layer. An assistant is

moreover accessible through the menu to help you define size expression.

Figure 12.18: Fenêtre de l’Assistant taille

L’assistant vous permet de définir :

• L’attribut à représenter, en utilisant la liste déroulante Champ ou la fonction Définir une expression de
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colonne (voir Expressions)

• La méthode de mise à l’échelle à choisir parmi ‘Flannery’, ‘Surface’ ou ‘Rayon’

• La taille minimale et maximale des symboles

• La plage de valeurs à représenter : la flèche à droite qui pointe vers le bas vous aide en remplissant automa-
tiquement les valeurs minimale et maximale du champ ou de l’expression choisi.

• La taille à appliquer pour les valeurs NULL.

À droite de la fenêtre, vous pouvez prévisualiser dynamiquement les symboles. Cette représentation est ajoutée à
la légende de la couche dans l’arborescence des couches et dans la légende du composeur d’impression.

Les paramètres montrés dans l’assistant taille ci-dessus, généreront l’expression suivante pour la taille ‘Définie
par les données’

coalesce(scale_exp(Importance, 1, 20, 2, 10, 0.57), 1)

Créer une analyse multivariée

A multivariate analysis rendering helps you evaluate the relationship between two or more variables e.g., one can
be represented by a color ramp while the other is represented by a size.

The simplest way to create multivariate analysis in QGIS is to first apply a categorized or graduated rendering on
a layer, using the same type of symbol for all the classes. Then, clicking on the symbol [Change] button above
the classification frame, you get the Le Créateur de symboles dialog from which, as seen above, you can activate
and set the size assistant option either on size (for point layer) or width (for line layer).

Like the proportional symbol, the size-related symbol is added to the layer tree, at the top of the categorized or
graduated classes symbols. And both representation are also available in the print composer legend item.

Rendu Ensemble de règles

Le moteur de rendu Ensemble de règles est utilisé pour afficher toutes les entités d’une couche en utilisant
un ensemble de règles prédéfinies dont l’aspect reflète la manière dont une entité a été classée en fonction de ses
attributs. Les règles sont définies par des expressions SQL. La fenêtre permet de regrouper les règles par type de
filtre ou échelle de validité. Vous pouvez activer le rendu selon les niveaux de symboles ou arrêter le rendu à la
première règle validée pour chaque entité.

Pour créer une règle, activez une ligne existante en double-cliquant dessus, ou cliquez sur ‘+’ puis sur la nouvelle
règle. Dans la fenêtre Propriétés de la règle, vous pouvez définir une étiquette pour la règle. Appuyez sur

le bouton pour ouvrir le constructeur de chaînes d’expression. Dans la Liste des fonctions, cliquez sur
Champs et valeurs pour afficher tous les attributs de la table d’attributs. Pour ajouter un attribut à la calculatrice
de champ Expression, double-cliquez sur son nom dans Champs et valeurs. Généralement, vous pouvez utiliser
les divers champs, valeurs et fonctions pour construire l’expression de calcul, ou vous pouvez juste la saisir dans
la boîte (voir Expressions). Vous pouvez créer une nouvelle règle en copiant et en collant une règle existante avec
le bouton droit de la souris. De même, vous pouvez utiliser la règle ‘ELSE’ qui sera exécutée si aucune des autres
règles de ce niveau ne s’applique. Depuis QGIS 2.8, les étiquettes des règles apparaissent dans la légende sous la
forme d’une arborescence. Double-cliquez sur un des éléments dans la légende et la fenêtre des propriétés de la
couche apparaît.

L’exemple de la figure figure_symbology_5 montre le rendu basé sur des règles pour la couche des rivières de
l’échantillon de données de QGIS.

Déplacement de point

Le rendu de Déplacement de point permet une visualisation de tous les points d’une couche, même si ceux-ci
se superposent. Pour se faire, les symboles des points sont répartis sur un cercle autour d’un symbole central.

Note: You can still render features with other renderer like Single symbol, Graduated, Categorized or Rule-Based
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Figure 12.19: Options du mode de rendu par Ensemble de Règles

Figure 12.20: Fenêtre Déplacement de points
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renderer using the Renderer drop-down list then the Renderer Settings... button.

Polygones inversés

Le rendu en Polygones inversés permet de définir un symbole à appliquer à l’extérieur des polygones de la
couche. Comme précédemment, vous pouvez alors choisir parmi des sous-modes de rendu : Symbole unique,
Gradué, Catégorisé, Ensemble de règles ou 2.5 D.

Figure 12.21: Fenêtre du mode de rendu en Polygones Inversés

Carte de chaleur

Avec le rendu de Carte de chaleur vous pouvez créer des cartes de chaleur en temps réel et dynamiques
pour des couches (multi-)points. Vous pouvez définir le rayon de la carte de chaleur en pixels, mm ou unités
cartographiques, choisir et éditer une palette de couleur pour le style de carte de chaleur et utiliser une jauge
pour choisir entre la vitesse de rendu et la qualité. Vous pouvez également définir une valeur maximale limite
et attribuer une pondération à chaque points via un champ ou une expression. Lorsque une entité est ajoutée ou
retirée, le rendu de carte de chaleur met automatiquement à jour le style de carte de chaleur.

2.5 D

Using the 2.5 D renderer it’s possible to create a 2.5 D effect on your layer’s features. You start by choosing
a Height value (in map units). For that you can use a fixed value, one of your layer’s fields, or an expression. You
also need to choose an Angle (in degrees) to recreate the viewer position (0° means west, growing in counter clock
wise). Use advanced configuration options to set the Roof Color and Wall Color. If you would like to simulate

solar radiation on the features walls, make sure to check the Shade walls based on aspect option. You can also
simulate a shadow by setting a Color and Size (in map units).

Astuce: Using 2.5 D effect with other renderers

110 Chapter 12. Les données vectorielles



QGIS User Guide, Version 2.14

Figure 12.22: Fenêtre Carte de chaleur

Figure 12.23: Fenêtre 2.5 D
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Once you have finished setting the basic style on the 2.5 D renderer, you can convert this to another renderer
(single, categorized, graduated). The 2.5 D effects will be kept and all other renderer specific options will be
available for you to fine tune them (this way you can have for example categorized symbols with a nice 2.5 D
representation or add some extra styling to your 2.5 D symbols). To make sure that the shadow and the “building”
itself do not interfere with other nearby features, you may need to enable Symbols Levels ( Advanced → Symbol
levels...). The 2.5 D height and angle values are saved in the layer’s variables, so you can edit it afterwards in the
variables tab of the layer’s properties dialog.

Rendu de couche

From the Style tab, you can also set some options that invariabily act on all features of the layer:

• Transparence de la couche : permet de rendre visible les couches situées en dessous.
Utiliser le curseur pour adapter la visibilité de la couche vectorielle à vos besoins. Vous pouvez également
définir directement le pourcentage de transparence dans la zone de texte située à côté.

• Layer blending mode and Feature blending mode: You can achieve special rendering effects with these tools
that you may previously only know from graphics programs. The pixels of your overlaying and underlaying
layers are mixed through the settings described in Modes de fusion.

• Apply paint effects on all the layer features with the Draw Effects button.

• Control feature rendering order allows you, using features attributes, to define the z-order in which they

shall be rendered. Activate the checkbox and click on the button beside. You then get the Define
Order dialog in which you:

– choose a field or build an expression to apply to the layer features

– set in which order the fetched features should be sorted, i.e. if you choose Ascending order, the
features with lower value are rendered under those with upper value.

– define when features returning NULL value should be rendered: first or last.

You can add several rules of ordering. The first rule is applied to all the features in the layer, z-ordering
them according to the value returned. Then, for each group of features with the same value (including those
with NULL value) and thus same z-level, the next rule is applied to sort its items among them. And so on...

Once the Define Order dialog is applied, a summary of the expression(s) used to control the layer rendering

is retranscribed in the textbox beside Control feature rendering order option.

Figure 12.24: Options de rendu de couche

Autres Paramètres

Niveaux de symbole

For renderers that allow stacked symbol layers (only heatmap doesn’t) there is an option to control the rendering
order of each symbol’s levels.

For most of the renderers, you can access the Symbols levels option by clicking the [Advanced] button below the
saved symbols list and choosing Symbol levels. For the Rendu Ensemble de règles the option is directly available
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through [Symbols levels] button, while for Déplacement de point renderer the same button is inside the Rendering
settings dialog.

To activate symbols levels, select the Enable symbol levels. Each row will show up a small sample of the
combined symbol, its label and the individual symbols layer divided into columns with a number next to it. The
numbers represent the rendering order level in which the symbol layer will be drawn. Lower values levels are
drawn first, staying at the bottom, while higher values are drawn last, on top of the others.

Figure 12.25: Fenêtre Niveaux de symbole

Note: If symbols levels are deactivated, the complete symbols will be drawn according to their respective features
order. Overlapping symbols will simply obfuscate to other below. Besides, similar symbols won’t “merge” with
each other.

Figure 12.26: Différence de rendu selon que les niveaux de symboles sont activés (A) ou non (B)

Effets

In order to improve layer rendering and avoid (or at least reduce) the resort to other software for final rendering of

maps, QGIS provides another powerful functionality: the Draw Effects options, which adds paint effects for
customizing the visualization of vector layers.

The option is available in the Layer Properties –> Style dialog, under the Layer rendering group (applying to the
whole layer) or in symbol layer properties (applying to corresponding features). You can combine both usage.
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Paint effects can be activated by checking the Draw effects option and clicking the Customize effects button,
that will open the Effect Properties Dialog (see figure_effects_1). The following effect types, with custom options
are available:

• Source: Draws the feature’s original style according to the configuration of the layer’s properties. The
transparency of its style can be adjusted.

Figure 12.27: Draw Effects: Source dialog

• Blur: Adds a blur effect on the vector layer. The options that someone can change are the Blur type (Stack
or Gaussian blur), the strength and transparency of the blur effect.

Figure 12.28: Draw Effects: Blur dialog

• Colorize: This effect can be used to make a version of the style using one single hue. The base will always

be a grayscale version of the symbol and you can use the Grayscale to select how to create it (options

are: ‘lightness’, ‘luminosity’ and ‘average’). If Colorise is selected, it will be possible to mix another
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color and choose how strong it should be. You can also control the Brightness, contrast and saturation
levels of the resulting symbol.

Figure 12.29: Draw Effects: Colorize dialog

• Drop Shadow: Using this effect adds a shadow on the feature, which looks like adding an extra dimension.
This effect can be customized by changing the offset degrees and radius, determining where the shadow
shifts towards to and the proximity to the source object. Drop Shadow also has the option to change the blur
radius, the transparency and the color of the effect.

Figure 12.30: Draw Effects: Drop Shadow dialog

• Inner Shadow: This effect is similar to the Drop Shadow effect, but it adds the shadow effect on the inside
of the edges of the feature. The available options for customization are the same as the Drop Shadow effect.

• Inner Glow: Adds a glow effect inside the feature. This effect can be customized by adjusting the spread
(width) of the glow, or the Blur radius. The latter specifies the proximity from the edge of the feature where
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Figure 12.31: Draw Effects: Inner Shadow dialog

you want any blurring to happen. Additionally, there are options to customize the color of the glow, with a
single color or a color ramp.

Figure 12.32: Draw Effects: Inner Glow dialog

• Outer Glow: This effect is similar to the Inner Glow effect, but it adds the glow effect on the outside of the
edges of the feature. The available options for customization are the same as the Inner Glow effect.

• Transform: Adds the possibility of transforming the shape of the symbol. The first options available
for customization are the Reflect horizontal and Reflect vertical, which actually create a reflection on the
horizontal and/or vertical axes. The 4 other options are:

– Shear: slants the feature along the x and/or y axis

– Scale: enlarges or minimizes the feature along the x and/or y axis by the given percentage

– Rotation: turns the feature around its center point

– and Translate changes the position of the item based on a distance given on the x and/or the y axis.
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Figure 12.33: Draw Effects: Outer Glow dialog

Figure 12.34: Draw Effects: Transform dialog
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There are some common options available for all draw effect types. Transparency and Blend mode options work
similar to the ones described in Rendu de couche and can be used in all draw effects except for the transform one.

One or more draw effects can used at the same time. You activate/deactivate an effect using its checkbox in the

effects list. You can change the selected effect type by using the Effect type option. You can reorder the

effects using Move up and Move down buttons, and also add/remove effects using the Add effect and
Remove effect buttons.

There is also a Draw mode option available for every draw effect, and you can choose whether to render
and/or to modify the symbol. Effects render from top to bottom.’Render only’ mode means that the effect will be
visible while the ‘Modify only’ mode means that the effect will not be visible but the changes that it applies will
be passed to the next effect (the one immediately below). The ‘Render and Modify’ mode will make the effect
visible and pass any changes to the next effect. If the effect is in the top of the effects list or if the immediately
above effect is not in modify mode, then it will use the original source symbol from the layers properties (similar
to source).

12.3.3 Onglet Étiquettes

Le moteur d’ Étiquettes fournit un système d’étiquetage intelligent pour les couches de points, lignes et polygones
et ne nécessite que peu de paramètres. Ce système gère les couches reprojetées à la volée. Les menus suivants
permettent de configurer l’étiquetage pour les couches vectorielles :

• Texte

• Formatage

• Tampon

• Fond

• Ombre

• Emplacement

• Rendu

Pour étiqueter une couche, lancez QGIS et chargez une couche vectorielle. Cochez la couche dans la légende et
cliquez sur le bouton Paramètres d’étiquetage de la couche de la barre d’outils QGIS ou sur l’onglet Étiquettes dans la
fenêtre de propriétés de la couche.

La première étape est de choisir une méthode d’étiquetage depuis la liste déroulante. Quatre options sont proposées
:

• Pas d’étiquette

• Montrer les étiquettes pour cette couche

• Etiquettes basées sur des règles

• et Bloquant : n’affiche pas d’étiquette mais définit la couche comme un obstacle pour les étiquettes des
autres couches.

Cochez l’option Montrer les étiquettes pour cette couche et sélectionnez un champ attributaire à utiliser pour
l’étiquette depuis la liste déroulante Étiqueter avec. Cliquez sur si vous souhaitez définir les étiquettes en
vous basant sur des expressions. Voir Définir des étiquettes basées sur des expressions.

Les étapes présentées ci-dessous décrivent un étiquetage simple, sans utilisation des fonctions de Valeurs définies
par les données, situées à droite des paramètres à définir. Voir Utiliser des valeurs de paramètres définies par les
données pour l’étiquetage pour un cas d’utilisation.

Texte

Vous pouvez définir le style du texte dans le menu Texte (voir Figure_labels_1 ). Utilisez l’option Casse pour
influencer le rendu du texte. Vous avez la possibilité d’afficher le texte ‘Tout en majuscules’, ‘Tout en minuscules’
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ou ‘Premières lettres en majuscules’. Utilisez le ref:blend-modes pour créer des effets bien connus des logiciels
de graphisme.

Figure 12.35: Étiquetage d’une couche vectorielle de points

Formatage

In the Formatting menu, you can define a character for a line break in the labels with the ‘Wrap on character’
function. You can format the Line Height and the alignment. For the latter typical values are available plus Follow
label placement. When set to this mode, text alignment for labels will be dependent on the final placement of the
label relative to the point. E.g., if the label is placed to the left of the point then the label will be right aligned, and
if it is placed to the right of the point then the label will be left aligned.

For line vector layers you can include line directions symbols. There are options specifying the type of symbol
and the symbol placement.

Utilisez l’option Nombres formatés pour formater les valeurs numériques de la table attributaire. Les chiffres
après la virgule sont insérés. L’activation de cette option ajoute par défaut trois chiffres après la virgule.

Tampon

To create a buffer, just activate the Draw text buffer checkbox in the Buffer menu. The buffer color is variable.

Here, you can also use blend modes. If the color buffer’s fill checkbox is activated, it will interact with partially
transparent text and give mixed color transparency results. Turning off the buffer fill fixes that issue (except where
the interior aspect of the buffer’s stroke intersects with the text’s fill) and also allows you to make outlined text.
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Fond

Dans le menu Fond, vous pouvez définir la forme de votre arrière-plan avec Taille X et Taille Y. Utilisez Taille selon
pour ajouter une zone de ‘Tampon’ à votre arrière-plan. La taille du tampon est définie par défaut ici. Le fond est
alors constitué de la zone tampon et du fond défini par les valeurs Taille X et Taille Y. Vous pouvez aussi définir
une Rotation correspondant à ‘Angle de l’étiquette’, ‘Angle par rapport à l’étiquette’ ou encore ‘Valeurs fixes’.
Définissez un Décalage X,Y avec les valeurs X et Y et le fond sera déplacé. En appliquant Angles arrondis X,Y,
l’arrière-plan s’arrondit aux angles. Il est également possible de fusionner le fond avec les couches sous-jacentes
dans la fenêtre de carte en utilisant le Mode de fusion (voir Modes de fusion).

Ombre

Utilisez le menu Ombre pour une Ombre portée définie par l’utilisateur. Le dessin de l’arrière-plan est très variable.
Choisissez entre ‘l’objet le plus bas de l’étiquette’, ‘Texte’, ‘Tampon’ et ‘Fond’. L’angle du Décalage dépend de
l’orientation de l’étiquette. Si vous cochez la case Utilise une ombre globale, alors le point zéro de l’angle est
toujours orienté vers le nord et ne dépend pas de l’orientation de l’étiquette. Vous pouvez influencer l’apparence
de l’ombre avec le Rayon d’estompage. Plus le nombre sera faible et plus les ombres seront douces. L’apparence
de l’ombre portée peut également être modifiée en choisissant un mode de fusion.

Emplacement

Choose the Placement menu for configuring label placement and labeling priority. Note that the placement options
differ according to the type of vector layer, namely point, line or polygon.

Emplacement pour les couches de points

With the Cartographic placement mode, point labels are generated with best visual relationship with the point
feature, following ideal cartographic placement rules. Labels can be placed at a set Distance either from the
point feature itself or from the bounds of the symbol used to represent the feature. The latter option is especially
useful when the symbol size isn’t fixed, e.g. if it’s set by a data defined size or when using different symbols in a
categorized renderer.

By default, placements are prioritised in the following order:

1. en haut à droite

2. en haut à gauche

3. coin inférieur droit

4. coin inférieur gauche

5. au centre à droite

6. au centre à gauche

7. en haut, décalé légèrement à droite

8. en bas, décalé légèrement à gauche.

La priorité de placement peut cependant être paramétrée pour une entité donnée en utilisant la liste des positions,
définie par les données. Cela permet d’utiliser un placement pour certaines entités et pas pour les autres, exemple:
les entités sur la côte peuvent empêcher les étiquettes de s’afficher sur les territoires hors d’eau.

The Around point setting places the label in an equal radius (set in Distance) circle around the feature. The
placement of the label can even be constrained using the Quadrant option.

In the Offset from point placement, labels are placed at a fixed offset from the point feature. You can select the
Quadrant in which to place your label. You are also able to set the X and Y offset distances between the points
and their labels and can alter the angle of the label placement with the Rotation setting. Thus, placement in a
selected quadrant with a defined rotation is possible.
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Emplacement pour les couches de lignes

Label options for line layers include Parallel, Curved or Horizontal. For the Parallel and Curved

options, you can set the position to Above line, On line and Below line. It’s possible to select several
options at once. In that case, QGIS will look for the optimal label position. For Parallel and curved placement
you can also use the line orientation for the position of the label. Additionally, you can define a Maximum angle
between curved characters when selecting the Curved option (see Figure_labels_2 ).

For all three placement options you can set up a minimum distance for repeating labels. The distance can be in
mm or in map units.

Figure 12.36: Étiquetage d’une couche vectorielle de lignes

Emplacement pour les couches de polygones

You can choose one of the following options for placing labels in polygons: Offset from centroid, Horizontal
(slow), Around centroid, Free and Using perimeter.

In the Offset from centroid settings you can specify if the centroid is of the visible polygon or whole
polygon. That means that either the centroid is used for the polygon you can see on the map or the centroid is
determined for the whole polygon, no matter if you can see the whole feature on the map. You can place your
label within a specific quadrant, and define offset and rotation. The Around centroid setting places the label at
a specified distance around the centroid. Again, you can define visible polygon or whole polygon for the
centroid.

12.3. Fenêtre Propriétés d’une couche vecteur 121



QGIS User Guide, Version 2.14

With the Using perimeter settings, you can define a position and a distance for the label. For the position,

Above line, On line, Below line and Line orientation dependent position are possible. You can specify
the distance between the label and the polygon outline, as well as the repeat interval for the label.

Figure 12.37: Étiquetage d’une couche vectorielle de polygones

In the priority section you can define the priority with which labels are rendered for all three vector layer types
(point, line, polygon). This placement option interact with labels of the other vector layers in the map canvas. If
there are labels from different layers in the same location, the label with the higher priority will be displayed and
the others will be left out.

Rendu

In the Rendering menu, you can tune when the labels can be rendered and their interaction with other labels and
features.

Under Label options, you find the scale-based and the Pixel size-based visibility settings.

The Label z-index determines the order in which labels are rendered, as well in relation with other feature labels in
the layer (using data-defined override expression), as with labels from other layers. Labels with a higher z-index
are rendered on top of labels (from any layer) with lower z-index.

De plus, la logique a été affinée pour gérer les cas où 2 étiquettes ont un index z identique :

• Si elles sont dans la même couche, une étiquette plus petite sera toujours tracée au dessus de l’étiquette plus
large.

• Si elles sont issues de couches différentes, les étiquettes sont tracées dans le même ordre que les couches
(pour respecter l’ordre des couches dans la légende).

À noter que ce paramètre ne définit par comment sont tracées les étiquettes par rapport aux entités d’autres
couches, il contrôle uniquement l’ordre dans lequel les étiquettes sont tracées au dessus des entités de la couche.

While rendering labels and in order to display readable labels, QGIS automatically evaluates the position of the

labels and can hide some of them in case of collision. You can however choose to Show all labels for this
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layer (including colliding labels) in order to manually fix their placement.

With data-defined expressions in Show label and Always Show you can fine tune which labels should be rendered.

Under Feature options, you can choose to label every part of a multi-part feature and limit the number of features
to be labeled. Both line and polygon layers offer the option to set a minimum size for the features to be labeled,
using Suppress labeling of features smaller than. For polygon features, you can also filter the labels to show
according to whether they completely fit within the feature or not. For line features, you can choose to Merge
connected lines to avoid duplicate labels, rendering a quite airy map in conjunction with the Distance or Repeat
options in Placement tab.

From the Obstacles frame, you can manage the covering relation between labels and features. Activate the
Discourage labels from covering features option to decide whether features of the layer should act as obstacles
for any label (including labels from other features in the same layer). An obstacle is a feature QGIS tries as far as
possible to not place labels over. Instead of the whole layer, you can define a subset of features to use as obstacles,

using the data-defined override control next to the option.

The priority control slider for obstacles allows you to make labels prefer to overlap features
from certain layers rather than others. A Low weight obstacle priority means that features of the layer are less
considered as obstacles and thus more likely to be covered by labels. This priority can also be data-defined, so
that within the same layer, certain features are more likely to be covered than others.

For polygon layers, you can choose the type of obstacle features could be by minimising the labels placement:

• over the feature’s interior: avoids placing labels over interior of polygon (prefers placing labels totally
outside or just slightly inside polygon)

• or over the feature’s boundary: avoids placing labels over boundary of polygon (prefers placing labels
outside or completely inside the polygon). It can be e.g. useful for regional boundary layers, where the
features cover an entire area. In this case it’s impossible to avoid placing labels within these features, and it
looks much better to avoid placing them over the boundaries between features.

Définir des étiquettes basées sur des expressions

QGIS permet d’utiliser des expressions pour étiqueter les entités. Cliquez sur l’icône dans le menu Étiquettes

de la boîte de dialogue Propriétés. Sur figure_labels_4 vous pouvez voir un exemple d’expression pour étiqueter les
régions de l’Alaska avec leur nom et leur superficie, en se basant sur le champ ‘NAME_2’, un texte de description
et la fonction $area en combinaison avec format_number() pour améliorer l’affichage numérique.

Expression based labeling is easy to work with. All you have to take care of is that:

• you need to combine all elements (strings, fields and functions) with a string concatenation function such as
concat, + or ||. Be aware that in some situations (null or numeric value involved) not all of these tools
will fit your need

• strings are written in ‘single quotes’

• fields are written in “double quotes” or without any quote.

Examinons quelques exemples :

# label based on two fields ’name’ and ’place’ with a comma as separator
"name" || ’, ’ || "place"

-> John Smith, Paris

# label based on two fields ’name’ and ’place’ with other texts
’My name is ’ + "name" + ’and I live in ’ + "place"
’My name is ’ || "name" || ’and I live in ’ || "place"
concat(’My name is ’, name, ’ and I live in ’, "place")

-> My name is John Smith and I live in Paris
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Figure 12.38: Utiliser des expressions pour l’étiquetage

# label based on two fields ’name’ and ’place’ with other texts
# combining different concatenation functions
concat(’My name is ’, name, ’ and I live in ’ || place)

-> My name is John Smith and I live in Paris
-> My name is John Smith # if the field ’place’ is NULL

# multi-line label based on two fields ’name’ and ’place’ with a descriptive text
concat(’My name is ’, "name", ’\n’ , ’I live in ’ , "place")
-> My name is John Smith

I live in Paris

# label based on a field and the $area function
# to show the place name and its rounded area size in a converted unit.
’The area of ’ || "place" || ’ has a size of ’ || round($area/10000) || ’ ha’

-> The area of Paris has a size of 10500 ha

# create a CASE ELSE condition. If the population value in field
# population is <= 50000 it is a town, otherwise a city.
concat(’This place is a ’, CASE WHEN "population <= 50000" THEN ’town’ ELSE ’city’ END)

-> This place is a town

Comme vous pouvez le constater dans le constructeur d’expressions, vous avez à votre disposition une centaine
de fonctions pour créer des expressions simples ou très complexes afin d’étiqueter vos données avec QGIS. Voir
Expressions pour plus d’informations et des exemples d’expressions.

Utiliser des valeurs de paramètres définies par les données pour l’étiquetage

Avec les fonctions de valeurs définies par des données, les paramètres de l’étiquetage sont remplacées par les
entrées de la table d’attributs. Vous pouvez activer et désactiver cette fonction avec le bouton droit de la souris.
Survolez le symbole et vous verrez les informations sur le remplacement des données définies, y compris le champ

actuellement appliqué. Nous décrivons maintenant un exemple d’utilisation de cette fonction pour l’outil :sup:
déplacement d’étiquette (voir figure_labels_5).
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1. Importez la couche lakes.shp depuis le jeu de données test de QGIS.

2. Double-cliquez la couche pour ouvrir la fenêtre des Propriétés. Sélectionnez Etiquettes puis Emplacement
et enfin Décalage par rapport au centroïde.

3. Dans le cadre Défini par les données, cliquez sur l’icône pour définir le champ correspondant à la
coordonnée. Choisissez ‘xlabel’ pour X et ‘ylabel’ pour Y. Les icônes revêtent maintenant une surbrillance
jaune.

4. Zoomez sur un lac.

5. Sélectionnez l’outil de la barre d’outils Étiquettes. Vous pouvez maintenant déplacer l’étiquette
manuellement vers une autre position (voir figure_labels_6). La nouvelle position est sauvegardée dans
les colonnes ‘xlabel’ et ‘ylabel’ de votre table attributaire.

Figure 12.39: Étiquetage d’une couche vectorielle de polygones avec l’option ‘Défini par les données’

Figure 12.40: Déplacer des étiquettes
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Étiquettes basées sur des règles

With Rule-based labeling multiple label configurations can be defined and applied selectively on the base of
expression filters, as in Rule-based rendering.

Rules can be set selecting the corresponding option at the top of the Labels panel (see figure_labels_7 ).

Figure 12.41: Étiquetage basé sur des règles

To create a rule, activate an existing row by double-clicking on it, or click on ‘+’ and click on the new rule. Within
the panel you can set the filter expression and the related label configurations.

12.3.4 Onglet Champs

Le menu Champs permet de manipuler les champs attributaires du jeu de données sélectionné. Les boutons

: sup:Nouvelle colonne et : sup:Effacer une colonne peuvent être utilisés lorsque la couche est en
Mode édition.

Outils d’édition

Dans le menu Champs se trouve également une colonne Outil d’édition. Cette colonne peut être utilisée pour
définir des valeurs ou des plages de valeurs à utiliser pour ce champ précis de la table attributaire. Si vous cliquez
sur [Outil d’édition], il s’ouvre une fenêtre de dialogue dans laquelle vous pouvez définir différentes modalités.
Celles-ci sont :

• Case à cocher : Affiche une case à cocher et vous pouvez définir quelle valeur stocker quand la case est
cochée ou pas.

• Classification : Affiche une liste déroulante avec les valeurs utilisées pour la classification, si vous avez
choisi le style ‘Catégorisé’ dans l’onglet Style de la fenêtre de propriétés.

• Couleur : Affiche un bouton de couleur permettant de choisir une couleur via la fenêtre Sélectionner une
couleur.

• Date/Heure : Affiche un champ de type date/heure qui peut ouvrir un calendrier permettant de choisir une
date, une heure ou les deux. Le champ doit être de type texte. Vous pouvez choisir un format personnalisé,
l’affichage d’un calendrier, etc.

• Énumération : Ouvre une liste déroulante avec les valeurs qui peuvent être utilisées selon la définition du
type de champ. Ce mode d’édition n’est actuellement disponible que pour les couches PostgreSQL.
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Figure 12.42: Rule settings
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Figure 12.43: Fenêtre d’édition d’une colonne attributaire

• Nom de fichier : Simplifie la sélection d’un fichier par l’ouverture d’un explorateur de fichiers.

• Cachée : Un attribut caché sera invisible. L’utilisateur ne pourra pas visualiser son contenu.

• Photo : Champ contenant le nom d’un fichier de photo. La largeur et la hauteur peuvent être précisées.

• Plage : Vous permet de spécifier une plage de valeurs numériques disponibles. Il peut s’agir d’une barre
coulissante ou d’une zone de texte éditable.

• Référence de la relation : Ce widget vous permet d’incorporer le formulaire d’entités de la couche
référencée dans le formulaire de la couche courante. Créer des relations un à plusieurs.

• Édition de texte (par défait) : Ceci permet l’édition d’un texte simple ou multi-ligne. Si vous choisissez
Multi-ligne, vous pouvez spécifier s’il s’agit d’un contenu en HTML.

• Valeurs uniques : Vous pouvez sélectionner l’une des valeurs déjà utilisées dans cette colonne. Une ligne
est affichée avec le support de l’auto-complétion si la case ‘Éditable’ est cochée, une boîte de saisie est
utilisée sinon.

• Générateur d’UUID : Champ en lecture seule qui génère un UUID (Identifiant Unique Universel) lorsqu’il
est vide.

• Liste de valeurs : Une liste déroulante avec des valeurs prédéfinies. La valeur est stockée dans l’attribut, la
description est affichée dans la liste. Vous pouvez définir des valeurs manuellement ou les charger depuis la
couche ou depuis un fichier CSV.

• Value Relation: Offers values from a related table in a combobox. You can select layer, key column and
value column. Several options are available to change the standard behaviours: allow null value, order by
value, allow multiple selections and use of autocompleter. The forms will display either a drop-down list or
a line edit field when completer checkbox is enabled.

• Vue web : Champ contenant une URL. La largeur et la hauteur sont variables.

Note: QGIS possède une option avancée ‘Cachée’ pour définir votre propre outil de champ qui utilise python
et l’ajouter à cette grande liste d’outils. Il est d’une utilisation délicate mais il est très bien expliqué dans le blog
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suivant qui explique comment créer un outil de validation en temps réel pouvant être utilisé comme les outils
décrits. Voir http://blog.vitu.ch/10142013-1847/write-your-own-qgis-form-elements

Astuce: Relative Path in widgets
If the path which is selected with the file browser is located in the same directory as the .qgs project file or below,
paths are converted to relative paths. This increases portability of a qgs project with multimedia information
attached. This is enabled only for File Name, Photo and Web View at this moment.

Avec l’Éditeur de mise en page des attributs vous pouvez maintenant définir des formulaires intégrés (voir
figure_fields_2). C’est utile pour les travaux de saisie de données ou pour identifier des objets en utilisant l’option
d’ouverture automatique du formulaire lorsqu’il y a des objets ayant beaucoup d’attributs. Vous pouvez créer un
éditeur ayant plusieurs onglets et groupes nommés pour présenter les champs d’attributs.

Choose ‘Drag and drop designer’ and an attribute column. Use the icon to create a category to insert a tab or
a named group (see figure_fields_3). When creating a new category, QGIS will insert a new tab or named group
for the category in the built-in form. The next step will be to assign the relevant fields to a selected category with

the icon. You can create more categories and use the same fields again.

Other options in the dialog are ‘Autogenerate’ and ‘Provide ui-file’.

• ‘Autogenerate’ just creates editors for all fields and tabulates them.

• The ‘Provide ui-file’ option allows you to use complex dialogs made with the Qt-Designer. Us-
ing a UI-file allows a great deal of freedom in creating a dialog. For detailed information, see
http://nathanw.net/2011/09/05/qgis-tips-custom-feature-forms-with-python-logic/.

QGIS dialogs can have a Python function that is called when the dialog is opened. Use this function to add extra
logic to your dialogs. The form code can be specified in three different ways:

• load from the environment (for example in startup.py or from a plugin)

• load from an external file, a file chooser will appear in that case to allow you to select a Python file from
your filesystem

• load from inline code, a Python editor will appear where you can directly type your form code

In all cases you must enter the name of the function that will be called (open in the example below).

An example is (in module MyForms.py):

def open(dialog,layer,feature):
geom = feature.geometry()
control = dialog.findChild(QWidged,"My line edit")

Référence à la Fonction Python Init comme ceci : open

12.3.5 Onglet Jointures

L’onglet Jointures permet de joindre une table attributaire chargée à une couche vecteur chargée. Après

avoir cliqué sur le bouton , la fenêtre Ajouter une jointure vectorielle apparaît. Vous devez définir une couche
de jointure à connecter à la couche cible. Ensuite, vous devez définir un champ de jointure qui sera commun à la
table à joindre et à la table attributaire de la couche cible. Vous pouvez enfin spécifier la liste des champs à joindre

en cochant la case Choisir les champs à joindre. Il en résulte que toutes les informations de la table à joindre
seront affichés en plus des champs de la table cible. Si vous avez spécifié une liste de champs à joindre, seuls
ceux-ci apparaîtront dans la table attributaire de la couche cible.

Actuellement, QGIS gère les jointures de tables non spatiales aux formats pris en charge par OGR (par exemple
CSV, DBF, Excel), au format texte délimité et issues de PostgreSQL (voir figure_joins_1).

De plus, la fenêtre de jointure vous permet de :
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Figure 12.44: Fenêtre de création de catégories avec la Mise en page de l’éditeur d’attribut

Figure 12.45: Formulaire intégré obtenu avec onglets et groupes nommés
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Figure 12.46: Joindre une table attributaire à une couche vectorielle existante

• Mettre la couche jointe en cache dans la mémoire virtuelle

• Créer un index des attributs joins

• Choisir les champs à joindre

• Personnaliser le préfixe du champ

12.3.6 Onglet Diagrammes

L’onglet Diagrammes permet d’ajouter une couche de graphiques sur une couche vecteur (voir fig-
ure_diagrams_1).

Cet onglet permet de générer :

• pie charts, a circular statistical graphic divided into slices to illustrate numerical proportion. The arc length
of each slice is proportional to the quantity it represents,

• text diagrams, a horizontaly divided circle showing statistics values inside

• et des Histogrammes.

For each type of diagram, the menu is divided into five tabs:
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Attributs

Attributes defines which variables to display in the diagram. Use add item button to select the desired fields into
the ‘Assigned Attributes’ panel. Generated attributes with Expressions can also be used.

You can move up and down any row with click and drag, sorting how atributes are displayed. You can also change
the label in the ‘Legend’ column or the attibute color by double-clicking the item.

Cette étiquette est le texte par défaut affiché dans la légende du composeur d’impression ou dans l’arborescence
de la couche, dans le panneau Couche.

Figure 12.47: Onglet Diagrammes de la fenêtre de Propriétés d’une couche vecteur

Apparence

Appearance defines how the diagram looks like. It provides general settings that do not interfere with the statistic
values such as:

• the graphic transparency, its outline width and color

• the width of the bar in case of histogram

• the circle background color in case of text diagram, and the font used for texts

• the orientation of the left line of the first slice represented in pie chart. Note that slices are displayed
clockwise.

In this menu, you can also manage the diagram visibility:

• by removing diagrams that overlap others or Show all diagrams even if they overlap each other

• by setting the scale visibility

Taille

Size is the main tab to set how the selected statistics are represented. The diagram size units can be ‘Map Units’
or ‘Millimeters’. You can use :

• Fixed size, an unique size to represent the graphic of all the features, except when displaying histogram

• or Scaled size, based on an expression using layer attributes.
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Figure 12.48: Onglet Diagrammes de la fenêtre de Propriétés d’une couche vecteur, sous-onglet Taille

Emplacement

Placement helps to define diagram position. According to the layer geometry type, it offers different options for
the placement:

• ‘Over the point’ or ‘Around the point’ for point geometry. The latter variable requires a radius to follow.

• ‘Over the line’ or ‘Around the line’ for line geometry. Like point feature, the last variable requires a distance
to respect and user can specify the diagram placement relative to the feature (‘above’, ‘on’ and/or ‘below’
the line) It’s possible to select several options at once. In that case, QGIS will look for the optimal position
of the diagram. Remember that here you can also use the line orientation for the position of the diagram.

• ‘Over the centroid’, ‘Around the centroid’ (with a distance set), ‘Perimeter’ and anywhere ‘Inside polygon’
are the options for polygon features.

The diagram can also be placed using feature data by filling the X and Y fields with an attribute of the feature.

The placement of the diagrams can interact with the labeling, so you can detect and solve position conflicts
between diagrams and labels by setting the Priority slider or the z-index value.

Options

The Options tab has settings only in case of histogram. You can choose whether the bar orientation should be
‘Up’, ‘Down’, ‘Right’ and ‘Left’.

Astuce: Switch quickly between diagrams
Given that almost all the settings above are common to the different types of diagram, when designing your
diagram, you can easily change the diagram type and check which one is more appropriate to your data without
any loss.

Exemple d’utilisation

Nous allons vous montrer un exemple en superposant aux frontières de l’Alaska des données concernant la tem-
pérature issues d’une couche vecteur portant sur le climat. Toutes ces couches sont disponibles dans l’échantillon
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de données QGIS (voir section Échantillon de données).

1. Tout d’abord, cliquez sur le bouton Ajouter une couche vecteur, naviguez jusqu’au jeu de données exemples de
QGIS et ajoutez les deux couches alaska.shp et climate.shp.

2. Double-cliquez sur la couche climate dans la légende pour ouvrir la fenêtre de Propriétés de la Couche.

3. Cliquez sur l’onglet Diagrammes, activez la case Afficher les diagrammes et choisissez ‘Diagramme

texte’ dans la liste déroulante Type de diagramme.

4. Dans l’onglet Apparence, nous choisissons le bleu clair comme couleur de fond et définissons une taille fixe
de 18 mm dans l’onglet Taille.

5. Dans l’onglet Position, l’emplacement défini est Autour du point.

6. Sur le diagramme, nous souhaiterions afficher les valeurs de trois colonnes T_F_JAN, T_F_JUL et

T_F_MEAN. Donc dans le sous-onglet Attributs, sélectionnez T_F_JAN et cliquez sur le bouton puis
faites de même avec les colonnes T_F_JUL et enfin T_F_MEAN.

7. Cliquez maintenant sur [Appliquer] pour afficher les diagrammes sur la carte.

8. Vous pouvez adapter la taille du graphique dans l’onglet Taille. Activez l’option Taille variable et
définissez la taille des diagrammes en fonction de la Valeur maximale d’un attribut et de l’option Taille. Si

les diagrammes apparaissent trop petits à l’écran, vous pouvez cocher la case Augmenter la taille des
petits diagrammes et définir la Taille minimale des diagrammes.

9. Changez les couleurs des attributs en double-cliquant sur les rectangles colorées dans le champ Attributs
utilisés. Figure_diagrams_3 donne un aperçu du résultat.

10. Cliquez enfin sur [OK].

Figure 12.49: Diagrammes issus de données de températures sur une carte

N’oubliez pas que, dans l’onglet Position, en cochant la case Source de définition de la position, vous pouvez
utiliser des valeurs d’attributs pour choisir l’emplacement des diagrammes. Par ailleurs, dans l’onglet Apparence,
vous pouvez définir la visibilité en fonction de l’échelle.

La taille et les attributs peuvent aussi être une expression. Utilisez le bouton pour ajouter une expression. Voir
Expressions pour plus d’informations et des exemples.
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12.3.7 Onglet Actions

QGIS est capable d’effectuer des actions basées sur les attributs d’une entité. Il peut s’agir de nombreuses
actions, par exemple exécuter un programme avec des arguments construits à partir des attributs d’une entité, ou
encore, passer des paramètres à un outil de publication de rapports sur internet.

Figure 12.50: Vue d’ensemble de la fenêtre Actions avec quelques exemples d’actions

Les actions sont utiles si vous voulez exécuter fréquemment une application externe ou charger une page web
basée sur une ou plusieurs valeurs de votre couche vecteur. Il en existe six types qui peuvent être utilisés de la
sorte :

• Les actions de type Générique, Mac, Windows et Unix lancent un processus externe.

• Les actions Python lancent un code Python.

• Les actions de type Générique et Python sont disponibles quel que soit le système d’exploitation.

• Les actions Mac, Windows et Unix sont disponibles uniquement depuis les systèmes d’exploitation corre-
spondants (c’est à dire que vous pouvez définir trois actions ‘Éditer’ qui ouvrent un éditeur et les utilisateurs
ne verront que l’action correspondant à leur système d’exploitation).

Quelques exemples d’actions sont fournis. Vous pouvez les charger en cliquant sur [Ajouter les actions par
défaut]. Un des exemples effectue une recherche basée sur la valeur d’un attribut. C’est ce qui est développé par
la suite.
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Définir des Actions

Les actions sur les attributs sont définies depuis la fenêtre Propriétés de la couche vecteur. Pour définir une
action, ouvrez la fenêtre Propriétés de la couche vecteur et cliquez sur le menu Actions. Allez à Propriétés de
l’action. Sélectionnez le type ‘Générique’ et fournissez un nom d’identification à l’action. Le texte de l’action doit
lui-même contenir le nom de l’application qui sera exécutée lorsque l’action est invoquée. Vous pouvez ajouter
un ou plusieurs champs en arguments pour l’application. Lorsque l’action est invoquée, tout jeu de caractères
commençant par % suivi d’un champ sera remplacé par la valeur de ce champ. Les caractères spéciaux %% sont
remplacés par la valeur du champ sélectionné dans la fenêtre Identifier les résultats ou dans la Table attributaire (
voir using_actions ci-après). Les guillemets double peuvent être utilisés pour regrouper le texte dans un argument
unique pour l’application, le script ou le programme. Ils sont ignorés lorsque précédés d’un antislash.

Si vous avez des noms de champs qui sont contenus dans d’autres noms de champs (par exemple, col1 et col10),
vous devez l’indiquer en entourant le nom de champ (le caractère %) par des crochets (par exemple [%col10]).
Ceci évitera de prendre le nom de champ %col10 pour %col1 avec un 0 à la fin. Les crochets seront retirés
quand QGIS substituera le nom par la valeur du champ. Si vous voulez que le champ à substituer soit entouré de
crochets, utilisez un deuxième jeu de crochets comme ceci : [[%col10]].

En utilisant l’outil Identifier les entités, vous ouvrez la fenêtre Identifier les résultats. Elle inclut une entrée
(Dérivé) qui contient des informations pertinentes selon le type de couche. Les valeurs de cette entrée sont acces-
sibles de la même manière que les autres champs en ajoutant (Derived). avant le nom du champ. Par exemple,
une couche de points a un champ X et Y et leurs valeurs peuvent être utilisées dans l’action avec %(Derived).X
et %(Derived).Y. Les attributs dérivés sont disponibles uniquement depuis la fenêtre Identifier les résultats
mais pas par la Table d’attributs.

Deux exemples d’action sont proposés ci-dessous :

• konqueror http://www.google.com/search?q=%nam

• konqueror http://www.google.com/search?q=%%

Dans le premier exemple, le navigateur internet konqueror est lancé avec une URL. L’URL effectue une
recherche Google sur la valeur du champ nam de la couche vecteur. Notez que l’application ou le script ap-
pelé par l’action doit être dans le path sinon vous devez fournir le chemin complet vers l’application. Pour
être certain, nous pouvons réécrire le premier exemple de cette manière : /opt/kde3/bin/konqueror
http://www.google.com/search?q=%nam. Ceci assurera que l’application konqueror sera exécutée
quand l’action sera invoquée.

Le deuxième exemple utilise la notation %% dont la valeur ne dépend pas d’un champ en particulier. Quand
l’action est invoquée, %% sera remplacé par la valeur du champ sélectionné dans les résultats de l’identification
ou dans la table d’attributs.

Utiliser des Actions

Les actions se lancent depuis la fenêtre Identifier les résultats, depuis la Table d’attributs ou depuis Exé-

cuter l’action de l’entité (rappelez-vous que ces fenêtres s’ouvrent en cliquant sur Identifier les entités,
Ouvrir la table d’attributs ou Exécuter l’action de l’entité). Pour lancer une action, faites un clic droit sur un enregistrement
et choisissez l’action depuis le menu qui apparaît. Les actions sont listées dans le menu par le nom que vous leur
avez donné en les définissant. Cliquez ensuite sur l’action que vous souhaitez lancer.

Si vous faites appel à une action qui utilise la notation %%, faites un clic droit sur la valeur du champ que vous
souhaitez passer à l’application ou au script, dans la fenêtre Identifier les résultats ou dans la Table attributaire.

Voici un autre exemple qui récupère des données d’une couche vecteur et qui les insère dans un fichier utilisant

bash et la commande echo (cela ne marchera que sur et peut-être ). La couche en question a des champs
pour le nom d’espèce taxon_name, la latitude lat et la longitude long. Nous souhaiterions faire une sélec-
tion spatiale de localisations et exporter les valeurs des enregistrements sélectionnés dans un fichier texte (ils
apparaissent en jaune sur la carte dans QGIS). Voici l’action qui permettra de le faire :

bash -c "echo \"%taxon_name %lat %long\" >> /tmp/species_localities.txt"
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Après avoir sélectionné quelques localités et lancé l’action sur chacune d’entre elles, le fichier de destination
ressemblera à ceci :

Acacia mearnsii -34.0800000000 150.0800000000
Acacia mearnsii -34.9000000000 150.1200000000
Acacia mearnsii -35.2200000000 149.9300000000
Acacia mearnsii -32.2700000000 150.4100000000

Comme exercice, nous allons créer une action qui réalise une recherche Google sur la couche lakes. Tout
d’abord, nous avons besoin de déterminer l’URL nécessaire pour effectuer une recherche sur un mot clé. Il suffit
simplement d’aller sur Google et faire une recherche simple puis récupérer l’URL dans la barre d’adresse de votre
navigateur. De cela, nous en déduisons la formulation : http://google.com/search?q=qgis, où qgis est le terme
recherché. À partir de tout cela, nous pouvons poursuivre :

1. Assurez-vous que la couche lakes est chargée.

2. Ouvrez la fenêtre Propriétés de la couche en double cliquant sur la couche dans la légende ou en faisant un
clic droit et en choisissant Propriétés dans le menu qui apparaît.

3. Cliquez sur l’onglet Actions

4. Entrez un nom pour l’action, par exemple Recherche Google.

5. Pour l’action, nous devons fournir le nom du programme externe à lancer. Dans ce cas, nous allons utiliser
Firefox. Si le programme n’est pas dans votre path, vous devez fournir le chemin complet.

6. A la suite du nom de l’application externe, ajoutez l’URL utilisée pour faire la recherche Google, jusqu’au
terme de recherche, mais sans l’ajouter : http://google.com/search?q=

7. Le texte dans le champ Action devrait ressembler à ceci : firefox
http://google.com/search?q=

8. Cliquez sur le menu déroulant contenant les noms des champs pour la couche lakes. Il est situé juste à
gauche du bouton [Insérer un champ].

9. Sélectionnez le champ ‘NAMES’ du menu déroulant et cliquez sur [Insérer un champ].

10. Votre texte Action ressemble maintenant à :

firefox http://google.com/search?q=%NAMES

11. Pour finaliser l’action, cliquez sur le bouton [Ajouter l’action à la liste].

L’action est donc entièrement définie et prête à être utilisée. Le texte final de l’action devrait correspondre à ça :

firefox http://google.com/search?q=%NAMES

Nous pouvons maintenant utiliser l’action. Fermez la fenêtre Propriétés de la couche et zoomez sur une zone
d’intérêt. Assurez-vous que la couche lakes est active puis identifiez un lac. Dans la fenêtre de résultats, vous
constatez que notre action est maintenant visible :

Quand vous cliquez sur l’action, cela ouvre Firefox et charge l’URL http://www.google.com/search?q=Tustumena.
Il est également possible d’ajouter d’autres champs attributs à l’action. Pour faire cela, vous pouvez ajouter un +
à la fin du texte de l’action, sélectionnez un autre champ et cliquez sur [Insérer un champ]. Dans cet exemple, la
recherche sur un autre champ n’aurait pas de sens.

Vous pouvez définir de multiples actions pour une couche et chacune apparaitra dans la fenêtre Identifier les
résultats.

Depuis la table attributaire, vous pouvez aussi faire appel à des actions via un simple clic droit sur une cellule et
sélection de l’action dans la fenêtre qui s’ouvre.

Vous pouvez imaginer toutes sortes d’utilisations pour ces actions. Par exemple, si vous avez une couche de
points contenant la localisation d’images ou de photos ainsi qu’un nom de fichier, vous pouvez créer une action
qui lancera un visualiseur pour afficher les images. Vous pouvez également utiliser les actions pour lancer des
rapports sur internet pour un champ attributaire ou une combinaison de champs, en les spécifiant de la même
manière que dans l’exemple d’une recherche Google.
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Figure 12.51: Sélection de l’entité et choix de l’action

Nous pouvons également fournir des exemples plus complexes, notamment sur la manière d’utiliser des actions
Python.

D’ordinaire, lorsque l’on crée une action pour ouvrir un fichier avec une application externe, on peut utiliser un
chemin absolu ou relatif. Dans ce dernier cas, le chemin dépend donc de l’emplacement du fichier d’exécution du
programme externe. Mais si nous souhaitons utiliser des chemins relatifs à la couche sélectionnée (stockée sous
forme de fichier comme un shapefile ou une base SpatiaLite) ? Le code suivant permet de le faire :

command = "firefox"
imagerelpath = "images_test/test_image.jpg"
layer = qgis.utils.iface.activeLayer()
import os.path
layerpath = layer.source() if layer.providerType() == ’ogr’

else (qgis.core.QgsDataSourceURI(layer.source()).database()
if layer.providerType() == ’spatialite’ else None)

path = os.path.dirname(str(layerpath))
image = os.path.join(path,imagerelpath)
import subprocess
subprocess.Popen( [command, image ] )

Il faut simplement se rappeler qu’il s’agit d’une action Python et qu’il faut modifier les variables command et
imagerelpath selon vos besoins.

Et si le chemin relatif doit dépendre du fichier de projet (sauvegardé) ? Le code de l’action Python deviendra :

command="firefox"
imagerelpath="images/test_image.jpg"
projectpath=qgis.core.QgsProject.instance().fileName()
import os.path
path=os.path.dirname(str(projectpath)) if projectpath != ’’ else None
image=os.path.join(path, imagerelpath)
import subprocess
subprocess.Popen( [command, image ] )

Un autre exemple d’action Python consiste à ajouter de nouvelles couche au projet. L’exemple qui suit montre
comment ajouter une couche vecteur et un raster. Les noms des fichiers à ajouter au projet et les noms à donner
aux couches dépendent de données attributaires (filename et layername sont deux champs de la table attributaire
de la couche sur laquelle l’action est créée) :

qgis.utils.iface.addVectorLayer(’/yourpath/[% "filename" %].shp’,
’[% "layername" %]’, ’ogr’)
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Pour ajouter un raster (ici une image TIF), cela devient :

qgis.utils.iface.addRasterLayer(’/yourpath/[% "filename" %].tif’,
’[% "layername" %]’)

12.3.8 Onglet Infobulles

Cet onglet est spécialement créé pour les Infobulles. Il inclut une fonctionnalité intéressante : les infobulles
qui affichent du texte en HTML. Alors que vous pouvez toujours choisir un Champ à afficher lors du survol
d’une entité sur la carte, il est maintenant possible d’insérer du code HTML qui crée un affichage complexe. Pour
activer les infobulles, sélectionnez l’option de menu Vue → Infobulles.

Les figures 1 et 2 montrent un exemple de code HTML et du rendu dans les infobulles.

Figure 12.52: Code HTML pour les infobulles

Figure 12.53: Infobulles basées sur du code HTML
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12.3.9 Onglet Rendu

QGIS gère la généralisation à la volée. Cela permet d’améliorer la vitesse d’affichage de nombreuses entités

complexes à large échelle. L’option peut être activée ou désactivée dans les propriétés des couches via la case
Simplifier la géométrie. Un paramètre global permet également d’activer la simplification par défaut au moment
du chargement de chaque couche (voir section Options).

Figure 12.54: Fenêtre de simplification de la géométrie d’une couche

Note: Feature generalisation may introduce artefacts into your rendered output in some cases. These may include
slivers between polygons and inaccurate rendering when using offset-based symbol layers.

While rendering extremely detailed layers (e.g. polygon layers with a huge number of nodes), this can cause
composer exports in PDF/SVG format to be huge as all nodes are included in the exported file. This can also make
the resultant file very slow to work with/open in other programs.

Checking Force layer to render as raster forces these layers to be rasterised so that the exported files won’t
have to include all the nodes contained in these layers and the rendering is therefore sped up.

You can also do this by forcing the composer to export as a raster, but that is an all-or-nothing solution, given that
the rasterisation is applied to all layers.

12.3.10 Onglet Métadonnées

Le menu Métadonnées comprend les sections Description, Attribution, URL Métadonnées, LegendURL et
Propriétés.

Dans la section Propriétés, vous disposez des informations générales sur la couche, y compris celles spécifiques
à son type, sa localisation, le nombre d’entités, le type d’entités et les possibilités d’édition. La table Emprise
fournit les informations sur l’emprise de la couche et le Système de Référence Spatiale de la Couche qui est une
information sur le SCR de la couche. Il s’agit d’un moyen rapide d’obtenir des informations utiles sur la couche.

Additionally, you can add or edit a title and abstract for the layer in the Description section. It’s also possible to
define a Keyword list here. These keyword lists can be used in a metadata catalogue. If you want to use a title
from an XML metadata file, you have to fill in a link in the DataUrl field.

Use Attribution to get attribute data from an XML metadata catalogue.

In MetadataUrl, you can define the general path to the XML metadata catalogue. This information will be saved
in the QGIS project file for subsequent sessions and will be used for QGIS server.
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In the LegendUrl section, you can provide the url of a legend image in the url field. You can use the Format
drop-down option to apply the appropriate format of the image. Currently png, jpg and jpeg image formats are
supported.

Figure 12.55: Onglet Métadonnées de la fenêtre de Propriétés d’une couche vecteur

12.3.11 Sauvegarder et Partager les propriétés d’une couche

Managing Custom Styles

When a layer is added to map canvas, QGIS uses by default a random symbol/color to render its features. You can
however set a default symbol in Project → Properties → Default styles that will be applied to each newly added
layer according to its geometry type.

But, most of the time, you’d prefer to have a custom and more complex style that can be applied automatically or
manually (with less efforts) to the layers. You can achieve this goal using the Style combobox at the bottom of the
Layer Properties dialog. This combobox provides you with functions to create, load and manage styles.

A style stores any information set in the layer properties dialog to render or interact with the features (including
symbology, labeling, action, diagram... settings).

By default, the style applied to a loaded layer is named default. Once you have got the ideal and appropriate

rendering for your layer, you can save it by clicking the Style combobox and choose:

• Rename Current: The active style gets renamed and updated with the current options

• Add: A new style is created using the current options.

At the bottom of the Style drop-down list, you see the styles set for the layer and the active one is checked. Once
you have more than one style defined for a layer, a Remove Current option can help you delete those you no
longer want.

Note that each time you validate the layer properties dialog, the active style is updated with the changes you’ve
done.
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Figure 12.56: Style combobox options

You can create as many styles as you wish for a layer but only one can be active at a time. Combined to layer
visibility preset, this offers a quick and powerful way to manage complex projects with few layers (no need to
duplicate any layer in the map legend).

Astuce: Manage styles from layer context menu
Right-click on the layer in Layers Panel to add, rename or remove layer style. You can also edit feature symbols.

Storing Style in a File or a Database

While these styles are saved inside the project and can be copied and pasted from layer to layer in the project,
it’s also possible to save them outside the project so that they can be loaded in another project. Clicking the

Style → Save Style saves the symbol as a QGIS layer style file (.qml) or SLD file (.sld). SLDs can be
exported from any type of renderer – single symbol, categorized, graduated or rule-based – but when importing
an SLD, either a single symbol or rule-based renderer is created. That means that categorized or graduated styles
are converted to rule-based. If you want to preserve those renderers, you have to stick to the QML format. On the
other hand, it can be very handy sometimes to have this easy way of converting styles to rule-based.

If the datasource of the layer is a database (PostGIS or Spatialite for example), you can also save your layer style
inside a table of the database. Just click on Save Style combobox and choose Save in database item then fill in the
dialog to define a style name, add a description, an ui file if applicable and check if the style is the default style.
You can add several style in the database. However each table can have only one default style.

When loading a layer in QGIS, if a default style already exists for this layer, QGIS will load the layer and its style.
After you modified the layer style, you can Save as Default, creating a new style that becomes the default one or
Restore Default style if you’re not satisfied.

Astuce: Quickly share a layer style within the project
You can also share layer style within a project without importing a file or database style: right-click on the layer
in the Layers Panel and, from the Styles combobox , copy the style of a layer and paste it to a group or a selection
of layers: the style is applied to all the layers that are of the same type (vector vs raster) as the original layer and,
in case of vector, have the same geometry type (point, line or polygon).
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Figure 12.57: Fenêtre d’enregistrement d’un style dans une base de données

12.4 Expressions

The Expressions feature is available from many parts in QGIS. It can be accessed using the Expression Builder, the
Select By Expression..., the Geometry generator symbol layer option, the Field calculator or the Data defined override

tool. Based on layer data and prebuilt or user defined functions, it offers a powerful way to manipulate attribute
value, geometry and variables in order to dynamically change the geometry style, the content or position of the
label, the value for diagram, the height of a composer item, select some features, create virtual field ...

Quelques exemples :

• From Field Calculator, calculate a “pop_density” field using existing “total_pop” and “area_km2” fields:

"total_pop" / "area_km2"

• Update the field “density_level” with categories according to the “pop_density” values:

CASE WHEN "pop_density" < 50 THEN ’Low population density’
WHEN "pop_density" >= 50 and "pop_density" < 150 THEN ’Medium population density’
WHEN "pop_density" >= 150 THEN ’High population density’

END

• Apply a categorized style to all the features according to whether their average house price is smaller or
higher than 10000C per square metre:

"price_m2" > 10000

• Using the “Select By Expression...” tool, select all the features representing areas of “High population
density” and whose average house price is higher than 10000C per square metre:

"density_level" = ’High population density’ and "price_m2" > 10000

Likewise, the previous expression could also be used to define which features should be labeled or shown in the
map. Using expressions offers you a lot of possibilities.

The Expressions feature offers access to the:

• Expression tab which lists functions to use

• Function Editor tab which helps to create custom functions to use in the expressions.

12.4.1 Liste de fonctions

The Expression tab contains functions as well as layer’s fields and values. It contains widgets to:
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Figure 12.58: The Expression tab

• type expressions using functions and/or fields. A preview of the expression’s result is displayed at the
bottom of the dialog.

• select the appropriate function among a list. A search box is available to filter the list and quickly find a
particular function or field. Double-clicking on the item’s name adds it to the expression being written.

• display help for each function selected. When a field is selected, this widget shows a sample of its values.
Double-clicking a value adds it to the expression.

To help to quickly find a function, they are organized in groups. In Operators, you find mathematical operators.
Look in Math for mathematical functions. The Conversions group contains functions that convert one data type
to another. The String group provides functions for data strings, such as Date and Time handles date and time
data. In the Geometry group, you find functions for geometry objects. With Record group functions, you can add
a numeration to your data set while Fields and Values group helps view all attributes of the attribute table. The
Customs group lists the functions created or imported by the user. There are many other groups, listed below.

Opérateurs

This group contains operators (e.g., +, -, *). Note that for most of the mathematical functions below, if one of the
inputs is NULL then the result is NULL.
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Fonction Description
a + b Addition de deux valeurs (a plus b)
a - b Soustraction de deux valeurs (a moins b)
a * b Multiplication de deux valeurs ( a multiplié par b)
a / b Division de deux valeurs ( a divisé par b)
a % b Reste de la division de a par b (par ex. 7 % 2 = 1 car 2 est présent trois fois dans 7 et il

reste 1)
a ^ b Puissance de deux valeurs (par ex. 2^2=4 ou 2^3=8)
a < b Compare deux valeurs et renvoie 1 si la valeur de gauche est moins grande que la valeur

de droite (a inférieur à b)
a <= b Compare deux valeurs et renvoie 1 si la valeur de gauche est moins grande ou égale à la

valeur de droite
a <> b Compare deux valeurs et renvoie 1 si elle ne sont pas égales
a = b Compare deux valeurs et renvoie 1 si elles sont égales
a != b Compare deux valeurs et renvoie 1 si elle ne sont pas égales
a > b Compare deux valeurs et renvoie 1 si la valeur de gauche est plus grande que la valeur de

droite (a supérieur à b)
a >= b Compare deux valeurs et renvoie 1 si la valeur de gauche est plus grande ou égale à la

valeur de droite
a ~ b Teste si a correspond à l’expression régulière b
|| Fusionne deux valeurs ensemble dans une chaîne de caractères. Si l’une des valeurs vaut

NULL, le résultat sera NULL.
‘\n’ Insert un retour à la ligne dans une chaîne de caractère
LIKE Renvoie 1 si le premier paramètre correspond au motif défini
ILIKE Renvoie 1 si le premier paramètre correspond au motif fourni de manière non sensible à

la casse (ILIKE peut être utilisé à la place d’LIKE pour rendre la correspondance
sensible à la casse)

a IS b Teste si deux valeurs sont identiques. Renvoie 1 si a est identique à b
a OR b Renvoie 1 lorsque la condition a ou b est vraie
a AND b Renvoie 1 lorsque la condition a et b est vraie
NOT Inverse une condition
nom de colonne
“nom de colonne”

Valeur de la colonne “nom de la colonne”. Attention à ne pas confondre avec les
guillemets simples, voir ci-dessous

‘texte’ Une chaîne de caractère. Attention à ne pas confondre avec les guillemets doubles, voir
ci-dessus

NULL valeur nulle
a IS NULL a n’a pas de valeur
a IS NOT NULL a a une valeur
a IN
(valeur[,valeur])

a fait partie des valeurs listées

a NOT IN
(valeur[,valeur])

a ne fait pas partie des valeurs listées

Quelques exemples :

• Joint une chaîne et une valeur depuis un nom de colonne:

’My feature’’s id is: ’ || "gid"

• Teste si la “description” du champ d’attribut commence avec la chaîne ‘Hello’ dans la valeur (notez la
position du caractère %):

"description" LIKE ’Hello%’

Conditions

Ce groupe contient des fonctions permettant de gérer des conditions dans les expressions.
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Fonction Description
CASE WHEN ... THEN
... END

Évalue une expression et renvoie un résultat si vrai. Vous pouvez tester
plusieurs conditions

CASE WHEN ... THEN
... ELSE ... END

Évalue une expression et renvoie un résultat différent selon qu’elle est vraie ou
fausse. Vous pouvez tester plusieurs conditions

coalesce Renvoie la première valeur non NULL de la liste en expression.
if Teste une condition et renvoie un résultat selon la condition de vérification
regexp_match Renvoie vrai si n’importe quelle partie d’une chaîne de caractères correspond à

l’expression rationnelle fournie

Quelques exemples:

• Envoie une valeur en retour si la première condition est vraie, sinon une autre valeur:

CASE WHEN "software" LIKE ’%QGIS%’ THEN ’QGIS’ ELSE ’Other’ END

Fonctions mathématiques

Ce groupe contient des fonctions mathématiques (par ex. racine carré, sin et cos).

Fonc-
tion

Description

abs Renvoie la valeur absolue d’un nombre
acos Renvoie le cosinus inverse d’une valeur en radians
asin Renvoie le sinus inverse d’une valeur en radians
atan Renvoie le cosinus inverse d’une valeur en radians
atan2(y,x) Renvoie la tangente inverse de y/x en utilisant les signes des deux arguments pour déterminer le

quadrant du résultat
az-
imuth(a,b)

Renvoie l’azimut par rapport au nord sous forme d’angle en radians mesuré dans le sens des
aiguilles d’une montre à partir de la verticale entre le point a et le point b.

ceil Arrondi un nombre vers le haut
clamp Restreint une valeur d’entrée à une plage spécifique
cos Renvoie le cosinus d’une valeur en radians
degrees Convertit des angles en radians vers des degrés
exp Renvoie l’exponentiel d’une valeur
floor Arrondit un nombre vers le bas
ln Renvoie la valeur du logarithme népérien de l’expression en argument
log Renvoie la valeur du logarithme selon la valeur et la base en arguments
log10 Renvoie la valeur du logarithme en base 10 de l’expression en argument
max Renvoie la valeur la plus haute d’un ensemble de valeurs
min Renvoie la valeur la plus faible d’un ensemble de valeurs
pi Renvoie la valeur de Pi pour utilisation dans d’autres calculs
radians Convertit des angles en degrés vers des radians
rand Renvoie un entier aléatoire selon la plage spécifiée entre les valeurs minimale et maximale

(inclusives)
randf Renvoie un nombre décimal aléatoire selon la plage spécifiée entres les valeurs minimale et

maximale (inclusives)
round Arrondi au nombre de décimales indiqué
scale_exp Transforme une valeur donnée d’un domaine d’entrée à une plage de sortie en utilisant une courbe

exponentielle
scale_linearTransforme une valeur donnée d’un domaine d’entrée à une plage de sortie en utilisant une

interpolation linéaire
sin Renvoie le sinus d’un angle
sqrt Renvoie la racine carrée d’une valeur
tan Renvoie la tangente d’un angle
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Fonctions de Couleur

Ce groupe contient des fonctions pour manipuler les couleurs.

Fonction Description
color_cmyk Renvoie une chaîne de caractères représentant une couleur basée sur ses composantes cyan,

magenta, jaune et noire
color_cmykaRenvoie une chaîne de caractères représentant une couleur basée sur ses composantes cyan,

magenta, jaune et noire et alpha (transparence)
color_hsl Renvoie une chaîne de caractères représentant une couleur basée sur ses attributs de teinte, de

saturation et de luminosité
color_hsla Renvoie une chaîne de caractères représentant une couleur basée sur ses attributs de teinte, de

saturation, de luminosité et alpha (transparence).
color_hsv Renvoie une chaîne de caractères représentant une couleur basée sur ses attributs de teinte, de

saturation et de valeur
color_hsva Renvoie une chaîne de caractères représentant une couleur basée sur ses attributs de teinte, de

saturation, de valeur et alpha (transparence)
color_part Renvoie une composante spécifique d’une chaîne de caractères de couleur, ex: la composante

rouge ou la composante alpha
color_rgb Renvoie une chaîne de caractères représentant une couleur basée sur ses composantes rouge,

verte, bleue
color_rgba Renvoie une chaîne de caractères représentant une couleur basée sur ses composantes rouge,

verte, bleue et sur la valeur alpha (transparence)
darker Renvoie une chaîne de caractères de couleur plus sombre (ou plus claire)
lighter Renvoie une chaîne de caractères de couleur plus claire (ou plus sombre)
project_colorRenvoie une couleur du jeu de couleurs du projet
ramp_color Renvoie une chaîne de caractères représentant la couleur d’une rampe de couleur
set_color_partDéfinit une composante spécifique d’une chaîne de caractères de couleur, ex: la composante

rouge ou la composante alpha

Conversions

Ce groupe contient des fonctions pour convertir un type de données en un autre (par ex. chaîne à entier, entier à
chaîne).

Fonc-
tion

Description

to_date Convertit une chaîne de caractère en objet date
to_datetimeConvertit une chaîne de caractères en objet de date et de temps
to_int Convertit une chaîne de caractères en nombre entier
to_interval Convertit une chaîne de caractère en objet d’intervalle de temps (peut être utilisée pour récupérer

les jours, heures, mois, etc. d’une date)
to_real Convertit une chaîne de caractères en nombre réel
to_string Convertit un nombre en chaîne de caractères
to_time Convertit une chaîne de caractères en objet de temps

Fonctions personnalisées

This group contains functions created by the user. See function_editor for more details.

Fonctions de Date et Heure

Ce groupe contient des fonctions permettant de gérer des données de date et d’heure.
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Fonction Description
age Returns as an interval the difference between two dates or datetimes
day Extrait le jour d’une date, ou d’un objet datetime, ou un nombre de jours depuis un intervalle
day_of_week Returns a number corresponding to the day of the week for a specified date or datetime
hour Extrait l’heure à partir d’une valeur de temps ou de date et de temps ou extrait e nombre

d’heures dans un intervalle
minute Extrait les minutes composant un temps ou une date ainsi que le nombre de minutes dans un

intervalle
month Extracts the month part from a date or datetime, or the number of months from an interval
now() Renvoie la date et le temps actuels
second Extrait les secondes d’un temps ou d’une date et d’un temps ou extrait le nombre de secondes

dans un intervalle
week Extracts the week number from a date or datetime, or the number of weeks from an interval
year Extracts the year part from a date or datetime, or the number of years from an interval

Quelques exemples:

• Obtenir le mois et l’année d’aujourd’hui dans le format “10/2014”

month(now()) || ’/’ || year(now())

Champs et Valeurs

Contains a list of fields from the layer.

Generally, you can use the various fields, values and functions to construct the calculation expression, or you can
just type it into the box.

To display the values of a field, you just click on the appropriate field and choose between Load top 10 unique
values and Load all unique values. On the right side, the Field Values list opens with the unique values. At the
top of the list, a search box helps filtering the values. To add a value to the expression you are writing, double
click its name in the list.

Sample values can also be accessed via right-click. Select the field name from the list, then right-click to access a
context menu with options to load sample values from the selected field.

Fields name should be double-quoted in the expression. Values or string should be simple-quoted.

Fuzzy Matching Functions

Ce groupe contient des fonctions destinées à réaliser des comparaisons floues entre les valeurs.

Fonction Description
ham-
ming_distance

Returns the number of characters at corresponding positions within the input strings where
the characters are different

levensheim Returns the minimum number of character edits (insertions, deletions or substitutions)
required to change one string to another. Measure the similarity between two strings

longest_common_substringReturns the longest common substring between two strings
soundex Returns the Soundex representation of a string

Fonctions Générales

Ce groupe contient des fonctions génériques.
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Fonc-
tion

Description

eval Évalue une expression passée en chaîne de caractères. Cette fonction est utilisée pour produire les
paramètres dynamiques tels que les variables de contexte ou les champs

layer_propertyReturns a property of a layer or a value of its metadata. It can be layer name, crs, geometry type,
feature count...

var Renvoie la valeur stockée dans une variable. Voir les fonctions “Variables” plus bas.

Fonctions de Géométrie

Ce groupe contient des fonctions qui opèrent sur des objets géométriques (par ex. longueur, aire).

Fonction Description
$area Renvoie la surface de l’entité courante
$geometry Renvoie la géométrie de l’entité courante (peut être utilisée en combinaison avec d’autres fonctions)
$length Renvoie la longueur de l’entité courante
$perimeter Renvoie le périmètre de l’entité actuelle
$x Renvoie la coordonnée x de l’entité actuelle
$x_at(n) Returns the x coordinate of the nth node of the current feature’s geometry
$y Renvoie la coordonnée y de l’entité courante
$y_at(n) Returns the y coordinate of the nth node of the current feature’s geometry
area Returns the area of a geometry polygon feature. Calculations are in the Spatial Reference System of this geometry
bounds Renvoie une géométrie représentant l’emprise d’une géométrie en entrée. Les calculs sont effectués dans le Système Spatial de Référence de cette géométrie.
bounds_height Renvoie la hauteur de l’emprise d’une géométrie. Les calculs sont effectués dans le Système Spatial de Référence de cette géométrie.
bounds_width Renvoie la largeur de l’emprise d’une géométrie. Les calculs sont effectués dans le Système Spatial de Référence de cette géométrie.
buffer Renvoie une géométrie qui représente l’ensemble des points dont la distance est inférieure ou égale à la distance avec une géométrie en entrée. Les calculs sont effectués dans le Système Spatial de Référence de cette géométrie
centroid Renvoie le centre géométrique d’une géométrie
closest_point Renvoie le point d’une géométrie qui est le plus proche d’une deuxième géométrie
combine Renvoie la combinaison de deux géométries
contains(a,b) Returns 1 (true) if and only if no points of b lie in the exterior of a, and at least one point of the interior of b lies in the interior of a
convex_hull Returns the convex hull of a geometry (this represents the minimum convex geometry that encloses all geometries within the set)
crosses Returns 1 (true) if the supplied geometries have some, but not all, interior points in common
difference(a,b) Renvoie une géométrie qui représente la partie de la géométrie a qui ne s’intersecte pas avec la géométrie b
disjoint Returns 1 (true) if the geometries do not share any space together
distance Renvoie la distance minimale (basée sur le référentiel spatial) entre deux géométries dans les unités de la projection
end_point Renvoie le dernier nœud d’une géométrie
exterior_ring Renvoie une ligne représentant l’anneau extérieur d’une géométrie de polygone. Si la géométrie n’est pas un polygone alors le resultat sera NULL
extrude(geom,x,y) Renvoie une version extrudée d’une géométrie (Multi-)Courbe ou d’une (Multi-)Polyligne avec une extension indiquée par x et y
geom_from_gml Renvoie une géométrie créée à partir d’une représentation géométrique GML
geom_from_wkt Renvoie une géométrie créée à partir d’une représentation well-known text (WKT)
geom_to_wkt Renvoie la représentation well-known text (WKT) d’une géométrie sans les métadonnées de SRID
geometry Renvoie la géométrie d’une entité
geometry_n Returns the nth geometry from a geometry collection, or null if the input geometry is not a collection
interior_ring_n Returns the geometry of the nth interior ring from a polygon geometry, or null if the geometry is not a polygon
intersection Renvoie une géométrie qui représente la portion commune de deux géométries
intersects Tests whether a geometry intersects another. Returns 1 (true) if the geometries spatially intersect (share any portion of space) and 0 if they don’t
intersects_bbox Tests whether a geometry’s bounding box overlaps another geometry’s bounding box. Returns 1 (true) if the geometries spatially intersect (share any portion of space) their bounding box and 0 if they don’t
is_closed Returns true if a line string is closed (start and end points are coincident), false if a line string is not closed and null if the geometry is not a line string
length Returns length of a line geometry feature (or length of a string)
m Renvoie la valeur m d’une géométrie de type point
make_line Créé une géométrie linéaire à partir d’une série de géométries ponctuelles
make_point(x,y,z,m) Returns a point geometry from x and y values (and optional z and m values)
make_point_m(x,y,m) Returns a point geometry from x and y coordinates and m values
make_polygon Créé une géométrie polygonale à partir d’un anneau externe et de séries optionnelles de géométries d’anneaux internes
nodes_to_points Renvoie une géométrie multi-point composée de chaque nœud de la géométrie en entrée
num_geometries Renvoie le nombre de géométries dans une collection de géométrie ou NULL si la géométrie en entrée n’est pas une collection

Suite sur la page suivante
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Table 12.1 – Suite de la page précédente
Fonction Description
num_interior_rings Renvoie le nombre d’anneaux intérieurs dans un polygone ou dans une collection de géométrie ou NULL si la géométrie en entrée n’est pas un polygone ou une collection
num_points Renvoie le nombre de sommets d’une géométrie
num_rings Renvoie le nombre d’anneaux (incluant les anneaux extérieurs) d’un polygone ou d’une collection de géométrie ou bien NULL si la géométrie en entrée n’est pas un polygone ou une collection
order_parts Ré-arrange les parties d’une géométrie multiple selon le critère donné
overlaps Tests whether a geometry overlaps another. Returns 1 (true) if the geometries share space, are of the same dimension, but are not completely contained by each other
perimeter Returns the perimeter of a geometry polygon feature. Calculations are in the Spatial Reference System of this geometry
point_n Renvoie un nœud donné d’une géométrie
point_on_surface Renvoie un point qui est certainement situé à la surface d’une géométrie
relate Tests or returns the Dimensional Extended 9 Intersection Model (DE-9IM) representation of the relationship between two geometries
reverse Inverse la direction d’une géométrie linéaire en inversant l’ordre de ses sommets
segments_to_lines Renvoie une géométrie multi-ligne composée d’une ligne pour chaque segment de la géométrie en entrée
shortest_line Renvoie la plus courte ligne joignant deux géométries. La ligne résultante commencera sur la géométrie 1 et se terminera sur la géométrie 2
start_point Renvoie le premier nœud d’une géométrie
sym_difference Renvoie une géométrie qui représente les portions non superposées de deux géométries
touches Teste si deux géométries se touchent. Renvoie 1 (vrai) si les géométries ont au moins un point en commun mais que leurs surfaces intérieures ne s’intersectent pas
transform Renvoie la géométrie transformée d’un SCR source vers un SCR cible
translate Renvoie une version translatée d’une géométrie. Les calculs sont effectués dans le Système Spatial de Référence de cette géométrie
union Renvoie une géométrie qui représente l’ensemble de points unis des géométries
within (a,b) Teste si une géométrie est située complètement à l’intérieur d’une autre. Renvoie 1 (vrai) si la géométrie a est contenue complètement dans la géométrie b
x Renvoie la coordonnée x d’une géométrie ponctuelle ou la coordonnée x du centroïde d’une géométrie non ponctuelle
x_min Returns the minimum x coordinate of a geometry. Calculations are in the Spatial Reference System of this geometry
x_max Returns the maximum x coordinate of a geometry. Calculations are in the Spatial Reference System of this geometry
y Renvoie la coordonnée y d’une géométrie ponctuelle ou la coordonnée y du centroïde d’une géométrie non ponctuelle
y_min Returns the minimum y coordinate of a geometry. Calculations are in the Spatial Reference System of this geometry
y_max Returns the maximum y coordinate of a geometry. Calculations are in the Spatial Reference System of this geometry
z Renvoie la coordonnée z d’une géométrie de type point

Quelques exemples :

• Return the x coordinate of the current feature’s centroid:

x($geometry)

• Send back a value according to feature’s area:

CASE WHEN $area > 10 000 THEN ’Larger’ ELSE ’Smaller’ END

Fonctions d’Enregistrement

Ce groupe contient des fonctions qui permettent d’accéder aux identifiants des enregistrements.

Fonc-
tion

Description

$cur-
rentfea-
ture

Renvoie l’entité courante évaluée. Cette fonction peut être utilisée en combinaison avec la
fonction ‘attribute’ pour renvoyer les valeurs d’attribut de l’entité courante.

$id Renvoie l’identifiant de l’entité de la ligne actuelle
$map Renvoie l’identifiant de l’élément actuel de la carte si la carte a été dessinée grâce à un

arrangement, ou « canevas » si la carte a été dessinée à l’intérieur de la fenêtre principale de QGIS
$rownum Renvoie le numéro de la ligne actuelle
$scale Returns the current scale of the map canvas
attribute Renvoie la valeur d’un attribut spécifique d’une entité.
get_feature Renvoie la première entité d’une couche qui correspond à la valeur d’un attribut donné.
uuid Generates a Universally Unique Identifier (UUID) for each row. Each UUID is 38 characters long

Quelques exemples :
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• Return the first feature in layer “LayerA” whose field “id” has the same value as the field “name” of the
current feature (a kind of jointure):

get_feature( ’layerA’, ’id’, attribute( $currentfeature, ’name’) )

• Calculate the area of the joined feature from the previous example:

area( geometry( get_feature( ’layerA’, ’id’, attribute( $currentfeature, ’name’) ) ) )

Fonctions de Chaîne

Ce groupe contient des fonctions qui opèrent sur des chaînes (par ex. qui remplace, convertit en majuscule).

Fonction Description
concat Concatenates several strings to one
format Formats a string using supplied arguments
for-
mat_date

Formats a date type or string into a custom string format

for-
mat_number

Returns a number formatted with the locale separator for thousands (also truncates the number to
the number of supplied places)

left(string,
n)

Renvoie un extrait de chaîne de caractères contenant les n caractères les plus à gauche de la
chaîne initiale

length Returns length of a string (or length of a line geometry feature)
lower converts a string to lower case
lpad Returns a string with supplied width padded using the fill character
reg-
exp_replace

Renvoie une chaîne de caractères en utilisant une expression rationnelle de substitution

reg-
exp_substr

Renvoie la portion d’une chaîne de caractères qui correspond à une expression rationnelle fournie

replace Returns a string with the supplied string replaced
right(string,
n)

Returns a substring that contains the n rightmost characters of the string

rpad Returns a string with supplied width padded using the fill character
strpos Returns the index of a regular expression in a string
substr Renvoie une partie de chaîne de caractères
title Convertit l’ensemble des mots d’une chaîne de caractères en casse de titre (tous les mots sont en

minuscule sauf la première lettre du mot qui est en majuscule)
trim Removes all leading and trailing white space (spaces, tabs, etc.) from a string
upper Converts string a to upper case
word-
wrap

Renvoie une chaîne de caractères découpée par les caractères espace, selon un nombre minimum
ou maximum de caractères

Fonctions récentes

This group contains recently used functions. Any expression used in the Expression dialog is added to the list,
sorted from the more recent to the less one. This helps to quickly retrieve any previous expression.

Variables Functions

This group contains dynamic variables related to the application, the project file and other settings. It means that
some functions may not be available according to the context:

• from the Select by expression dialog

• from the Field calculator dialog

• from the layer properties dialog
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• from the print composer

To use these functions in an expression, they should be preceded by @ character (e.g, @row_number). Are
concerned:

Fonction Description
atlas_feature Returns the current atlas feature (as feature object)
atlas_featureid Returns the current atlas feature ID
atlas_featurenumber Returns the number of pages in composition
atlas_filename Returns the current atlas file name
atlas_geometry Returns the current atlas feature geometry
atlas_pagename Returns the current atlas page name
atlas_totalfeatures Returns the total number of features in atlas
grid_axis Returns the current grid annotation axis (eg, ‘x’ for longitude, ‘y’ for latitude)
grid_number Returns the current grid annotation value
item_id Returns the composer item user ID (not necessarily unique)
item_uuid Returns the composer item unique ID
layer_id Returns the ID of current layer
layer_name Returns the name of current layer
layout_dpi Returns the composition resolution (DPI)
layout_numpages Returns the number of pages in the composition
layout_pageheight Returns the composition height in mm
layout_pagewidth Returns the composition width in mm
map_id Returns the ID of current map destination. This will be ‘canvas’ for canvas renders, and the item ID for composer map renders
map_extent_center Returns the point feature at the center of the map
map_extent_height Returns the current height of the map
map_extent_width Returns the current width of the map
map_rotation Returns the current rotation of the map
map_scale Returns the current scale of the map
project_filename Renvoie le nom du fichier du projet actuel
project_folder Renvoie le nom du répertoire du projet actuel
project_path Renvoie le chemin complet (incluant le nom de fichier) du projet actuel
project_title Renvoie le titre du projet actuel
qgis_os_name Renvoie le nom du système d’exploitation : ‘windows’, ‘linux’ ou ‘osx’
qgis_platform Renvoie la plate-forme QGIS : ‘desktop’ ou ‘server’
qgis_release_name Renvoie le nom de la version de QGiS utilisée
qgis_version Renvoie la chaîne de caractère de la version de QGIS utilisée
qgis_version_no Renvoie le numéro de version de QGIS utilisé
symbol_angle Returns the angle of the symbol used to render the feature (valid for marker symbols only)
symbol_color Returns the color of the symbol used to render the feature
user_account_name Returns the current user’s operating system account name
user_full_name Returns the current user’s operating system user name
row_number Stores the number of the current row

12.4.2 Éditeur de fonction

Avec l’Éditeur de fonction vous êtes en mesure de définir vos propres fonctions Python de manière confortable.

L’éditeur de fonction créera les nouveaux fichiers Python dans le répertoire .qgis2\python\expressions
et chargera automatiquement toutes les fonctions définies au démarrage de QGIS. Soyez conscients que les nou-
velles fonctions sont seulement sauvegardées dans le répertoire expressions et non dans le fichier du projet.
Si vous avez un projet qui utilise une de vos fonctions personnalisées vous aurez besoin de partager le fichier .py
dans le répertoire expressions.

Voici un court exemple de comment créer vos propres fonctions :

@qgsfunction(args="auto", group=’Custom’)
def myfunc(value1, value2, feature, parent):

pass
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Figure 12.59: L’onglet Éditeur de fonction

Ce court exemple crée la fonction ‘myfunc’ qui vous donnera une fonction avec deux valeurs. Quand vous utilisez
l’argument de fonction args=’auto’ le nombre d’arguments de la fonction requis sera calculé selon le nombre
d’arguments définis en Python (moins 2 - feature, et parent).

Cette fonction peut être utilisée avec l’expression suivante :

myfunc(’test1’, ’test2’)

Votre fonction sera implémentée dans le groupe de fonctions Custom de l’onglet Expression après l’utilisation du
bouton Lancer le script.

Plus d’informations sur la création de code Python peuvent être trouvées dans PyQGIS-Developer-Cookbook.

L’éditeur de fonction ne se limite pas à la calculatrice de champ, il est disponible à chaque fois que vous travaillez
avec des expressions.

12.5 Travailler avec la table d’attributs

La Table attributaire affiche les entités de la couche sélectionnée. Chaque ligne représente une entité avec ses
attributs répartis dans plusieurs colonnes. Chaque entité de la table peut être recherchée, sélectionnée, déplacée et
éditée.

Pour ouvrir la table attributaire d’une couche vectoriel, activez la couche en cliquant dessus depuis la zone de

légende de la carte. Puis dans le menu Couche, cliquez sur Ouvrir la table d’attributs. Vous pouvez aussi y

accéder avec un clic droit sur la couche puis en sélectionnant Ouvrir la table d’attributs ou en cliquant sur le

bouton Ouvrir la table d’attributs dans la barre d’outils des Attributs.

Cela ouvrira une nouvelle fenêtre qui affiche les attributs de toutes les entités de la couche (voir fig-
ure_attributes_1). Le nombre des entités et le nombre d’entités sélectionnées sont affichés dans la barre de titre de
la table d’attributs.

Les boutons situés au-dessus de la table d’attributs apportent les fonctionnalités suivantes :

• Activer le mode d’édition pour permettre d’activer les fonctions d’édition (ou Ctrl+E)

• Enregistrer les modifications (ou Ctrl+S)
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Figure 12.60: Table d’attributs de la couche ‘regions’

• Recharger la table

• Ajouter une entité

• Supprimer les entités sélectionnées (ou Ctrl+D)

• Sélection les entités en utilisant une expression

• Tout sélectionner (ou Ctrl+a)

• Inverser la sélection (ou Ctrl+r)

• Tout désélectionner (ou Ctrl+u)

• Déplacer la sélection au sommet (ou Ctrl+t)

• Déplacer la carte sur les lignes sélectionnées (ou Ctrl+P)

• Zoomer la carte sur les lignes sélectionnées (ou Ctrl+J)

• Copier les lignes sélectionnées dans le presse papier (ou Ctrl+C)

• Coller à partir du presse-papier (ou Ctrl+v)

• Supprimer le champ pour les couches PostGIS et les couches gérées par OGR GDAL version >= 1.9 (ou
Ctrl+L)

• Ajouter un champ pour les couches PostGIS et les couches gérées par OGR GDAL version >= 1.6 (ou
Ctrl+W)

• Ouvrir la calculatrice de champs (ou Ctrl+I)

Sous la table se trouve la barre de Champs Calculés qui permet d’effectuer des calculs qui s’appliquent rapidement

aux attributs visibles dans la table. Cette barre utilise les mêmes expressions que dans la Calculatrice de Champs

(consultez Calculatrice de champ).

Astuce: Éviter d’exporter la géométrie WKT
Si vous souhaitez utiliser les données attributaires dans un programme externe (comme Excel), utilisez le bouton

Copier les lignes sélectionnées dans le presse-papier. Vous pouvez copier les données sans la géométrie si vous désactivez
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l’option Copier la représentation WKT de la géométrie depuis la table attributaire du menu Préférences →
Options → onglet Sources de données .

12.5.1 Sélectionner une entité depuis la table

Chaque ligne sélectionnée dans la table d’attributs correspond aux attributs d’une entité sélectionnée de la couche.
Si la sélection est modifiée sur la carte, elle est également mise à jour dans la table d’attributs. De la même manière,
une modification de la sélection dans la table est automatiquement répercutée sur la carte.

Les lignes peuvent être sélectionnées en cliquant sur le numéro de ligne placé tout à gauche. Plusieurs lignes
peuvent être sélectionnées en maintenant la touche Ctrl. Une sélection continue s’effectue en gardant appuyée
la touche Shift et en cliquant sur une nouvelle ligne, toutes les lignes entre la première sélection et la dernière
seront sélectionnées. Déplacer la position du curseur dans la table d’attributs en cliquant sur une cellule ne modifie
pas la sélection des lignes. Modifier les entités sélectionnées depuis la carte ne modifie pas la position du curseur
dans la table.

Vous pouvez faire un tri sur les colonnes en cliquant sur l’en-tête. Une petite flèche indique l’ordre de tri (une
flèche pointant vers le bas indiquera un tri décroissant, une flèche vers le haut, un tri croissant).

Pour une simple recherche par attributs sur une seule colonne, choisissez Filtre de colonne → du menu dans
le coin inférieur gauche. Sélectionnez le champ (colonne) à partir duquel la recherche doit être effectuée dans le
menu déroulant et appuyez sur le bouton [Appliquer]. Seules les entités correspondantes sont affichées dans la
table attributaire.

Pour effectuer une sélection, vous devez utiliser l’icône Sélectionner les entités en utilisant une expression en haut de la table
d’attributs. Cet outil vous permet de définir un sous-ensemble de votre table en utilisant une Liste de fonctions

identiques à celles de la Calculatrice de champ (voir Calculatrice de champ). Le résultat de la requête peut ensuite
être sauvegardée comme une nouvelle couche vecteur. Par exemple, si vous souhaitez trouver les régions qui sont
des ‘borough’ dans la couche regions.shp des fichiers test de QGIS, vous devez déplier le menu Champs et
Valeurs et choisir le champ que vous souhaitez interroger. Double-cliquez donc sur le champ ‘TYPE_2’ puis sur
‘=’ et cliquez sur [Charger toutes les valeurs uniques]. Dans la liste qui apparaît, choisissez et double-cliquez
sur ‘Borough’. Dans le champ Expression apparaît alors la requête suivante :

"TYPE_2" = ’Borough’

Vous pouvez également utiliser l’entrée Liste des fonctions → Récent (Sélection) pour réutiliser une sélection faite
précédemment. Les 20 dernières expressions sont proposées.

Les lignes correspondantes seront sélectionnées et le nombre total de ces lignes apparaît dans la barre de titre de
la table d’attributs, et dans la barre d’état de la fenêtre principale. Pour des recherches qui s’appliquent seulement
aux entités sélectionnées dans la carte, utilisez le constructeur de requête décrit dans la section Constructeur de
requête.

Pour n’afficher que les lignes sélectionnées, utilisez Ne montrer que les entités sélectionnées du menu situé dans
le coin inférieur gauche. Voir la prochaine section pour en savoir plus sur le filtrage des entités.

La zone de saisie de la calculatrice de champs vous permet d’effectuer des calculs uniquement sur les entités
sélectionnées. Par exemple, vous pouvez modifier le nombre d’un champ ID du fichier regions.shp avec cette
expression

ID+5

comme montré dans la figure_attributes_1 .

12.5.2 Filtrer les entités

En bas de la table attributaire, vous disposez d’une liste déroulante qui contient différents filtres :

• Montrer toutes les entités ;
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• Ne montrer que les entités sélectionnées ;

• Ne montrer que les entités visibles sur la carte ;

• Ne montrer que les entités nouvelles ou éditées ;

• Filtre de champ ;

• Filtre avancé (expression) ;

Les quatre premiers sont assez explicites, les deux derniers sont des filtres basés sur une expression. Le Filtre de
champ permet à l’utilisateur de choisir un nom de champ dans la liste, ce qui ajoute un formulaire sur la droite
qui permet de rentrer un paramètre de filtre sur ce champ, évalué par l’opérateur like. Ce filtre va générer une
expression tel un Filtre avancé. Cliquer sur le dernier type de filtre ouvre une fenêtre pour écrire une expression,
voir Expressions pour plus d’information.

12.5.3 Affichage tabulaire/formulaire

Par défaut la fenêtre affiche la table attributaire sous forme tabulaire. Dans certains cas, il est préférable d’utiliser
un affichage formulaire pour modifier certaines entités plus facilement.

Vous pouvez passer à la vue formulaire en cliquant en bas à droite, sur et revenir à la vue tabulaire avec .

12.5.4 Zoom sur l’entité

Pour zoomer sur une entité, sans avoir à la sélectionner, cliquez-droit sur l’entité que vous souhaitez voir, dans la
table d’attribut, et sélectionnez Zoomer sur l’entité.

12.5.5 Enregistrer les entités sélectionnées dans une nouvelle couche

Les entités sélectionnées peuvent être sauvegardées dans n’importe quel format géré par OGR et également trans-
formées dans n’importe quel système de projection (SCR). Ouvrez simplement le menu clic-droit de la souris sur
la couche et cliquez sur Enregistrer sous pour définir un nom de fichier de sortie, son format et son SCR (consultez

la section Le panneau Couches). Pour enregistrer la sélection, assurez-vous que l’option N’enregistrer que les
entités sélectionnées est cochée. Il est également possible de définir des options de création OGR dans la boîte de
dialogue.

12.5.6 Coller dans une nouvelle couche

Les entités qui ont été copiées peuvent être collées dans une nouvelle couche. Pour faire cela, passer la couche
en mode édition. Sélectionnez quelques entités, copiez-les puis collez-les dans une nouvelle couche via Éditer →
Coller les entités comme puis Nouvelle couche vecteur ou Nouvelle couche vecteur en mémoire.

Ceci fonctionne avec les entités sélectionnées et copiées depuis QGIS mais également avec les entités au format
well-known text (WKT) provenant d’un autre logiciel.

12.5.7 Editer les valeurs d’attributs

Le bouton Ouvrir la calculatrice de champs de la table d’attributs permet d’opérer des calculs sur la base des valeurs
attributaires ou d’utiliser des fonctions, par exemple pour calculer la longueur ou la surface des entités. Les
résultats peuvent être écrits dans une nouvelle colonne attributaire, un champ virtuel ou mettre à jour une colonne
existante.

Un Champ virtuel est un champ basé sur une expression et calculé à la volée, c’est-à-dire que sa valeur est mise
à jour automatiquement dès que l’un des paramètres utilisés dans l’expression change. L’expression est définie
une fois pour toute, il n’est donc pas nécessaire de recalculer le champ à chaque fois qu’un paramètre change.
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Par exemple, vous pouvez utiliser un champ virtuel pour calculer la superficie des entités qui viennent d’être
numérisées ou pour calculer automatiquement un intervalle de temps entre des dates qui changent (par ex. en
utilisant la fonction now()).

Note: Utilisation des Champs Virtuels
• Les champs virtuels ne sont pas des attributs permanents, ils ne sont sauvegardés et disponibles que dans le

projet dans lequel ils ont été créés.

• Un champ est défini comme virtuel uniquement à sa création et l’expression utilisée pour le générer ne peut
pas être modifiée par la suite : pour le faire, vous devez supprimer et recréer le champ.

La calculatrice de champ fonctionne avec toutes les couches qui gèrent le mode édition. Lorsque vous cliquez
sur le bouton de la calculatrice de champ, la fenêtre s’ouvre (voir figure_attributes_2). Si la couche n’est pas en
mode édition, un avertissement s’affiche et l’utilisation de la calculatrice de champ basculera automatiquement la
couche en édition avant d’effectuer le calcul.

La barre de calcul de champ n’est visible que si la couche est en mode édition.

Dans la barre de calcul de champ, vous sélectionnez d’abord le champ à éditer puis ouvrez le calculateur
d’expressions pour saisir l’expression ou écrivez directement dans le champ de saisie et enfin cliquez sur le bouton
[Tout mettre à jour], [Mettre à jour la sélection] ou [Mise à jour filtrée] selon votre besoin.

Calculatrice de champ

Basé sur le Constructeur d’expression, la Calculatrice de champ propose une interface complète de création
d’expression pour l’appliquer à un champ existant ou à créer. Pour utiliser cette calculatrice de champ, vous
devez tout d’abord choisir si vous voulez mettre à jour uniquement une éventuelle sélection, créer un nouveau
champ où les résultats de l’expression seront enregistrés ou mettre à jour un champ existant.

Si vous choisissez d’ajouter un nouveau champ, vous devez lui donner un nom, un type (nombre entier, nombre
décimal ou chaîne de caractère), une longueur et sa précision (voir figure_attributes_2). Par exemple, si vous créez
un champ d’une longueur de 10 et doté d’une précision de 3, vous aurez 6 chiffres avant la virgule, la virgule et 3
chiffres après.

L’exemple suivant montre comment la calculatrice de champs fonctionne. Il s’agit de calculer la longueur en km
de la couche railroads issue de l’échantillon de données QGIS.

1. Chargez le fichier shapefile railroads.shp dans QGIS et ouvrez sa Table d’Attributs.

2. Cliquez sur Basculer en mode édition et ouvrez la Calculatrice de champs.

3. Cochez la case Créer un nouveau champ pour enregistrer le résultat des calculs dans un nouveau champ.

4. Ajoutez longueur dans le nom de ce champ, réel en tant que type et définissez une longueur de 10 et
une précision de 3.

5. Double-cliquez maintenant sur la fonction $length de la catégorie Géometrie pour l’ajouter à la zone
d’Expression.

6. Terminez en rentrant ‘/ 1000’ à la fin de l’expression et en cliquant sur le bouton [Ok].

7. Vous pouvez maintenant voir la nouvelle colonne longueur dans la table d’attributs.

12.5.8 Travailler avec tables non-spatialisées

QGIS vous permet de charger des tables n’ayant pas d’information spatiale, cela comprend les tables supportées
par OGR, les fichiers de texte délimité et les tables PostgreSQL, MSSQL et Oracle. Les tables peuvent être
utilisées pour regarder les champs, pour des requêtes ou pour de l’édition. Lorsque vous chargez une table de ce

type, elle apparaîtra dans la liste des couches, elle peut être ouverte avec l’outil Ouvrir la table d’attributs. Elle est
ensuite éditable comme n’importe qu’elle autre table attributaire.
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Figure 12.61: Calculatrice de champ
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Par exemple vous pouvez utiliser ces colonnes pour définir des valeurs d’attributs ou un intervalle de valeurs qui
sont autorisées à être ajoutées à une couche vectorielle spécifique durant une numérisation. Jetez un œil du côté
de l’outil d’édition pour en savoir plus, section Onglet Champs.

12.5.9 Mise en forme conditionnelle des cellules de la table d’attrbuits

Vous pouvez afficher le panneau de Mise en forme conditionnelle en cliquant sur en haut à droite de la fenêtre
de la table d’attributs en vue tabulaire (bouton non disponible en vue formulaire).

Ce nouveau panneau permet à l’utilisateur d’ajouter des règles pour la mise en forme de champs ou de lignes
complètes en fonction d’une expression. Ajouter une nouvelle règle ouvre un formulaire pour définir :

• le nom de la règle,

• la condition basée sur une expression,

• un formatage prédéfini,

• quelques autres paramètres pour améliorer, modifier ou définir le formatage :

– couleurs d’arrière-plan et du texte,

– utilisation d’une Icône,

– texte en gras, italique, souligné ou barré,

– texte,

– police.

Figure 12.62: Mise en forme conditionnelle des cellules de la table d’attrbuits

12.5.10 Créer des relations un à plusieurs

Utiliser des relations est courant dans les bases de données. L’idée est que des entités (lignes) de différentes
couches (tables) peuvent être liées les unes aux autres.

Comme exemple, nous prendrons une couche contenant toutes les régions de l’Alaska (des polygones) qui fournit
quelques attributs sur le nom, le type de région et un identifiant unique (qui jouera le rôle de clé primaire).
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Clés étrangères

Nous prenons ensuite une autre couche de point ou une table contenant des informations sur les aéroports localisés
dans les régions. Si vous souhaitez accéder, depuis la couche des régions, vous devez créer une relation ‘un à
plusieurs’, en utilisant des clés étrangères, car il y a plusieurs aéroports dans la plupart des régions.

Figure 12.63: Les régions d’Alaska contenant des aéroports

En plus des attributs existants dans la table des aéroports, un autre champ, fk_region, va jouer le rôle de clé
étrangère (si la table est stockée dans une base de données, vous allez sans doute définir une contrainte sur ce
champ).

Ce champ fk_region contiendra toujours un identifiant de région. Il peut être vu comme un pointeur vers la région
à laquelle l’aéroport appartient. Et vous pouvez créer un formulaire personnalisé d’édition pour la saisie. Cela
fonctionne avec différents fournisseurs (vous pouvez vous en servir également avec des shapefiles ou des fichiers
csv) et la seule chose que vous avez à faire est de dire à QGIS qu’il y a une relation entre les tables.

Couches

QGIS ne fait pas la différence entre une table et une couche vectorielle. Une couche vectorielle correspond
simplement à une table associée à une géométrie. Vous pouvez donc ajouter une table comme s’il s’agissait d’une
couche vectorielle. Vous pouvez tester en chargeant le shapefile ‘region’ (avec géométrie), la table csv ‘airports’
(sans géométrie mais avec la clé étrangère (fk_region)). Chaque aéroport appartient à une région et chaque région
peut contenir plusieurs aéroports (une relation un à plusieurs typique).

Définir (Gestionnaire de Relations)

La première chose que nous allons faire est de dire à QGIS qu’il y a une relation entre nos couches et tables.
Cela se fait dans le menu Projet → Propriétés du projet. Allez dans l’onglet Relations et cliquez sur Ajouter une
relation.

• Nom sera utilisé comme titre. Il s’agit d’un texte lisible décrivant la relation. Ici, nous allons simplement
mettre “Aéroports”.

• Couche référençante (enfant) est la couche contenant la clé étrangère. Dans notre cas il s’agit de la couche
des aéroports.

• Champ référençant correspond au champ qui pointe vers l’autre couche, le champ fk_region dans notre
cas.

• Couche de référence (parent) est la couche contenant la clé primaire. Ici il s’agit de la couche des régions.
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• Champ de référence est le champ contenant la clé primaire dans la couche de référence, le champ ID dans
notre cas.

• Id est utilisé pour des besoins internes et doit être unique. Ce sera utilisé lors de la création de formulaires
d’édition personnalisés. Si vous laissez ce champ vide, un numéro sera généré automatiquement mais vous
pouvez en assigner un si vous le souhaitez.

Figure 12.64: Gestionnaire de Relations

Formulaires

Maintenant que QGIS a bien généré la relation, le formulaire d’édition va être amélioré. Nous n’avons pas mod-
ifié le formulaire d’édition par défaut (généré automatiquement), une nouvelle zone va simplement être ajoutée
au formulaire. Sélectionnez la couche de régions dans la légende et utilisez l’outil d’identification. Selon vos
préférences, le formulaire s’ouvre directement ou vous devez le faire via la zone d’identification qui s’affiche.

Figure 12.65: Formulaire de la couche des régions affichant la relations avec les aéroports

Comme vous pouvez le voir, les aéroports présents dans la région sont tous affichés dans la table. Quelques
boutons sont également disponibles, voyons ce qu’ils font.

12.5. Travailler avec la table d’attributs 161



QGIS User Guide, Version 2.14

• Le bouton permet de passer en mode édition. Soyez conscients qu’il active le mode édition de la couche
des aéroports bien qu’il soit situé dans le formulaire de la couche des régions. La table affiche bien les entités
de la couche des aéroports.

• Le bouton permet d’ajouter une nouvelle entité à la couche des aéroports. Par défaut, il attribut la région
identifiée à ce nouvel aéroport.

• Le bouton supprime un aéroport sélectionné de manière permanente.

• Le bouton ouvre une nouvelle fenêtre où vous pouvez sélectionner des aéroports existants et qui seront
ensuite attribués à la région identifiée. Ceci est pratique lorsque vous assignez par erreur la mauvaise région
à un aéroport.

• Le bouton permet de supprimer le lien entre l’aéroport sélectionné et la région identifiée, le laissant non
assigné (la clé étrangère devient alors NULL).

• Les deux boutons à droite basculent entre la vue table et la vue formulaire, ce dernier permettant d’afficher
tous les aéroports dans leur formulaire respectif.

Si vous travaillez sur la table des aéroports, un nouvel élément apparaît qui vous permet d’inclure le formulaire de
la région à laquelle un aéroport est lié. Il s’active via les propriétés de la couche aéroports dans l’onglet Champs
en changeant l’outil d’édition du champ contenant la clé étrangère, ‘fk_region’, et en le définissant à ‘Valeur
relationnelle’.

Vous devriez ainsi voir que le formulaire de la région est inclus dans celui d’un aéroport et il vous permet de
modifier la région assignée à l’aéroport.

Figure 12.66: Formulaire d’identification d’un aéroport et de sa région associée

12.6 Éditer

QGIS dispose d’un support étendu de l’édition de données provenant de couches vectorielles et tables OGR,
SpatiaLite, PostGIS, MSSQL Spatial et Oracle Spatial.

Note: La procédure pour éditer des couches GRASS est différente - voir section Numérisation et édition de
couche vectorielle GRASS pour plus de détails.

Astuce: Éditions simultanées
Cette version de QGIS ne vérifie pas si quelqu’un d’autre est en train d’éditer une entité en même temps que vous,
la dernière personne qui enregistre sa modification gagne !
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12.6.1 Définir le rayon de tolérance d’accrochage et de recherche

For an optimal and accurate edit of the vector layer geometries, we need to set an appropriate value of snapping
tolerance and search radius for features vertices.

Tolérance d’accrochage

La tolérance d’accrochage est la distance que QGIS utilise pour chercher le sommet et/ou le segment le plus
près que vous souhaitez connecter lorsque vous créez un nouveau sommet ou en déplacez un existant. Si vous
n’êtes pas dans la tolérance d’accrochage, QGIS va laisser le vertex à l’endroit où vous lâchez le bouton de la
souris, au lieu de l’accrocher à un sommet ou un segment existant. Les paramètres de tolérance d’accrochage
affectent tous les outils qui utilisent cette tolérance.

1. A general, project-wide snapping tolerance can be defined by choosing Settings → Options..., Digitizing
tab. You can select between ‘To vertex’, ‘To segment’ or ‘To vertex and segment’ as default snap mode.
You can also define a default snapping tolerance and a search radius for vertex edits. The tolerance can be
set either in map units or in pixels. The advantage of choosing pixels is that the snapping tolerance doesn’t
have to be changed after zoom operations. In our small digitizing project (working with the Alaska dataset),
we define the snapping units in feet. Your results may vary, but something on the order of 300 ft at a scale
of 1:10000 should be a reasonable setting.

2. A layer-based snapping tolerance that overrides the global snapping options can be defined by choosing
Settings → Snapping options. It enables and adjusts snapping mode and tolerance on a layer basis (see
figure_edit_1 ). This dialog offers three different modes to select the layer(s) to snap to:

• Current layer: only the active layer is used, a convenient way to ensure topology within the layer being
edited

• All layers: a quick and simple setting for all visible layers in the project so that the pointer snaps to all
vertices and/or segments. In most cases it is sufficient to use this snapping mode.

• Advanced: if you need to edit a layer and snap its vertices to another layer, ensure the target layer
is checked and increase the snapping tolerance to a greater value. Furthermore, snapping will never
occur to a layer that is not checked in the snapping options dialog, regardless of the global snapping
tolerance. So be sure to mark the checkbox for those layers that you need to snap to.

Figure 12.67: Modification des options d’accrochage sur une couche (mode avancé)

Astuce: Control the list of layers to snap
The Snapping Options dialog is by default populated with parameters (mode, tolerance, units) set in the global
Digitizing tab. To avoid layers being checked by default in the Advanced mode and hence set snappable, define
the Default Snap mode to Off.

Snapping tolerance can be set in pixels or map units (the units of the map view). While in the Advanced
layer selection mode, it is possible to use a snapping tolerance that refers to layer units, the units of the
reprojected layer when ‘on-the-fly’ CRS transformation is on.
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Rayon de recherche

Search radius is the distance QGIS uses to search for the closest vertex you are trying to select when you click
on the map. If you aren’t within the search radius, QGIS won’t find and select any vertex for editing. Snap
tolerance and search radius are set in map units or pixels, so you may find you need to experiment to get them set
right. If you specify too big of a tolerance, QGIS may snap to the wrong vertex, especially if you are dealing with
a large number of vertices in close proximity. Set search radius too small, and it won’t find anything to move.

Le rayon de recherche pour l’édition des sommets dans l’unité de la couche peut être défini dans l’onglet Numéri-
sation du menu Préférences → Options. Au même endroit que vous définissez la tolérance d’accrochage pour
tout le projet.

12.6.2 Édition topologique

Besides layer-based snapping options, you can also define topological functionalities in the Snapping options...

dialog in the Settings (or File) menu. Here, you can define Enable topological editing, and/or for polygon

layers, activate the Avoid Intersections option.

Activer l’édition topologique

The option Enable topological editing is for editing and maintaining common boundaries in features mosaics.
QGIS ‘detects’ shared boundary by the features, so you only have to move a common vertex/segment once, and
QGIS will take care of updating the neighboring features.

Éviter les intersections de nouveaux polygones

A second topological option called Avoid intersections prevents you to draw new features that overlap an
existing one. It is for quicker digitizing of adjacent polygons. If you already have one polygon, it is possible
with this option to digitize the second one such that both intersect, and QGIS then cuts the second polygon to
the boundary of the existing one. The advantage is that you don’t have to digitize all vertices of the common
boundary.

Note: If the new geometry is totally covered by existing ones, it gets cleared and the new feature will have no
geometry when allowed by the provider, otherwise saving modifications will make QGIS pop-up an error message.

Warning: Use cautiously the Avoid Intersections option
Because the option cuts or clears geometry of any overlaping feature from any polygon layer, do not forget to
uncheck this option once you no longer need it otherwise, you can get unexpected geometries.

Activer l’accrochage sur les intersections

Une autre possibilité est de cocher Activer l’accrochage sur les intersections. Cela vous permet d’accrocher
les nouveaux nœuds sur une intersection entre les autres couches, même s’il n’y a pas de nœud à cette intersection.

Vérificateur de géométrie

A core plugin can help the user to find the geometry invalidity. You can find more information on this plugin at
Extension Vérificateur de géométrie.
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12.6.3 Numériser une couche existante

Par défaut, QGIS charge les couches en lecture seule : c’est une sécurité pour éviter d’éditer accidentellement une
couche si la souris glisse. Cependant, vous pouvez choisir d’éditer une couche du moment que le fournisseur de
données le gère et que la source de données est éditable (c’est-à-dire. fichiers qui ne sont pas en lecture seule).

L’édition des couches vectorielles est répartie dans les barres d’outils de numérisation et de numérisation avancée
telles que décrites dans la section Numérisation avancée. Vous pouvez afficher les deux depuis le menu Vue→
Barres d’Outils →. En utilisant les outils de numérisation basiques, vous pouvez accomplir les actions suivantes :

Bouton Fonction Bouton Fonction

Éditions en cours Basculer en mode édition

Ajouter une entité : Créer un point Ajouter une entité : Créer une Ligne

Ajouter une entité : Créer un polygone Déplacer l’entité

Ajoute une polyligne courbe Ajoute une polyligne courbe par rayon

Outil de noeud Supprimer les entités sélectionnées

Couper les entités Copier les entités

Coller les entités Enregistrer les modifications de la couche

Tableau Numérisation : barre d’outils basiques de numérisation pour les couches vectorielles

Note that while using any of the digitizing tools, you can still zoom or pan in the map canvas without losing the
focus on the tool.

All editing sessions start by choosing the Toggle editing option found in the context menu of a given layer, from
the attribute table dialog, the digitizing toolbar or the Edit menu.

Once the layer is in edit mode, additional tool buttons on the editing toolbar will become available and markers
will appear at the vertices of all features unless Show markers only for selected features option under Settings →
Options... → Digitizing menu is checked.

Astuce: Sauvegardez régulièrement

N’oubliez pas d’ Enregistrer les modifications de la couche régulièrement. Cette action vérifiera aussi que les modifica-
tions apportées peuvent être intégrées dans votre source de données.

Ajouter des entités

You can use the Add Feature, Add Feature or Add Feature icons on the toolbar to add new feature (point, line
and polygon) into the current layer.

The next buttons Add circular string or Add circular string by radius allow users to add line or polygon features with a
circular geometry.

To create features with these tools, you first digitize the geometry then enter its attributes. To digitize the geometry,
left-click on the map area to create the first point of your new feature.

For linear or curved geometries, keep on left-clicking for each additional point you wish to capture or use au-
tomatic tracing capability to accelerate the digitization. You can switch back and forth between linear Add fea-
ture tool and curved Add circular string... tools to create compound curved geometry. Pressing Delete or
Backspace key reverts the last node you add. When you have finished adding points, right-click anywhere on
the map area to confirm you have finished entering the geometry of that feature.

Note: Curved geometries are stored as such only in compatible data provider
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Although QGIS allows to digitize curved geometries within any editable data format, you need to be using a data
provider (e.g. PostGIS, GML or WFS) that supports curves to have features stored as curved, otherwise QGIS
segmentizes the circular arcs. The memory layer provider also supports curves.

Astuce: Customize the digitizing rubber band
While capturing polygon, the by-default red rubber band can hide underlying features or places you’d like to
capture a point. This can be fixed by setting a lower opacity (or alpha channel) to the rubber band’s Fill Color in
Settings → Options → Digitizing menu. You can also avoid the use of the rubber band by checking Don’t update
rubber band during node editing.

The attribute window will appear, allowing you to enter the information for the new feature. Figure_edit_2 shows
setting attributes for a fictitious new river in Alaska. However, in the Digitizing menu under the Settings →
Options menu, you can also activate:

• Supprimer les fenêtres d’avertissements lors de la création de chaque entité pour éviter leurs apparitions

• or Reuse last entered attribute values to have fields automatically filled at the opening of the form and
just have to type changing values.

Figure 12.68: Fenêtre de saisie des attributs après avoir numérisé une nouvelle entité vecteur

Avec le bouton Déplacer l’entité, vous pouvez déplacer des entités existantes.

Outil de noeud

For shapefile-based or MapInfo layers as well as SpatiaLite, PostgreSQL/PostGIS, MSSQL Spatial, and Oracle

Spatial tables, the Node Tool provides manipulation capabilities of feature vertices similar to CAD programs. It
is possible to simply select multiple vertices at once and to move, add or delete them altogether. The node tool
also works with ‘on the fly’ projection turned on and supports the topological editing feature. This tool is, unlike
other tools in QGIS, persistent, so when some operation is done, selection stays active for this feature and tool.

It is important to set the property Settings → Options → Digitizing → Search Radius: to a number
greater than zero. Otherwise, QGIS will not be able to tell which vertex is being edited and will display a warning.

Astuce: Marqueurs de sommets
La version actuelle de QGIS propose trois types de marqueurs - un ‘Cercle semi-transparent’, une ‘Croix’ ou
‘Aucun’. Pour changer de style de marqueurs, allez dans Options depuis le menu Préférences et cliquez sur
l’onget Numérisation et sélectionnez le symbole voulu dans la liste déroulante.
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Opérations basiques

Commencez par cliquer sur le bouton Outil de nœud puis sélectionnez une entité. Des petits carrés rouges appa-
raissent sur chaque sommet de cette entité, cela indique qu’elle est bien sélectionnée.

• Sélectionner des sommets : La sélection se fait en cliquant directement sur un sommet, sur un segment
pour en sélectionner les deux extrémités ou en dessinant un rectangle autour de quelques sommets. Quand
un sommet est sélectionné, sa couleur devient bleue. Pour ajouter des sommet à une sélection, maintenez
appuyée la touche Ctrl et continuez la sélection. Maintenez Ctrl appuyé en cliquant pour inverser l’état
sélectionné ou désélectionné des sommets (les sommets non sélectionnés le deviendront et ceux qui l’étaient
seront désélectionnés).

• Ajouter des sommets : Pour ajouter un sommet, double-cliquez simplement sur un segment, un nouveau
sommet apparaîtra sur le segment proche du curseur. Notez que le sommet est créé sur le segment et pas
forcément exactement à l’emplacement du curseur, il est donc peut-être nécessaire de le déplacer.

• Deleting vertices: Select the vertices and click the Delete key. Deleting all the vertices of a feature
generates, if compatible with the datasource, a geometryless feature. Note that this doesn’t delete the

complete feature, just the geometry part; To delete a complete feature use the Delete Selected tool.

• Déplacer des sommets : Sélectionnez tous les sommets que vous voulez déplacer (en cliquant sur un
sommet ou un segment), puis déplacez votre souris en maintenant le bouton appuyé. Tous les sommets
bougeront dans la même direction que le curseur. Si l’accrochage est activé, la sélection complète peut
sauter sur la ligne ou le sommet le plus proche du curseur.

Chaque changement effectué avec l’outil de nœud correspond à une entrée séparée du bouton Annuler. Rappelez-
vous que toutes les manipulations supportent l’édition topologique, si elle est activée. La projection à la volée est
également supportée. Enfin, l’outil de nœud affiche une info-bulle au passage de la souris sur un sommet afin de
l’identifier.

Astuce: Move features with precision

The Move Feature tool doesn’t currently allow to snap features while moving. Using the Node Tool, select
ALL the vertices of the feature, click a vertex, drag and snap it to a target vertex: the whole feature is moved and
snapped to the other feature.

L’Éditeur de sommet

With activating the Node Tool on a feature, QGIS opens the Vertex Editor panel listing all the vertices of the
feature with their x, y (z, m if applicable) coordinates and r (for the radius, in case of circular geometry). Simply
select a row in the table does select the corresponding vertex in the map canvas, and vice versa. Simply change
a coordinate in the table and your vertex position is updated. You can also select multiple rows and delete them
altogether.

Couper, Copier et Coller des entités

Les entités sélectionnées peuvent être coupées, copiées et collées entre des couches d’un même projet QGIS, du

moment que les couches de destination sont Basculées en mode édition au préalable.

Astuce: Transform polygon into line and vice-versa using copy/paste
Copy a line feature and paste it in a polygon layer: QGIS pastes in the target layer a polygon whose boundary
corresponds to the closed geometry of the line feature. This is a quick way to generate different geometries of the
same data.
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Figure 12.69: Vertex editor panel showing selected nodes

Features can also be pasted to external applications as text. That is, the features are represented in CSV format,
with the geometry data appearing in the OGC Well-Known Text (WKT) format. WKT features from outside QGIS
can also be pasted to a layer within QGIS.

When would the copy and paste function come in handy? Well, it turns out that you can edit more than one layer
at a time and copy/paste features between layers. Why would we want to do this? Say we need to do some work
on a new layer but only need one or two lakes, not the 5,000 on our big_lakes layer. We can create a new layer
and use copy/paste to plop the needed lakes into it.

Comme exemple, nous allons copier quelques lacs dans une nouvelle couche :

1. Chargez la couche dont vous voulez copier des entités (couche source)

2. Chargez ou créez la couche sur laquelle vous voulez coller des entités (couche cible)

3. Lancez l’édition pour la couche cible

4. Assurez-vous que la couche source est active en cliquant dessus dans la légende

5. Use the Select Features by area or single click tool to select the feature(s) on the source layer

6. Cliquez sur l’outil Copier les entités

7. Assurez-vous que la couche cible est active en cliquant dessus dans la légende

8. Cliquez sur l’outil Coller les entités

9. Stoppez l’édition et sauvegardez les changements

Qu’arrive-t-il si les couches sources et cibles ont différents schémas de données (noms et type des champs dif-
férents) ? QGIS remplit ceux qui correspondent et ignore les autres. Si la copie des attributs ne vous intéresse pas,
la façon dont vous définissez les champs et les types de données n’a pas d’importance. Si vous voulez être sûr que
tout - l’entité et ses attributs - soit copié, assurez-vous que les schémas de données correspondent.

Note: Conformité des entités copiées
Si vos couches source et cible utilisent la même projection, les entités collées auront la même géométrie que
dans la couche source. Cependant, si la couche cible n’a pas la même projection, QGIS ne peut garantir que les
géométries seront identiques. Cela est simplement dû aux erreurs d’arrondissement faites lors de la conversion de
projection.

Astuce: Copier une chaîne d’attribut dans une autre
Si vous avez créé une nouvelle colonne dans votre table attributaire avec un type ‘chaîne’ et que vous souhaitez
copier les valeurs d’une autre colonne d’attribut qui a une longueur plus grande que la taille de la colonne, celle-ci
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sera étendue à la même longueur. Ceci est possible parce que le pilote GDAL Shapefile à partir de GDAL/OGR
1.10 sait auto-étendre des champs de type chaîne et entier pour s’adapter dynamiquement à la longueur des don-
nées insérées.

Supprimer les entités sélectionnées

If we want to delete an entire feature (attribute and geometry), we can do that by first selecting the geometry using

the regular Select Features by area or single click tool. Selection can also be done from the attribute table. Once you

have the selection set, press Delete or Backspace key or use the Delete Selected tool to delete the features.
Multiple selected features can be deleted at once.

L’outil Couper les entités de la barre d’outils numérisation peut également être utilisé pour supprimer des entités.
Ceci supprime effectivement les entités et les place également dans un “presse-papier spatial”. Donc nous coupons

les entités pour les supprimer et nous pouvons ensuite utiliser l’outil Coller les entités pour les récupérer, nous
donnant alors la capacité d’annuler une fois les changements. Couper, copier et coller fonctionnent sur les entités
sélectionnées ce qui signifie que nous pouvons travailler sur plus d’un objet à la fois.

Sauvegarder les couches éditées

Quand une couche est en mode édition, tous les changements sont stockés en mémoire par QGIS. Ils ne sont pas
sauvegardés immédiatement dans la source de données ou sur le disque. Si vous voulez enregistrer les modifica-

tions sans quitter le mode d’édition, il faut cliquer sur le bouton Enregistrer les modifications de la couche. Lorsque vous

déactivez le mode édition en cliquant sur Basculer en mode édition (ou en fermant QGIS), il vous est demandé si
vous souhaitez sauvegarder les changements ou les annuler.

Si les changements ne peuvent pas être sauvés (par exemple à cause d’un disque plein ou des valeurs d’attributs
dépassant la plage prévue), l’état de la mémoire de QGIS est préservé. Cela vous permet d’ajuster vos éditions et
réessayer.

Astuce: Intégrité des données
Il est toujours bon de sauvegarder vos données sources avant de les éditer. Bien que les auteurs de QGIS s’efforcent
de préserver l’intégrité de vos données, il n’y pas de garantie à cet égard.

Saving multiple layers at once

Cette fonctionnalité permet la numérisation simultanée de plusieurs couches. Choisissez Enregistrer les
couches sélectionnées pour enregistrer toutes les modifications apportées dans plusieurs couches en même temps.

Vous avez aussi la possibilité de Retourner à l’étape précédente sur la couche sélectionnée afin d’annuler la
numérisation effectuée sur toutes les couches sélectionnées. Si vous souhaitez arrêter la modification des couches

sélectionnées, l’option Annuler sur la couche sélectionnée est le moyen le plus facile.

Les mêmes fonctions sont disponibles pour l’édition de toutes les couches du projet.

12.6. Éditer 169



QGIS User Guide, Version 2.14

12.6.4 Numérisation avancée

Bouton Fonction Bouton Fonction

Enable Advanced Digitizing Tools Enable Tracing

Annuler Refaire

Pivoter l’entité Simplifier l’entité

Ajouter un anneau Ajouter une partie

Remplir l’anneau Effacer un anneau

Effacer une partie Remodeler les entités

Décalage X,Y Séparer les entités

Séparer les parties Fusionner les entités sélectionnées

Fusionner les attributs des entités sélectionnées Rotation des symboles de point

Tableau Numérisation avancée : barre d’outils de numérisation avancée pour les couches vectorielles

Annuler et refaire

Les outils Annuler et Refaire vous permettent d’annuler ou revenir sur un certain nombre d’opérations sur les
données vectorielles. La vue de base est une fenêtre où toutes les opérations sont répertoriées (voir Figure_edit_4).
Cette fenêtre n’est pas affichée par défaut, mais peut être affichée par un clic droit sur une barre d’outils puis en
cochant Annuler/Refaire. L’outil est actif même quand la fenêtre n’est pas visible.

Figure 12.70: Outils Annuler et Refaire

Quand vous cliquez sur Annuler ou Ctrl+z (ou Cmd+z), l’état de toutes les entités et de leurs attributs retourne
à l’état connu avant que l’opération annulée ait été appliquée. Les changements autres que les modifications
classiques des vecteurs (par exemple des modifications effectuées par une extension) peuvent être ou ne pas être
annulés, selon la manière dont ils ont été effectués.

Pour utiliser l’historique Annuler/Refaire, cliquez simplement sur une opération dans la liste de l’historique.
Toutes les entités retrouveront leur état antérieur à cette opération.

Pivoter l’entité

Utilisez Pivoter l’entité pour pivoter une ou plusieurs entités de la carte. Cliquez sur le bouton Pivoter l’entité puis
cliquez sur l’entité à pivoter. Soit cliquez sur la carte pour placer l’entité pivotée ou entrer un angle de rotation
dans le gadget de saisie de l’utilisateur. Si vous souhaitez pivoter plusieurs entités, il faut les sélectionner au
préalable.
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Si vous activez l’outil avec des entités sélectionnées, son ou leur centroïde apparaît et sera le point d’ancrage pour
la rotation. Si vous souhaitez déplacer ce point d’ancrage, appuyer sur la touche Ctrl et cliquez sur la carte pour
le positionner.

Si vous appuyez sur la touche Shift avant de cliquer sur la carte, la rotation appliquée suivra un pas de 45 degrés,
ce qui peut être modifié par la suite dans le gadget de saisie de l’utilisateur.

To abort feature rotation, you need to click on Rotate Feature(s) icon.

Simplifier l’entité

The Simplify Feature tool allows you to reduce the number of vertices of a feature, as long as the geometry
remains valid. With the tool you can also simplify many features at once or multi-part features.

First, click on the feature or drag a rectangle over the features. A dialog where you can define a tolerance in map
units, layer units or pixels pops up and a colored and simplified copy of the feature(s), using the given
tolerance, appears over them. QGIS calculates the amount of vertices that can be deleted while maintaining the
geometry. The higher the tolerance is the more vertices can be deleted. When the expected geometry fits your
needs just click the [OK] button. The tolerance you used will be saved when leaving a project or when leaving an
edit session. So you can go back to the same tolerance the next time when simplifying a feature.

To abort feature simplification, you need to click on Simplify Feature icon.

Note: unlike the feature simplification option in Settings → Options → Rendering menu which simplifies the

geometry just for rendering, the Simplify Feature tool really modifies feature’s geometry in data source.

Ajouter une partie

You can Add Part to a selected feature generating a multipoint, multiline or multipolygon feature. The new part
must be digitized outside the existing one which should be selected beforehand.

The Add Part can also be used to add a geometry to a geometryless feature. First, select the feature in the
attribute table and digitize the new geometry with the Add Part tool.

Effacer une partie

The Delete Part tool allows you to delete parts from multifeatures (e.g., to delete polygons from a multi-polygon
feature). This tool works with all multi-part geometries: point, line and polygon. Furthermore, it can be used to
totally remove the geometric component of a feature. To delete a part, simply click within the target part.

Ajouter un anneau

Vous pouvez créer des polygones à trou en utilisant l’icône Ajouter un anneau. Cela signifie qu’il est possible
de dessiner des polygones à l’intérieur d’une zone existante et d’en faire des trous, seule la zone entre les limites
externes des polygones sera conservée.
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Remplir l’anneau

You can use the Fill Ring function to add a ring to a polygon and add a new feature to the layer at the same time.

Using this tool, you simply have to digitize a polygon within an existing one. Thus you need not first use the
Add Ring icon and then the Add feature function anymore.

Effacer un anneau

The Delete Ring tool allows you to delete rings within an existing polygon, by clicking inside the hole. This
tool only works with polygon and multi-polygon features. It doesn’t change anything when it is used on the outer
ring of the polygon.

Remodeler les entités

Il est possible de retoucher des lignes ou des polygones grâce à l’outil Remodeler les entités. Vous pouvez changer
la forme d’une ligne ou d’un polygone en traçant une nouvelle forme entre deux sommets, la modification viendra
s’ajouter à l’existant ou le remplacer selon la taille de l’intervalle entre le premier sommet et celui clôturant le
remodelage. Cette méthode convient pour remplacer de petites portions d’une entité, la ligne de remodelage n’est
pas autorisée à croiser plusieurs anneaux de polygones, car cela générerait un polygone invalide.

Par exemple, vous pouvez modifier les limites d’un polygone avec cet outil. Tout d’abord, cliquez à l’intérieur
du polygone près de la zone où vous souhaitez ajouter un nœud. Franchissez ensuite la limite et positionnez
les nœuds à extérieur du polygone. Pour terminer cliquez à nouveau à l’intérieur du polygone. L’outil ajoute
automatiquement un nœud à l’endroit où la ligne intersecte la limite du polygone. Il est possible également de
supprimer des morceaux de polygones en commençant à l’extérieur du polygone puis en ajoutant des nœuds à
l’intérieur et en terminant à l’extérieur par un clic droit.

Note: L’outil de remodelage peut altérer la position de départ d’un anneau polygonal ou d’une ligne close, le
point “double” ne sera plus le même. Ce n’est pas un problème pour la plupart des applications, mais c’est quelque
chose à considérer.

Décalage X,Y

The Offset Curve tool creates parallel shifts of line layers. The tool can be applied to the edited layer (the
geometries are modified) or also to background layers (in which case it creates copies of the lines / rings and adds
them to the edited layer). It is thus ideally suited for the creation of distance line layers. The User Input dialog
pops-up, showing the displacement distance.

Pour créer un décalage sur une couche de linéaires, vous devez activer le mode édition puis activer l’outil
Décalage X,Y. Cliquez alors sur une entité pour la déplacer. Déplacez avec la souris et cliquez quand vous le souhaitez
ou entrez une distance dans le gadget de saisie de l’utilisateur. Vos modificatons peuvent être sauvegardées en

cliquant sur l’outil Enregistrer les modifications de la couche.

La boîte de dialogue des options de QGIS (onglet Numérisation puis section Outils de décalage de courbe) vous
permet de configurer quelques paramètres tels que Style de jointure, Segments de quadrant, Limite d’angle
droit.
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Séparer les entités

Vous pouvez diviser une entité en utilisant le bouton Séparer les entités. Pour couper, dessinez une ligne en travers
de l’entité avec cet outil et terminez avec un clic droit.

Séparer les parties

Dans QGIS , il est possible de découper des parties d’une entité composée de plusieurs et donc d’en ajouter. Tracez

simplement une ligne à travers des parties que vous souhaitez découper en utilisant l’outil Séparer les parties.

Fusionner les entités sélectionnées

L’outil Fusionner les entités sélectionnées permet de fusionner plusieurs entités. Une boîte de dialogue vous permet
de sélectionner la valeur à appliquer parmi les valeurs des entités sélectionnées ou de sélectionner une fonction
(Minimum, Maximum, Médiane, Moyenne, Somme, Ignorer l’attribut) pour chaque colonne. Si les entités n’ont
pas de frontière commune, un multi-polygone sera créé.

Fusionner les attributs des entités sélectionnées

The Merge Attributes of Selected Features tool allows you to apply same attributes to features without merging their

boundaries. First, select several features. Then press the Merge Attributes of Selected Features button. Now QGIS asks
you which attributes are to be applied to all selected objects. As a result, all selected objects have the same attribute
entries.

Rotation des symboles de point

L’outil Rotation des symboles de points vous permet de changer l’orientation des symboles de point dans la carte. Vous
devez définir une colonne de la table d’attributs comme champ de rotation dans le menu Avancé de l’onglet Style
des Propriétés de la couche de points. De même vous devez aller dans ‘Symbole SVG’ et choisir Source de
définition des propriétés. Cochez la case Angle et choisissez le champ de rotation. Sans ces paramètres, l’outil est
inactif.

Figure 12.71: Rotation des symboles de point

Pour changer l’orientation, sélectionnez une entité ponctuelle sur le canevas et faite là tourner en gardant le bouton
gauche de votre souris appuyé. Une flèche rouge avec la valeur de rotation est visible (voir Figure_edit_5).
Lorsque vous relâchez le bouton, la valeur sera mise à jour dans la table attributaire.
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Note: Si vous gardez la touche Ctrl enfoncée, la rotation se fera par palier de 15 degrés.

Automatic Tracing

Usually, when using capturing map tools (add feature, add part, add ring, reshape and split), you need to click
each vertex of the feature.

Using the automatic tracing mode you can speed up the digitization process. Enable the Tracing tool by pushing
the icon or pressing t key and snap to a vertex or segment of a feature you want to trace along. Move the mouse
over another vertex or segment you’d like to snap and instead of an usual straight line, the digitizing rubber band
represents a path from the last point you snapped to the current position. QGIS actually uses the underlying
features topology to build the shortest path between the two points. Click and QGIS places the intermediate
vertices following the path. You no longer need to manually place all the vertices during digitization.

Tracing requires snapping to be activated in traceable layers to build the path. You should also snap to an existing
vertex or segment while digitizing and ensure that the two nodes are topologically connectable following existing
features, otherwise QGIS is unable to connect them and thus traces a single straight line.

Note: Adjust map scale or snapping settings for an optimal tracing
If there are too many features in map display, tracing is disabled to avoid potentially long tracing structure prepa-
ration and large memory overhead. After zooming in or disabling some layers the tracing is enabled again.

Astuce: Quickly enable or disable automatic tracing by pressing t key
By pressing t key, tracing can be enabled/disabled anytime even while digitizing one feature, so it is possible to
digitize some parts of the feature with tracing enabled and other parts with tracing disabled. Tools behave as usual
when tracing is disabled.

12.6.5 Le panneau Numérisation avancée

Lors de la saisie de nouvelles géométries ou de parties de géométries vous avez aussi la possibilité d’utiliser le
panneau de Numérisation avancée. Vous pouvez numériser des lignes exactement parallèles ou à un angle spécifié
ou bloquer les lignes dans une orientation spécifique. En outre vous pouvez entrer directement les coordonnées de
sorte que vous pouvez définir précisément votre géométrie.

Figure 12.72: Le panneau Numérisation avancée

Note: Les outils ne sont pas disponibles si la vue de la carte est en coordonnées géographiques.

12.6.6 Créer de nouvelles couches vecteur

QGIS vous permet de créer de nouvelles couches Shapefile, SpatialLite, GPS et couches en mémoire temporaire.
La création d’une nouvelle couche GRASS est supportée avec l’extension GRASS. Merci de vous référez à la

174 Chapter 12. Les données vectorielles



QGIS User Guide, Version 2.14

section Création d’une nouvelle couche vectorielle GRASS pour plus d’informations sur la création de couches
vectorielles GRASS.

Créer une nouvelle couche Shapefile

Pour créer une nouvelle couche shapefile à éditer, allez dans le menu Créer une couche → Nouvelle couche
Shapefile... du menu Couche. La fenêtre Nouvelle couche vecteur apparaitra telle que montrée dans Figure_edit_6.
Choisissez le type de géométrie de la couche (point, ligne ou polygone) et le SCR (système de coordonnées de
référence).

Notez que QGIS ne gère pas encore la création d’entité 2.5D (c’est.-à-dire des entités avec des coordonnées X, Y,
Z).

Figure 12.73: Fenêtre de création d’une nouvelle couche Shapefile

Pour terminer la création de la nouvelle couche, ajouter les attributs désirés en cliquant sur le bouton [Ajouter à
la liste d’attributs] après avoir spécifié le nom et le type de chaque attribut. Un attribut ‘id’ est proposé par défaut

et peut être supprimé. Seuls les attributs de type Nombre décimal , Nombre entier , Données texte

et Date sont gérés. De plus, selon le type d’attribut vous pouvez définir la largeur et la précision
de la nouvelle colonne. Une fois satisfait de vos attributs, cliquez sur [OK] et donnez un nom pour le shapefile.
QGIS va automatiquement ajouter l’extension .shp au nom que vous lui avez spécifié. Une fois la couche créée,
elle sera ajoutée à la carte et vous pourrez l’éditer de la manière décrite dans la section ref:sec_edit_existing_layer
ci-dessus.

Créer une nouvelle couche SpatiaLite

Pour créer une nouvelle couche SpatiaLite à éditer, allez dans le menu Créer une couche → Nouvelle couche
SpatiaLite... du menu Couche. La fenêtre Nouvelle couche SpatiaLite apparaitra telle que montrée dans Fig-
ure_edit_7.

12.6. Éditer 175



QGIS User Guide, Version 2.14

Figure 12.74: Fenêtre de création d’une nouvelle couche SpatiaLite
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La première étape est de sélectionner une base SpatiaLite existante ou d’en créer une nouvelle en utilisant le

bouton à droite de la liste des bases de données. Donnez un nom à la nouvelle couche, choisissez un type

puis un SCR avec [Spécifier le SCR]. Si besoin, vous pouvez cocher Créer une clé primaire autoincrémentée.

Pour définir une table attributaire, ajoutez les noms des colonnes avec leur type de données et cliquez sur le
bouton [Ajouter à la liste d’attribut]. Lorsque la liste d’attributs est terminée, cliquez sur [OK]. QGIS ajoutera
automatiquement cette nouvelle couche à la légende où vous pourrez l’éditer comme indiquée dans la section
Numériser une couche existante ci-dessus.

D’autres opérations de gestion des couches SpatiaLite peuvent être effectuées via DB Manager. Voir Extension
DB Manager.

Créer une nouvelle couche GPS

Pour créer un nouveau fichier GPX, vous devez d’abord charger l’extension GPS. Extension→ Installer/Gérer

les extensions ouvre la fenêtre Gestionnaire d’extensions. Activez la case Outils GPS.

Lorsque cette extension est chargée, choisissez Créer une couche → Créer une nouvelle couche GPS du menu
Couche. Dans la fenêtre Sauvegarder le fichier GPS sous ..., vous pouvez choisir où enregistrer la nouvelle couche
GPS.

Créer une nouvelle couche en mémoire temporaire

Des couches vides en mémoire temporaire peuvent être définies en utilisant le menu Couche → Créer une couche
→ Nouvelle couche en mémoire temporaire. Ici vous pouvez même créer des couches Multipoint, Multi-
ligne et Multipolygone, Point, Ligne et Polygone. Les couches en mémoire temporaire ne sont pas
sauvegardées et seront supprimées à la fermeture de QGIS. Voir aussi Coller dans une nouvelle couche.

12.7 Couches virtuelles

Un type particulier de couche vecteur vous permet de définir une couche résultant d’une requête complexe en
utilisant le langage SQL sur une ou plusieurs couches vectorielles que QGIS est capable de charger. Ce type de
couches est appelé couches virtuelles : elles ne contiennent pas de donnée et correspondent à des vues sur d’autres
couches.

12.7.1 Créer une couche virtuelle

Ouvrez la fenêtre de création de couche virtuelle en cliquant sur Ajouter/Editer une couche virtuelle... depuis le
menu Couche ou la barre d’outils correspondante.

La fenêtre vous permet de spécifier une requête SQL. La requête peut faire appel aux noms (ou identifiants, id) de
couches vectorielles existantes ainsi qu’aux noms de champs de ces couches.

Par exemple, si vous avez une couche nommée regions, vous pouvez créer une nouvelle couche virtuelle avec
cette requête SQL : SELECT * FROM regions WHERE id < 100. La requête SQL sera exécutée quel
que soit le fournisseur de la couche regions et même si ce fournisseur ne gère pas les requêtes SQL.

Des jointures et des requêtes complexes peuvent être crées en utilisant directement les noms des couches à joindre.

12.7.2 Langage supporté

The underlying engine uses SQLite and Spatialite to operate.

It means you can use all of the SQL your local installation of SQLite understands.

12.7. Couches virtuelles 177



QGIS User Guide, Version 2.14

Functions from SQLite and spatial functions from Spatialite can also be used in a virtual layer query. For in-
stance, creating a point layer out of a attribute-only layer can be done with a query similar to: SELECT id,
MakePoint(x, y, 4326) as geometry FROM coordinates

Functions of QGIS expressions can also be used in a virtual layer query.

To refer the geometry column of a layer, use the name geometry.

Contrary to a pure SQL query, all the fields of a virtual layer query must be named. Don’t forget to use the as
keyword to name your columns if they are the result of a computation or function call.

12.7.3 Problèmes de performance

With default parameters set, the virtual layer engine will try its best to detect the type of the different columns of
the query, including the type of the geometry column if one is present.

This is done by introspecting the query when possible or by fetching the first row of the query (LIMIT 1) at last
resort. Fetching the first row of the result just to create the layer may be undesirable for performance reasons.

The creation dialog allows to specify different parameters:

• unique identifier column: this option allows to specify which field of the query represents unique inte-
ger values that QGIS can use as row identifiers. By default, an autoincrementing integer value is used.
Specifying a unique identifier column allows to speed up selection of rows by id.

• no geometry: this option forces the virtual layer to ignore any geometry field. The resulting layer is an
attribute-only layer.

• geometry column: this option allows to specify the name of the column that is to be used as the geometry
of the layer.

• geometry type: this option allows to specify the type of the geometry of the virtual layer.

• geometry CRS: this option allows to specify the coordinate reference system of the virtual layer.

12.7.4 Commentaires spéciaux

Le moteur de couche virtuelle essaie de déterminer le type de chaque champ de la requête. S’il n’y arrive pas, la
première ligne de la requête est récupérée pour déterminer les types des champs.

Le type d’un champ particulier peut être spécifié directement dans la requête en utilisant des commentaires spéci-
aux.

La syntaxe est la suivante : /*:type*/. Il doit être placé juste après le nom du champ. type peut correspondre
soit à int pour des entiers, real pour des nombres réels ou text pour du texte.

Par exemple : SELECT id+1 as nid /*:int*/ FROM table

Le type et le système de coordonnées d’un champ géométrie peuvent également être précisés grâce au commen-
taires spéciaux suivants : /*:gtype:srid*/ où gtype est le type de géométrie (point, linestring,
polygon, multipoint, multilinestring ou multipolygon) et srid, un entier correspondant au
code EPSG du système de coordonnées.

12.7.5 Utilisation des index

When requesting a layer through a virtual layer, indexes of this source layer will be used in the following ways:

• if an = predicate is used on the primary key column of the layer, the underlying data provider will be asked
for a particular id (FilterFid)

• for any other predicates (>, <=, !=, etc.) or on a column without primary key, a request built from an
expression will be used to request the underlying vector data provider. It means indexes may be used on
database providers if they exist.
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A specific syntax exists to handle spatial predicates in requests and trigger the use of a spa-
tial index: a hidden column named _search_frame_ exists for each virtual layer. This col-
umn can be compared for equality to a bounding box. Example: select * from vtab where
_search_frame_=BuildMbr(-2.10,49.38,-1.3,49.99,4326)

Spatial binary predicates like ST_Intersects are greatly sped up when used in conjunction with this spatial
index syntax.
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CHAPTER 13

Les données raster

13.1 Les données raster

Cette section explique comment visualiser et définir les propriétés d’une couche raster. QGIS utilise la biblio-
thèque GDAL pour lire et écrire des raster de multiples formats dont ArcInfo Binary Grid, ArcInfo ASCII Grid,
GeoTIFF, ERDAS IMAGINE et bien d’autres. La gestion des raster GRASS se fait de manière native via une
extension spécifique. Des raster peuvent également être lus par QGIS depuis des archives zip et gzip.

A ce jour, plus de 100 formats raster sont gérés par la bibliothèque GDAL (voir GDAL-SOFTWARE-SUITE dans
Bibliographie). La liste complète est disponible sur cette page : http://www.gdal.org/formats_list.html.

Note: Certains des formats listés peuvent ne pas fonctionner dans QGIS pour diverses raisons. Par exemple,
certains formats requièrent une bibliothèque commerciale externe ou la bibliothèque GDAL n’a peut-être pas
été compilée sur votre système d’exploitation pour gérer le format souhaité. Seuls les formats ayant été testés
correctement apparaissent dans la liste des types de fichiers proposés au moment de l’ajout de données raster dans
QGIS. Les autres formats peuvent être chargés en sélectionnant [GDAL] Tous les fichiers (*) .

La gestion des données raster GRASS est décrite dans la section Intégration du SIG GRASS.

13.1.1 Qu’est ce qu’un raster ?

Les données raster dans les SIG sont des matrices de cellules discrètes qui représentent des objets, au-dessus
ou en dessous de la surface de la Terre. Les cellules de la grille raster sont de la même taille et généralement
rectangulaires (dans QGIS, elles seront toujours rectangulaires). Les jeux de données raster les plus classiques
sont des données de télédétection telles que des photographies aériennes ou des images satellitaires et des données
issues de modèles telles que les matrices d’élévation.

Contrairement aux données vectorielles, les données raster n’ont pas de base de données associée. Elles sont
géoréférencées grâce à la résolution des pixels et les coordonnées x/y du pixel d’un des coins de la couche raster.
Cela permet à QGIS de positionner les données correctement dans la zone de la carte.

Pour afficher correctement les données, QGIS utilise les informations de géoréférencement intégrées aux couches
raster (par exemple GeoTiff) ou présentes dans un fichier world.

13.1.2 Charger des données raster dans QGIS

Les données raster sont chargées soit en cliquant sur l’icone Ajouter une couche raster ou en sélectionnant dans le

menu Couche → Ajouter une couche raster.... Plus d’une couche peut être chargée en conservant la touche
Ctrl ou Shift du clavier appuyée et en cliquant sur les fichiers dans la fenêtre Ouvrez des données raster gérées
par GDAL.

Une fois la couche raster chargée vous pouvez faire un clic-droit sur son nom dans la légende de la carte pour
sélectionner et activer des paramètres spécifiques à la couche ou pour ouvrir la fenêtre de propriétés de la couche.
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Menu du bouton droit de la souris pour les couches raster

• Zoomer sur la couche

• Zoom à la meilleur échelle (100%)

• Étirer sur l’emprise actuelle

• Afficher dans l’aperçu

• Supprimer

• Dupliquer

• Définir le SCR d’une couche

• Définir le SCR du projet depuis cette couche

• Enregistrer sous...

• Propriétés

• Renommer

• Copier le style

• Ajouter un groupe

• Étendre tout

• Réduire tout

• Mettre à jour l’ordre de rendu

13.2 Fenêtre Propriétés de la couche raster

Pour voir et définir les propriétés d’une couche raster, double-cliquez sur le nom de la couche dans la légende de la
carte ou faites un clic-droit son nom et choisissez Propriétés dans le menu qui apparaît. La fenêtre des Propriétés
de la couche apparaîtra (voir figure_raster_1).

Il y a plusieurs onglets dans cette fenêtre :

• Général

• Style

• Transparence

• Pyramides

• Histogramme

• Métadonnées

13.2.1 Onglet Général

Informations sur la couche

L’onglet Général affiche des informations basiques sur le raster sélectionné, dont la source de la couche, le nom
affiché dans la légende (qui peut être modifié), le nombre de colonnes, lignes et les valeurs ‘no-data’.

Système de coordonnées de référence

Le système de coordonnées de référence (SCR) est également affiché ici au format PROJ.4. S’il est incorrect, il
peut être modifié en cliquant sur le bouton [Spécifier].
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Figure 13.1: Fenêtre de Propriétés des couches raster

Visibilité dépendante de l’échelle

La visibilité en fonction de l’échelle se définit également dans cet onglet. Vous devez activer la case à cocher et
définir une échelle appropriée pour l’affichage de vos données sur la carte.

Tout en bas, sont affichés un aperçu de la couche, son symbole de légende et sa palette.

13.2.2 Onglet Style

Rendu des bandes raster

QGIS propose quatre Types de rendu. Le choix s’effectue en fonction du type de données.

1. Couleur à Bandes Multiples - Si le fichier raster est multibande et contient plusieurs bandes (par exemple,
avec une image satellite)

2. Palette - Si le fichier ne contient qu’une seule bande indexée (par exemple, pour les cartes topographiques)

3. Bande Grise Unique - (Une seule bande de gris). Le rendu de l’image sera gris. QGIS choisit ce rendu si
ce fichier n’est ni multibande, ni une palette indexée, ni une palette continue (utilisée par exemple pour les
cartes avec des reliefs ombrés)

4. Pseudo-Couleur à Banque Unique - vous pouvez utiliser ce rendu pour les fichiers contenant une palette
continue ou des cartes en couleur (par exemple pour une carte des altitudes)

Couleur à bandes multiples

Avec ce type de rendu, trois bandes de l’image seront utilisées, chacune correspondant à la composante rouge,
verte ou bleue de l’image colorée finale. Vous pouvez choisir parmi différentes méthodes d’Amélioration du
contraste : ‘Pas d’amélioration’, ‘Étirer jusqu’au MinMax’, ‘Étirer et couper jusqu’au MinMax’ ou ‘Couper
jusqu’au MinMax’.

Ces options vous offrent de nombreuses possibilités de modifier l’apparence de votre couche raster. Premièrement
vous devez connaître la plage de valeurs de votre image. Vous pouvez utiliser pour cela l’Emprise et cliquer sur
[Charger]. Pour les valeurs de Min et de Max de vos bandes, QGIS vous laisse le choix entre une Précision
Estimée (plus rapide) ou Réelle (plus lente).

Maintenant vous pouvez échelonner les couleurs grâce à la partie Charger les valeurs min/max. Beaucoup
d’images n’ont que très peu de valeurs très faibles ou très élevées. Ces extrêmes peuvent être ignorés en util-
isant l’option Bornes d’exclusion des valeurs extrêmes. Par défaut la plage proposée va de 2% à 98% des
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Figure 13.2: Rendu Raster - Couleur à bandes multiples
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valeurs de données et peut être ajustée manuellement. Avec ce paramétrage, l’aspect gris de l’image peut dis-
paraitre. Avec l’option Min / max, QGIS crée une table de couleur à partir de toutes les données de l’image
originale (par exemple, QGIS crée une table de couleur avec 256 valeurs, si vous avez des bandes codées sur
8 bits). Vous pouvez également calculer votre table de couleur en utilisant l’option Moyenne +/- écart-type
x . Ainsi, seules les valeurs comprises dans cet intervalle (écart-type ou multiple de l’écart-type) seront
considérées. Ceci est utile lorsqu’un ou deux pixels ont des valeurs anormalement élevées et ont un impact négatif
sur le rendu du raster.

Tous les calculs peuvent également être réalisés pour l’emprise Actuelle.

Astuce: Visualiser une seule bande d’un raster multibande
Si vous désirez visualiser une seule bande d’une image multibande (par exemple la bande rouge), vous pouvez
penser que vous pourriez définir les bandes Verte et Bleue à “Non définie”. Mais ce n’est pas la manière correcte.
Pour afficher la bande Rouge, définissez le type d’image à Bande grise unique, puis sélectionnez la bande Rouge
comme bande à utiliser pour le gris.

Palette

C’est l’option standard pour les fichiers à une seule bande qui incluent déjà une table de couleurs, où à chaque
valeur de pixel a été assignée une couleur. Dans ce cas, la palette est utilisée automatiquement. Si vous désirez
modifier l’assignement des couleurs pour certaines valeurs, double cliquez simplement sur la couleur et la boîte de
dialogue de Sélection de couleur apparaîtra. Il est possible d’assigner un label aux valeurs de couleur. L’étiquette
apparaîtra alors dans la légende de la couche raster.

Figure 13.3: Rendu Raster - Palette de couleurs

Amélioration de contraste

Note: Lors de l’ajout d’une couche raster GRASS, l’option Amélioration de contraste sera automatiquement
Étirer jusqu’au MinMax, quelles que soient les options générales de QGIS définies pour cette option.

13.2. Fenêtre Propriétés de la couche raster 185



QGIS User Guide, Version 2.14

Bande grise unique

Ce type de rendu vous permet de représenter une bande d’un raster par un Dégradé de couleur : ‘Noir vers blanc’
ou ‘Blanc vers noir’. Vous pouvez choisir un Min et un Max en choisissant d’abord une Emprise puis en cliquant
sur [Charger]. QGIS peut utiliser les valeurs Min et Max Estimée (plus rapide) ou utiliser les valeurs
Réelle (plus lent).

Figure 13.4: Rendu Raster - Bande grise unique

Grâce à la partie Charger les valeurs min/max, vous pouvez échelonner les couleurs. Les valeurs extrêmes peuvent
être ignorées en utilisant l’option Bornes d’exclusion des valeurs extrêmes. Par défaut la plage proposée va de
2% à 98% des valeurs de données et peut être ajustée manuellement. Avec ce paramétrage, l’aspect gris de l’image
peut disparaitre. D’autres réglages peuvent être effectués via les boutons Min / max and Moyenne +/- écart-
type x . Le premier crée une table de couleur à partir de toutes les données de l’image originale alors que
le deuxième crée une table de couleur qui ne considère que les valeurs comprises dans l’intervalle constitué par
l’écart-type ou un multiple de l’écart-type. Ceci est utile lorsqu’un ou deux pixels ont des valeurs anormalement
élevées et ont un impact négatif sur le rendu du raster.

Pseudo-couleur à bande unique

C’est une option de rendu pour les fichiers à bande unique, incluant une palette de couleurs continues. Vous
pouvez aussi créer des palettes de couleurs pour les fichiers à bande unique. Trois manières de faire une
interpolation de couleurs sont disponibles :

1. Discrète

2. Linéaire

3. Exacte

Sur la partie gauche, le bouton Ajouter une valeur manuellement, permet d’ajouter une valeur individuelle à la ta-

ble de couleurs. Le bouton Supprimer la valeur sélectionnée efface une valeur et Trier les éléments de la palette de couleurs

permet de trier la table de couleurs en fonction des valeurs de pixels. En double-cliquant sur une valeur,
vous pouvez l’éditer manuellement. Un double-clic sur une couleur ouvre la fenêtre Modifier la couleur où
vous pouvez la modifier. De plus, vous pouvez ajouter une étiquette de légende pour chaque valeur (mais

cette information n’apparaîtra pas lors de l’utilisation de l’outil d’identification). Vous pouvez également
Charger une palette de couleur depuis la bande, si une table de couleurs a été définie pour la bande. Enfin vous pouvez utiliser
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Figure 13.5: Rendu Raster - Pseudo-couleur à bande unique
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les boutons Charger une palette de couleur depuis un fichier ou Exporter une palette de couleur vers un fichier pour importer ou ex-
porter une table de couleur depuis ou vers une autre session.

Sur la partie droite, il est possible de Générer une nouvelle palette de couleur. Pour le ‘Mode’ de classification

par ‘Intervalles égaux’, vous n’avez qu’à choisir le nombre de Classes et cliquez sur le bouton

Classer. Vous pouvez inverser l’ordre des couleurs de la palette en cochant la case Inverser. Dans le cas d’une

classification par Mode ‘Continu’, QGIS crée automatiquement les classes en fonction des Min et Max. La
partie située en dessous, Charger les valeurs min/max, permet d’ajuster ces valeurs. En effet, beaucoup d’images
n’ont que très peu de valeurs très faibles ou très élevées. Ces extrêmes peuvent être ignorés en utilisant l’option
Bornes d’exclusion des valeurs extrêmes. Par défaut la plage proposée va de 2% à 98% des valeurs de données et
peut être ajustée manuellement. Avec ce paramétrage, l’aspect gris de l’image peut disparaitre. Avec l’option
Min / max, QGIS crée une table de couleur à partir de toutes les données de l’image originale (par exemple, QGIS
crée une table de couleur avec 256 valeurs, si vous avez des bandes codées sur 8 bits). Vous pouvez également
calculer votre table de couleur en utilisant l’option Moyenne +/- écart-type x . Ainsi, seules les valeurs
comprises dans cet intervalle (écart-type ou multiple de l’écart-type) seront considérées.

Rendu des couleurs

Pour chaque type de Rendu par bande, des options de Rendu de la couleur sont disponibles.

Vous pouvez réaliser des effets spéciaux sur le rendu de vos rasters en utilisant un des modes de fusion (voir
Fenêtre Propriétés d’une couche vecteur).

D’autres paramètres permettent de modifier la Luminosité, la Saturation et le Contraste. Vous pouvez également
utiliser un Dégradé de gris et le faire ‘Par clarté’, ‘Par luminosité’, ou ‘Par moyenne’. Pour une teinte de couleur,
vous pouvez en modifier la ‘Force’

Ré-échantillonnage

Les options de Ré-échantillonnage déterminent l’apparence d’un raster quand vous zoomez ou dé-zoomez. Dif-
férents modes de ré-échantillonnage permettent d’optimiser l’apparence d’un raster. Ils calculent une nouvelle
matrice de valeurs via une transformation géométrique.

Figure 13.6: Rendu de raster - Ré-échantillonnage

En appliquant la méthode ‘Plus proche voisin’, le raster peut apparaître pixelisé lorsque l’on zoome dessus. Ce
rendu peut être amélioré en choisissant les méthodes ‘Bilinéaire’ ou ‘Cubique’ qui adoucissent les angles. L’image
est alors lissée. Ces méthodes sont adaptées par exemple aux rasters d’élévation.
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13.2.3 Onglet Transparence

QGIS permet d’afficher chaque raster à des niveaux de transparence différents. Utilisez le curseur de transparence

pour indiquer dans quelle mesure les couches sous-jacentes (s’il y en a) pourront être visibles
à travers cette couche raster. Cela est très utile, si vous désirez superposer plus d’une couche raster (par exemple
une carte des reliefs ombrés superposée à une carte raster classifiée). Cela donnera un rendu proche d’un rendu en
trois dimensions.

De plus, vous pouvez entrer une valeur raster qui sera traitée comme NODATA dans Valeur nulle supplémentaire.

Un moyen encore plus flexible de personnaliser la transparence est d’utiliser la section Options de transparence
personnalisée. La transparence de chaque pixel peut être définie dans cet onglet.

Par exemple, pour donner une transparence de 20% à l’eau sur notre raster d’exemple landcover.tif, les
étapes suivantes sont nécessaires :

1. Chargez le raster landcover.tif.

2. Ouvrez la boîte de dialogue Propriétés de la couche en double-cliquant sur le nom du raster dans la légende
ou avec un clic droit et en choisissant Propriétés dans le menu qui apparaît.

3. Sélectionnez l’onglet Transparence.

4. Dans la liste Bande de transparence, choisissez ‘Aucune’.

5. Cliquez sur le bouton Ajouter des valeurs manuellement. Une nouvelle ligne apparait dans la liste des pixels.

6. Entrez la valeur raster dans les colonnes ‘De’ et ‘Vers’ (mettez la valeur 0) puis ajustez la transparence à
20%.

7. Cliquez sur le bouton [Appliquer] et regardez la carte.

Vous pouvez répéter les étapes 5 et 6 pour personnaliser la transparence d’autres valeurs.

Comme vous pouvez le voir, il est assez facile de définir une transparence personnalisée, mais cela peut prendre

un peu de temps. Par conséquent, vous pouvez utiliser le bouton Exporter dans un fichier pour sauver vos paramètres

de transparence dans un fichier. Le bouton Importer depuis le fichier charge vos paramètres de transparence et les
applique à la couche raster actuelle.

13.2.4 Onglet Pyramides

Les couches raster à haute résolution peuvent ralentir la navigation dans QGIS. En créant des copies des données
de plus basses résolutions (des pyramides), les performances peuvent être considérablement améliorées puisque
QGIS sélectionne la résolution la plus pertinente à utiliser en fonction du niveau de zoom.

Vous devez avoir accès en écriture dans le répertoire où les données originelles sont stockées pour construire les
pyramides.

Plusieurs méthodes de ré-échantillonnage peuvent être utilisées pour calculer les pyramides :

• Plus proche voisin

• Moyenne

• Gauss

• Cubique

• Mode

• Aucune

Si vous choisissez ‘Interne (si possible)’ pour le Format de pyramide, QGIS tente de construire les pyramides au
sein même du fichier image. Vous pouvez aussi choisir les modes ‘Externe’ ou ‘Externe (.aux)’.
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Figure 13.7: Onglet Pyramides

Notez que construire des pyramides peut altérer le fichier original et, une fois créées, elles ne peuvent plus être
supprimées. Si vous désirez préserver une version ‘sans pyramide’ de vos raster, réalisez une copie de sauvegarde
avant de les construire.

13.2.5 Onglet Histogramme

L’onglet Histogramme vous permet de visualiser la distribution des bandes ou des couleurs dans votre raster. Il
se génère automatiquement quand vous accédez à l’onglet Histogramme. Toutes les bandes seront représentées

ensemble. Vous pouvez exporter une image de l’histogramme grâce au bouton . Avec l’option Visibilité du

bouton Préférences / Actions, vous pouvez choisir de ne représenter qu’une seule bande sur l’histogramme.
Pour cela, choisissez l’option Afficher la bande sélectionnée. Les Options Min/max permettent de ‘Toujours
afficher les marqueurs de min et max’, ‘Zoomer sur les min/max’ et ‘Mettre à jour le style des min/max’. Les
options Actions permettent de ‘Réinitialiser’ ou de ‘Recalculer l’histogramme’ après avoir choisi les Options de
Min/max.

13.2.6 Onglet Métadonnées

L’onglet Métadonnées affiche de nombreuses informations sur la couche raster, dont les statistiques sur chaque
bande de la couche raster. Les informations sont regroupées par section : Description, Attribution, URL Métadon-
nées et Propriétés. Les statistiques sont recueillies ‘à la demande’, de sorte qu’il est possible que les statistiques
sur une couche n’aient pas encore été collectées.

13.3 Analyse Raster

13.3.1 Calculatrice Raster

La Calculatrice Raster du menu Raster vous permet d’effectuer des calculs sur la base des valeurs des pixels d’un
raster existant (voir figure_raster_10). Le résultat est écrit dans un nouveau raster dans un des formats gérés par
GDAL.
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Figure 13.8: Histogramme raster

Figure 13.9: Métadonnées Raster

13.3. Analyse Raster 191



QGIS User Guide, Version 2.14

Figure 13.10: Calculatrice Raster
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La liste Bandes raster contient toutes les couches rasters actuellement chargées pouvant être utilisées. Pour
ajouter un raster à la formule de calcul, faites un double-clic sur son nom dans la liste. Vous pouvez alors utiliser
les opérateurs pour construire une formule ou bien les taper directement dans la zone de saisie.

Dans la partie Couche de résultat, vous devez définir la couche en sortie. Vous pouvez préciser l’étendue de la
zone de calcul en vous basant sur une des couches raster utilisées ou en spécifiant des coordonnées X et Y ainsi
que les nombres de lignes et de colonnes pour indiquer la résolution. Si la couche en entrée a une résolution
différente, les valeurs seront interpolées avec l’algorithme du plus proche voisin.

La partie Opérateurs contient tous les opérateurs disponibles. Pour ajouter un opérateur à la formule, cliquez sur
le bouton approprié. Les opérateurs mathématiques (+, -, *, ... ) et les fonctions trigonométriques (sin, cos,
tan, ... ) sont disponibles, d’autres feront leur apparition !

Le fait de cocher Ajouter le résultat au projet chargera automatiquement le raster de résultat dans la légende
du projet courant et pourra être visualisé.

Exemples

Conversion en pieds de données d’élévation en mètres

Pour créer un raster d’élévation en pieds à partir d’un raster en mètres, vous devez utiliser le facteur de conversion
3,28. La formule est la suivante :

"elevation@1" * 3.28

Utilisation d’un masque

Si vous souhaitez masquer certaines zones d’un raster, par exemple si vous vous intéressez uniquement aux alti-
tudes supérieures à 0, vous pouvez utiliser la formule suivante qui crée un masque et l’applique au raster en une
seule étape.

("elevation@1" >= 0) * "elevation@1"

En d’autres termes, les pixels de valeur supérieure ou égale à 0 prennent la valeur 1, les autres la valeur 0. Ceci
permet de créer le masque à la volée.

Si vous souhaitez classer un raster, par exemple en deux classes d’altitudes, vous pouvez utiliser la formule suiv-
ante pour créer un raster contenant deux valeurs, 1 et 2, en une seule étape :

("elevation@1" < 50) * 1 + ("elevation@1" >= 50) * 2

En d’autres termes, les pixels de valeur inférieure à 50 prennent la valeur 1. Pour tous les pixels supérieurs ou égal
à 50 prennent la valeur 2.

13.3.2 Alignement de rasters

Cet outil permet de prendre plusieurs rasters en entrée et de les aligner exactement :

• reprojète dans le même SRC,

• rééchantillone à la même taille de cellule et décalage dans la grille,

• découpe une région d’intérêt,

• rééchantillonne les valeurs lorsque cela est nécessaire.

Les rasters seront sauvegardés dans de nouveaux fichiers.

First, open the tools from Raster → Align Raster... and click on the Add new raster button to choose one existing
raster in QGIS. Select an output file to save the raster after the alignment, the resampling method and if the tools

need to Rescale values according to the cell size. You can Edit file settings and Remove an existing file from the list.

Then in the main Align raster window, you can choose one or more options:
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• sélectionner une Couche de référence,

• reprojeter dans un nouveau SCR,

• choisir une Taille de cellule différente,

• choisir un Décalage de la grille,

• Découper selon l’emprise,

• choisir la Taille de sortie,

• Ajouter les rasters alignés au canevas de la carte.
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CHAPTER 14

Les données OGC

14.1 QGIS comme client de données OGC

L’OGC (Open Geospatial Consortium) est une organisation internationale à laquelle participent plus de 300 or-
ganisations commerciales, gouvernementales, associatives et laboratoires de recherche à travers le monde. Ses
membres développent et implémentent des standards pour les services et le contenu géospatial, le traitement de
données SIG et les formats d’échange.

Un nombre croissant de spécifications décrivant les modèles de données géographiques sont développées
par l’OGC pour servir des besoins spécifiques dans des situations nécessitant une interopérabilité et des
technologies géospatiales, dont les SIG. Des informations supplémentaires peuvent être trouvées sur le site
http://www.opengeospatial.org/.

Les spécifications importantes de l’OGC prises en charge par QGIS sont :

• WMS — Web Map Service (Client WMS / WMTS)

• WMTS — Web Map Tile Service (Client WMS / WMTS)

• WFS — Web Feature Service (Client WFS et WFS-T)

• WFS-T — Web Feature Service - Transactional (Client WFS et WFS-T)

• WCS — Web Coverage Service (Client WCS)

• SFS — Simple Features for SQL (Couches PostGIS)

• GML — Geography Markup Language

Les services OGC sont de plus en plus utilisés pour échanger des données géospatiales entre différentes implé-
mentations SIG et des fournisseurs de données. QGIS peut maintenant traiter les spécifications citées ci-dessus
dont le SFS (via PostgreSQL / PostGIS, voir section Couches PostGIS).

14.1.1 Client WMS / WMTS

Aperçu de la gestion du WMS

QGIS peut actuellement agir comme client WMS pour les versions 1.1, 1.1.1 et 1.3 des serveurs WMS. Il a été
tout particulièrement testé avec des serveurs accessibles publiquement comme ceux de DEMIS.

Un serveur WMS agit en fonction des requêtes envoyées par le client (par exemple QGIS) pour une carte raster
avec une étendue donnée, un ensemble de couches, une sémiologie et une transparence. Le serveur WMS consulte
alors ses sources de données locales, rasterise la carte et la renvoie au client dans un format raster. Pour QGIS,
cela sera par exemple du JPEG ou du PNG.

Un WMS est de manière générale un service web mis en œuvre selon une architecture REST (Representational
State Transfer) plutôt qu’un service RPC (Remote Procedure Call) pleinement déployé. De cette façon, vous
pouvez copier les adresses générées par QGIS et les coller dans un navigateur internet pour retrouver les mêmes
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images que dans QGIS. Cela peut être très pratique pour résoudre des problèmes, car de fait il y a plusieurs
modèles de serveur WMS sur le marché, chacun ayant son interprétation du standard WMS.

Des couches WMS peuvent être ajoutées assez simplement, du moment que vous connaissez l’URL pour accéder
au serveur WMS, vous avez une connexion sous forme de service sur ce serveur, et celui-ci comprend le protocole
HTTP comme mécanisme de transport.

De plus, QGIS mettra vos réponses WMS dans le cache (c-a-d images) pendant 24 heures tant que la demande
GetCapabilities n’est pas sollicitée. La demande GetCapabilities est sollicitée chaque fois que le bouton [Connex-
ion] du dialogue [Ajout de couche(s) d’un Serveur WMS(T)S] est utilisé pour récupérer les capacités du serveur
WMS. C’est une fonction automatique prévue pour optimiser le temps de chargement des projets. Si un projet
est sauvé et possède une couche WMS, les tuiles WMS correspondantes seront téléchargées à partir du cache, la
prochaine fois que le projet est ouvert, si elles ne sont pas plus vieilles que 24 heures.

Aperçu du support WMTS

QGIS peut aussi agir comme client WMTS. WMTS est un standard OGC de diffusion des données cartographiques
sous formes de tuiles prédéfinies. C’est un moyen de diffusion plus rapide et plus efficient que le standard WMS
car les tuiles sont générées à l’avance et les requêtes clientes ne portent que sur la transmission des tuiles, non leur
production. A contrario, une requête WMS implique à la fois la génération des données et leur transmission. Un
exemple bien connu d’utilisation de données cartographiques tuilées, non conforme au standard OGC, est Google
Maps.

Afin d’afficher des données à différentes échelles proches de celles souhaitées par l’utilisateur, les dalles WMTS
sont produites à différents niveaux d’échelle et peuvent être demandées par une application SIG cliente.

Ce diagramme illustre le concept de tuiles prédéfinies:

Figure 14.1: Le concept de tuiles prédéfinies WMTS

Les deux types d’interfaces WMTS que QGIS gère sont les paires clef-valeurs (KVP) et RESTful. Ces deux
interfaces sont différentes et vous devrez les paramétrer de manière différente dans QGIS.

1. Pour accéder à un service WMTS KVP, l’utilisateur doit ouvrir l’interfaces WMS/WMTS et ajouter la
chaîne de caractères suivante à l’URL du service de tuile WMTS :

"?SERVICE=WMTS&REQUEST=GetCapabilities"

Un exemple de ce type d’adresse est

http://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities

Pour les tests, la couche topo2 de ce WMTS fonctionne correctement. Ajouter cette chaîne indique que le
service web WMTS est utilisé à la place du service WMS.
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2. Le service RESTful WMTS prend la forme différente d’une URL classique. Le format recommandé par
l’OGC est le suivant:

{WMTSBaseURL}/1.0.0/WMTSCapabilities.xml

Ce format aide à reconnaître les adresses RESTful. Un service WMTS RESTful est accédé par QGIS
en ajoutant simplement cette adresse dans la configuration de l’URL WMS. Voici un exemple de ce type
d’adresse pour les cartes de l’Autriche: http://maps.wien.gv.at/basemap/1.0.0/WMTSCapabilities.xml.

Note: Vous pouvez encore trouver de vieux services nommés WMS-C. Ces services sont proches
du WMTS (même objectif mais fonctionnement différent). Vous pouvez les gérer de la même
manière que les services WMTS. Ajoutez seulement ?tiled=true à la fin de l’url. Consultez
http://wiki.osgeo.org/wiki/Tile_Map_Service_Specification pour plus d’informations sur cette spécification.

Lorsque vous lisez WMTS, vous pouvez également penser WMS-C.

Sélection des serveurs WMS/WMTS

La première fois que vous utilisez la fonctionnalité de services WMS dans QGIS, il n’y a aucun serveur défini.

Commencez par cliquer sur le bouton Ajoutez une couche WMS dans la barre d’outils ou via le menu Couche →
Ajoutez une couche WMS....

La fenêtre Ajouter des couches depuis un serveur pour ajouter des couches d’un serveur WMS s’ouvre.
Vous pouvez ajouter des serveurs pour tester en cliquant le bouton [Ajouter les serveurs par défaut].
Cela ajoutera deux serveurs WMS de démonstration, celui de DM Solutions Group et celui de Lizardtech.
Pour définir un nouveau serveur WMS, dans l’onglet Couches, cliquez sur le bouton [Nouveau] puis en-
trez les paramètres de connexion du serveur WMS désiré, comme listé dans le tableau table_OGC_1:

Nom Un nom pour cette connexion. Ce nom sera utilisé dans la liste déroulante des connexions
aux serveurs afin que vous puissiez le distinguer des autres serveurs WMS.

URL URL du serveur fournissant les données. Cela doit être un nom d’hôte publique – le
même format que si vous l’utilisiez pour ouvrir une connexion Telnet ou pinguer un hôte
(ou dans un navigateur Internet).

Nom utilisateur Nom d’utilisateur pour accéder à un serveur WMS sécurisé. Ce paramètre est optionnel.
Mot de Passe Mot de passe pour une authentification basique à un serveur WMS. Ce paramètre est

optionnel.

Ignorer l’adresse
GetMap

Ignorer l’adresse GetMap signalée : force l’utilisation de l’adresse précisée dans le
champ URL ci-dessus.

Ignorer l’adresse
GetFeatureInfo

Ignorer l’adresse GetFeatureInfo signalée : force l’utilisation de l’adresse précisée
dans le champ URL ci-dessus.

Table OGC 1 : Paramètres de connexion à un serveur WMS

Si vous devez configurer un serveur proxy pour pouvoir recevoir des services WMS à partir d’Internet, vous
pouvez ajouter votre serveur proxy dans les options. Choisissez le menu Préférences → Options et cliquez sur

l’onglet Réseau. Vous pouvez alors ajouter votre configuration de proxy et l’activer en cochant la case Utiliser
un proxy pour l’accès Internet. Assurez-vous que vous avez sélectionné le type de proxy correct dans la liste

déroulante Type de proxy .

Une fois qu’une nouvelle connexion à un serveur WMS a été créée, elle sera sauvegardée pour les futures sessions
de QGIS.

Astuce: À propos des URL des serveurs WMS
Assurez-vous, lorsque vous entrez l’URL du serveur WMS, d’avoir uniquement l’URL de base. Par exemple,
vous ne devez pas avoir de paramètres tels que request=GetCapabilities ou version=1.0.0 dans
votre URL.
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Warning: Taper le nom utilisateur et le mot de passe dans l’onglet Authentification gardera les identifiants
non protégés dans la configuration de connexion. Ces identifiants seront visible si, par exemple, vous partagez
le fichier du projet avec quelqu’un. Il est donc recommandé de sauver vos identifiants dans une configuration
d’authentification (onglet configurations). Voir ref:authentication_index pour plus de détails.

Chargement des couches WMS/WMTS

Une fois que vous avez remplis les paramètres, vous pouvez utiliser le bouton [Connect] pour récupérer les
propriétés du serveur sélectionné. Cela inclut l’encodage des images, les couches, les styles de couches et les
projections. Étant donné qu’il s’agit d’une opération réseau, la vitesse de réponse dépend de la qualité de la
connexion réseau au serveur WMS. Lorsque les données sont téléchargées depuis le serveur WMS, la progression
du téléchargement est visible dans le coin inférieur gauche de la boîte de dialogue WMS.

Votre écran devrait maintenant ressembler à la figure_OGR_1, qui montre la réponse fournie par le serveur WMS
du Portail Européen du Sol.

Figure 14.2: Fenêtre d’ajout d’un serveur WMS, avec indication des couches disponibles

Format d’image

La section Format d’image liste les formats qui sont gérés à la fois par le client et leur serveur. Choisissez en
fonction de votre besoin de précision de l’image.

Astuce: Format d’image
Les serveurs WMS vous offriront typiquement le choix entre les formats d’image JPEG et PNG. Le JPEG est un
format de compression avec perte alors que le PNG reproduit fidèlement les données raster brutes.
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Utilisez le JPEG si vous vous attendez à ce que les données WMS soient de nature photographiques et/ou si vous
acceptez une perte de qualité dans l’image. Ce compromis réduit généralement de cinq fois le temps de transfert
des données par rapport au PNG.

Utilisez le PNG si vous voulez une représentation précise des données d’origine, et vous acceptez des temps de
transfert des données plus longs.

Options

La zone Options de la fenêtre dispose d’un champ textuel où vous pouvez saisir le Nom de la couche WMS. Ce
nom sera affiché dans la légende après le chargement de la couche.

Sous le nom de la couche vous pouvez définir la Taille de tuile (par exemple 256x256), si vous souhaitez diviser
la requête WMS en plusieurs requêtes.

Limite d’entité de GetFeatureInfo permet de définir quelles entités requêter sur le serveur.

Si vous sélectionnez un WMS depuis la liste, la projection par défaut, fournie par mapserver, apparaît. Si le bouton
[Modifications...] est actif, vous pouvez cliquer dessus pour changer cette projection par défaut pour une autre,
fournie par le serveur WMS.

Enfin, vous pouvez activer Utiliser la légende WMS contextuelle si le serveur WMS prend en charge cette
fonctionnalité. Sera alors affichée une légende adaptée aux éléments présents dans l’extension courante de la
carte, les éléments de légende qui correspondent à des éléments non affichés ne seront pas inclus dans la légende.

Ordre des couches

L’onglet Ordre des couches liste les couches sélectionnées disponibles pour le serveur WMS actuellement con-
necté. Certaines couches seront peut-être dépliables, cela signifie que différents styles sont disponibles pour cette
couche.

Vous pouvez sélectionner plusieurs couches à la fois, mais seulement un style d’image par couche. Lorsque
plusieurs couches sont sélectionnées, celles-ci seront combinées par le serveur WMS et transmises à QGIS en une
seule fois.

Astuce: Ordonner les couches WMS
Les couches WMS sont superposées par le serveur dans l’ordre listé dans la section Couches, du haut vers le bas.
Si vous souhaitez changer cet ordre, utilisez l’onglet Ordre des couches.

Transparence

Dans cette version de QGIS, le paramètre de Transparence globale de la fenêtre de Propriétés de la couche est
codé en dur pour être toujours activé, si disponible.

Astuce: Transparence des couches WMS
La disponibilité de la transparence de l’image WMS dépend du format d’image utilisé : les formats PNG et GIF
gèrent la transparence, tandis que le format JPEG ne le gère pas.

Système de Coordonnées de Référence

Un Système de Coordonnées de Référence de (SCR) est la terminologie de l’OGC pour désigner une projection
QGIS.

Chaque couche WMS peut être représentée dans plusieurs projections (ou SCR), en fonction des possibilités du
serveur WMS.

Pour choisir un SCR, cliquez sur le bouton [Modifications...] et une fenêtre similaire à la figure Projection 3 de
la section Utiliser les projections apparaîtra. La principale différence est qu’ici seules les projections gérées par le
serveur seront listées.
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Recherche de serveur

Dans QGIS vous pouvez rechercher directement des serveurs WMS. La figure Figure_OGC_2 montre l’onglet
Recherche de serveurs de la fenêtre Ajouter des couches d’un serveur.

Figure 14.3: Fenêtre de recherche de serveurs WMS à partir de mots clés

Comme vous pouvez le voir, il est possible d’entrer une chaîne de recherche dans un champ texte puis cliquez sur le
bouton [Chercher]. Après un court moment d’attente, le résultat de la recherche sera affiché sous le champ texte.
Parcourez la liste et inspectez les résultats de la recherche dans le tableau. Pour visualiser le résultat, sélectionnez
un serveur, cliquez sur le bouton [Ajoutez les lignes sélectionnées à la liste des serveurs WMS] et retournez
sur l’onglet Couches. QGIS a automatiquement mis à jour votre liste de serveur et les résultats sélectionnés de la
recherche sont déjà activés dans la liste des serveurs WMS sauvés. Vous n’avez plus qu’à interroger la liste des
couches en cliquant sur le bouton [Connecter]. Cette option est pratique quand vous voulez chercher des couches
par des mots clés spécifiques.

Fondamentalement cette option est un front end à l’API de http://geopole.org.

Jeux de Tuiles

Lorsque vous utilisez des services WMTS (WMS en cache) tel que:

http://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities

vous pouvez naviguer dans l’onglet Jeux de tuiles fourni par le serveur. Cette table liste d’autres informations
telles que la taille des tuiles, les formats et les SCR gérés. En combinaison avec cette fonctionnalité, vous pouvez
utiliser la jauge d’échelle de tuile en sélectionnant Paramètres → Panneaux (sous KDE) ou Vue → Panneaux
(Gnome, Windows et MacOSX) et en choisissant Echelle de tuile. Cela vous donne les échelles disponibles sur le
serveur de tuile avec une juage de sélection.
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Utiliser l’outil Identifier

Une fois que vous avez ajouté un serveur WMS et si une couche du serveur WMS est interrogeable, vous pouvez

utiliser l’outil Identifier pour sélectionner un pixel sur la carte. Une requête est envoyée au serveur WMS pour
chaque sélection effectuée. Les résultats de la requête sont renvoyés au format texte. Le formatage de ce texte
dépend du serveur WMS utilisé. Sélection du format

Si le serveur gère plusieurs formats de sortie, une liste déroulante des format gérés est automatiquement ajoutée à
la boîte de dialogue des résultats et le format sélectionné peut être stocké dans le fichier de projet pour la couche.
Support du format GML

L’outil d’identification gère les réponses des serveurs WMS (GetFeatureInfo) au format GML (intitulé Entité dans
l’interface graphique de QGIS). Si le format “Entité est géré par le serveur et qu’il est sélectionné, les résultats de
l’outil d’identification sont des entités vecteur, comme s’il s’agissait d’une couche vecteur normale. Lorsqu’une
seule entité est sélectionnée dans l’arbre, elle est mise en valeur dans la carte et elle peut être copié dans le presse-
papier et copiée dans une autre couche vecteur. Consultez l’exemple de gestion de GetFeatureInfor au format
GML pour UMN Mapserver ci-dessous.

# in layer METADATA add which fields should be included and define geometry (example):

"gml_include_items" "all"
"ows_geometries" "mygeom"
"ows_mygeom_type" "polygon"

# Then there are two possibilities/formats available, see a) and b):

# a) basic (output is generated by Mapserver and does not contain XSD)
# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "application/vnd.ogc.gml,text/html"

# b) using OGR (output is generated by OGR, it is send as multipart and contains XSD)
# in MAP define OUTPUTFORMAT (example):
OUTPUTFORMAT

NAME "OGRGML"
MIMETYPE "ogr/gml"
DRIVER "OGR/GML"
FORMATOPTION "FORM=multipart"

END

# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "OGRGML,text/html"

Visualiser les propriétés

Une fois que vous avez ajouté un serveur WMS, vous pouvez voir ses propriétés en faisant un clic-droit sur la
couche dans la légende et en sélectionnant Propriétés. Onglet Métadonnées

L’onglet Métadonnées affiche la richesse des informations du serveur WMS, généralement collectées à partir de
la requête capabilities renvoyée par le serveur. Beaucoup de définitions peuvent être obtenues par la lecture des
normes WMS (voir OPEN-GEOSPATIAL-CONSORTIUM Bibliographie), mais en voici quelques-unes :

• Propriétés du serveur

– Version du WMS — La version de WMS gérée par le serveur.

– Formats d’image — La liste des types MIME que le serveur peut renvoyer lors qu’il dessine la carte.
QGIS gère tous les formats pour lesquelles la bibliothèque Qt en sous-couche a été compilée, qui sont
à minima les types image/png et image/jpeg.

– Formats de l’outil Identitier — La liste des types MIME auxquels le serveur peut répondre quand
vous utilisez l’outil Identifier. Pour l’instant QGIS gère le type text-plain.

• Propriétés de la couche
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– Selectionnée — Si la couche a été sélectionnée quand le serveur correspondant a été ajouté au projet.

– Visible — Si cette couche a été sélectionnée comme visible dans la légende (pas encore utilisé dans
cette version de QGIS).

– Peut identifier — Si cette couche retournera des résultats quand l’outil Identifier est utilisé sur celle-ci.

– Peut être transparente — Si cette couche peut être rendue avec une transparence. Cette version de
QGIS utilisera toujours la transparence si cette option est à Oui et que le format d’image gère la
transparence.

– Peut zoomer — Si on peut zoomer sur cette couche avec le serveur. Cette version de QGIS suppose
que toutes les couches WMS ont ce paramètre défini à Oui. Les couches déficientes seront peut-être
rendues d’une manière étrange.

– Décompte des cascades — Les serveurs WMS peuvent agir comme un proxy à d’autres serveurs
WMS pour obtenir des données pour une couche. Cette entrée affiche le nombre de fois où la requête
pour cette couche est redirigée vers un autre serveur WMS pour obtenir un résultat.

– Largeur fixe, hauteur fixe — Si les pixels sources d’une couche ont des dimensions fixes. Cette ver-
sion de QGIS suppose que toutes les couches WMS ont ce paramètre non fixé. Les couches déficientes
seront peut-être rendues d’une manière étrange.

– Emprise en WGS 84 — La limite du contour de la couche, en coordonnées WGS 84. Certains
serveurs WMS ne définissent pas ceci correctement (par exemple, des coordonnées UTM sont util-
isées à la place). Si cela est le cas, alors la vue initiale sera rendue avec une vue très étendue. Le
webmaster du WMS doit être informé de cette erreur sur ce paramètre qui est certainement connu
en tant qu’éléments XML du WMS LatLonBoundingBox, EX_GeographicBoundingBox ou
the CRS:84 BoundingBox.

– Disponibilité des SCR — Les projections que l’on peut utiliser via le serveur WMS. Elles sont listées
dans le format natif du WMS.

– Disponibilité des styles — Les styles d’images que le serveur WMS peut utiliser pour le rendu de
cette couche.

Affiche la légende WMS dans la légende et dans le composeur

Le fournisseur de données WMS de QGIS est capable d’afficher un graphique de légende dans la liste des couches
ainsi que dans le composeur de cartes. La légende WMS sera affichée uniquement si le serveur dipose de l’option
GetLegendGraphic et si la couche dispose de l’url getCapability pour que vous puissiez choisir un style popur
cette couche.

Si une légende graphique est disponible, elle est affichée sous la couche. Elle est de faible taille et vous devez
cliquer dessus pour l’afficher complètement (dû à une limite d’architecture de QgsLegendInterface). Cliquer sur
la légende de la couche ouvrira une fenêtre avec la légende en pleine résolution.

Dans le composeur de cartes, la légende sera intégrée à sa dimension originale (téléchargement). La résolution de
la légende graphique peut être paramétrée dans les propriétés de l’objet sous Légende -> Graphique de légende
WMS pour correspondre à vos besoins d’impression.

La légende affichera une information contextuelle basée sur l’échelle courante. La légende WMS sera affichée
uniquement si le serveur WMS dispose de la fonction GetLegendGraphic et si la couche dispose d’une url getCa-
pability pour pouvoir choisir son style.

Limitations du client WMS

Toutes les fonctionnalités d’un client WMS n’ont pas été intégrées dans cette version de QGIS. Les exceptions les
plus notables sont présentées ci-après.

Éditer la configuration d’une couche WMS
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Une fois que vous avez complété la procédure d’ Ajout de couches WMS, il n’y aucun moyen de modifier la config-
uration. Une solution de contournement consiste à supprimer la couche et recommencer.

Serveurs WMS nécessitant une authentification

Actuellement les serveurs WMS publics et sécurisés sont gérés. Les serveurs sécurisés sont accessibles via authen-
tification publique. Vous pouvez ajouter ces informations d’authentification (optionnelles) au moment de l’ajout
d’un serveur WMS. Voir la section Sélection des serveurs WMS/WMTS pour les détails.

Astuce: Accéder à des couches OGC sécurisées
Si vous avez besoin d’accéder à des couches sécurisées avec des méthodes sécurisées autres que la sim-
ple authentification, vous pouvez utiliser InteProxy comme proxy transparent, qui gère plusieurs méthodes
d’authentification. Vous pouvez trouver plus d’informations dans le manuel d’InteProxy que vous trouverez sur le
site http://inteproxy.wald.intevation.org.

Astuce: QGIS WMS Mapserver
Depuis la version 1.7.0, QGIS possède sa propre implémentation d’un Mapserver WMS 1.3.0. Référez vous à
QGIS comme serveur de données OGC pour en savoir plus.

14.1.2 Client WCS

Un service Web Coverage (WCS) fournit un accès à des données raster sous une forme qui permet le rendu
côté client, comme une entrée vers des modèles scientifiques. WCS peut être comparé à WFS et WMS. Comme ces
services, WCS permet aux clients de choisir des portions de données issues du serveur basées sur des contraîntes
spatiales et d’autres critères de recherche.

QGIS dispose d’un fournisseur WCS natif qui gère les version 1.0 et 1.1 (qui sont significativement différentes)
mais la version 1.0 est privilégiée car la version 1.1 pose beaucoup de problèmes (chaque serveur l’implémente
de manière différente avec beaucoup de particularités).

Le fournisseur WCS natif gère l’ensemble des requêtes réseau et utilise les paramètres réseau de QGIS (partic-
ulièrement le proxy). Il est également possible d’utiliser un mode cache (‘toujours en cache’, ‘préférer le cache’,
‘préférer le réseau’, ‘toujours le réseau’) et le fournisseur gère également la sélection dans le temps si un domaine
de temps est fourni par le serveur.

Warning: Taper le nom utilisateur et le mot de passe dans l’onglet Authentification gardera les identifiants
non protégés dans la configuration de connexion. Ces identifiants seront visible si, par exemple, vous partagez
le fichier du projet avec quelqu’un. Il est donc recommandé de sauver vos identifiants dans une configuration
d’authentification (onglet configurations). Voir ref:authentication_index pour plus de détails.

14.1.3 Client WFS et WFS-T

Dans QGIS, une couche WFS se comporte à peu près comme n’importe quelle autre couche vecteur. Vous pouvez
identifier et sélectionner des objets et voir la table attributaire. Depuis QGIS 1.6, l’édition (WFS-T) est prise en
charge si le serveur le propose.

Dans l’ensemble, l’ajout d’une couche WFS suit une procédure très similaire à celle des couches WMS. La
différence est qu’il n’y a pas de serveur défini par défaut, nous allons donc devoir en ajouter un.

Charger une couche WFS

Pour notre exemple nous utiliserons le serveur WFS de DM Solutions et afficherons une couche. L’URL est :
http://www2.dmsolutions.ca/cgi-bin/mswfs_gmap

1. Cliquez sur le bouton Ajouter une couche WFS de la barre d’outils Couches. La fenêtre Ajouter une couche
WFS d’un serveur apparaît.
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2. Cliquez sur [Nouveau].

3. Entrez ‘DM Solutions’ pour le nom.

4. Entrez l’URL (voir ci-dessus).

5. Cliquez sur le bouton [OK].

6. Choisisez ‘Solutions DM’ depuis la liste déroulante Connexions Serveur.

7. Cliquez sur [Connexion].

8. Attendez que la liste des couches soit complète.

9. Cliquez sur la couche Parks dans la liste.

10. Cliquez sur [Appliquer] pour ajouter la couche à la carte.

Il est à noter que tous paramètres de proxy que vous auriez renseignés dans vos options sont également reconnus.

Warning: Taper le nom utilisateur et le mot de passe dans l’onglet Authentification gardera les identifiants
non protégés dans la configuration de connexion. Ces identifiants seront visible si, par exemple, vous partagez
le fichier du projet avec quelqu’un. Il est donc recommandé de sauver vos identifiants dans une configuration
d’authentification (onglet configurations). Voir ref:authentication_index pour plus de détails.

Figure 14.4: Ajout d’une couche WFS

Vous remarquerez que la progression du téléchargement est affichée en bas à gauche de la fenêtre principale
de QGIS. Une fois que la couche est chargée, vous pouvez identifier et sélectionner une ou deux provinces et
visualiser la table d’attributs.

Seul le WFS 1.0.0 est géré. Pour le moment il n’y a pas eu de test pour les autres versions des services WFS des
serveurs WFS. Si vous rencontrez des problèmes avec d’autres serveurs WFS, n’hésitez pas à contacter l’équipe
de développement. Référez-vous à la section Aide et support pour plus d’informations sur les listes de diffusions.

Astuce: Trouver des serveurs WFS
Vous trouverez d’autres serveurs WFS en cherchant dans votre moteur de recherche favori. Il existe de nombreuses
listes d’URL publiques, plus ou moins à jour.
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14.2 QGIS comme serveur de données OGC

QGIS Server est une implémentation open source WMS 1.3, WFS 1.0.0 et WCS 11.1.1, qui en plus, propose des
fonctionnalités cartographiques avancées pour le rendu thématique. QGIS Server est une application FastCGI/CGI
(Common Gateway Interface) écrite en C++ qui fonctionne avec un serveur web (tel que Apache, Lighttpd). Il
dispose d’une extension Python qui autorise un développement rapide et efficace et un déploiement de nouvelles
fonctionnalités. Il a été financé au départ par les projets de l’UE Orchestra, Sany et la ville d’Uster en Suisse.

QGIS Server utilise QGIS comme backend pour la logique des couches SIG et le rendu cartographique. La
bibliothèque Qt est utilisée pour l’interface et la programmation multiplateforme en C++. À la différence des
autres serveurs WMS, le Serveur QGIS utilise les règles de cartographie comme langage de configuration, à la
fois pour la configuration du serveur et pour les règles cartographiques définie par l’utilisateur.

Etant donné que QGIS Desktop et QGIS Server utilisent les mêmes bibliothèques de visualisation, les cartes
publiées sur le web ont le même aspect que sous le SIG Desktop.

Dans les sections qui suivent vous trouverez les instructions d’installation de QGIS Server sur Linux De-
bian/Ubuntu. Pour d’autres plateformes ou distributions, nous vous recommandons les contributions d’utilisateurs
accessibles aux adresses suivantes :

• http://hub.qgis.org/projects/quantum-gis/wiki/QGIS_Server_Tutorial

• http://linfiniti.com/2010/08/qgis-mapserver-a-wms-server-for-the-masses/

• http://www.itopen.it/qgis-server-python-plugins-ubuntu-setup/

14.2.1 Installation de QGIS Server sur Debian/Ubuntu

A ce stade, nous donnerons une courte et simple procédure d’installation pour une configuration de travail mini-
male utilisant Apache 2 sur Debian Squeeze (avec quelques variations mineures pour Ubuntu 14.04). De nombreux
autres OS proposent aussi des paquets pour QGIS Server. Si vous devez les compiler depuis la source, merci de
vous référez aux URL ci-dessus.

Premièrement, ajoutez le dépôt SIG Debian suivant :

$ cat /etc/apt/sources.list.d/debian-gis.list
deb http://qgis.org/debian trusty main
deb-src http://qgis.org/debian trusty main

$ # Add keys
$ sudo gpg --keyserver keyserver.ubuntu.com --recv-key 3FF5FFCAD71472C4
$ sudo gpg --export --armor 3FF5FFCAD71472C4 | sudo apt-key add -

$ # Update package list
$ sudo apt-get update && sudo apt-get upgrade

Maintenant, installez QGIS Server :

$ sudo apt-get install qgis-server python-qgis

Installez par exemple l’extension HelloWorld pour tester les serveurs. Créez un répertoire pour accueillir les
extensions serveur. Cela sera spécifié dans la configuration de l’hôte virtuel et passé au serveur par le biais d’une
variable d’environnement :

$ sudo mkdir -p /opt/qgis-server/plugins
$ cd /opt/qgis-server/plugins
$ sudo wget https://github.com/elpaso/qgis-helloserver/archive/master.zip
$ # In case unzip was not installed before:
$ sudo apt-get install unzip
$ sudo unzip master.zip
$ sudo mv qgis-helloserver-master HelloServer
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Installez le serveur Apache dans un hôte virtuel séparé sur le port 80. Activez le module rewrite pour transmettre
les entêtes HTTP BASIC auth.

$ sudo a2enmod rewrite
$ cat /etc/apache2/conf-available/qgis-server-port.conf
Listen 80
$ sudo a2enconf qgis-server-port

Voici la configuration de l’hôte virtuel, stocké dans /etc/apache2/sites-available/001-qgis-server.conf
:

<VirtualHost *:80>
ServerAdmin webmaster@localhost
DocumentRoot /var/www/html

ErrorLog ${APACHE_LOG_DIR}/qgis-server-error.log
CustomLog ${APACHE_LOG_DIR}/qgis-server-access.log combined

# Longer timeout for WPS... default = 40
FcgidIOTimeout 120
FcgidInitialEnv LC_ALL "en_US.UTF-8"
FcgidInitialEnv PYTHONIOENCODING UTF-8
FcgidInitialEnv LANG "en_US.UTF-8"
FcgidInitialEnv QGIS_DEBUG 1
FcgidInitialEnv QGIS_SERVER_LOG_FILE /tmp/qgis-000.log
FcgidInitialEnv QGIS_SERVER_LOG_LEVEL 0
FcgidInitialEnv QGIS_PLUGINPATH "/opt/qgis-server/plugins"

# Needed for QGIS HelloServer plugin HTTP BASIC auth
<IfModule mod_fcgid.c>

RewriteEngine on
RewriteCond %{HTTP:Authorization} .
RewriteRule .* - [E=HTTP_AUTHORIZATION:%{HTTP:Authorization}]

</IfModule>

ScriptAlias /cgi-bin/ /usr/lib/cgi-bin/
<Directory "/usr/lib/cgi-bin">

AllowOverride All
Options +ExecCGI -MultiViews +FollowSymLinks
# for apache2 > 2.4
Require all granted
#Allow from all

</Directory>
</VirtualHost>

Maintenant activez l’hôte virtuel et redémarrer Apache :

$ sudo a2ensite 001-qgis-server
$ sudo service apache2 restart

Testez le serveur avec l’extension HelloWorld :

$ wget -q -O - "http://localhost/cgi-bin/qgis_mapserv.fcgi?SERVICE=HELLO"
HelloServer!

Vous pouvez avoir un aperçu des GetCapabilities de QGIS server ici :
http://localhost/cgi-bin/qgis_mapserv.fcgi?SERVICE=WMS&VERSION=1.3.0&REQUEST=GetCapabilities

Astuce: Si vous travaillez avec une entité qui a beaucoup de nœuds alors la modification ou l’ajout d’une nouvelle
entité échouera. Dans ce cas, il est possible d’insérer le code suivant dans le fichier 001-qgis-server.conf
file:

<IfModule mod_fcgid.c>
FcgidMaxRequestLen 26214400
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FcgidConnectTimeout 60
</IfModule>

14.2.2 Créer un serveur WMS / WFS depuis un projet QGIS

Pour fournir un nouveau service WMS, WFS ou WCS avec QGIS Server, nous devons créer un fichier de projet
QGIS avec quelques données. Ici nous utilisons le fichier shape ‘Alaska’ provenant du jeu de données d’exemple
de QGIS. Il faut également définir les couleurs et les styles des couches dans QGIS et le SRS du projet si ils ne
sont pas déjà définis.

Figure 14.5: Définitions pour un projet WMS/WFS/WCS de QGIS Server

Ensuite allez dans le menu Serveur OWS de la boîte de dialogue Projet → Propriétés du projet et indiquez les
informations sur OWS dans les champs dans Informations générale du service. Elles apparaitront dans la réponse

GetCapabilities des services WMS, WFS et WCS. Si vous n’avez pas coché les Informations générale du
service, QGIS Server utilisera les informations fournies par le fichier wms_metadata.xml disponible dans le
répertoire cgi-bin.

Warning: If you’re using the QGIS project with styling based on SVG files using relative paths then you
should know that the server considers the path relative to its qgis_mapserv.fcgi file (not to the qgs file). So, if
you deploy a project on the server and the SVG files are not placed accordingly, the output images may not
respect the Desktop styling. To ensure this doesn’t happen, you can simply copy the SVG files relative to the
qgis_mapserv.fcgi. You can also create a symbolic link in the directory where the fcgi file resides that points
to the directory containing the SVG files (on Linux/Unix).
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Capacités WMS

Dans la section Capacités WMS, vous pouvez définir l’emprise affichée de la réponse WMS GetCapabilities en
saisissant les valeurs X/Y minimum et maximum dans les champs de Emprise annoncée. En cliquant sur Utiliser
l’emprise actuelle du canevas, ces valeurs sont paramétrées pour utiliser celles du canevas de carte de QGIS. En

cliquant sur Restreindre les SCR, vous pouvez restreindre la liste des systèmes de référence de coordonnées

(SCR) que QGIS Server renvoie. Utilisez le bouton pour sélectionner ces SCR depuis le sélecteur de Système
de Coordonnées de Référence ou cliquez sur Utilisé pour ajouter le SCR utilisé dans le projet QGIS à la liste.

Si vous avez défini des composeurs d’impression dans votre projet, ils seront listés dans la réponse GetProjectSet-
tings et pourront être utilisés par la requête GetPrint pour créer des impressions, une des mises en page servant de
modèle. Ceci est une extension propre à QGIS de la norme WMS 1.3.0. Si vous souhaitez exclure un composeur

de la publication par WMS, cochez Exclure des composeurs et cliquez le bouton en dessous. Sélectionnez
ensuite un composeur depuis la boîte de dialogue Selection de composeur d’impression afin de l’ajouter à la liste
des composeurs exclus.

Si vous désirez exclure une couche ou un groupe de couches de la publication WMS, cochez Exclure des

couches et cliquez sur le bouton dessous. Cela ouvre une boîte de dialogue Sélection de couches et de groupes
spécifiques qui vous permet de choisir les couches et les groupes qui ne seront pas publiés. Utilisez les touches
Shift ou Ctrl pour choisir plusieurs entrées.

Vous pouvez recevoir la réponse GetFeatureInfo en texte simple, XML et GML. Le format par défaut est le XML.
Le texte simple et le GML dépendent du format de sortie choisi lors de la requête GetFeatureInfo.

Si vous le désirez, vous pouvez cocher Ajouter la géométrie de l’entité à la réponse. Cela permettra à la
réponse GetFeatureInfo de renvoyer les géométries des entités dans un format texte. Si vous voulez que QGIS
Server annonce une URL pour les requêtes spécifiques dans la réponse WMS GetCapabilities, ajoutez l’URL dans
le champ URL publiée. De plus, vous pouvez restreindre la taille maximale des cartes renvoyées par la requête
GetMap en indiquant une longueur et une largeur maximales dans les champs de la section Maximums pour la
requête GetMap.

Si une de vos couches utilise l’affichage d’indication de carte (pour afficher du texte issu d’expressions), cette
dernière sera listée au sein de la sortie GetFeatureInfo. Si la couche utilise une Valeur Relationnelle pour un de
ses attributs, cette information sera également renvoyée par la sortie de GetFeatureInfo.

QGIS supporte les requêtes WMS serveur suivantes :

• GetCapabilities

• GetMap

• GetFeatureInfo

• GetLegendGraphic (SLD profile)

• DescribeLayer (SLD profile)

• GetStyles (custom QGIS profile)

Capacités WFS

Dans la partie Capacités WFS, vous pouvez sélectionner les couches qui vous voulez publier en WFS et indiquer
si elle permettent les opérations de mise à jour, d’insertion et de suppression. Si vous ajoutez une URL dans
le champ URL publiée des Capacités WFS, QGIS Server annoncera cette URL spécifique dans la réponse WFS
GetCapabilities.

QGIS supporte les requêtes WFS serveur suivantes :

• GetCapabilities

• DescribeFeatureType

• GetFeature
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• Transaction

Capacités WMS

Dans la partie Capacités WCS, vous pouvez sélectionner les couches qui vous voulez publier en WCS. Si vous
indiquez une URL dans le champ URL publiée de la section Capacités WCS, QGIS Server annoncera cette URL
spécifique dans la réponse WCS GetCapabilities.

Maintenant, sauvegarder la session dans un fichier de projet alaska.qgs. Pour founir le projet en WMS/WFS,
nous créons un nouveau répertoire /usr/lib/cgi-bin/project avec des provlèges d’administrateur et
nous ajoutons le fichier de projet alaska.qgs ainsi qu’une copie du fichier qgis_mapserv.fcgi. C’est
tout !

Nous pouvons maintenant tester notre projet WMS, WFS et WCS. Ajoutez les WMS, WFS et WCS dans QGIS
tel que décrit dans Chargement des couches WMS/WMTS, Client WFS et WFS-T et Client WCS et chargez les
données. L’URL est la suivante :

http://localhost/cgi-bin/project/qgis_mapserv.fcgi

QGIS supporte les requêtes WCS serveur suivantes :

• GetCapabilities

• DescribeCoverage

• GetCoverage

GetCapabilities Caching

In order to improve response time, QGIS Server caches the responses to the GetCapabilities requests.
When such a request comes, QGIS Server is caching the response and marking the cache valid. At the same time,
it watches if the project file changes. If the project is changed then the cache is marked as invalid and QGIS Server
waits for a new request in order to recreate the cache.

Bien configurer votre OWS

Pour les couches vectorielles, le menu Champs de la fenêtre Couche → Propriétés vous permet de définir quels
attributs seront publiés. Par défaut, tous les attributs sont publiés par votre WMS et WFS. Si vous souhaitez ne
pas publier un attribut donné, décochez la case correspondante sous la colonne WMS ou WFS.

Vous pouvez superposer en filigrane, sur les cartes produites par votre WMS, des annotations de texte ou de
SVG dans le fichier de projet. Voir la section sur les outils d’annotation dans Outils généraux pour obtenir des
instructions sur la création d’annotations. Pour afficher les annotations en filigrane sur la sortie WMS, la case à
cocher Figer la position de la carte de la fenêtre Annotation de texte doit être décochée. Cette fenêtre est accessible
en double-cliquant sur l’annotation alors qu’un des outils d’annotation est actif. Pour les annotations SVG, vous
devrez soit configurer le projet pour sauvegarder les chemins absolus (dans l’onglet Général de la fenêtre du menu
Projet→ Propriétés du projet) ou modifier manuellement le chemin d’accès à l’image SVG de façon à ce qu’il
représente un chemin d’accès relatif valide.

14.2.3 Server configuration and supported parameters

QGIS Server supports some vendor parameters and requests that greatly enhance the possibilities of customising
its behavior. The following paragraphs list the vendor parameters and the environment variables supported by the
server.
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Paramètres additionnels supportés par tout type de requête

• FILE_NAME parameter: if set, the server response will be sent to the client as a file attachment with the
specified file name.

• Paramètre MAP: Comme avec MapServer, le paramètre MAP peut être utilisé pour spécifier le chemin vers
le fichier projet QGIS. Vous pouvez indiquer un chemin absolu ou un chemin relatif à l’emplacement de
l’exécutable du serveur (qgis_mapserv.fcgi). Si aucun chemin n’est indiqué, QGIS Server recherche
les fichiers .qgs dans le dossier de son exécutable.

Exemple:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&MAP=/home/qgis/mymap.qgs&...

Note: You can define a QGIS_PROJECT_FILE as an environment variable to tell the server executable where
to find the QGIS project file. This variable will be the location where QGIS will look for the project file. If not
defined it will use the MAP parameter in the request and finally look at the server executable directory.

Paramètres additionnels supportés par la requête WMS GetMap

In the WMS GetMap request, QGIS Server accepts a couple of extra parameters in addition to the standard
parameters according to the OGC WMS 1.3.0 specification:

• Paramètre DPI : Le paramètre DPI peut être utilisé pour spécifier la résolution de sortie.

Exemple:

http://localhost/cgi-bin/qgis_mapserv.fcgi?REQUEST=GetMap&DPI=300&...

• Paramètre OPACITIES : L’opacité peut être définie sur la couche ou le groupe de couches. Les valeurs
possibles vont de 0 (transparence totale) à 255 (complètement opaque).

Exemple:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&LAYERS=mylayer1,mylayer2&OPACITIES=125,200&...

• FILTER parameter: (Available in QGIS 1.8 and above). Subsets of layers can be selected with the
FILTER parameter. Syntax is basically the same as for the QGIS subset string. However, there
are some restrictions to avoid SQL injections into databases via QGIS server:

Text strings need to be enclosed with quotes (single quotes for strings, double quotes for attributes)
A space between each word / special character is mandatory. Allowed Keywords and special char-
acters are ‘AND’,’OR’,’IN’,’=’,’<’,’>=’, ‘>’,’>=’,’!=*,’(‘,’)’. Semicolons in string expressions are not
allowed

Exemple:

http://myserver.com/cgi/qgis_mapserv.fcgi?REQUEST=GetMap&LAYERS=mylayer1,mylayer2&FILTER=mylayer1:"OBJECTID" = 3;mylayer2:’text’ = ’blabla’&....

Note: It is possible to make attribute searches via GetFeatureInfo and omit the X/Y parameter if a FILTER is
there. QGIS server then returns info about the matching features and generates a combined bounding box in the
xml output.

• SELECTION parameter: (Available in QGIS 1.8 and above) Vector features can be selected by passing
comma separated lists with feature ids in GetMap and GetPrint.

Exemple:

http://myserver.com/cgi/qgis_mapserv.fcgi?REQUEST=GetMap&LAYERS=mylayer1,mylayer2&SELECTION=mylayer1:3,6,9;mylayer2:1,5,6&...
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Paramètres additionnels supportés par la requête WMS GetFeatureInfo

QGIS Server WMS GetFeatureInfo requests supports the following extra optional parameters to define the toler-
ance for point, line and polygon layers:

• FI_POINT_TOLERANCE parameter: Tolerance for point layers GetFeatureInfo request, in pixels.

• FI_LINE_TOLERANCE parameter: Tolerance for linestring layers GetFeatureInfo request, in pixels.

• FI_POLYGON_TOLERANCE parameter: Tolerance for polygon layers GetFeatureInfo request, in pixels.

Requête GetPrint

QGIS server has the capability to create print composer output in pdf or pixel format. Print composer windows
in the published project are used as templates. In the GetPrint request, the client has the possibility to specify
parameters of the contained composer maps and labels.

Exemple :

The published project has two composer maps. In the GetProjectSettings response, they are listed as possible print
templates:

<WMS_Capabilities>
...
<ComposerTemplates xsi:type="wms:_ExtendedCapabilities">
<ComposerTemplate width="297" height="210" name="Druckzusammenstellung 1">
<ComposerMap width="171" height="133" name="map0"/>
<ComposerMap width="49" height="46" name="map1"/></ComposerTemplate>
</ComposerTemplates>
...
</WMS_Capabilities>

The client has now the information to request a print output:

http://myserver.com/cgi/qgis_mapserv.fcgi?...&REQUEST=GetPrint&TEMPLATE=Druckzusammenstellung 1&map0:EXTENT=xmin,ymin,xmax,ymax&map0:ROTATION=45&FORMAT=pdf&DPI=300

Parameters in the GetPrint request are:

• <map_id>:EXTENT gives the extent for a composer map as xmin,ymin,xmax,ymax.

• <map_id>:ROTATION map rotation in degrees

• <map_id>:GRID_INTERVAL_X, <map_id>:GRID_INTERVAL_Y Grid line density for a composer
map in x- and y-direction

• <map_id>:SCALE Sets a mapscale to a composer map. This is useful to ensure scale based visibility of
layers and labels even if client and server may have different algorithms to calculate the scale denominator

• <map_id>:LAYERS, <map_id>:STYLES possibility to give layer and styles list for composer map (use-
ful in case of overview maps which should have only a subset of layers)

Requête GetLegendGraphics

Several additional parameters are available to change the size of the legend elements:

• BOXSPACE space between legend frame and content (mm)

• LAYERSPACE versical space between layers (mm)

• LAYERTITLESPACE vertical space between layer title and items following (mm)

• SYMBOLSPACE vertical space between symbol and item following (mm)

• ICONLABELSPACE horizontal space between symbol and label text (mm)

• SYMBOLWIDTH width of the symbol preview (mm)
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• SYMBOLHEIGHT height of the symbol preview (mm)

These parameters change the font properties for layer titles and item labels:

• LAYERFONTFAMILY / ITEMFONTFAMILY font family for layer title / item text

• LAYERFONTBOLD / ITEMFONTBOLD ‘TRUE’ to use a bold font

• LAYERFONTSIZE / ITEMFONTSIZE Font size in point

• LAYERFONTITALIC / ITEMFONTITALIC ‘TRUE’ to use italic font

• LAYERFONTCOLOR / ITEMFONTCOLOR Hex color code (e.g. #FF0000 for red)

• LAYERTITLE / RULELABEL (from QGIS 2.4) set them to ‘FALSE’ to get only the legend graphics
without labels

Contest based legend. These parameters let the client request a legend showing only the symbols for the features
falling into the requested area:

• BBOX the geographical area for which the legend should be built

• CRS / SRS the coordinate reference system adopted to define the BBOX coordinates

• WIDTH / HEIGHT if set these should match those defined for the GetMap request, to let QGIS Server
scale symbols according to the map view image size.

Contest based legend features are based on the UMN MapServer implementation:

Requête GetProjectSettings

This request type works similar to GetCapabilities, but it is more specific to QGIS Server and allows a client to
read additional information which is not available in the GetCapabilities output:

• initial visibility of layers

• information about vector attributes and their edit types

• information about layer order and drawing order

• liste des couches publiées en WFS

Export DXF

It is possible to export layers in the DXF format using the GetMap Request. Only layers that have read access in
the WFS service are exported in the DXF format. Here is a valid REQUEST and a documentation of the available
parameters:

http://your.server.address/wms/liegenschaftsentwaesserung/abwasser_werkplan?SERVICE=WMS&VERSION=1.3.0&REQUEST=GetMap&LAYERS=Haltungen,Normschacht,Spezialbauwerke&STYLES=&CRS=EPSG%3A21781&BBOX=696136.28844801,245797.12108743,696318.91114315,245939.25832905&WIDTH=1042&HEIGHT=811&FORMAT=application/dxf&FORMAT_OPTIONS=MODE:SYMBOLLAYERSYMBOLOGY;SCALE:250&FILE_NAME=werkplan_abwasser.dxf

Paramètres :

• FORMAT=application/dxf

• FILE_NAME=yoursuggested_file_name_for_download.dxf

• FORMAT_OPTIONS=see options below, key:value pairs separated by Semicolon

FORMAT_OPTIONS Parameters:

• SCALE:scale to be used for symbology rules, filters and styles (not an actual scaling of the data - data
remains in the original scale).

• MODE:NOSYMBOLOGY|FEATURESYMBOLOGY|SYMBOLLAYERSYMBOLOGY corresponds
to the three export options offered in the QGIS Desktop DXF export dialog.

• LAYERSATTRIBUTES:yourcolumn_with_values_to_be_used_for_dxf_layernames - if not specified,
the original QGIS layer names are used.
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• USE_TITLE_AS_LAYERNAME if enabled, the title of the layer will be used as layer name.

Paramètres additionnels supportés par la requête WFS GetFeature

In the WFS GetFeature request, QGIS Server accepts two extra parameters in addition to the standard parameters
according to the OGC WFS 1.0.0 specification:

• GeometryName parameter: this parameter can be used to get the extent or the centroid as the geometry or
no geometry if none if used (ie attribute only). Allowed values are extent, centroid or none.

• StartIndex parameter: STARTINDEX is standard in WFS 2.0, but it’s an extension for WFS 1.0.0 which
is the only version implemented in QGIS Server. STARTINDEX can be used to skip some features in the
result set and in combination with MAXFEATURES will provide for the ability to use WFS GetFeature to
page through results. Note that STARTINDEX=0 means start with the first feature, skipping none.

QGIS Server logging

Pour enregistrer les requêtes envoyées au serveur, paramétrez les variables d’environnement suivantes :

• QGIS_SERVER_LOG_FILE : indique le chemin et le nom de fichier du journal. Assurez-vous que le
serveur dispose des permissions adaptées pour écrire dans le fichier. Le fichier est créé automatiquement
lors de l’envoi de requêtes vers le serveur. S’il n’existe pas, vérifiez les permissions.

• GIS_SERVER_LOG_LEVEL: indique le niveau de journalisation désiré. Les valeurs disponibles sont les
suivantes:

– 0 INFO (journalise toutes les requêtes),

– 1 WARNING,

– 2 CRITICAL (journalise uniquement les erreurs critiques, adapté à un fonctionnement en production).

Exemple:

SetEnv QGIS_SERVER_LOG_FILE /var/tmp/qgislog.txt
SetEnv QGIS_SERVER_LOG_LEVEL 0

Note:
• Lorsque vous utilisez le module Fcgid, utilisez la clause FcgidInitialEnv à la place de SetEnv !

• La journalisation du serveur est également activée si l’éexécutable est compilé en mode publication.

Nom court pour les couches, les groupes et le projet

A number of elements have both a <Name> and a <Title>. The Name is a text string used for machine-to-
machine communication while the Title is for the benefit of humans.

For example, a dataset might have the descriptive Title “Maximum Atmospheric Temperature” and be requested
using the abbreviated Name “ATMAX”. User can already set title for layers, groups and project.

OWS name is based on the name used in layer tree. This name is more a label for humans than a name for
machine-to-machine communication.

QGIS Server gère :

• l’édition de nom courts dans les propriétés des couches

• WMS data dialog to layer tree group (short name, title, abstract) By right clicking on a layer group and
selecting the Set Group WMS data option you will get:

• l’édition de nom court dans les propriétés du projet et l’ajout d’un validateur d’expressions régulières
"^[A-Za-z][A-Za-z0-9\._-]*" pour les éditions de noms courts (via une méthode statique)
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• l’ajout d’un validateur de fonction rationnelles "^[A-Za-z][A-Za-z0-9\._-]*" pour les éditions de
noms courts (via une méthode statique)

• l’ajout d’un élément TreeName dans les propriétés du projet (fullProjectSettings)

Si un nom court a été utilisé pour des couches, des groupes et pour le projet, il sera utilisé par QGIS Server pour
définir le nom de la couche.

Connection to service file

In order to make apache aware of the PostgreSQL service file (see the Service connection file section) you need to
make your *.conf file look like:

SetEnv PGSERVICEFILE /home/web/.pg_service.conf

<Directory "/home/web/apps2/bin/">
AllowOverride None

.....

Add fonts to your linux server

Keep in mind that you may use QGIS projects that point to fonts that may not exist by default on other machines.
This means that if you share the project, it may look different on other machines (if the fonts don’t exist on the
target machine).

In order to ensure this does not happen you just need to install the missing fonts on the target machine. Doing this
on desktop systems is usually trivial (double clicking the fonts).

For linux, if you don’t have a desktop environment installed (or you prefer the command line) you need to:

• On Debian based systems:

sudo su
mkdir -p /usr/local/share/fonts/truetype/myfonts && cd /usr/local/share/fonts/truetype/myfonts

# copy the fonts from their location
cp /fonts_location/* .

chown root *
cd .. && fc-cache -f -v
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• On Fedora based systems:

sudo su
mkdir /usr/share/fonts/myfonts && cd /usr/share/fonts/myfonts

# copy the fonts from their location
cp /fonts_location/* .

chown root *
cd .. && fc-cache -f -v

Variables d’environnement

You can configure some aspects of QGIS server by setting environment variables. For example, to set QGIS
server on Apache to use /path/to/config/QGIS/QGIS2.ini settings file, add to Apache config:

SetEnv QGIS_OPTIONS_PATH "/path/to/config/"

or, if using fcgi:

FcgidInitialEnv QGIS_OPTIONS_PATH "/path/to/config/"

This is a list of the variables supported by QGIS server:

• QGIS_OPTIONS_PATH: Specifies the path to the directory with settings. It works the
same way as QGIS application –optionspath option. It is looking for settings file in
<QGIS_OPTIONS_PATH>/QGIS/QGIS2.ini.

• QUERY_STRING: The query string, normally passed by the web server. This variable can be useful while
testing QGIS server binary from the command line.

• QGIS_PROJECT_FILE: the .qgs project file, normally passed as a parameter in the query string, you can
also set it as an environment variable (for example by using mod_rewrite Apache module).

• QGIS_SERVER_LOG_FILE: indique le chemin et le nom de fichier du journal. Assurez-vous que le
serveur dispose des permissions adaptées pour écrire dans le fichier. Le fichier est créé automatiquement
lors de l’envoi de requêtes vers le serveur. S’il n’existe pas, vérifiez les permissions.

• QGIS_SERVER_LOG_LEVEL: Specify desired log level. See QGIS Server logging

• MAX_CACHE_LAYERS: Specify the maximum number of cached layers (default: 100).

• DISPLAY: This is used to pass (fake) X server display number (needed on Unix-like systems).

• QGIS_PLUGINPATH: Useful if you are using Python plugins for the server, this sets the folder that is
searched for Python plugins.
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CHAPTER 15

Les données GPS

15.1 Extension GPS

15.1.1 Qu’est ce que le GPS ?

Le GPS, Global Positioning System, est un système basé sur des satellites qui permet à toute personne possédant un
récepteur GPS d’obtenir sa position exacte n’importe où dans le monde. Il est utilisé comme aide à la navigation,
par exemple pour les avions, dans les bateaux et par les voyageurs. Le récepteur GPS utilise les signaux des
satellites pour calculer la latitude, la longitude et (parfois) l’élévation. La plupart des récepteurs ont également
la possibilité de stocker la position (nommé points d’intérêt ou waypoints), des séquences de positions qui
constituent un itinéraire prévu et un journal de suivi ou track des déplacements du récepteur en fonction du
temps. Points d’intérêt, itinéraires et tracks sont les trois types d’objet basiques dans les données GPS. QGIS
affiche les points d’intérêt dans des couches points tandis que les itinéraires et les tracks sont affichés dans des
couches linéaires.

15.1.2 Charger des données GPS à partir d’un fichier

Il y a des dizaines de formats de fichier différent pour stocker des données GPS. Le format que QGIS utilise
est appelé GPX (GPS eXchange format), qui est un format d’échange standard qui peut contenir n’importe quel
nombre de waypoints, itinéraires et tracks dans un même fichier.

Pour charger un fichier GPX vous devez d’abord charger l’extension : allez dans Extension → Installer/

Gérer les extensions puis cochez la case Outils GPS. Quand l’extension est chargée, deux boutons avec un
petit périphérique GPS apparaissent dans la barre d’outils et dans Couche → Créer couche → :

• Outils GPS

• Créer une nouvelle couche GPS

Pour travailler sur des données GPS, nous utiliserons le fichier GPX fournit dans le jeu de données test de QGIS
: qgis_sample_data/gps/national_monuments.gpx. Référez-vous à la section Échantillon de don-
nées pour plus d’informations sur le jeu de données test.

1. Sélectionnez le menu Vecteur → GPS → Outils GPS ou cliquez sur l’icône Outils GPS dans la barre
d’outils et ouvrez l’onglet Charger un fichier GPX (voir figure_GPS_1).

2. Naviguez vers le répertoire qgis_sample_data/gps/, sélectionnez le fichier
national_monuments.gpx et cliquez sur le bouton [Ouvrir].

Utilisez le bouton [Parcourir] pour sélectionner le fichier GPX, puis utilisez la case à cocher pour sélectionner
les types de géométrie que vous voulez charger à partir de ce fichier GPX. Chaque type d’objet sera chargé dans
une couche séparée lors du clic sur le bouton [OK]. Le fichier national_monuments.gpx ne contient que
des waypoints.
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Figure 15.1: La fenêtre d’Outils GPS

Note: Les récepteurs GPS permettent de stocker des données dans différents systèmes de coordonnées. Lorsque
vous récupérez un fichier GPX (depuis votre GPS ou un site web) et le chargez dans QGIS, assurez-vous que les
données sont dans le système WGS 84 (latitude/longitude). Cela correspond à la spécification officielle du format
GPX et QGIS la suit. Voir http://www.topografix.com/GPX/1/1/.

15.1.3 GPSBabel

Comme QGIS ne lit que les fichiers GPS au format GPX, vous avez besoin d’un moyen pour convertir les autres
formats de fichier GPS en GPX. Le logiciel libre GPSBabel le fait pour de nombreux formats. Il est disponible
sur http://www.gpsbabel.org. Ce programme peut aussi transférer des données GPS entre votre ordinateur et
un périphérique GPS. QGIS utilise GPSBabel pour réaliser ces tâches, il est donc recommandé de l’installer.
Cependant si vous voulez juste charger des données à partir de fichiers GPX vous n’en avez pas besoin. La version
1.2.3 de GPSBabel est connue pour bien fonctionner avec QGIS, mais vous pouvez devriez pouvoir utiliser des
versions plus récentes sans problème.

15.1.4 Importer des données GPS

Pour importer des données d’un fichier qui n’est pas un fichier GPX, vous devez utiliser l’outil Importer un autre
fichier dans la fenêtre des outils GPS. Vous sélectionnez le fichier que vous voulez importer, le type de géométrie,
l’emplacement où stocker le fichier GPX converti et sous quel nom l’enregistrer. Tous les formats de données GPS
ne supportent pas les trois types d’entités, ne vous laissant le choix qu’entre un ou deux types.

15.1.5 Télécharger des données GPS à partir d’un périphérique

QGIS peut utiliser GPSBabel pour télécharger des données d’un périphérique GPS directement vers de nouvelles
couches vecteurs. Pour cela, utilisez l’onglet Télécharger depuis le récepteur GPS de la fenêtre Outils GPS (voir
Figure_GPS_2). Vous y choisissez votre type de périphérique GPS, le port auquel il est connecté (ou USB si le
GPS le permet), le type de géométrie que vous voulez télécharger, le fichier GPX où les données seront stockées
et le nom de la nouvelle couche.

Le type de périphérique que vous sélectionnez dans le menu périphérique GPS détermine comment GPSBabel
tente de communiquer avec votre périphérique GPS. Si aucun des types ne fonctionne avec votre périphérique
GPS, vous pouvez créer un nouveau type adapté (voir la section Définir de nouveaux types de périphériques).

Le port peut être un nom de fichier ou n’importe quel autre nom que votre système d’exploitation utilise comme
référence vers le port physique de votre ordinateur sur lequel est connecté le périphérique GPS. Cela peut aussi
être de l’USB, si votre périphérique GPS fonctionne dans ce mode.

• Sous Linux, il s’agit de quelque chose qui ressemble à /dev/ttyS0 ou /dev/ttyS1.
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Figure 15.2: L’outil de téléchargement

• Sous Windows, il s’agit de COM1 ou COM2.

Quand vous cliquez sur le bouton [OK] les données seront téléchargées du périphérique et apparaîtront dans une
couche dans QGIS.

15.1.6 Envoyer des données GPS vers un appareil

Vous pouvez également envoyer directement vos données depuis une couche vecteur de QGIS vers un périphérique
GPS en utilisant l’onglet Uploader vers le GPS de la fenêtre des Outils GPS. Pour cela, vous devez sélectionner la
couche que vous voulez envoyer (qui doit être au format GPX), le type de votre périphérique GPS et le port (com
ou USB) auquel il est connecté. De la même manière que pour l’outil de téléchargement, vous pouvez définir de
nouveaux types de périphérique si le vôtre n’est pas dans la liste.

Cet outil est très utile lorsque combiné avec les capacités d’édition vectorielle de QGIS. Il permet de charger une
carte, créer des points et des itinéraires, puis de les envoyer pour les utiliser dans votre périphérique GPS.

15.1.7 Définir de nouveaux types de périphériques

Il y a beaucoup de types différents de périphériques GPS. Les développeurs de QGIS ne peuvent pas les tester
tous, si vous en avez un qui ne fonctionne pas avec un des types de périphériques dans les outils Uploader vers le
GPS et Télécharger depuis le récepteur GPS, vous pouvez définir votre propre type de périphérique. Cela se fait
via l’éditeur de périphérique GPS en cliquant sur le bouton [Éditer les périhériques] depuis les onglets d’upload
et de téléchargement.

Pour définir un nouveau périphérique, cliquez sur le bouton [Nouveau], entrez un nom, saisissez les commandes
de téléchargement et d’envoi de données vers votre GPS et cliquez sur le bouton [Mise à jour]. Le nom sera listé
dans la liste des périphériques des onglets de téléchargement et d’upload, il peut s’agir de n’importe quelle chaîne
de caractère. La commande de téléchargement est la commande qui est utilisée pour récupérer les données du
périphérique vers un fichier GPX. Il s’agira certainement d’une commande GPSBabel, mais vous pouvez utiliser
un autre programme en ligne de commande qui crée un fichier GPX. QGIS remplacera les mots clé %type, %in,
et %out lorsqu’il lancera la commande.

%type sera remplacé par -w si vous téléchargez des waypoints, -r pour des routes et -t pour des tracks. Ce
sont des options de la ligne de commande qui précisent à GPSBabel quel type d’objet télécharger.

%in sera remplacé par le port que vous avez choisi dans l’onglet de téléchargement et %out sera remplacé par le
nom choisi pour le fichier GPX où les données téléchargées doivent être stockées. Donc si vous créez un type de
périphérique avec la commande de téléchargement gpsbabel %type -i garmin -o gpx %in %out
(qui correspond à celle définie pour le type ‘Garmin serial’) et l’utilisez pour télécharger les waypoints depuis
le port /dev/ttyS0 vers le fichier output.gpx, QGIS remplacera les mots-clés et lancera la commande
gpsbabel -w -i garmin -o gpx /dev/ttyS0 output.gpx.
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La commande de téléchargement est la commande qui est utilisée pour télécharger des données vers le pé-
riphérique. Les même mots-clés sont utilisés mais %in est maintenant remplacé par le nom du fichier GPX
pour la couche qui est à uploader et %out est remplacé par le nom du port.

Pour en savoir plus sur GPSBabel et les options de ligne de commande disponibles, référez-vous à
http://www.gpsbabel.org.

Une fois le nouveau type de périphérique créé, celui-ci apparaîtra dans les listes de périphériques des outils de
téléchargement et d’upload.

15.1.8 Chargement de points/traces depuis un périphérique GPS

Comme précisé dans les sections précédentes, QGIS utilise GPSBabel pour télécharger les points et traces directe-
ment dans le projet. QGIS est fourni avec un profil pré-défini pour charger depuis des périphériques GPS Garmin.
Malheureusement il existe un bug #6318 qui ne permet pas de créer d’autres profils, aussi le téléchargement direct
dans QGIS depuis les Outils GPS est pour le moment limité aux périphériques Garmin.

Garmin GPSMAP 60cs

MS Windows

Installez les drivers USB Garmin depuis http://www8.garmin.com/support/download_details.jsp?id=591

Connectez le périphérique. Ouvrez les Outils GPS et utilisez Périphérique GPS=Garmin serial et
Port=usb: Remplissez les champs Nom de la couche and Fichier en sortie. Quelquefois il semble y avoir
des problèmes avec certains répertoire, cela fonctionne en général en utilisant un répertoire du style c:\temp.

Ubuntu/Mint GNU/Linux

Il est d’abord nécessaire de régler un problème concernant les permissions du périphérique, comme cela est ex-
pliqué à cette adresse : https://wiki.openstreetmap.org/wiki/USB_Garmin_on_GNU/Linux. Vous pouvez essayer
de créer un fichier /etc/udev/rules.d/51-garmin.rules contenant cette règle

ATTRS{idVendor}=="091e", ATTRS{idProduct}=="0003", MODE="666"

Après cela il est nécessaire de s’assurer que le module du noyau garmin_gps n’est pas chargé

rmmod garmin_gps

vous pouvez alors utiliser les Outils GPS. Malheureusement il semble y avoir un bug #7182 et généralement QGIS
se bloque plusieurs fois avant que l’opération ne réussisse.

BTGP-38KM datalogger (seulement Bluetooth)

MS Windows

Un bug connu ne permet pas de télécharger les données depuis QGIS, aussi il est nécessaire d’utiliser GPSBabel
depuis la ligne de commande ou à travers son interface dédiée. La commande qui fonctionne est

gpsbabel -t -i skytraq,baud=9600,initbaud=9600 -f COM9 -o gpx -F C:/GPX/aaa.gpx

Ubuntu/Mint GNU/Linux

Avec Windows, utilisez la même commande (ou les mêmes paramètres si vous utilisez l’interface de GPSBabel).
Sous Linux il est possible que vous obteniez un message du genre

skytraq: Too many read errors on serial port

vous pouvez tenter d’allumer et d’éteindre le datalogger avant de réessayer.

220 Chapter 15. Les données GPS

http://www.gpsbabel.org
http://hub.qgis.org/issues/6318
http://www8.garmin.com/support/download_details.jsp?id=591
https://wiki.openstreetmap.org/wiki/USB_Garmin_on_GNU/Linux
http://hub.qgis.org/issues/7182


QGIS User Guide, Version 2.14

BlueMax GPS-4044 datalogger (BT et USB)

MS Windows

Note: Il est nécessaire d’installer ses drivers avant l’utilisation dans Windows 7. Voir le site du fabricant pour le
téléchargement des drivers.

Télécharger avec GPSBabel, aussi bien en USB ou BT retourne toujours une erreur du genre

gpsbabel -t -i mtk -f COM12 -o gpx -F C:/temp/test.gpx
mtk_logger: Can’t create temporary file data.bin
Error running gpsbabel: Process exited unsuccessfully with code 1

Ubuntu/Mint GNU/Linux

Avec USB

Après avoir connecté le cable, utilisez la commande dmesg pour afficher le port qui est utilisé, par exemple
/dev/ttyACM3. Ensuite utilisez GPSBabel comme d’habitude depuis la ligne de commande ou son interface
dédiée.

gpsbabel -t -i mtk -f /dev/ttyACM3 -o gpx -F /home/user/bluemax.gpx

Avec Bluetooth

Utilisez le gestionnaire de périphériques Blueman (Blueman Device Manager) pour associer le périphérique et le
rendre accessible à travers un port du système, puis lancez GPSBabel

gpsbabel -t -i mtk -f /dev/rfcomm0 -o gpx -F /home/user/bluemax_bt.gpx

15.2 Suivi GPS en direct

Pour activer le suivi GPS en direct dans QGIS, sélectionnez le menu Vue → Panneaux Information GPS. Une
nouvelle fenêtre sera ancrée à gauche de la carte.

Cette fenêtre propose quatre écrans différents :

• Coordonnées de la position GPS et saisie manuelle de sommets et d’entités

• Force des signaux GPS des satellites connectés

• Graphe polaire montrant le numéro et la position des satellites

• Écran des options GPS (voir figure_gps_options)

Avec un récepteur GPS connecté (il doit être compatible avec votre système d’exploitation), un simple clic sur
[Connexion] connecte le GPS à QGIS. Un second clic (maintenant sur [Déconnexion]), déconnecte le récepteur
de l’ordinateur. Sous GNU/Linux, le support gpsd est intégré afin de gérer la connexion de la majorité des
récepteurs GPS. De ce fait, vous devez préalablement configurer gpsd pour y connecter QGIS correctement.

Warning: Si vous désirez enregistrer votre position sur la carte, vous devez au préalable, créer une nouvelle
couche et la passer en mode édition.

15.2.1 Coordonnées de la position

Si le GPS reçoit les signaux d’un nombre suffisant de satellites, vous verrez votre position exprimée en
latitude, longitude et élévation ainsi que d’autres attributs.
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Figure 15.3: Coordonnées de la position GPS et autres attributs
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15.2.2 Force du signal GPS

Cet écran affiche la force des signaux GPS des satellites connectés sous forme de barres.

Figure 15.4: Force du signal GPS

15.2.3 Graphe polaire

Si vous voulez connaître la position des satellites connectés, vous devez passer à l’écran du graphe polaire.
Vous y voyez également les identifiants ID des satellites dont vous recevez un signal.

Figure 15.5: Graphe polaire GPS

15.2.4 Configuration GPS

Si vous avez des problèmes de connexion, vous pouvez tester :

• Auto-détecter

• Interne

• Port Série

• gpsd (en indiquant l’Hôte, le Port et le Périphérique auquel le GPS est connecté)

Cliquez à nouveau sur [Connecter] pour réinitialiser la connexion avec le récepteur GPS.

Vous pouvez activer Enregistrer automatiquement chaque entité ajoutée lorsque vous êtes en mode édition.

Ou vous pouvez activer Ajouter automatiquement des points en choisissant la largeur et la couleur.
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Figure 15.6: Configuration du suivi GPS
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En activant Curseur, utilisez le curseur pour augmenter ou diminuer la taille du curseur
marquant la position du GPS sur la carte.

Centrer la carte vous permet de choisir comment mettre à jour l’emprise de la carte. Par exemple ‘toujours’
ou ‘lorsque l’on sort’, si les coordonnées enregistrées commencent à sortir de la carte, ou encore ‘jamais’.

Enfin, vous pouvez activer le Fichier journal et définir un fichier pour enregistrer les messages du suivi GPS.

Si vous voulez enregistrer une entité manuellement, vous devez retourner à l’écran Coordonnées de la position et
cliquer sur [Ajouter des entités] ou [Ajouter un point de tracé].

15.2.5 Connexion à un GPS Bluetooth pour le suivi en direct

Avec QGIS, vous pouvez vous connecter à un GPS Bluetooth pour la récupération de données terrain. Pour réaliser
cette tâche, vous aurez besoin d’un GPS Bluetooth et d’un récepteur Bluetooth sur votre ordinateur.

Au démarrage, vous devez faire en sorte que votre GPS soit reconnu et appairé avec votre ordinateur. Allumer le
GPS, cliquer sur l’icône Bluetooth de votre barre de notification et rechercher un Nouveau Périphérique.

Sur le côté droit du masque de sélection des périphériques, assurez-vous que tous les périphériques sont sélection-
nés pour garantir que votre unité GPS apparaissent dans cette sélection. Dans la prochaine étape, un service de
connexion série devrait être disponible. Sélectionnez-le et cliquez sur le bouton [Configurer].

Retenez le numéro du port COM affecté à la connexion GPS dans les propriétés Bluetooth.

Une fois que le GPS a été reconnu, faîtes l’appariement avec la connexion. Généralement, le code d’autorisation
est 0000.

Maintenant, ouvrez le panneau Information GPS et basculez dans l’écran des options GPS. Sélectionnez le
port COM de la connexion GPS et cliquez sur le bouton [Connect]. Après un moment, un curseur indiquant votre
position doit apparaître.

Si QGIS ne peut recevoir de données GPS, vous devriez alors redémarrer votre GPS, attendre 5-10 secondes
et réessayer de le connecter. Généralement, celle solution fonctionne. Si vous avez de nouveau une erreur de
connexion, assurez-vous que vous n’avez pas un autre capteur Bluetooth à proximité, apparairé avec le GPS.

15.2.6 Utiliser un Garmin GPSMAP 60cs

MS Windows

Le moyen le plus facile pour le faire fonctionner est d’utiliser un logiciel intermédiaire (en freeware mais pas
libre) appelé GPSGate.

Lancez le programme, faîtes-le rechercher les périphériques GPS (fonctionne pour les GPS USB et Bluetooth) et
sous QGIS, cliquez sur [Connecter] dans le panneau de suivi en direct en utilisant le mode Auto-détection.

Ubuntu/Mint GNU/Linux

Comme pour Windows le plus simple est d’utiliser un serveur intermédiaire, dans ce cas GPSD, donc

sudo apt-get install gpsd

Vous pouvez alors charger le module du noyau garmin_gps

sudo modprobe garmin_gps

Connectez ensuite l’unité. Vérifiez avec dmesg que le périphérique utilisé par l’unité, par exemple
/dev/ttyUSB0. Maintenant, vous pouvez lancer qpsd.

15.2. Suivi GPS en direct 225

http://update.gpsgate.com/install/GpsGateClient.exe


QGIS User Guide, Version 2.14

gpsd /dev/ttyUSB0

Connectez enfin avec l’outil de suivi en direct de QGIS.

15.2.7 Utiliser BTGP-38KM datalogger (seulement Bluetooth)

Utiliser GPSD (sous GNU/Linux) ou GPSGate (sous Windows) est très facile.

15.2.8 Utiliser BlueMax GPS-4044 datalogger (BT et USB)

MS Windows

Le suivi en direct fonctionne pour les modes USB et BT en utilisant GPSGate ou même sans lui. Utilisez le mode
Auto-détection ou pointez l’outil dans le bon port.

Ubuntu/Mint GNU/Linux

Via USB

Le suivi en direct fonctionne avec les deux sous GPSD.

gpsd /dev/ttyACM3

ou sans lui en connectant l’outil de suivi en direct de QGIS directement au périphérique (par exemple
/dev/ttyACM3).

Via Bluetooth

Le suivi en direct fonctionne avec les deux sous GPSD.

gpsd /dev/rfcomm0

ou sans lui en connectant l’outil de suivi en direct de QGIS directement au périphérique (par exemple
/dev/rfcomm0).
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Système d’authentification

16.1 Aperçu du Système d’authentification

Figure 16.1: Anatomie du Système d’authentification

16.1.1 Base de données d’authentification

The new authentication system stores authentication configurations in an SQLite database file located, by default,
at:

<user home>\.qgis2\qgis-auth.db

This authentication database can be moved between QGIS installations without affecting other current QGIS user
preferences, as it is completely separate from normal QGIS settings. A configuration ID (a random 7-character
alphanumeric string) is generated when initially storing a configuration to the database. This represents the con-
figuration, thereby allowing the ID to be stored in plain text application components, (such as project, plugin, or
settings files) without disclosure of its associated credentials.
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Note: The parent directory of the qgis-auth.db can be set using the following environment variable,
QGIS_AUTH_DB_DIR_PATH, or set on the command line during launch with the --authdbdirectory
option.

16.1.2 Mot de passe principal

To store or access sensitive information within the database, a user must define a master password. A new master
password is requested and verified when initially storing any encrypted data to the database. Only when sensitive
information is accessed is the user prompted for the master password, which is then cached for the remainder of
the session (until application is quit), unless the user manually chooses an action to clear its cached value. Some
instances of using the authentication system do not require input of the master password, such as when selecting an
existing authentication configuration, or applying a configuration to a server configuration (such as when adding
a WMS layer).

Figure 16.2: Entrer un nouveau mot de passe principal

Note: A path to a file containing the master password can be set using the following environment variable,
QGIS_AUTH_PASSWORD_FILE.

Gestion du mot de passe principal

Once set, the master password can be reset; the current master password will be needed prior to resetting. During
this process, there is an option to generate a complete backup of the current database.

Figure 16.3: Réinitialiser le mot de passe principal

If the user forgets the master password, there is no way to retrieve or override it. There is also no means of
retrieving encrypted information without knowing the master password.

If a user inputs their existing password incorrectly three times, the dialog will offer to erase the database.
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Figure 16.4: Password prompt after three invalid attempts

16.1.3 Configuration de l’authentification

You can manage authentication configurations from Configurations in the Authentication tab of the QGIS Options
dialog (Settings → Options).

Figure 16.5: Configurations editor

Use the button to add a new configuration, the button to remove configurations, and the button to
modify existing ones.

The same type of operations for authentication configuration management (Add, Edit and Remove) can be done
when configuring a given service connection, such as configuring an OWS service connection. For that, there are
action buttons within the configuration selector for fully managing configurations found within the authentication
database. In this case, there is no need to go to the configurations in Authentication tab of QGIS options unless
you need to do more comprehensive configuration management.

When creating or editing an authentication configuration, the info required is a name, an authentication method
and any other info that the authentication method requires (see more about the available authentication types in
Méthodes d’authentification).
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Figure 16.6: Adding config from within Configuration editor

Figure 16.7: WMS connection dialog showing [Add], [Edit], and [Remove] authentication configuration buttons
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16.1.4 Méthodes d’authentification

Available authentications are provided by C++ plugins much in the same way data provider plugins are sup-
ported by QGIS. The method of authentication that can be selected is relative to the access needed for the re-
source/provider, e.g. HTTP(S) or database, and whether there is support in both QGIS code and a plugin. As such,
some authentication method plugins may not be applicable everywhere an authentication configuration selector is
shown. A list of available authentication method plugins and their compatible resource/providers can be accessed
going to Settings – > Option and, in the Authentication tab, click the Installed plugins button.

Figure 16.8: Available method plugins list

Plugins can be created for new authentication methods that do not require QGIS to be recompiled. Since the
support for plugins is currently (since QGIS 2.12) C++-only, QGIS will need to be restarted for the new dropped-
in plugin to become available to the user. Ensure your plugin is compiled against the same target version of QGIS
if you intend to add it to an existing target install.

Figure 16.9: Basic HTTP authentication configs

Note: The Resource URL is currently an unimplemented feature that will eventually allow a particular configu-
ration to be auto-chosen when connecting to resources at a given URL.

16.1.5 Master Password and Auth Config Utilities

Under the Options menu (Settings → Options) in the Authentication tab, there are several utility actions to manage
the authentication database and configurations:

• Input master password — Opens the master password input dialog, independent of performing any auth db
command. Clear cached master password—Unsets the master password if it has been set via input dialog.
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Figure 16.10: PKI paths authentication configs

Figure 16.11: PKI PKCS#12 file paths authentication configs

Figure 16.12: Stored Identity authentication configs
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Figure 16.13: Utilities menu

Reset master password—Opens a dialog to change the master password (the current password must be
known) and optionally back up the current database.

• Clear cached authentication configurations — Clears the internal lookup cache for configurations used to
speed up network connections. This does not clear QGIS’s core network access manager’s cache, which
requires a relaunch of QGIS.

• Reset master password - Replaces the current master password for a new one. The current master password
will be needed prior to resetting and a backup of database can be done.

• Remove all authentication configurations — Clears the database of all configuration records, without re-
moving other stored records.

• Erase authentication database — Schedules a backup of the current database and complete rebuild of the
database table structure. These actions are scheduled for a later time, so as to ensure other operations like
project loading do not interrupt the operation or cause errors due to a temporarily missing database.

Figure 16.14: DB erase verification menu

16.1.6 Using authentication configurations

Typically, an authentication configuration is selected in a configuration dialog for a network services (such as
WMS). However, the selector widget can be embedded anywhere authentication is needed or in non-core func-
tionality, like in third-party PyQGIS or C++ plugins.

When using the selector, No authentication is displayed in the pop-up menu control when nothing is selected,
when there are no configurations to choose from, or when a previously assigned configuration can no longer be
found in the database. The Type and Id fields are read-only and provide a description of the authentication method
and the config’s ID respectively.

16.1.7 Python bindings

All classes and public functions have sip bindings, except QgsAuthCrypto, since management of the master
password hashing and auth database encryption should be handled by the main app, and not via Python. See
Impératifs de sécurité concerning Python access.

16.1. Aperçu du Système d’authentification 233



QGIS User Guide, Version 2.14

Figure 16.15: Auth config selector with no autentication

Figure 16.16: Auth config selector with config selected

16.2 Processus d’authentification des utilisateurs

Figure 16.17: Processus pour l’utilisateur générique

16.2.1 Authentification HTTP(S)

L’une des connexions les plus communes à des ressources est par HTTP(S), par ex. serveurs cartographiques web,
et les extensions pour méthode d’authentification fonctionnent souvent pour ces types de connexions. Ces exten-
sions ont accès à l’objet demande de HTTP et peuvent manipuler tant la demande que ses en-têtes. Cela permet
un grand nombre de formes d’authentification basées sur Internet. Lorsque la connexion se fait par HTTP(S) en
utilisant la méthode standard d’authentification nom utilisateur/mot de passe une authentification HTTP BASIC
sera essayée lors de la connexion.
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Figure 16.18: Configuration d’une connexion WMS pour HTTP BASIC

16.2.2 Authentification de la base de données

Les connexions aux ressources des bases de données sont généralement stockées comme paires clé=valeur, qui
exposeront les noms d’utilisateur et (optionnellement) les mots de passe, si une configuration d’authentification
n’est pas utilisée. Lors de la configuration avec le nouveau système auth, la clé=valeur sera une représentation
abstraite des identifiants, par ex. authfg=81t21b9

16.2.3 Authentification PKI

Lors de la configuration des composants PKI avec le système d’authentification, vous avez l’option d’importer les
composants dans la base de données ou de référencer les fichiers des composants stockés dans votre système de
fichiers. Cette dernière option peut être utile si les composants changent fréquemment ou s’ils seront remplacés
par l’administrateur système. Dans tous les cas vous devrez sauver toute phrase clé nécessaire pour l’accès aux
clés privées dans la base de données.

Tous les composants PKI peuvent être gérer par des éditeurs séparés dans le Gestionnaire de Certificats qui peut
être ouvert dans l’onglet Authentification du dialogue Options de QGIS (Paramètres→ Options) en cliquant sur le
bouton [Gestion des certificats].

Dans le Gestionnaire de certificats, il y a des éditeurs pour les Identités, Serveurs et Autorités. Chacun dans son
propre onglet, et ils sont décrits ci-dessous dans l’ordre dans lequel ils apparaissent dans le tableau de processus
ci-dessus. L’ordre des onglets est relatif aux éditeurs les plus utilisés une fois que vous êtes habitué au processus.

Note: Parce que toutes les modifications du système d’authentification sont immédiatement écrites dans la base
de données, il n’est pas nécessaire de cliquer sur le bouton [OK] du dialogue Options pour qu’une modification
soit sauvée. C’est différent des autres paramètres du dialogue Options.
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Figure 16.19: Configuration d’une connexion SSL-avec-PKI pour Postgres

Autorités de certification

Vous pouvez gérer les Autorités de Certificats (AC) disponibles à partir de l’onglet Autorités du Gestionnaire de
certificats à partir de l’onglet Authentification du dialogue Options de QGIS.

Comme référencé dans le tableau de processus ci-dessus, la première étape est d’importer ou de référencer le
fichiers d’AC. Cette étape est optionnelle, est peut être inutile si votre chaîne de confiance PKI est originaire
d’AC racine déjà installés dans votre système d’exploitation (SE), tel qu’un certificat d’un vendeur commercial
de certificats. Si votre AC racine d’authentification n’est pas dans les AC racine reconnus par le SE, il devra être
importé ou avoir le chemin à son système de fichier référencé. (Contactez votre administrateur système en cas de
doute).

By default, the root CAs from your OS are available; however, their trust settings are not inherited. You should
review the certificate trust policy settings, especially if your OS root CAs have had their policies adjusted. Any
certificate that is expired will be set to untrusted and will not be used in secure server connections, unless you
specifically override its trust policy. To see the QGIS-discoverable trust chain for any certificate, select it and click

the Show information for certificate.

You can edit the trust policy for any selected certificate within the chain. Any change in trust policy to

a selected certificate will not be saved to the database unless the Save certificate trust policy change to database button is
clicked per selected certification. Closing the dialog will not apply the policy changes.

You can review the filtered CAs, both intermediate and root certificates, that will be trusted for secure connections

or change the default trust policy by clicking the Options button.

Warning: Changing the default trust policy may result in problems with secure connections.

You can import CAs or save a file system path from a file that contains multiple CAs, or import individual CAs.
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Figure 16.20: Processus de configuration PKI
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Figure 16.21: Ouvrir le gestionnaire de certificats

Figure 16.22: Éditeur d’Autorités de Certification
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Figure 16.23: Boîte de dialogue d’information du Certificat

Figure 16.24: Sauvegarder les modifications dans les politiques de confiance

Figure 16.25: Authorities options menu
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The standard PEM format for files that contain multiple CA chain certifications has the root cert at the bottom of
the file and all subsequently signed child certificates above, towards the beginning of the file.

The CA certificate import dialog will find all CA certificates within the file, regardless of order, and also offers the
option to import certificates that are considered invalid (in case you want to override their trust policy). You can
override the trust policy upon import, or do so later within the Authorities editor.

Figure 16.26: Dialogue import des certificats

Note: Si vous copier les informations d’un certificat dans le champs Texte PEM, veuillez noter que les certificats
encryptés ne sont pas supportés.

Identités

You can manage available client identity bundles from the Identities tab in the Certificate manager from the
Authentication tab of the QGIS Options dialog. An identity is what authenticates you against a PKI-enabled
service and usually consists of a client certificate and private key, either as separate files or combined into a single
“bundled” file. The bundle or private key is often passphrase-protected.

Once you have any Certificate Authorities (CAs) imported you can optionally import any identity bundles into the
authentication database. If you do not wish to store the identities, you can reference their component file system
paths within an individual authentication configuration.

When importing an identity bundle, it can be passphrase-protected or unprotected, and can contain CA certificates
forming a trust chain. Trust chain certifications will not be imported here; they can be added separately under the
Authorities tab.

Upon import the bundle’s certificate and private key will be stored in the database, with the key’s storage encrypted
using the QGIS master password. Subsequent usage of the stored bundle from the database will only require input
of the master password.

Personal identity bundles consisting of PEM/DER (.pem/.der) and PKCS#12 (.p12/.pfx) components are sup-
ported. If a key or bundle is passphrase-protected, the password will be required to validate the component prior
to import. Likewise, if the client certificate in the bundle is invalid (for example, its effective date has not yet
started or has elapsed) the bundle can not be imported.
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Figure 16.27: Identities editor

Figure 16.28: PEM/DER identity import
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Figure 16.29: PKCS#12 identity import

16.2.4 Handling bad layers

Occasionally, the authentication configuration ID that is saved with a project file is no longer valid, possibly
because the current authentication database is different than when the project was last saved, or due to a credentials
mismatch. In such cases the Handle bad layers dialog will be presented upon QGIS launch.

Figure 16.30: Handle bad layers with authentication

If a data source is found to have an authentication configuration ID associated with it, you will be able to edit it.
Doing so will automatically edit the data source string, much in the same way as opening the project file in a text
editor and editing the string.

16.2.5 Changing authentication config ID

Occasionally, you will need to change the authenticationn configuration ID that is associated with accessing a
resource. There are instances where this is useful:

• Resource auth config ID is no longer valid - This can occur when you have switched auth databases add
need to align a new configuration to the ID already associated with a resource.

• Shared project files - If you intended to share projects between users, e.g. via a shared file server, you can
predefine a 7-character (containing a-z and/or 0-9) that is associated with the resource. Then, individual
users change the ID of an authentication configuration that is specific to their credentials of the resource.
When the project is opened, the ID is found in the authentication database, but the credentials are different
per user.
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Figure 16.31: Edit bad layer’s authentication config ID

Figure 16.32: Changing a layer’s authentication config ID (unlocked yellow text field)

16.2. Processus d’authentification des utilisateurs 243



QGIS User Guide, Version 2.14

Warning: Changing the auth config ID is considered an advanced operation and should only be done with
full knowledge as to why it is necessary. This is why there is a lock button that needs clicked, to unlock the
ID’s text field prior to editing the ID.

16.2.6 Support Serveur QGIS

When using a project file, with layers that have authentication configurations, as a basis for a map in QGIS Server,
there are a couple of additional setup steps necessary for QGIS to load the resources:

• La base de données d’authentification a besoin d’être disponible

• Authentication database’s master password needs to be available

When instantiating the authentication system, Server will create or use qgis-auth.db in ~/.qgis2/ or the
directory defined by the QGIS_AUTH_DB_DIR_PATH environment variable. It may be that the Server’s user has
no HOME directory, in which case, use the environment variable to define a directory that the Server’s user has
read/write permissions and is not located within the web-accessible directories.

To pass the master password to Server, write it to the first line of file at a path on the file system readable by the
Server processes user and defined using the QGIS_AUTH_PASSWORD_FILE environment variable. Ensure to
limit the file as only readable by the Server’s process user and to not store the file within web-accessible directories.

Note: La variable QGIS_AUTH_PASSWORD_FILE sera effacée de l’environnement du serveur tout de suite
après avoir été utilisée

16.2.7 Exceptions du serveur SSL

Figure 16.33: Exception du serveur SSL

Vous pouvez gérer les configurations et exceptions du serveur SSL à partir de l’onglet Serveurs dans la section
Authentification du dialogue Options de QGIS.

Quelque fois, lors de la connexion à un serveur SSL, des erreurs de “handshake” ou de certificat du serveur se
produisent. Vous pouvez ignorer ces erreurs ou créer une exception dans la configuration de serveur SSL. C’est
similaire au comportement des navigateurs internet qui vous permettent d’ignorer les erreurs SSL, mais avec plus
de contrôle granulaire.

Warning: Vous ne devriez pas créer une configuration de serveur SSL à moins que vous ayez une parfaite
connaissance de l’ensemble de la configuration SSL entre serveur et client. Vous devriez plutôt signaler le
problème au gestionnaire du serveur.

Note: Certaines configurations PKI utilisent une chaîne de confiance AC totalement différente pour valider
l’identité des clients que la chaîne utilisée pour valider le certificat du serveur SSL. Dans de tels cas, toute con-
figuration créée pour la connexion au serveur ne résoudra pas nécessairement le problème de validation de votre
identité client, et ce n’est que l’émetteur de votre identité client ou le gestionnaire du serveur qui puisse résoudre
ce problème.
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Vous pouvez pré-configurer la configuration d’un serveur SSL en cliquant sur le bouton . Ou, vous pouvez
ajouter une configuration lorsqu’une erreur SSL se produit durant la connexion et que le dialogue Erreur SSL
apparaît (lorsque l’erreur peut être temporairement ignorée ou alors sauvée dans la base de données et ignorée) :

Figure 16.34: Ajouter manuellement une configuration

Une fois qu’une configuration SSL est sauvée dans la base de données, elle peut être éditée ou effacée.

Si vous voulez pré-configurer une configuration SSL et que le dialogue d’import ne fonctionne pas avec la con-
nexion à votre serveur, vous pouvez activer manuellement une connexion dans la Console Python en utilisant le
code suivant (remplacer https://bugreports.qt-project.org par l’URL de votre serveur):

from PyQt4.QtNetwork import *
req = QNetworkRequest(QUrl(’https://bugreports.qt-project.org’))
reply = QgsNetworkAccessManager.instance().get(req)

Cela ouvrira un dialogue d’erreur SSL si une erreur survient, où vous pourrez choisir de sauver la configuration
dans la base de données.

16.3 Impératifs de sécurité

Lorsque le mot de passe principal est tapé, l’API est disponible pour accéder aux configurations d’authentification
de la base de données d’authentification, de façon similaire à ce que fait Firefox. Cependant, lors de la mise
en œuvre initiale, aucune protection contre l’accès à PyQGIS n’a été définie. Cela peut conduire à des prob-
lèmes lorsqu’un utilisateur télécharge/installe un plugin ou une application PyQGIS malicieux qui a accès aux
identifiants.

16.3. Impératifs de sécurité 245



QGIS User Guide, Version 2.14

Figure 16.35: Ajouter une configuration pendant une erreur SSL

Figure 16.36: Configuration SSL existante

246 Chapter 16. Système d’authentification



QGIS User Guide, Version 2.14

Figure 16.37: Éditer une configuration SSL existante

La solution rapide pour le déploiement initial de fonctionnalité est de ne pas inclure la plupart des liens pyQGIS
pour le système d’authentification.

Une autre solution simple, mais non robuste, est d’ajouter une liste déroulante dans Paramètres→ Options →
Authentification (défaut : “jamais”) :

"Allow Python access to authentication system"
Choices: [ confirm once per session | always confirm | always allow | never]

Un tel paramètre optionnel devra être sauvé dans un endroit dont Python n’a pas accès, par ex. la base de données
d’authentification, et encrypté avec le mot de passe principal.

• Une autre option serait de traquer quels sont les plugins que l’utilisateur utilise spécifiquement.

• autorisé à accéder au système d’authentification, bien qu’il puisse être compliqué de déduire quel est
l’extension qui passe l’appel.

• Isoler les extensions, peut être dans leurs propres environnements virtuels, réduirait le piratage “inter-
extension’ des configurations d’authentification d’une extension qui est autorisée. Cela peut aussi vouloir
dire de limiter la communication entre extensions, mais peut être seulement entre les extensions de tiers.

• Une autre bonne solution est d’émettre des certificats pour signer le code des auteurs d’extensions approu-
vés. Puis de valider le certificat de l’extension lors du chargement. En cas de besoin, l’utilisateur pourrait
directement définir une politique de non-confiance pour le certificat associé à l’extension en utilisant les
dialogues de gestion des certificats.

• Alternativement, accès aux données sensitives du système d’authentification à partir de Python

• ne devrait jamais être permis, et seulement l’utilisation des gadgets de base de QGIS ou la duplication des in-
tégrations du système d’authentification, pourrait permettre à l’extension de fonctionner avec les ressources
qui ont une configuration d’authentification, tout en ayant le mot de passe principal et la configuration
d’authentification chargés dans l’espace de l’application principale.

Les mêmes préoccupations de sécurité s’appliquent aux extensions C++, mais il sera plus difficile d’en restreindre
l’accès, car il n’y a pas de fonction de correspondance qui peut être retirée comme c’est le cas pour Python.
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16.3.1 Contraintes

Les problèmes confus de licensing and exporting associés à OpenSSL s’appliquent. Pour que Qt puisse fonctionner
avec les certificats d’OpenSSL, il a besoin d’avoir accès aux librairies d’OpenSSL. Suivant la façon dont Qt est
compilé, le défaut est de se lier dynamiquement aux librairies d’OpenSSL lors de l’exécution (pour contourner les
limitations de l’export).

QCA suit une tactique similaire, où la liaison à QCA n’a aucune contrainte, parce que l’extension qca-ossl
(OpenSSL) est chargée lors de l’exécution. L’extension qca-ossl est directement liée aux librairies OpenSSL.
Les développeurs sont ceux qui doivent s’assurer que toutes les contraintes de liens d’OpenSSL soient satisfaites,
s’ils publient l’extension. Peut être, je n’en suis pas sûr, je ne suis pas un avocat.

Le système d’authentification se déactive sans risque lorsque qca-ossl n’est pas trouvé lors de l’exécution.
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CHAPTER 17

Intégration du SIG GRASS

GRASS integration provides access to GRASS GIS databases and functionalities (see GRASS-PROJECT in Bibli-
ographie). The integration consists of two parts: provider and plugin. The provider allows to browse, manage and
visualize GRASS raster and vector layers. The plugin can be used to create new GRASS locations and mapsets,
change GRASS region, create and edit vector layers and analyze GRASS 2-D and 3-D data with more than 400
GRASS modules. In this section, we’ll introduce the provider and plugin functionalities and give some examples
of managing and working with GRASS data.

The provider supports GRASS version 6 and 7, the plugin supports GRASS 6 and 7 (starting from QGIS 2.12).
QGIS distribution may contain provider/plugin for either GRASS 6 or GRASS 7 or for both versions at the same
time (binaries have different file names). Only one version of the provider/plugin may be loaded on runtime
however.

17.1 Jeu de données de démonstration

As an example, we will use the QGIS Alaska dataset (see section Échantillon de données). It includes
a small sample GRASS LOCATION with three vector layers and one raster elevation map. Create a
new folder called grassdata, download the QGIS ‘Alaska’ dataset qgis_sample_data.zip from
http://download.osgeo.org/qgis/data/ and unzip the file into grassdata.

More sample GRASS LOCATIONs are available at the GRASS website at
http://grass.osgeo.org/download/sample-data/.

17.2 Charger des données GRASS raster et vecteur

If the provider is loaded in QGIS, the location item with GRASS icon is added in the browser tree under each
folder item which contains GRASS location. Go to the folder grassdata and expand location alaska and
mapset demo.

You can load GRASS raster and vector layers like any other layer from the browser either by double click on layer
item or by dragging and dropping to map canvas or legend.

Astuce: Charger des données GRASS
If you don’t see GRASS location item, verify in Help → About → Providers if GRASS vector provider is loaded.

17.3 Importer des données dans un SECTEUR GRASS par glisser-
déposer

This section gives an example of how to import raster and vector data into a GRASS mapset.
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1. In QGIS browser navigate to the mapset you want to import data into.

2. In QGIS browser find a layer you want to import to GRASS, note that you can open another instance of the
browser (Browser Panel (2)) if source data are too far from the mapset in the tree.

3. Drag a layer and drop it on the target mapset. The imported may take some time for larger layers, you will
see animated icon in front of new layer item until the import finishes.

Where raster data are in different CRS, they can be reprojected using an Approximate (fast) or Exact (precise)
transformation. If a link to the source raster is created (using r.external), the source data are in the same CRS and
the format is known to GDAL, the source data CRS will be used. You can set these options in the Browser tab in
Options GRASS.

If a source raster has more bands, a new GRASS map is created for each layer with .<band number> suffix and

group of all maps with icon is created. External rasters have a different icon .

17.4 Gérer GRASS depuis l’Explorateur QGIS

• Copying maps: GRASS maps may be copied between mapsets within the same location using drag and
drop.

• Deleting maps: Right click on a GRASS map and select Delete from context menu.

• Renaming maps: Right click on a GRASS map and select Rename from context menu.

17.5 Options GRASS

GRASS options may be set in GRASS Options dialog, which can be opened by right clicking on the location or
mapset item in the browser and then choosing GRASS Options.

17.6 Lancer l’extension GRASS

To use GRASS functionalities in QGIS, you must select and load the GRASS plugin using the Plugin Manager.

To do this, go to the menu Plugins → Manage and Install Plugins..., select GRASS and click [OK].

The following main features are provided with the toolbar menu when you start the GRASS plugin:

• Ouvrir le jeu de données

• Nouveau jeu de données

• Fermer le jeu de données

• Ouvrir les outils GRASS

• Afficher la région courante GRASS

• Options GRASS

17.7 Ouvrir un jeu de données GRASS

A GRASS mapset must be opened to get access to GRASS Tools in the plugin (the tools are disabled if no mapset
is open). You can open a mapset from the browser: right click on mapset item and then choose Open mapset from
context menu.
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17.8 Secteur et Jeu de données GRASS

Les données GRASS sont stockées dans un répertoire référencé sous le nom GISDBASE. Ce répertoire, souvent
appelé grassdata, doit être créé avant que vous commenciez à travailler avec l’extension GRASS dans QGIS.
Dans ce répertoire, les données GRASS sont organisées par projets et stockées dans des sous-répertoires appelés
SECTEUR ( LOCATION en Anglais). Chaque SECTEUR est défini par son système de coordonnées, sa projection
et son étendue géographique. Chaque SECTEUR peut contenir plusieurs Jeux de données (MAPSETs en
Anglais) (sous-répertoires du SECTEUR) qui sont utilisés pour subdiviser le projet en différents thèmes, sous
régions ou espaces de travail pour chaque membre d’une équipe (Neteler & Mitasova 2008 Bibliographie). Pour
pouvoir analyser des couches raster ou vecteur à l’aide des modules GRASS, vous devez les importer dans un
SECTEUR. (Ce n’est pas complètement vrai, car avec les modules GRASS r.external et v.external,
vous pouvez lier (en lecture seule) des données externes gérées par GDAL/OGR sans les importer. Comme il ne
s’agit pas d’une fonctionnalité courante pour les débutants sur GRASS, elle ne sera pas décrite ici).

Figure 17.1: Données GRASS du SECTEUR Alaska

17.9 Importer des données dans un SECTEUR GRASS

See section Importer des données dans un SECTEUR GRASS par glisser-déposer to find how data can be easily
imported by dragging and dropping in the browser.

Cette section donne un exemple d’importation de données raster et vecteur dans le SECTEUR GRASS ‘alaska’
fournit dans le jeu de données QGIS ‘Alaska’, de la manière la plus classique, en utilisant les modules GRASS de
base. Nous utiliserons la couche raster d’occupation du sol landcover.img et la couche vectorielle au format
GML lakes.gml, toutes deux présentes dans le jeu de données ‘Alaska’ (voir Échantillon de données).

1. Démarrez QGIS et assurez vous que l’extension GRASS est chargée.

2. Dans la barre d’outils GRASS, cliquez sur Ouvrir un jeu de données pour ouvrir l’assistant Jeu de données.

3. Sélectionnez comme base de données GRASS, le répertoire grassdata dans le jeu de données QGIS
Alaska, puis le SECTEUR ‘alaska’, le Jeu de donnée ‘demo’ et cliquez sur [OK].
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4. Maintenant cliquez sur Ouvrir les outils GRASS. La boîte à outils GRASS s’ouvre (voir section La Boîte à
outils GRASS).

5. Pour importer la couche raster landcover.img, cliquez sur le module r.in.gdal dans l’onglet Ar-
borescence des modules. Ce module GRASS vous permet d’importer les fichiers raster gérés par la librairie
GDAL dans un SECTEUR GRASS. La fenêtre r.in.gdal apparaît.

6. Naviguer jusqu’au répertoire raster dans le jeu de données QGIS ‘Alaska’ et sélectionnez le fichier
landcover.img.

7. Définissez landcover_grass comme nom de sortie pour le raster et cliquez sur
[Lancer]. Dans l’onglet Rendu, vous voyez la commande GRASS en cours r.in.gdal -o
input=/path/to/landcover.img output=landcover_grass.

8. Lorsque Terminé avec succès s’affiche, cliquez sur [Vue]. La couche raster landcover_grass est
maintenant importée dans GRASS et pourra être affichée dans QGIS.

9. Pour importer le fichier GML lakes.gml, cliquez sur le module v.in.ogr dans l’onglet Arbores-
cence des modules. Ce module vous permet d’importer des données vectorielles gérées par OGR dans un
SECTEUR GRASS. La fenêtre v.in.ogr apparaît.

10. Naviguer jusqu’au répertoire gml dans le jeu de données QGIS ‘Alaska’ et sélectionnez le fichier
lakes.gml.

11. Définissez lakes_grass comme nom de sortie et cliquez sur [Lancer]. Vous n’avez pas besoin des autres
options dans cet exemple. Dans l’onglet Rendu, vous voyez la commande GRASS en cours v.in.ogr -o
dsn=/path/to/lakes.gml output=lakes\_grass.

12. Lorsque Terminé avec succès s’affiche, cliquez sur [Vue]. La couche raster lakes_grass est maintenant
importée dans GRASS et pourra être affichée dans QGIS.

17.9.1 Créer un nouveau SECTEUR GRASS

À titre d’exemple, voici le SECTEUR alaska GRASS, projeté en Albers Equal Area et ayant pour unité le pied.
Ce SECTEUR alaska sera utilisé pour tous les exemples et exercices GRASS qui suivent. Il est utile de le
télécharger et de l’installer sur votre ordinateur (voir Échantillon de données).

1. Démarrez QGIS et assurez vous que l’extension GRASS est chargée.

2. Affichez le shapefile alaska.shp (voir section Charger une couche à partir d’un fichier) du jeu de don-
nées QGIS Alaska (voir Échantillon de données).

3. Dans la barre d’outils GRASS, cliquez sur Nouveau jeu de données pour ouvrir l’assistant de création de Jeux
de données.

4. Sélectionnez un répertoire existant de base de données GRASS (GISDBASE) grassdata ou créez en
un pour le nouveau SECTEUR avec le gestionnaire de fichiers de votre ordinateur. Cliquez sur le bouton
[Suivant].

5. Nous pouvons utiliser cet assistant à la fois pour créer un nouveau Jeu de données dans un SECTEUR
existant (voir section Ajouter un nouveau Jeu de données) et pour créer également un nouveau SECTEUR.
Cliquez sur le bouton radio Créez un nouveau secteur (voir figure_grass_location_2).

6. Entrez un nom pour le SECTEUR – nous avons utilisé ‘alaska’ – et cliquez sur le bouton [Suivant].

7. Définissez la projection en cliquant sur le bouton radio Projection pour activer la liste des projections.

8. Nous utilisons la projection Albers Equal Area Alaska (pieds). Étant donné que nous savons qu’elle cor-
respond au code EPSG 2964, nous le saisissons dans le champ de recherche. (Note : Si vous souhaitez
reproduire la manipulation pour un autre SECTEUR et une autre projection dont vous ne connaissez pas le

code EPSG, cliquez sur Statut de la projection dans le coin inférieur droit de la barre d’état de QGIS (voir
section Utiliser les projections)).

9. Saisissez 2964 dans le Filtre pour sélectionner la projection.
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10. Cliquez sur [Suivant].

11. Pour définir la région par défaut, nous devons saisir les limites Nord, Sud , Est et Ouest du SECTEUR. Ici il
suffit de cliquer sur le bouton [Fixer l’emprise courante de QGIS], pour appliquer l’emprise du shapefile
alaska.shp déjà chargé comme emprise par défaut.

12. Cliquez sur [Suivant].

13. Nous avons aussi besoin de définir un Jeu de données dans notre nouveau SECTEUR (étape indispens-
able lors de la création d’un nouveau SECTEUR). Vous pouvez l’appeler comme vous le souhaitez - nous
utiliserons ‘demo’. GRASS crée automatiquement un Jeu de données spécial appelé PERMANENT,
conçu pour stocker les données essentielles du projet, son emprise spatiale par défaut et la définition du
système de coordonnées (voir Neteler & Mitasova 2008 Bibliographie).

14. Vérifiez le résumé pour vous assurez que tout est correct et cliquez sur [Terminer].

15. Le nouveau SECTEUR ‘alaska’ et les deux Jeux de données ‘démo’ et ‘PERMANENT’ sont créés.
Le jeu de données ouvert à ce moment est ‘démo’, tel que vous l’avez défini.

16. Notez que certains outils de la barre d’outils GRASS qui n’étaient pas accessibles le sont maintenant.

Figure 17.2: Créer un nouveau SECTEUR ou Jeu de données GRASS dans QGIS

Si ce processus semble long, il s’agit en fait d’un moyen simple et rapide de créer un SECTEUR. Le SECTEUR
‘alaska’ est maintenant prêt pour l’importation de données (voir section Importer des données dans un SECTEUR
GRASS). Vous pouvez également utiliser des données raster ou vecteur existantes dans le SECTEUR ‘alaska’
inclues dans le jeu de données QGIS ‘Alaska’ Échantillon de données et continuez avec la section Le modèle
vecteur de GRASS.

17.9.2 Ajouter un nouveau Jeu de données

Un utilisateur a seulement des droits d’écriture sur le Jeu de données GRASS qu’il a créé. Cela veut dire,
qu’au-delà de l’accès à son propre Jeu de données GRASS, vous pouvez lire les Jeux de données des
autres utilisateurs (et ils peuvent lire le votre), mais vous ne pouvez modifier ou supprimer que les données de
votre propre Jeu de données.

Tous les Jeux de données incluent un fichier WIND qui stocke l’emprise et la résolution raster courante (voir
Neteler & Mitasova 2008 dans Bibliographie et section L’outil région GRASS).

1. Démarrez QGIS et assurez vous que l’extension GRASS est chargée.

2. Dans la barre d’outils GRASS, cliquez sur Nouveau jeu de données pour ouvrir l’assistant de création de Jeux
de données.

3. Sélectionnez le répertoire grassdata de la base de données GRASS (GISDBASE) qui contient déjà le
SECTEUR ‘alaska’ et où nous voulons ajouter un autre SECTEUR nommé ‘test’.

4. Cliquez sur [Suivant].
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5. Nous pouvons utiliser cet assistant à la fois pour créer un nouveau Jeu de données dans le SECTEUR
existant et pour créer un nouveau SECTEUR. Cliquez sur le bouton radio Sélectionnez le Secteur (voir
figure_grass_location_2) et cliquez sur [Suivant].

6. Entrez le texte du nom pour le nouveau Jeu de données. En dessous, dans l’assistant, vous pouvez
voir une liste des Jeux de données et de leurs propriétaires.

7. Cliquez sur [Suivant], vérifiez le résumé pour vous assurer qu’il est correct et cliquez sur [Terminer].

17.10 Le modèle vecteur de GRASS

Il est important de comprendre le modèle de données vectorielles GRASS avant de se lancer dans la numérisation.
En général, GRASS utilise un modèle de données vectorielles topologique. Cela signifie que les surfaces ne sont
pas représentées par des polygones fermés et distincts, mais par une ou plusieurs limites. Une limite entre des
polygones adjacents n’est numérisée qu’une seule fois et est partagée par les deux surfaces. Les limites doivent
être connectées sans trous. Une surface est identifiée (et libellée) via le centroïde de la surface.

Outre les limites et centroïdes, une couche vectorielle peut également contenir des points et des lignes. Tous ces
éléments de géométrie peuvent être mélangés dans une couche vectorielle et seront représentés dans différentes
‘sous-couches’ dans une carte vectorielle GRASS. Ainsi, une couche GRASS n’est pas un vecteur ou un raster,
mais un niveau à l’intérieur d’une couche vectorielle. Il est important de bien distinguer ceci (même s’il est pos-
sible de mélanger des éléments de géométries différentes, c’est inhabituel et même dans GRASS, on l’utilise dans
des cas particuliers tel que l’analyse de réseau. Normalement, vous devriez stocker des éléments de géométries
différentes dans des couches différentes).

Il est possible de stocker plusieurs ‘sous-couches’ dans une couche vectorielle. Par exemple, des champs, de la
forêt et des lacs peuvent être stockés dans une couche vectorielle. Des forêts et des lacs adjacents partagent les
mêmes limites, mais ils auront des tables attributaires différentes. Il est aussi possible de faire correspondre une
table attributaire aux limites. Par exemple, la limite entre un lac et une forêt peut être une route qui peut avoir une
table attributaire différente.

La ‘sous-couche’ est définie dans GRASS par un chiffre. Ce chiffre définit s’il y a plusieurs sous-couches
à l’intérieur d’une couche vectorielle (par exemple, il définit s’il s’agit de lac ou de forêt). Pour l’instant, il
s’agit d’un nombre, mais dans des versions futures GRASS pourra utiliser des noms pour les sous-couches dans
l’interface utilisateur.

Les données attributaires peuvent être stockées dans le SECTEUR au format dBase, SQLite3 ou dans des tables
de bases de données externes comme par exemple : PostgreSQL, MySQL, Oracle, etc.

Les données attributaires sont liées à la géométrie par le biais d’un champ ‘category’.

‘Category’ (clé, ID) est un entier attaché à la géométrie, et il est utilisé comme lien vers une colonne de clé dans
la table de base de données.

Astuce: Apprendre le modèle vecteur de GRASS
Le meilleur moyen d’apprendre le modèle vecteur de GRASS et ses possibilités est de télécharger
un des nombreux tutoriels GRASS où le modèle vecteur est décrit plus précisément. Voir
http://grass.osgeo.org/documentation/manuals/ pour plus d’informations, livres et tutoriels dans différentes
langues.

17.11 Création d’une nouvelle couche vectorielle GRASS

To create a new GRASS vector layer, select one of following items from mapset context menu in the browser:

• Nouvelle couche de points

• Nouvelle couche de lignes

• Nouvelle couche de polygones
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and enter a name in the dialog. A new vector map will be created and layer will be added to canvas and editing
started. Selecting type of the layer does not restrict geometry types which can be digitized in the vector map. In
GRASS, it is possible to organize all sorts of geometry types (point, line and polygon) in one vector map. The
type is only used to add the layer to the canvas, because QGIS requires a layer to have a specific type.

It is also possible to add layers to existing vector maps selecting one of the items described above from context
menu of existing vector map.

Dans GRASS, il est possible de gérer plusieurs types de géométrie (point, ligne et surface) dans une seule couche
d’information, car GRASS utilise un modèle vecteur topologique. Vous n’avez donc pas besoin de sélectionner
un type de géométrie quand vous créez une couche vectorielle GRASS. Ce comportement est différent de celui
de la création de shapefile avec QGIS, car les shapefiles utilisent un modèle vecteur d’entité simple (voir section
Créer de nouvelles couches vecteur).

17.12 Numérisation et édition de couche vectorielle GRASS

GRASS vector layers can be digitized using the standard QGIS digitizing tools. There are however some particu-
larities, which you should know about, due to

• GRASS topological model versus QGIS simple feature

• complexity of GRASS model

– multiple layers in single maps

– multiple geometry types in single map

– geometry sharing by multiple features from multiple layers

The particularities are discussed in the following sections.

Save, discard changes, undo, redo

Warning: Toutes les modifications faites pendant l’édition sont immédiatement écrites dans la couche vecteur
et les tables attributaires associées.

Les modifications sont écrites après chaque opération mais il est possible d’annuler / refaire une modification ou
toutes les modifications au moment de fermer l’édition. Si une annulation partielle ou complète est utilisée, l’état
d’origine est ré-écrit dans la couche vectorielle et ses tables attributaires associées.

Il y a deux raisons principales à ce comportement :

• It is the nature of GRASS vectors coming from conviction that user wants to do what he is doing and it is
better to have data saved when the work is suddenly interrupted (for example, blackout)

• Necessity for effective editing of topological data is visualized information about topological correctness,
such information can only be acquired from GRASS vector map if changes are written to the map.

Barre d’outils

The ‘Digitizing Toolbar’ has some specific tools when a GRASS layer is edited:
Icône Outil Fonction

Nouveau Point Numérise un nouveau point

Nouvelle Ligne Numérise une nouvelle ligne

Nouveau Contour Digitize new boundary

Nouveau Centroïde Numérise un nouveau centroïde (permet d’étiqueter un polygone existant)

New Closed Boundary Digitize new closed boundary

Tableau Numérisation avec GRASS 1 : outils d’édition GRASS

Astuce: Numérisation de polygones dans GRASS
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Si vous voulez créer un polygone dans GRASS, vous devez numériser premièrement les limites du polygone.
Ensuite, vous ajoutez un centroïde (emplacement de l’étiquette) dans le polygone fermé. La raison en est, que
le modèle vectoriel topologique assure toujours le lien entre les informations d’attributs des polygones via le
centroïde et non via la limite.

Categorie

Category, often called cat, is sort of ID. The name comes from times when GRASS vectors had only singly
attribute “category”. Category is used as a link between geometry and attributes. A single geometry may have
multiple categories and thus represent multiple features in different layers. Currently it is possible to assign only
one category per layer using QGIS editing tools. New features have automatically assigned new unique category,
except boundaries. Boundaries usually only form areas and do not represent linear features, it is however possible
to define attributes for a boundary later, for example in different layer.

New categories are always created only in currently being edited layer.

It is not possible to assign more categories to geometry using QGIS editing, such data are properly represented as
multiple features, and individual features, even from different layers, may be deleted.

Attributs

Attributes of currently edited layer can only be modified. If the vector map contains more layers, features of other
layers will have all attributes set to ‘<not editable (layer #)>’ to warn you that such attribute is not editable. The
reason is, that other layers may have and usually have different set of fields while QGIS only supports one fixed
set of fields per layer.

If a geometry primitive does not have a category assigned, a new unique category is automatically assigned and
new record in attribute table is created when an attribute of that geometry is changed.

Astuce: If you want to do bulk update of attributes in table, for example using ‘Field Calculator’ (Calculatrice
de champ), and there are features without category which you don’t want to update (typically boundaries), you
can filter them out by setting ‘Advanced Filter’ to cat is not null.

Style d’édition

The topological symbology is essential for effective editing of topological data. When editing starts, a specialized
‘GRASS Edit’ renderer is set on the layer automatically and original renderer is restored when editing is closed.
The style may be customized in layer properties ‘Style’ tab. The style can also be stored in project file or in
separate file as any other style. If you customize the style, do not change its name, because it is used to reset the
style when editing is started again.

Astuce: Do not save project file when the layer is edited, the layer would be stored with ‘Edit Style’ which has
no meaning if layer is not edited.

The style is based on topological information which is temporarily added to attribute table as field ‘topo_symbol’.
The field is automatically removed when editing is closed.

Astuce: Do not remove ‘topo_symbol’ field from attribute table, that would make features invisible because the
renderer is based on that column.

Accrochage

To form an area, vertices of connected boundaries must have exactly the same coordinates. This can be achieved
using snapping tool only if canvas and vector map have the same CRS. Otherwise, due conversion from map
coordinates to canvas and back, the coordinate may become slightly different due to representation error and CRS
transformations.

Astuce: Use layer’s CRS also for canvas when editing.

Limites
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Simultaneous editing of multiple layers within the same vector at the same time is not supported. This is mainly
due to the impossibility of handling multiple undo stacks for a single data source.

On Linux and Mac OSX only one GRASS layer can be edited at time. This is due to a bug in GRASS which
does not allow to close database drivers in random order. This is being solved with GRASS developers.

Astuce: Droits d’édition GRASS
Vous devez être propriétaire du Jeu de données que vous voulez éditer. Il est impossible de modifier des
informations d’un Jeu de données qui n’est pas à vous, même si vous avez des droits en écriture.

17.13 L’outil région GRASS

La définition d’une région (définir une emprise spatiale de travail) dans GRASS est très importante pour travailler
avec des couches rasters. Le travail d’analyse vecteur n’est, par défaut, pas limitée à une région définie. Mais, tous
les rasters nouvellement créés auront l’emprise spatiale et la résolution de la région GRASS en cours d’utilisation,
indépendamment de leur emprise et résolution d’origine. La région courante GRASS est stockée dans le fichier
$LOCATION/$MAPSET/WIND, et celui-ci définit les limites Nord, Sud, Est et Ouest, le nombre de lignes et de
colonnes ainsi que la résolution spatiale horizontale et verticale.

Il est possible d’afficher ou de masquer l’emprise de la région GRASS dans QGIS à l’aide du bouton
Afficher la région courante GRASS.

The region can be modified in ‘Region’ tab in ‘GRASS Tolls’ dock widget. Type in the new region bounds and
resolution, and click [Apply]. If you click on [Select the extent by dragging on canvas] you can select a new
region interactively with your mouse on the QGIS canvas dragging a rectangle.

Le module GRASS g.region propose un grand nombre de paramètres pour définir de façon appropriée les
limites et la résolution d’une région pour faire de l’analyse raster. Vous pouvez vous servir de ces paramètres dans
la boîte à outils GRASS décrite dans la section La Boîte à outils GRASS.

17.14 La Boîte à outils GRASS

La fenêtre Ouvrir les outils GRASS donne accès aux fonctionnalités GRASS qui permettent de travailler sur les
données d’un SECTEUR et d’un Jeu de données. Pour utiliser la Boîte à outils GRASS, vous devez ouvrir
un SECTEUR et un Jeu de données sur lequel vous avez des droits d’écriture (que vous avez normalement si
vous avez créé le Jeu de données). Cela est nécessaire car les rasters et les vecteurs nouvellement créés lors
des analyses doivent être écrits dans le SECTEUR et Jeu de données courant.

17.14.1 Travailler avec les modules GRASS

La console de la Boîte à outils GRASS vous donne accès à pratiquement tous les modules GRASS (plus de 300)
en ligne de commande. Afin d’offrir un environnement de travail plus agréable, environ 200 d’entre eux sont
disponibles via l’interface graphique de la Boîte à outils GRASS.

La liste des modules GRASS disponibles via la Boîte à outils de QGIS 2.14 est détaillée sur le wiki de GRASS :
http://grass.osgeo.org/wiki/GRASS-QGIS_relevant_module_list.

Il est aussi possible de personnaliser le contenu de la boîte à outils GRASS. Ceci est décrit dans la section
Paramètrer la boîte à outils GRASS.

Comme indiqué sur la figure figure_grass_toolbox_1, vous pouvez chercher le module GRASS approprié en util-
isant l’onglet Arborescence des modules ou en utilisant l’onglet Liste des Modules pour faire une recherche.

Lorsque vous cliquez sur un module, un nouvel onglet apparaît proposant trois sous-onglets : Options, Rendu et
Manuel.
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Figure 17.3: GRASS Toolbox and Module Tree

Options

L’onglet Options propose une interface simplifiée où vous pouvez sélectionner un raster ou un vecteur en cours de
visualisation dans QGIS et saisir les paramètres spécifiques au module avant de le lancer.

Tous les paramètres du module ne sont généralement pas fournis afin de simplifier les fenêtres. Pour utiliser des
paramètres qui ne se trouvent pas dans la fenêtre, vous devez utiliser la console GRASS et lancer les modules en
lignes de commande.

Une nouvelle fonctionnalité depuis QGIS 1.8.0 est l’ajout d’un bouton Afficher les options avancées >> en-
dessous de la fenêtre simplifiée de l’onglet Options. Pour l’instant seul le module v.in.ascii a été adapté afin
de servir d’exemple d’utilisation mais d’autres le seront dans les prochaines versions de QGIS. La finalité est de
pouvoir recourir à toutes les options de GRASS sans devoir ouvrir la console GRASS.

Rendu

L’onglet Rendu fournit des informations sur l’état de sortie du module. Quand vous cliquez sur le bouton [Lancer],
le module passe sur l’onglet Rendu et vous voyez les informations sur le processus en cours. Si tout se passe bien,
vous verrez finalement le message Terminé avec succès.

Manuel

L’onglet Manuel montre la page HTML d’aide du module GRASS. Vous pouvez vous en servir pour voir les autres
paramètres du module et pour avoir une connaissance plus approfondie de l’objet du module. À la fin de chaque
page d’aide d’un module, vous avez des liens vers Main Help index (index principal), Thematic.index
(index par thème) et Full.index (index complet). Ces liens vous donnent les mêmes informations que si vous
utilisiez directement g.manual.

Astuce: Afficher les résultats immédiatement
Si vous voulez voir immédiatement dans votre fenêtre carte le résultat des calculs du module, vous pouvez utiliser
le bouton ‘Vue’ au bas de l’onglet du module.

17.14.2 Exemples de modules GRASS

Les exemples suivants décrivent les possibilités de certains modules GRASS.
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Figure 17.4: GRASS Toolbox Module Options

Figure 17.5: GRASS Toolbox Module Output
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Figure 17.6: GRASS Toolbox Module Manual
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Création de courbes de niveau

Le premier exemple permet de créer une couche vectorielle de courbes de niveau à partir d’un modèle numérique
de terrain (MNT). Ici, nous considérerons que le SECTEUR Alaska a été installé comme décrit dans la section
Importer des données dans un SECTEUR GRASS.

• Premièrement, ouvrez le secteur en cliquant sur le bouton Ouvrir le jeu de données et choisissez le secteur
Alaska.

• Ouvrez la boite à outils à l’aide du bouton Ouvrir les outils GRASS.

• Dans la liste des outils double-cliquez sur Raster -> Gestion de surface -> Générer des lignes vectorielles
de contours.

• Now a single click on the tool r.contour will open the tool dialog as explained above (see Travailler avec
les modules GRASS).

• In the Name of input raster map enter gtopo30.

• Dans le champ Increment between Contour levels , saisissez la valeur 100. (Cela va créer des courbes
de niveau tous les 100 mètres)

• Saisisez dans le champ Nom de la couche vectorielle en sortie, le nom ctour_100.

• Cliquer sur [Lancer] pour lancer le traitement. Attendez quelques instants que le message Terminé avec
succès apparaisse à l’écran. Cliquez enfin sur [Vue] puis [Fermer].

Comme il s’agit d’une grande région, cela prendra un certain temps à s’afficher. Une fois l’affichage terminé, vous
pouvez ouvrir la fenêtre de propriétés de la couche pour changer la couleur des courbes de niveau afin qu’elles
apparaissent clairement au dessus de la couche raster d’élévation comme décrit dans Fenêtre Propriétés d’une
couche vecteur.

Zoomez sur une petite région montagneuse du centre de l’Alaska. Avec un zoom important, vous constaterez
que les courbes de niveau sont constituées de lignes brisées avec des angles vifs. GRASS offre la possibilité de
généraliser les cartes vecteurs à l’aide de l’outil v.generalize, tout en conservant leur forme générale. L’outil utilise
différents algorithmes ayant différents objectifs. Certains de ces algorithmes (par exemple : Douglas Peucker et
Réduction de Vertex) simplifient les lignes en supprimant des sommets. La couche simplifiée se chargera plus
rapidement. Cette commande est utile lorsque vous avez une couche vectorielle très détaillée et que vous créez
une carte à petite échelle où les détails ne sont donc pas nécessaires.

Astuce: L’outil de simplification
Vous remarquerez que fTools dispose aussi d’un outil de simplification Simplifier la géometrie qui fonctionne
comme l’algorithme Douglas-Peucker de GRASS, v.generalize.

Cependant, le but de cet exemple est différent. Les courbes de niveau créées avec r.contour ont des angles vifs
qui doivent être lissés. Parmi les algorithmes de v.generalize, il y a l’algorithme de Chaiken qui fait justement ça
(comme Hermite splines). Gardez à l’esprit que ces algorithmes peuvent ajouter des sommets supplémentaires
au vecteur, l’amenant à se charger encore plus lentement.

• Ouvrez la Boîte à outils GRASS et double cliquez sur Vecteur -> Développer la carte -> Généralisation.
Cliquez alors sur le module v.generalize pour ouvrir sa fenêtre d’options.

• rifier que la couche vectorielle ‘ctour_100’ apparait dans le champ Nom de la couche vectorielle en entrée.

• Dans la liste des algorithmes choisissez Chaiken. Laisser les autres options par défaut et descendez à la
dernière ligne pour donner le nom de la couche d’information à créer : Nom de la couche vectorielle en
sortie ‘ctour_100_smooth’, et cliquez sur [Lancer].

• Cela peut prendre plusieurs minutes. Lorsque le texte Terminé avec succès apparait, cliquez sur le
bouton [Vue] puis sur [Fermer].

• Vous pouvez changer la couleur de cette couche vectorielle pour qu’elle apparaisse clairement sur le raster
et qu’elle contraste aussi avec la couche de départ.Vous remarquerez que les nouvelles courbes de niveau
ont des angles plus arrondis que l’original tout en restant fidèle à la forme globale d’origine.
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Figure 17.7: GRASS module v.generalize to smooth a vector map

Astuce: Autres utilisations de r.contour
La procédure décrite ci-dessus peut être utilisée dans d’autres cas similaires. Si vous disposez d’une couche
d’informations raster représentant des précipitations, par exemple, vous pouvez utiliser la même méthode pour
créer des isohyètes (lignes reliant des points d’égales quantités de précipitations).

Créer un ombrage avec effet 3D

Différentes méthodes sont utilisées pour afficher les modèles numérique de terrain et donner un effet 3D au carte.
L’utilisation de courbes de niveau comme décrit ci-dessus est un des moyens souvent utilisés pour produire des
cartes topographiques. Un autre moyen de rendre cet effet 3D est d’utiliser l’ombrage. L’ombrage est créé à
partir du modèle numérique de terrain (MNT) en calculant d’abord les pentes et les expositions puis en simulant
la position du soleil dans le ciel ce qui donne à chaque cellule une valeur de réflectance. Les pentes éclairées par
le soleil sont plus claires et les pentes à l’abri du soleil sont plus sombres.

• Commencez par ouvrir la couche raster gtopo30. Ouvrez la Boîte à outils GRASS et dans la catégorie
Raster double cliquez sur Analyse spatiale → Analyse de terrain.

• Cliquez ensuite sur r.shaded.relief pour lancer le module.

• Changer l’ Azimuth du soleil par rapport au nord, en degrés et mettez 315 au lieu de 270.

• Saisissez gtopo30_shade comme nom pour la nouvelle couche d’ombrage et cliquez sur le bouton
[Lancer].

• Quand le calcul est terminé, ajoutez le raster d’ombrage à la fenêtre carte. Normalement, il devrait s’afficher
en niveau de gris.

• Pour voir les deux couches d’informations ombrage et gtopo30 en même temps, placez la couche ombrage
sous la couche gtopo30 dans le gestionnaire de couches et ouvrez la fenêtre Propriétés de la couche
gtopo30, allez sur l’onglet Transparence et fixez la transparence à environ 25%.

Vous devriez maintenant avoir la couche gtopo30 en couleur et en transparence, affiché au dessus de la
couche d’ombrage en niveau de gris. Pour bien visualiser l’effet d’ombrage, décochez puis recochez la couche
gtopo30_shade dans la légende.

Utiliser la console GRASS

L’extension Grass de QGIS est faite pour les utilisateurs ne connaissant pas GRASS et qui ne sont pas familiers
avec les modules et les options. Ainsi, certains modules dans la Boîte à outils n’apparaissent pas avec toutes les
options possibles et certains n’apparaissent pas du tout. La console GRASS donne accès à ces modules addition-
nels qui n’apparaissent pas dans la Boîte à outils et aux options supplémentaires des modules qui n’apparaissent

262 Chapter 17. Intégration du SIG GRASS



QGIS User Guide, Version 2.14

que de façon simplifiée dans la Boîte à outils. Cet exemple montre l’utilisation d’une option supplémentaire du
module r.shaded.relief utilisé ci-dessus.

Figure 17.8: The GRASS shell, r.shaded.relief module

Le module r.shaded.relief possède un paramètre zmult qui multiplie la valeur de l’altitude (exprimé dans la
même unité que les coordonnées X - Y) ce qui a pour effet d’accentuer le relief.

• Ouvrez le raster gtopo30 comme ci-dessus, lancez la Boîte à outils GRASS et ouvrez la
console GRASS. Dans la console, entrez la ligne suivante r.shaded.relief map=gtopo30
shade=gtopo30_shade2 azimuth=315 zmult=3 et pressez [Entrée].

• Une fois le calcul terminé, allez sur l’onglet Parcourir et double-cliquez sur le nouveau raster
gtopo30_shade2 pour l’afficher dans QGIS.

• Comme expliqué ci-dessus, placez le raster d’ombrage sous le raster gtopo30 puis vérifiez la transparence
du raster gtopo30. Vous devriez constater que le relief apparaît plus marqué qu’avec le premier raster
d’ombrage.

Statistiques raster avec des couches vectorielles

L’exemple suivant comment un module GRASS peut aggréger des données raster et ajouter des colonnes de
statistiques pour chaque polygone d’une couche vectorielle.
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Figure 17.9: Displaying shaded relief created with the GRASS module r.shaded.relief

• Encore une fois, nous allons utiliser le jeu de données Alaska. Référez vous à Importer des données dans
un SECTEUR GRASS pour importer les shapefiles contenus dans le répetoire shapefiles dans GRASS.

• Un étape intermédiaire est nécessaire : des centroïdes doivent importés afin d’avoir une couche GRASS
vecteur complète (qui inclue les contours et les centroïdes).

• Dans la Boîte à outils choisissez Vecteur -> Gestion des entités et ouvrez le module v.centroids.

• Entrez ‘forest_areas’ comme nom de couche en sortie et lancez le module.

• Maintenant ouvrez la couche vectorielle forest_areas et affichez les types de forêts avec différentes
couleurs : caduques, persistentes, mélangées. Dans la fenêtre Propriétés, onglet symbologie , choisissez le

Type de légende ‘Valeur unique’ et le champ ‘VEGDESC’ comme champ de classification. (Reportez
vous aux explications de l’onglet Symbologie Onglet Style de la section vecteur).

• Réouvrez la Boîte à outils GRASS et ouvrez Vecteur -> Mise à jour vectorielle via d’autres cartes.

• Cliquez sur le module v.rast.stats. Saisissez gtopo30 et forest_areas.

• Un seul paramètre additionnel est requis : Entrez elev pour le column prefix, et cliquez sur le bouton
[Lancer]. C’est un opération lourde qui peut durer longtemps (jusqu’à deux heures).

• Pour finir, ouvrez la table attributaire de forest_areas, et vérifiez que plusieurs nouvelles colonnes ont
étés ajoutées dont elev_min, elev_max, elev_mean, etc., pour chaque polygone de forêt.

17.14.3 Paramètrer la boîte à outils GRASS

Pratiquement tous les modules GRASS peuvent être ajoutés à la Boîte à outils. Une interface XML est fournie
pour analyser les fichiers XML très simples qui configurent l’apparence et les paramètres des modules dans la
boîte à outils.

Un exemple de fichier XML pour le module v.buffer (v.buffer.qgm) est donné ci-dessous :

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE qgisgrassmodule SYSTEM "http://mrcc.com/qgisgrassmodule.dtd">

<qgisgrassmodule label="Vector buffer" module="v.buffer">
<option key="input" typeoption="type" layeroption="layer" />
<option key="buffer"/>
<option key="output" />

</qgisgrassmodule>

L’analyseur lit cette définition et crée un nouvel onglet à l’intérieur de la Boîte à outils lorsque vous
sélectionnez le module. Une description plus détaillée pour ajouter des modules, changer les groupes
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de modules, etc. est disponible sur le wiki de QGIS à l’adresse http://hub.qgis.org/projects/quantum-
gis/wiki/Adding_New_Tools_to_the_GRASS_Toolbox.
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CHAPTER 18

Outils de traitement QGIS

18.1 Introduction

Ce chapitre présente le module de Traitements de QGIS, un environnement de géo-traitements qui permet
d’exécuter des algorithmes natifs ou d’applications tierces directement depuis QGIS, vous permettant d’effectuer
des tâches d’analyses spatiales rapidement et efficacement.

Dans les sections suivantes, seront exposés les éléments graphiques de ce module et comment les exploiter au
maximum.

Il y a quatre éléments de base dans l’interface graphique du module de Traitements, permettant d’exécuter dif-
férents algorithmes. Le choix d’un outil plutôt qu’un autre dépendra du type d’analyse à réaliser, selon les
préférences de l’utilisateur et du projet. Tous les éléments (à l’exception de l’interface de traitement par lots
qui est appelé par la boîte à outils ou la fenêtre d’exécution d’un algorithme) peuvent être utilisées à partir du
menu Traitements. (Vous y verrez plus que quatre entrées de menu : les autres entrées ne sont pas destinées à
l’exécution d’algorithmes et seront expliquées plus tard dans ce chapitre).

• La Boîte à outils. Il s’agit de l’élément principal de l’interface du module de Traitements et permet de lancer
les algorithmes individuellement ou par lot.

• Le modeleur graphique. Les algorithmes peuvent être combinés graphiquement en utilisant le modeleur
pour définir une chaîne de traitements, composée de plusieurs étapes de traitement

• Le gestionnaire d’historiques. Toutes les actions réalisées par un élément précité sont sauvegardées dans un
fichier d’historique et peuvent être aisément reproduites grâce au gestionnaire d’historiques.

• Le gestionnaire de traitement par lot. Cette interface permet d’exécuter des traitements par lots et
d’automatiser l’exécution d’un même traitement sur plusieurs sources de données.

Dans les sections suivantes, chacun de ces éléments sera détaillé.

18.2 La boîte à outils

La Boîte à outils est l’élément principal du module de Traitements et probablement celui que vous utiliserez le
plus au quotidien. Elle montre la liste des algorithmes disponibles, regroupés en plusieurs catégories. C’est aussi
par son intermédiaire qu’il est possible d’exécuter un algorithme sur un jeu de données en entrée, ponctuellement
ou par lot.

The toolbox contains all the available algorithms, divided into so-called “Providers”.

Providers can be (de)activated in the settings dialog. A label in the bottom part of the toolbox will remind you
of that whenever there are inactive providers. Use the link in the label to open the settings window and set up
providers. We will discuss the settings dialog later in this manual.

By default only, providers that do not rely on third-party applications (that is, those that only require QGIS el-
ements to be run) are active. ALgorithms requiring external applications might need additional configuration.
Configuring providers is explained in a later chapter in this manual.
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Figure 18.1: Boîte à outils de Traitements
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Figure 18.2: Modeleur de chaîne de traitement

Figure 18.3: Historique des traitements
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Figure 18.4: Interface de Traitements par lot

Dans la partie haute de la boîte à outils se trouve un champ texte. Pour réduire le nombre d’algorithmes affichés
dans la boîte à outils et vous permettre de trouver celui qui vous convient, il vous suffit d’entrer un mot-clé ou une
phrase dnas ce champ. La liste des algorithmes contenant ce texte est filtrée au fur et à mesure de la saisie.

If there are algorithms that match your search but belong to a provider that is not active, an additional label will
be shown in the lower part of the toolbox.

If you click on the link in that label, the list of algorithms will also include those from inactive providers, which
will be shown in light gray. A link to active each inactive provider is also shown.

Pour exécuter un algorithme, double-cliquez simplement sur son nom dans la boîte à outils.

18.2.1 La fenêtre Algorithme

Une fois que vous avez double-cliqué sur le nom de l’algorithme à exécuter, une fenêtre semblable à la suivante
sera affichée (ici, il s’agit de la fenêtre de l’algorithme ‘Centroïdes de polygones’).

Cette fenêtre permet de définir les données d’entrée à l’algorithme. Elle présente ici la liste des données d’entrée
et des paramètres à fournir. Cette fenêtre différera selon les paramètres nécessaires à l’exécution de l’algorithme
et sera créée automatiquement.

Les algorithmes différeront par le nombre et le type de paramètres, mais la structure sera la même pour tous. Les
paramètres présents dans la table pourront être un des types suivants.

• Une couche raster, à sélectionner dans la liste des couches de ce type disponibles (ouvertes) dans QGIS.
Le sélecteur contient également un bouton sur sa partie droite, pour choisir un fichier correspondant à une
couche non ouverte dans QGIS.

• Une couche vectorielle, à sélectionner dans la liste des couches disponibles dans QGIS. Tout comme pour
les couches raster, vous pouvez sélectionner une couche par son nom de fichier, mais à la condition que
l’algorithme ne nécessite pas un champ de cette couche vectorielle. Dans ce dernier cas, il est nécessaire de
charger au préalable la couche vectorielle, afin de pouvoir accéder à la liste des champs.

Vous verrez un bouton pour chaque sélecteur de couche de vecteur, comme le montre la figure ci-dessous.

Si l’algorithme propose plusieurs boutons d’itération, vous ne pourrez en activer qu’un seul. Si un bouton cor-
respondant à une couche vecteur est activé, l’algorithme s’exécutera successivement sur chacune des entités de
la couche plutôt que sur la couche en entier, produisant alors autant de sorties que de nombre d’exécution de
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Figure 18.5: Boîte à outils de Traitements
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Figure 18.6: Processing Toolbox showing search results
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Figure 18.7: Processing Toolbox showing search results
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Figure 18.8: Fenêtre de paramètres

Figure 18.9: Bouton d’itération sur les couches vecteur
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l’algorithme. Cela permet d’automatiser un traitement qui doit être réalisé sur chaque entité d’une couche séparé-
ment.

• Une table, à sélectionner dans la liste des tables disponibles dans QGIS. Des tables non spatiales peu-
vent être chargées dans QGIS comme les couches vectorielles et sont en fait traitées de la même manière.
Actuellement, les seules tables utilisables par les algorithmes proviennent de fichiers dBase (.dbf) ou CSV
(.csv).

• Une option, à choisir dans une liste d’options possibles.

• Une valeur numérique, à entrer dans le champ. Sur le côté se situe un bouton, vous permettant d’entrer une
expression mathématique ou une valeur calculée. Des formules basées sur les données chargées dans QGIS
peuvent être ajoutées à l’expression, par exemple la taille des cellules d’une couche ou le point le plus au
nord d’une autre.

Figure 18.10: Sélecteur de nombre

• Un intervalle, où doivent être remplies les valeurs minimales et maximales.

• Une chaîne de texte, à mettre dans le champ correspondant.

• Le num d’un champ, à choisir dans la liste des attributs d’une couche vectorielle ou d’une table préalable-
ment sélectionnées.

• Un système de coordonnées de référence. Vous pouvez saisir le code EPSG directement dans la zone de
texte ou le sélectionner depuis la fenêtre de sélection du SCR qui apparaît lorsque vous cliquez sur le bouton
à droite

• Une emprise, à entrer sous la forme des quatre limites xmin, xmax, ymin, ymax. En cliquant sur le bouton
situé à droite du sélecteur, un menu apparaîtra, vous permettant de choisir l’emprise courante du canevas ou
de le sélectionner avec la souris sur le canevas.

Figure 18.11: Sélecteur d’emprise

Dans le premier cas s’affichera une fenêtre comme celle-ci.

Dans le second cas, la fenêtre de paramètres sera cachée afin de vous permettre de cliquer et glisser sur le
canevas. Une fois le rectangle délimité, la fenêtre réapparaîtra, contenant les valeurs de l’emprise choisie.
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Figure 18.12: Liste d’emprises

Figure 18.13: Sélection interactive d’une emprise

• Une liste d’éléments (parmi les couches raster, vectorielles ou les tables), à choisir dans la liste des éléments
disponibles dans QGIS. Pour sélectionner un élément, cliquez sur le petit bouton situé à sa gauche pour faire
apparaître une fenêtre comme celle-ci.

Figure 18.14: Sélection Multiple

• Une petite table, à éditer par l’utilisateur, pour définir certains paramètres tels que tables de recherche ou le
produit de convolution.

Cliquez sur le bouton sur le côté droit pour voir la table et éditer ses valeurs.

Selon l’algorithme, les lignes sont modifiables ou non, en utilisant les boutons situés à droite de la fenêtre.

Along with the parameters tab, you will find another tab named ‘Log’. Information provided by the algorithm
during its execution is written in this tab, and allow you to track the execution and be aware and have more details
about the algorithm as it runs. Notice that not all algorithms write information to this tab, and many of them might
run silently without producing any output other than the final files.
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Figure 18.15: Table fixe

On the right hand side of the dialog you wil find a short description of the algorithm, which will help you un-
derstand its purpose and its basic ideas. If such a description is not available, the description panel will not be
shown.

Some algorithms might have a more detailed help file, which might include description of every parameter it uses,
or examples. In that case, you will find a Help tab in the parameters dialog.

A propos des projections

Les algorithmes lancés depuis le module de traitement - ainsi que la plupart des applications tierces utilisables à
partir du module - n’effectuent pas de reprojection des couches en entrée et supposent que toutes les données sont
déjà dans un système de coordonnées identique pour être analysées. Si plusieurs couches, aussi bien raster que
vecteurs, sont utilisées par un algorithme, c’est à vous de vérifier qu’ils sont dans le même système de coordonnées.

Notez que, du fait des possibilités de projection à la volée de QGIS, bien que deux couches puissent sembler se
chevaucher et correspondre, ceci pourrait ne pas être vrai si leurs coordonnées originales sont indiquées dans des
systèmes de projection différents. La reprojection dans un système identique doit être effectuée manuellement
et les fichiers qui en résultent, utilisés comme couches d’entrée pour l’algorithme. Notez que le processus de
reprojection peut aussi être réalisé avec les algorithmes déjà disponibles dans le cadre de traitement.

Par défaut, la fenêtre de paramétrage affichera une description du SCR de chaque couche à côté de son nom,
rendant facile la sélection des couches ayant un SCR identique comme couches en entrée. Si vous ne souhaitez
pas avoir cette information complémentaire, vous pouvez désactiver cette fonctionnalité dans la fenêtre de config-
uration des traitements en décochant l’option Afficher SCR.

Si vous essayez d’exécuter un algorithme avec deux ou plusieurs couches en entrée avec des SCR non identiques,
une fenêtre d’alerte s’affichera.

Vous pourrez toujours exécuter l’algorithme mais sachez que dans la plupart des cas, ceci générera des résultats
erronés, comme des couches vides du fait de couches en entrée qui ne se superposent pas.

18.2.2 Les données générées par les algorithmes

Les données générées par un algorithme peuvent être des types suivants :

• Une couche raster

• Une couche vectorielle

• Une table
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• Un fichier HTML (utilisé pour les sorties texte et graphiques)

These are all saved to disk, and the parameters table will contain a text box corresponding to each one of these
outputs, where you can type the output channel to use for saving it. An output channel contains the information
needed to save the resulting object somewhere. In the most usual case, you will save it to a file, but in the case of
vector layers, and when they are generated by native algorithms (algorithms not using external applications) you
can also save to a PostGIS or Spatialite database, or a memory layer.

To select an output channel, just click on the button on the right side of the text box, and you will see a small
context menu with the available options.

In the most usual case, you will select saving to a file. If you select that option, you will be prompted with a
save file dialog, where you can select the desired file path. Supported file extensions are shown in the file format
selector of the dialog, depending on the kind of output and the algorithm.

The format of the output is defined by the filename extension. The supported formats depend on what is supported
by the algorithm itself. To select a format, just select the corresponding file extension (or add it, if you are directly
typing the file path instead). If the extension of the file path you entered does not match any of the supported
formats, a default extension will be appended to the file path, and the file format corresponding to that extension
will be used to save the layer or table. Default extensions are .dbf for tables, .tif for raster layers and .shp
for vector layers. These can be modified in the setting dialog, selecting any other of the formats supported by
QGIS.

If you do not enter any filename in the output text box (or select the corresponding option in the context menu),
the result will be saved as a temporary file in the corresponding default file format, and it will be deleted once you
exit QGIS (take care with that, in case you save your project and it contains temporary layers).

Vous pouvez définir une répertoire par défaut pour la sortie des données. Allez dans la fenêtre de configuration
(par le menu Traitements) et dans le groupe Général, vous trouverez un paramètre Dossier de sortie. Il constituera
le dossier par défaut si vous entrez un nom de fichier sans chemin (par exemple monfichier.shp) dans un
algorithme.

Lorsque vous lancez un algorithme qui utilise une couche vectorielle en mode itératif, le chemin de fichier entré
est pris comme chemin de base pour tous les fichiers de sortie, dont le nom correspondra au nom du fichier de
base suivi du numéro d’index d’itération. L’extension du fichier (et le format) sera la même pour tous les fichiers
générés.

En plus des couches raster et vecteur, les algorithmes génèrent des graphiques et des textes sous forme de fichiers
HTML. Ces sorties sont montrées à la fin de l’exécution de chaque algorithme dans une nouvelle fenêtre. Cette
fenêtre conserve les résultats produits par tous les algorithmes lancés pendant la session en cours et peut être
affichée à tout moment via le menu Traitements→ Affichage des résultats du menu principal de QGIS.

Certaines applications tierces peuvent créer des fichiers d’un type différent à ceux précédemment exposés. Ces
fichiers résultats ne seront pas gérés par QGIS (ouverts ou intégrés dans le projet courant) dans la mesure où le
format de fichier n’est pas reconnu par QGIS. C’est par exemple le cas de fichier LAS produits par LiDAR. Ces
fichiers sont créés, mais vous ne verrez rien de plus dans la session de travail QGIS.

Pour les autres types de résultat, vous pourrez choisir de les charger ou non à l’issue de l’exécution de l’algorithme
en cochant la case. Par défaut, tous les fichiers sont chargés.

Le Module de Traitements ne prend pas en charge de sorties optionnelles. Tous les résultats sont créés. Cependant
vous pouvez choisir de désactiver les sorties qui ne vous intéressent pas (ces fichiers seront créés dans des fichiers
temporaires qui seront supprimés en quittant QGIS).

18.2.3 Configurer le Module de Traitements

Comme mentionné précédemment, le menu de configuration permet d’accéder à une nouvelle fenêtre dans laque-
lle vous pouvez paramétrer le fonctionnement des algorithmes. Les paramètres sont regroupés en blocs sélec-
tionnables sur la partie gauche.

A côté de l’entrée Dossier de sortie déjà exposée, le bloc Général contient les paramètres pour le style de rendu
par défaut des couches générées par les algorithmes. Créez ces styles à l’aide de QGIS, sauvegardez-les dans un
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fichier que vous indiquerez dans la configuration de l’algorithme. Une couche traitée par l’algorithme présentera
alors ce style dans le canevas de QGIS.

Le rendu des styles peut être configuré pour chaque algorithme et pour chacune de ses sorties. Cliquez avec le
bouton droit sur le nom de l’algorithme dans la boîte à outils et sélectionnez Éditer les styles de rendu. Une fenêtre
comme celle-ci apparaitra.

Figure 18.16: Styles de rendu

Sélectionnez le fichier de style (.qml) que vous souhaitez appliquer à chaque résultat et appuyez sur [OK].

Les autres paramètres de configuration du groupe Général sont les suivants :

• Utiliser le nom de fichier comme nom de couche. Le nom de chaque couche créée par un algorithme est
défini par l’algorithme lui-même. Dans certains cas, un nom fixe peut être utilisé, ce qui signifie que le
même nom sera utilisé, quelle que soit la couche utilisée en entrée. Dans d’autres cas, le nom peut dépendre
du nom de la couche d’entrée ou de certains des paramètres utilisés pour exécuter l’algorithme. Si cette case
est cochée, le nom sera plutôt issu de celui du fichier de sortie. Notez, que, si la sortie est enregistrée dans
un fichier temporaire, le nom de ce fichier temporaire est généralement long et créé de manière à éviter les
collisions avec d’autres noms de fichiers déjà existants.

• Keep dialog open after running algorithm. Once an algorithm has finished execution and its output layers
are loaded into the QGIS project, the algorithm dialog is closed. If you want to keep it open (to run the
algorithm again with different parameters, or to better check the output that is written to the log tab), check
this option

• N’utiliser que les entités sélectionnées. Si cette option est sélectionnée, chaque fois qu’une couche vecteur
est utilisée comme entrée pour un algorithme, seules ses entités sélectionnées seront utilisées. Si aucune
entité de la couche n’est sélectionnée, toutes seront utilisées.

• Script Pré-exécution et Script Post-exécution. Ces paramètres font référence à des scripts écrits à l’aide des
fonctions du menu Traitements et sont expliqués dans la section abordant les algorithmes et la console.

Vous trouverez également un bloc Général pour chaque fournisseur d’algorithmes. Chaque bloc contient une
rubrique Activé pour le faire apparaître dans la boîte à outils. De plus, certains fournisseurs ont leurs propres
options de configuration. Cela sera détaillé dans la description de chaque fournisseur.

18.3 Le modeleur graphique

Le modeleur graphique vous permet de créer des modèles complexes en utilisant une interface simple et facile
à utiliser. Dans un SIG, la plupart des opérations d’analyses ne sont pas simples mais font parties d’une chaîne
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d’opérations. En utilisant le modeleur graphique, cette chaîne de traitements peut être regroupée dans une tâche,
qui est plus simple à exécuter et peut être réutilisée sur d’autres jeux de données. Peu importe le nombre d’étapes et
d’algorithmes impliqués, un modèle est exécuté comme un seul algorithme, permettant ainsi d’économiser temps
et effort, notamment sur de plus grands modèles.

Le modeleur peut être ouvert à partir du menu Traitements.

Le modeleur possède un espace de travail où sont représentés la structure du modèle et le flux de traitement. Sur
la partie gauche se trouve un panneau avec deux onglets pour ajouter de nouveaux éléments au modèle.

Figure 18.17: Modeleur

Deux étapes sont nécessaires pour la création d’un modèle:

1. Définir les entrées nécessaires. Ces entrées seront ajoutées à la fenêtre des paramètres, afin que l’utilisateur
puisse y fixer les valeurs nécessaires à l’excéution du modèle. Le modèle en lui-même est un algorithme.
Ainsi la fenêtre des paramètres est générée automatiquement comme cela est le cas pour tous les algorithmes
fournis avec le Module de Traitements.

2. Définir le flux de traitements. A partir des données d’entrée du modèle, le flux de traitements est défini
en ajoutant des algorithmes et en sélectionnant comment ces derniers utiliseront les données ou d’autres
données générées par d’autres algorithmes déjà présents dans le modèle.

18.3.1 Définition des données d’entrée

La première étape pour créer un modèle est de définir les données d’entrées nécessaires. Vous trouverez les
éléments suivants dans l’onglet Entrées dans la partie gauche de la fenêtre du modeleur :

• Couche raster

• Couche vectorielle

• Chaîne de caractères
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• Champ d’une table

• Table

• Etendue

• Nombre

• Booléen

• Fichier

Double cliquez sur ces éléments pour faire apparaître une fenêtre avec leurs détails. Selon le paramètre, cette
fenêtre peut contenir une simple description (que l’utilisateur verra à l’exécution du modèle) ou d’autres informa-
tions. Par exemple, à l’ajout d’une valeur numérique, à la description devront être définies la valeur par défaut
ainsi que la liste des valeurs valides. La figure suivante illustre cette fenêtre.

Figure 18.18: Paramètres du modèle

Pour chaque donnée d’entrée ajoutée, un nouvel élément apparaît dans l’espace de travail du modeleur.

Figure 18.19: Paramètres du modèle

Vous pouvez également ajouter des données d’entrée en faisant glisser le type choisi depuis la liste et en le déposant
dans le modèle à l’endroit souhaité.

18.3.2 Définition d’un flux de traitements

Une fois les données d’entrée définies, il faut à présent ajouter les algorithmes de traitement. Ces algorithmes se
situent dans l’onglet Algorithmes, regroupés par fournisseur comme dans la boîte à outils.
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Figure 18.20: Paramètres du modèle

Pour ajouter un algorithme, double-cliquez sur son nom ou faites-le glisser comme pour les données d’entrée.
Une boîte d’exécution apparaît, semblable à celle qui apparaît lorsque l’on lance ce même algorithme à partir
de la boîte à outils. L’illustration suivante montre celle correspondant à l’algorithme ‘Index de convergence’ de
SAGA.

Comme vous pouvez le voir, quelques différences existent entre les deux fenêtres. Ainsi, le nom de fichier en
sortie de l’algorithme est remplacé par un simple champ texte. Pour créer une couche temporaire en sortie pour
être utilisée par un autre algorithme et supprimée à la fin, laissez le champ texte vide. Dans le cas contraire, la
couche résultante sera un résultat final de l’algorithme et portera le nom défini dans le champ de texte. C’est ce
nom que verra l’utilisateur du modèle à son exécution.

La sélection des valeurs de chaque paramètre s’effectue également différemment, en raison de la différence de
contexte entre le modeleur et la boite à outils. Détaillons les valeurs pour chaque type de paramètre.

• Les couches raster et vectorielles et les tables. Elles sont à choisir dans une liste, non pas des couches ou
tables déjà chargées dans QGIS, mais soit des entrées du modèle, soit des couches et/ou tables générées par
les algorithmes déjà présents dans le modèle.

• Les valeurs numériques. Les valeurs littérales peuvent être directement indiquées dans le champ correspon-
dant. Mais ce dernier peut aussi être rempli à partir d’une donnée d’entrée du modèle. Dans ce cas, la valeur
sera paramétrée par l’utilisateur à l’exécution du modèle.

• Les chaînes de caractères. Comme pour les valeurs numériques, les chaînes peuvent être fixées une fois
pour toute ou à l’exécution du modèle.

• Un champ de table. Les champs d’une table ou d’une couche ne sont pas connus au moment de la conception
du modèle, puisqu’ils seront définis à l’exécution du modèle. Pour remplir ce paramètre, entrez le nom du
champ directement dans le champ texte correspondant, ou sélectionnez-le dans la liste des champs des tables
déjà présentes dans le modèle. La validité du champ sélectionné sera vérifiée à l’exécution.

Dans tous les cas, vous trouverez un paramètre supplémentaire nommé Algorithme parent qui n’est pas disponible
lors de l’appel de l’algorithme via la boîte à outils. Ce paramètre vous permet de choisir dans quel ordre seront
exécutés les algorithmes, en définissant explicitement un algorithme qui sera parent d’un autre, son exécution sera
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Figure 18.21: Paramètres du modèle

forcée en premier.

Lorsque vous utilisez les sorties d’un algorithme comme entrée de votre algorithme, le premier est implicitement
défini comme l’algorithme parent du votre (et ajoute la flèche correspondante sur le modèle). Cependant, dans
certains cas, un algorithme peut dépendre d’un autre même s’il n’en utilise pas les sorties (par exemple un algo-
rithme qui exécute une requête SQL sur une base de données PostGIS et un autre qui importe une couche dans
cette même base de données). Dans ce cas, sélectionnez le simplement dans le paramètre Algorithme parent et
l’exécution se fera dans le bon ordre.

Une fois tous les paramètres remplis, validez avec le bouton [OK] et l’algorithme sera ajouté au canevas. Il sera
lié aux autres éléments déjà présents, données d’entrée ou algorithmes fournissant des objets à utiliser comme
entrée.

Les éléments peuvent être disposés et rangés en les glissant dans l’espace de travail. Cela améliore la lecture et
la compréhension du modèle. Les liens entre éléments sont mis à jour automatiquement. Vous pouvez zoomer et
dé-zoomer avec la molette de la souris.

Vous pouvez à tout moment exécuter votre algorithme en cliquant que le bouton [Exécuter]. Toutefois, pour
pouvoir l’utiliser à partir de la boîte à outils, le modèle doit être sauvegardé et le modeleur fermé. La boîte à outils
pourra alors mettre à jour les traitements disponibles.

18.3.3 Sauvegarder et charger les modèles

Utilisez le bouton [Sauvegarder] pour sauvegarder le modèle courant et le bouton [Ouvrir] pour restaurer un
précédent modèle. Les modèles sont sauvegardés dans un fichier avec l’extension .model. Si le modèle a
précédemment été sauvegardé à partir du modeleur, vous n’aurez pas à redonner de nom de fichier, ce nom étant
déjà associé au modèle sera réutilisé.

Avant de sauvegarder un modèle, il faudra définir son nom et le groupe auquel il appartient. Pour cela, remplissez
les deux champs texte situés sur la partie haute de la fenêtre.

Les modèles sauvegardés dans le répertoire models (le répertoire par défaut) apparaîtront dans la boîte à outils
dans le groupe correspondant. Lorsque la boîte à outils est ouverte, tous les fichiers portant l’extension .model
du répertoire models sont chargés. Comme le modèle fait maintenant partie des algorithmes, il peut être utilisé
comme tous les autres depuis la boite à outils ou depuis le modeleur.
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Le répertoire par défaut des modèles peut être défini dans les configurations du Module de Traitements, dans le
groupe Modeles.

Les modèles sauvegardés dans le répertoire models apparaîtront dans la boîte à outils dans le groupe correspon-
dant ainsi que dans la liste des Algorithmes proposés dans le modeleur. Cela signifie qu’il peut être utilisé comme
tous les autres depuis la boite à outils ou depuis le modeleur.

18.3.4 Editer un modèle

Vous pouvez éditerle modèle sur lequel vous travaillez, en redéfinissant le flux de traitements et les relations entre
algorithmes et données d’entrée.

Si vous cliquez avec le bouton droit sur un algorithme de l’espace de travail du modèle, le menu contextuel suivant
apparaîtra:

Figure 18.22: Clic droit du modeleur

Choisissez l’option Enlever pour supprimer l’algorithme sélectionné. Un algorithme ne peut être enlevé que si
aucun autre algorithme ne dépend de lui, c’est-à-dire si aucune de ses sorties n’est utilisée par ailleurs. Si vous
tentez de supprimer un algorithme utilisé par ailleurs, le message d’avertissement suivant s’affichera :

Figure 18.23: Impossible de supprimer l’algorithme

Choisissez l’option Éditer pour afficher la fenêtre des paramètres de l’algorithme, pour changer les données en
entrée et les paramètres. Tous les paramètres d’entrée ne seront pas systématiquement affichés. Les couches ou
les valeurs générées en amont dans le flux de traitement ne seront ainsi pas disponibles, pour éviter les références
circulaires.

Sélectionnez les nouvelles valeurs et validez avec le bouton [OK]. Les liens entre les éléments du modèle seront
actualisés dans l’espace de travail du modeleur.

Un modèle peut tourner partiellement en désactivant certains de ses algorithmes. Pour ce faire, sélectionnez
l’option Désactiver qui figure dans le menu contextuel qui apparaît en faisant un clic-droit sur un algorithme.
Celui-ci et tous les autres qui en dépendent figureront en gris et ne seront pas exécutés par le modèle.

Figure 18.24: Modèle dont un algorithme a été désactivé

284 Chapter 18. Outils de traitement QGIS



QGIS User Guide, Version 2.14

Si vous faîtes un clic-droit sur un algorithme qui n’est pas actif, vous verrez alors l’option Activer du menu que
vous pouvez utiliser pour le rendre actif.

18.3.5 Editer l’aide et les métadonnées

Vous pouvez documenter vos modèles. Cliquez sur le bouton [Éditer l’aide du modèle] et une fenêtre semblable
à celle-ci apparaîtra.

Figure 18.25: Editeur d’aide

Sur la partie droite apparaîtra une simple page HTML, créée à partir de la description des paramètres d’entrées et
des sorties de l’algorithme, ainsi que d’autres éléments tels que description générale du modèle ou ses auteurs. A la
première ouverture de l’éditeur d’aide, ces champs seront vides, mais vous pouvez les éditer à partir des éléments
situés à gauche de la fenêtre. Sélectionnez un élément dans la partie supérieure puis remplissez sa description
dans la partie inférieure.

L’aide d’un modèle est enregistrée comme une partie intégrante du modèle.

18.3.6 Exporter le modèle en script Python

Comme nous le verrons dans un des chapitres suivants, les algorithmes peuvent être appelés depuis la console
Python de QGIS et de nouveaux algorithmes peuvent être également créés directement en Python. Une manière
rapide de créer un script Python est de créer un modèle puis de l’exporter en Python.

Pour ce faire, cliquez sur le bouton Exporter en script Python. Sélectionnez le fichier de sortie dans le dialogue
de sélection de fichiers et le module de Traitements va y écrire les commandes Python qui correspondent aux
opérations effectuées par le modèle.

18.3.7 A propos des algorithmes disponibles

Vous remarquerez que certains algorithmes présents dans la boîte à outils n’apparaissent pas dans la liste depuis
le modeleur. Pour pouvoir être utilisé dans un modèle, un algorithme doit présenter une syntaxe correcte pour
pouvoir être lié aux autres traitements. Si cela n’est pas le cas, par exemple si le nombre de couche en sortie n’est
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pas connu à l’avance, alors il ne sera pas possible de l’utiliser au sein d’un modèle et n’apparaîtra donc pas dans
la liste du modeleur.

De même, certains algorithmes du modeleur ne sont pas disponibles dans la boîte à outils. Ils sont destinés à
être utilisés dans un modèle et n’ont que peu d’intérêt en dehors de ce contexte. C’est par exemple le cas de la
‘Calculatrice’ : c’est un simple calculateur arithmétique qui vous permet de modifier une valeur numérique (saisie
par l’utilisateur ou générée par un autre algorithme). Cet outil peut être utile dans un modèle, mais n’a que peu
d’intérêt en dehors de ce contexte.

18.4 L’interface de traitement par lot

18.4.1 Introduction

Les algorithmes (dont les modèles) peuvent être exécutés par lot. C’est à dire qu’ils peuvent être exécutés en
utilisant non pas une mais plusieurs entrées, exécutant les algorithmes autant de fois que nécessaire. Ceci est utile
lors du traitement de gros volume de données, puisqu’il n’est pas nécessaire de lancer l’algorithme plusieurs fois
à partir de la boîte à outils.

Pour exécuter un algorithme en traitement par lots, cliquez avec le bouton droit sur son nom dans la boîte à outis
et sélectionnez l’option Exécution par lots dans le menu contextuel qui apparaît.

Figure 18.26: Clic-droit pour ouvrir l’interface de Traitements par lot

If you have the execution dialog of the algorithm open, you can also start the batch processing interface from
there, clicking on the Run as batch process... button.

Figure 18.27: Batch Processing From Algorithm Dialog
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18.4.2 La table des paramètres

L’exécution d’un traitement par lots est semblable à l’exécution simple d’un algorithme. Les valeurs des
paramètres peuvent être définies, mais dans le cas présent, il est nécessaire de définir les valeurs pour chaque
exécution de l’algorithme. Ces valeurs sont à donner dans la table suivante.

Figure 18.28: Traitement par lot

Chaque ligne de la table correspond à une itération de l’algorithme et chaque cellule contient la valeur de chaque
paramètre. Ce sont les mêmes paramètres que dans la boîte à outils, mais présentés différemment.

Par défaut, la table contient seulement deux lignes. Vous pouvez ajouter ou retirer des lignes en utilisant les
boutons situés en bas de la fenêtre.

Une fois le nombre de lignes souhaitées atteint, vous pouvez remplir les paramètres avec les valeurs correspon-
dantes.

18.4.3 Remplir la table de paramètres

Pour la plupart des paramètres, la valeur à fixer est triviale. Selon le type de paramètre, entrez simplement la
valeur ou sélectionnez l’option adéquate dans la liste de choix.

Filenames for input data objects are introduced directly typing or, more conveniently, clicking on the button
on the right hand of the cell, which will show a context menu with two option: one for selecting from the layers
currently opened and another to select from the filesystem. This second option, when selected, shows a typical
file chooser dialog. Multiple files can be selected at once. If the input parameter represents a single data object
and several files are selected, each one of them will be put in a separate row, adding new ones if needed. If the
parameter represents a multiple input, all the selected files will be added to a single cell, separated by semicolons
(;).

Layer identifiers can be directly typed in the parameter text box. You can enter the full path to a file or the name of
a layer that is currently loaded in the current QGIS project. The name of the layer will be automatically resolved
to its source path. Notice that, if several layers have the same name, this might cause unexpected results due to
ambiguity.

Les données en sortie sont toujours sauvegardées dans un fichier et, contrairement à son exécution à partir de la
boîte à outils, la sauvegarde dans un fichier temporaire ou une base de données n’est pas permise. Vous pouvez
entrer le nom directement ou utiliser l’explorateur de fichiers en cliquant sur le bouton adéquat.
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Une fois le fichier choisi, une nouvelle fenêtre apparaît permettant le remplissage automatique des autres cellules
d’une même colonne (même paramètre).

Figure 18.29: Remplissage automatique des paramètres de traitement par lot

Si la valeur par défaut (‘Ne pas autocompléter’) est choisie, seule la cellule sélectionnée sera remplie, avec le nom
du fichier sélectionné. Dans le cas contraire, toutes les cellules sous la ligne sélectionnée seront remplies à partir
de la valeur choisie. Ainsi, il est aisée de remplir la table de paramètres et le traitement par lots s’en trouve facilité.

Le remplissage automatique peut également effectué en concaténant un compteur au nom de fichier, ou en ajoutant
un champ à un autre dans la même ligne. Cela peut être utile pour nommer des résultats en fonction de la donnée
d’entrée.

Figure 18.30: Chemin vers les fichiers dans l’interface de Traitements par lot

18.4.4 Exécuter le traitement par lots

Pour exécuter un traitement par lots une fois définies toutes les valeurs nécessaires, cliquez simplement sur le
bouton [OK]. La progression du traitement s’affiche alors dans la partie basse de la fenêtre.

18.5 Utiliser les algorithmes du module de traitements depuis la
console Python

La console permet aux utilisateurs confirmés d’accroître leur productivité en réalisant des opérations complexes
qui ne pourraient par être réalisées à partir de l’interface graphique du module de Traitements. Les modèles impli-
quant plusieurs algorithmes peuvent être définis à partir de l’interface en lignes de commandes et des opérations
additionnelles comme les boucles ou les branchements conditionnels permettent de créer des flux de traitements
plus puissants et plus flexibles.

Il n’y a pas de console spécifique au module de traitements de QGIS mais toutes les commandes du module sont
disponibles via la console Python de QGIS. Cela signifie que vous pouvez intégrer ces commandes dans votre
travail et les connecter aux autres fonctions accessibles depuis la console (dont les méthodes issues de l’API
QGIS).

Le code exécuté à partir de la console Python, même s’il n’utilise pas de méthodes de traitements particulières,
peut être converti en un nouveau algorithme pour être réutilisé dans la boîte à outils, le modeleur ou dans un autre
flux de traitements, comme tout autre algorithme. Ainsi certains algorithmes que vous pouvez trouver dans la
boîte à outils sont en fait de simples scripts.

Dans cette section, nous allons voir comme utiliser des algorithmes issus du module de Traitements à partir de la
console Python de QGIS et également comment écrire des algorithmes en Python.
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18.5.1 Appeler des algorithmes depuis la console Python

La première chose à faire est d’importer les fonctions de traitement à l’aide de l’instruction suivante:

>>> import processing

A présent, la seule instruction (intéressante) à faire est d’exécuter un algorithme. Cela est effectué en utilisant la
méthode runalg(), qui prend en premier paramètre le nom de l’algorithme à lancer, puis tous les paramètres
nécessaires à son exécution. Vous devez donc connaître le nom de commande de l’algorithme, qui peut être
différent de celui affiché dans la boîte à outils. Pour le trouver, utilisez alglist() dans la console et tapez :

>>> processing.alglist()

Vous devriez avoir quelque chose qui ressemble à ceci.

Accumulated Cost (Anisotropic)---------------->saga:accumulatedcost(anisotropic)
Accumulated Cost (Isotropic)------------------>saga:accumulatedcost(isotropic)
Add Coordinates to points--------------------->saga:addcoordinatestopoints
Add Grid Values to Points--------------------->saga:addgridvaluestopoints
Add Grid Values to Shapes--------------------->saga:addgridvaluestoshapes
Add Polygon Attributes to Points-------------->saga:addpolygonattributestopoints
Aggregate------------------------------------->saga:aggregate
Aggregate Point Observations------------------>saga:aggregatepointobservations
Aggregation Index----------------------------->saga:aggregationindex
Analytical Hierarchy Process------------------>saga:analyticalhierarchyprocess
Analytical Hillshading------------------------>saga:analyticalhillshading
Average With Mask 1--------------------------->saga:averagewithmask1
Average With Mask 2--------------------------->saga:averagewithmask2
Average With Thereshold 1--------------------->saga:averagewiththereshold1
Average With Thereshold 2--------------------->saga:averagewiththereshold2
Average With Thereshold 3--------------------->saga:averagewiththereshold3
B-Spline Approximation------------------------>saga:b-splineapproximation
...

Il s’agit de la liste des algorithmes disponibles, par ordre alphabétique, accompagnés des noms de commande.

Vous pouvez également passer une chaine de caractères en paramètre de cette méthode. Au lieu de retourner la
liste complète des algorithmes, elle filtrera les résultats selon la chaîne fournies. Par exemple, si vous recherchez
un algorithme permettant de calculer la pente d’un MNT, l’instruction alglist("slope") donnera le résultat
suivant :

DTM Filter (slope-based)---------------------->saga:dtmfilter(slope-based)
Downslope Distance Gradient------------------->saga:downslopedistancegradient
Relative Heights and Slope Positions---------->saga:relativeheightsandslopepositions
Slope Length---------------------------------->saga:slopelength
Slope, Aspect, Curvature---------------------->saga:slopeaspectcurvature
Upslope Area---------------------------------->saga:upslopearea
Vegetation Index[slope based]----------------->saga:vegetationindex[slopebased]

Ce résultat peut différer d’un système à l’autre selon les algorithmes disponibles.

Il est ainsi facile de trouver l’algorithme recherché et son nom de commande, ici
saga:slopeaspectcurvature.

Une fois trouvé le nom de commande de l’algorithme, il s’agit de connaître la bonne syntaxe pour l’exécuter.
Cela comprend la liste et l’ordre des paramètres à fournir à l’appel de la méthode runalg(). Une méthode
est destinée à décrire en détail un algorithme et renvoie la liste des paramètres nécessaires et le type de sorties
générées : il s’agit de la méthode alghelp(nom_de_l_algorithme). Veillez à bien utiliser le nom de
commande et non le nom descriptif.

L’appel à la méthode avec le paramètre saga:slopeaspectcurvature donnera la description suivante :

>>> processing.alghelp("saga:slopeaspectcurvature")
ALGORITHM: Slope, Aspect, Curvature

ELEVATION <ParameterRaster>

18.5. Utiliser les algorithmes du module de traitements depuis la console Python 289



QGIS User Guide, Version 2.14

METHOD <ParameterSelection>
SLOPE <OutputRaster>
ASPECT <OutputRaster>
CURV <OutputRaster>
HCURV <OutputRaster>
VCURV <OutputRaster>

Vous avez à présent tout ce qu’il faut pour exécute n’importe quel algorithme. Comme indiqué précédemment,
l’instruction runalg() suffit pour exécuter un algorithme. Sa syntaxe est la suivante:

>>> processing.runalg(name_of_the_algorithm, param1, param2, ..., paramN,
Output1, Output2, ..., OutputN)

La liste des paramètres et des sorties à fournir dépend de l’algorithme à exécuter et correspond au résultat, dans
l’ordre donné, de la méthode alghelp().

Selon le type de paramètre, les valeurs peuvent être fournies selon plusieurs manières. Une rapide description de
ces possibilités est donnée pour chaque type de paramètre d’entrée :

• Les couches raster, vectorielles ou les tables. Indiquez simplement le nom identifiant la donnée (le nom
dans la liste de couches de QGIS) ou un nom de fichier (si la couche n’a pas encore été ouverte, elle sera
chargée mais pas ajoutée au canevas). Si vous avez une instance d’un objet QGIS représentant une couche,
vous pouvez également la transmettre en paramètre. Si l’entrée est optionnelle et que vous ne souhaitez pas
fournir de données particulières, utilisez la valeur None.

• Sélection. Si un algorithme possède un paramètre sélection, cette valeur doit être une valeur entière.
Pour connaître les options possibles, vous pouvez utilisez la commande algoptions(), comme dans
l’exemple suivant :

>>> processing.algoptions("saga:slopeaspectcurvature")
METHOD(Method)

0 - [0] Maximum Slope (Travis et al. 1975)
1 - [1] Maximum Triangle Slope (Tarboton 1997)
2 - [2] Least Squares Fitted Plane (Horn 1981, Costa-Cabral & Burgess 1996)
3 - [3] Fit 2.Degree Polynom (Bauer, Rohdenburg, Bork 1985)
4 - [4] Fit 2.Degree Polynom (Heerdegen & Beran 1982)
5 - [5] Fit 2.Degree Polynom (Zevenbergen & Thorne 1987)
6 - [6] Fit 3.Degree Polynom (Haralick 1983)

Dans l’exemple, l’algorithme présente ces types de paramètres, avec sept options. Notez que le premier
élément a pour numéro 0.

• Entrées multiples. La valeur est une chaîne de caractères, avec les entrées séparées par des points-virgules
(;). Comme pour les couches simples et les tables, chaque élément d’entrée peut être le nom d’une variable
objet ou un nom de fichier.

• Champ de la table XXX. Insérez une chaîne de caractère contenant le nom du champ à utiliser. Ce paramètre
est sensible à la casse.

• Table fixée. Entrez la liste de toutes les valeurs, séparées par des virgules (,) et entre guillemets ("). Les
valeurs commencent par la première ligne et se lisent de gauche à droite. Vous pouvez aussi utiliser un
tableau à deux dimensions pour représenter la table.

• SCR. Entrez le code EPSG du système de coordonnées désiré.

• Étendue. Vous devez fournir une chaîne de caractères avec les valeurs xmin, xmax, ymin et ymax séparées
par des virgules (,).

Booléen, fichier, chaîne de caractères et valeurs numériques ne nécessitent pas d’explications particulières.

Pour spécifier les valeurs par défaut des paramètres tels que chaînes de caractères, booléens ou valeurs numériques,
entrez None dans l’entrée correspondante.

Pour les données en sortie, entrez le chemin à utiliser, comme dans la boîte à outils. Si vous préférez sauvegarder
le résultat dans un fichier temporaire, indiquez None. L’extension du fichier déterminera le format de fichier
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utilisé. Si elle n’est pas reconnue par l’algorithme, le format de fichier par défaut sera utilisé et l’extension sera
ajouté à la fin du nom de fichier.

À la différence des algorithmes exécutés depuis la boîte à outils, les sorties ne sont pas ajoutées automatiquement
au canevas de la carte s’ils sont exécutés depuis la console Python. Si vous souhaitez ajouter une couche à la carte,
vous devez le faire vous même après avoir exécuté l’algorithme. Pour ce faire, vous pouvez utiliser les commandes
de l’API QGIS ou, encore plus simple, utiliser une des méthodes fournies pour ce genre de tache.

La méthode runalg renvoie un dictionnaire Python avec pour clés les noms des sorties (correspondant à la
description des éléments de l’algorithme) et pour valeurs les chemins des résultats. Vous pouvez charger ces
couches de résultat en passant les chemins correspondants à la méthode load().

18.5.2 Fonctions supplémentaires pour gérer des données

En plus des fonctions utilisées pour appeler les algorithmes, importer le module processing permet d’importer
des fonctions additionnelles qui facilitent le travail avec les données et plus particulièrement avec les données
vecteur. Il s’agit juste de commodités qui font appel à des fonctions de l’API QGIS, en utilisant en général une
syntaxe moins complexe. Il est conseillé d’utiliser ces fonctions lors du développement de nouveaux algorithmes
car elle facilitent grandement la manipulation des données.

Voici, ci-dessous, certaines de ces commandes. Plus d’information peut être trouvée dans les classes du paquet
processing/tools et dans les scripts d’exemples fournis avec QGIS.

• getObject(obj) : Renvoie un objet QGIS (une couche ou une table) issu de l’objet passé en paramètre,
qui peut correspondre à un nom de fichier ou un nom d’objet dans le panneau Couches de QGIS.

• values(couche, champs) : Renvoie les valeurs de la table d’attributs de la couche vecteur pour le
champ passé en paramètre. Les champs peuvent être passés en tant que noms de champ ou index du champ
dans la table, en commençant par zero. Renvoie un dictionnaire de listes, dont les clés correspondent à la
liste des champs passée en paramètre. La sélection existante est prise en compte.

• features(couche) : Renvoie un itérateur sur les entités d’une couche vecteur, prenant en compte la
sélection existante.

• uniqueValues(couche, champ) : Renvoie la liste des valeurs uniques trouvées dans un champ. Le
champ peut être passé en paramètre en tant que nom ou index dans la table, en commençant par zéro. La
sélection existante est prise en compte.

18.5.3 Créer des scripts et les exécuter depuis la boîte à outils

Vous pouvez créer vos propres algorithmes en écrivant le code Python correspondant et en ajoutant quelques lignes
fournissant les informations nécessaires pour le faire fonctionner. Vous trouverez le menu Créer un nouveau script
dans le groupe Outils du bloc Script de la boîte à outils. Double-cliquez dessus pour ouvrir la fenêtre d’édition
de script. C’est ici que vous pouvez écrire votre code. En sauvegardant d’ici votre script dans le répertoire des
scripts (le répertoire par défaut qui s’affiche quand vous ouvrez la fenêtre de sauvegarde) avec l’extension
.py, vous créez automatiquement l’algorithme correspondant.

Le nom de l’algorithme (celui qui apparaît dans la boîte à outils) est généré à partir du nom de fichier, en enlevant
son extension et en remplaçant les underscores (‘_’) par des espaces.

Voici par exemple le code permettant de calculer l’Indice d’Humidité Topographique (Topographic Wetness Index,
TWI) directement à partir d’un MNT.

##dem=raster
##twi=output
ret_slope = processing.runalg("saga:slopeaspectcurvature", dem, 0, None,

None, None, None, None)
ret_area = processing.runalg("saga:catchmentarea(mass-fluxmethod)", dem,

0, False, False, False, False, None, None, None, None, None)
processing.runalg("saga:topographicwetnessindex(twi), ret_slope[’SLOPE’],

ret_area[’AREA’], None, 1, 0, twi)
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Comme vous pouvez le voir, le calcul utilise trois algorithmes, provenant de SAGA. Le dernier calcule le TWI,
mais nécessite de une couche représentant la pente et une autre d’accumulation des flux. Dans la mesure où ces
deux couches n’existent pas mais que nous disposons d’un MNT, nous allons les calculer en faisant appel aux
algorithmes SAGA adéquats.

Le bout de code où le traitement est effectué n’est pas compliqué à comprendre si vous avez lu les sections
précédentes. Cependant, les premières lignes nécessitent quelques explications. Elles fournissent les informations
nécessaires pour convertir votre code en un algorithme utilisable à partir d’autres contextes, comme la boîte à
outils ou le modeleur graphique.

Ces lignes débutent par deux symboles de commentaire Python (##) et présentent la structure suivante :

[parameter_name]=[parameter_type] [optional_values]

Voici la liste des types de paramètres gérés par les scripts de traitement, leur syntaxe ainsi que quelques exemples.

• raster. Une couche raster.

• vector. Une couche vectorielle.

• table. Une table.

• number. Une valeur numérique. Une valeur par défaut doit être définie. Par exemple, depth=number
2.4.

• string. Une chaîne de caractère. Comme pour les valeurs numériques, une valeur par défaut doit être
définie. Par exemple, name=string Victor.

• boolean. Une valeur booléenne. Ajoutez True (Vrai) ou False (Faux) pour définir la valeur par défaut.
Par exemple, verbose=boolean True pour plus un rendu plus parlant.

• multiple raster. Un ensemble de couches raster en entrée.

• multiple vector. Un ensemble de couches vectorielles en entrée.

• field. Un champ dans la table d’attributs d’une couche vectorielle. Le nom de la couche doit être ajoutée
après l’étiquette field. Par exemple, si vous déclarez une couche vectorielle macouche=vector en
entrée, vous pouvez utilisez monchamp=champ1 macouche pour ajouter en paramètre le champ de
cette couche.

• folder. Un répertoire.

• file. Un nom de fichier.

Le nom du paramètre correspond à ce qui sera affiché lorsque l’utilisateur exécutera l’algorithme, ainsi qu’au
nom de variable à utiliser dans le script. La valeur saisie par l’utilisateur pour ce paramètre sera assignée à cette
variable, portant ce nom.

A l’affichage du nom de paramètre, les underscores (‘_’) sont convertis en espaces pour améliorer la lisibilité.
Ainsi, par exemple, si vous souhaitez que l’utilisateur saisisse une valeur appelée ‘Valeur numérique’, vous devez
utiliser une variable nommée Valeur_numérique.

Les valeurs de couches et de table sont des chaînes de caractères contenant le chemin du fichier
de l’objet correspondant. Pour les transformer en objets QGIS, vous pouvez utiliser la fonction
processing.getObjectFromUri(). Les entrées multiples ont également une valeur de chaîne qui contient
les chemins des fichiers des objets sélectionnés, séparés par des points-virgules (;).

Les sorties sont définies de la même manière, avec les étiquettes suivantes:

• output raster

• output vector

• output table

• output html

• output file

• output number
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• output string

La valeur attribuée à une variable de sortie est toujours une chaîne de caractères contenant le chemin de l’objet. Si
le nom est vide, un fichier temporaire sera créé.

Si un résultat est défini, l’algorithme tentera de l’ajouter à QGIS à l’issue de son exécution. C’est la raison
pour laquelle la couche résultat TWI, nommée explicitement par l’utilisateur, sera chargée, même si la méthode
runalg() ne le fait pas.

N’utilisez donc pas la méthode load() dans vos scripts, mais uniquement à partir de la console. Si un algorithme
définit une couche en sortie, celle-ci doit être déclarée ainsi. Dans le cas contraire, vous ne pourriez pas l’utiliser
dans le modeleur parce que sa syntaxe (comme définie par ses étiquettes, exposées précédemment) ne correspond
pas à ce que l’algorithme crée effectivement.

Les sorties masquées (nombres ou chaînes) n’ont pas de valeur. C’est à vous de leur assigner une valeur. Pour
cela, affecter une valeur à la variable pour la déclarer en sortie. Par exemple, vous pourriez utiliser la déclaration
suivante,

##average=output number

l’instruction suivante fixe la valeur de sortie à 5:

average = 5

En complément des étiquettes définissant les paramètres et les sorties, vous pouvez définir la catégorie dans
laquelle l’algorithme apparaîtra, en utilisant l’étiquette group.

Si votre algorithme est long, il est conseillé d’informer l’utilisateur de l’avancée du traitement de
l’algorithme. Vous disposez de la variable globale progress, avec deux méthodes, setText(text) et
setPercentage(percent) pour modifier le message et la barre de progression.

Plusieurs exemples sont fournis. Veuillez vous y reporter pour servir d’exemples. Cliquez avec le bouton droit sur
un script et choisissez Éditer le script pour voir et éditer le code correspondant.

18.5.4 Documenter ses scripts

Comme pour les modèles, vous pouvez ajouter des commentaires à vos scripts, pour expliciter le traitement effec-
tué et son utilisation. Dans la fenêtre d’édition du script se situe un bouton [Editer l’aide], qui vous amènera à
la fenêtre d’édition de l’aide. Veuillez vous reporter à la section Modeleur graphique pour plus d’information sur
cette fenêtre.

Les fichiers d’aide sont sauvegardés dans le même répertoire que les scripts, avec l’extension .help. Veuillez
noter qu’à la première édition de l’aide, la fermeture de la fenêtre ne sauvegarde pas vos modifications. Par contre,
si le fichier a déjà été sauvegardé une fois préalablement, les modifications seront conservées.

18.5.5 Scripts de pré et post-exécution

Des scripts peuvent également être utilisés en amont et en aval de l’exécution d’un algorithme. Ce mécanisme
peut être utilisé pour automatiser des tâches qui doivent être lancées à chaque fois qu’un algorithme est exécuté.

La syntaxe est identique à celle qui est expliquée plus haut mais une variable globale nommée alg est disponible.
Elle représente l’objet alogrithme qui vient (ou qui va) être lancé.

Dans le groupe Général de la boîte de dialogue de configuration des géo-traitements, vous trouverez deux entrées
nommées Script de pré-exécution et Script de post-exécution où les noms des scripts à lancer dans chacun des cas
peuvent être saisis.
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18.6 Le gestionnaire d’historique

18.6.1 L’historique des traitements

A chaque exécution d’un algorithme, les informations du traitement, paramètres utilisés, date et heure d’exécution,
sont sauvegardées dans le gestionnaire d’historiques.

Ainsi, il est possible de suivre et vérifier les tâches effectuées et de les reproduire facilement.

Le gestionnaire d’historiques est un ensemble d’entrées de registre, regroupées selon la date d’exécution, permet-
tant de retrouver facilement quel algorithme a été exécuté à un moment donné.

Figure 18.31: Historique

Les informations de traitement sont sauvegardées sous forme de ligne de commande, même si l’algorithme a
été exécuté depuis la boîte à outils. Cela permet également de comprendre l’interface en ligne de commande en
visualisant la commande effectivement lancée depuis la boîte à outils.

Pour ré-exécuter une commande présente dans l’historique, double-cliquez sur l’entrée correspondante.

18.6.2 Le log des traitements

The history dialog only contains the execution calls, but not the information produced by the algorithm when
executed. That information is written to the QGIS log, in a Processing tab.

Third-party algorithms are usually executed by calling their command-line interfaces, which communicate with
the user via the console. Although that console is not shown, a full dump of it is written to the log each time you
run one of those algorithms. To avoid cluttering the log with that information, you can disable it for each provider,
looking for the corresponding option in the provider entry of the settings dialog.
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Certains algorithmes génèrent des messages d’avertissements ou des commentaires dans le log, même si le traite-
ment semble avoir réussi. Vérifiez ces messages si les résultats ne semblent pas cohérents.

18.7 Écrire de nouveaux algorithmes sous la forme de scripts
python

Vous pouvez créer vos propres algorithmes en écrivant le code Python correspondant et en ajoutant quelques lignes
supplémentaires nécessaires à la définition de la sémantique de l’algorithme. Vous pouvez trouver un Créer un
nouveau script sous le menu Outils du bloc Script de la boîte à outils. Double-cliquez dessus pour ouvrir la fenêtre
d’édition de script. C’est ici que vous pouvez écrire votre code. En sauvegardant votre script dans le répertoire
des scripts (le répertoire par défaut qui s’affiche quand vous ouvrez la fenêtre de sauvegarde) avec l’extension
.py, vous créez automatiquement l’algorithme correspondant.

Le nom de l’algorithme (celui qui apparaît dans la boîte à outils) est généré à partir du nom de fichier, en enlevant
son extension et en remplaçant les underscores (‘_’) par des espaces.

Voici par exemple le code permettant de calculer l’Indice Topographique d’Humidité (Topographic Wetness Index,
TWI) directement à partir d’un MNE

##dem=raster
##twi=output raster
ret_slope = processing.runalg("saga:slopeaspectcurvature", dem, 0, None,

None, None, None, None)
ret_area = processing.runalg("saga:catchmentarea", dem,

0, False, False, False, False, None, None, None, None, None)
processing.runalg("saga:topographicwetnessindextwi, ret_slope[’SLOPE’],

ret_area[’AREA’], None, 1, 0, twi)

Comme vous pouvez le voir, il utilise 3 algorithmes, provenant de SAGA. Le dernier calcule le TWI, mais nécessite
de une couche représentant la pente et une autre d’accumulation des flux. Dans la mesure où ces deux couches
n’existent pas mais que nous disposons d’un MNT, nous allons les calculer en faisant appel aux algorithmes SAGA
adéquats.

Le bout de code où le traitement est effectué n’est pas compliqué à comprendre si vous avez lu les sections
précédentes. Cependant, les premières lignes nécessitent quelques explications. Elles fournissent les informa-
tions nécessaires pour convertir votre code en un algorithme utilisable à partir d’autres contextes de l’interface
graphique, comme la boîte à outils ou le modeleur graphique.

Ces lignes commencent par deux symboles de commentaires Python (##) et ont la structure suivante :

[parameter_name]=[parameter_type] [optional_values]

Voici la liste des types de paramètres gérés par les scripts de traitement, leur syntaxe ainsi que quelques exemples.

• raster. Une couche raster

• vector. Une couche vectorielle

• table. Un tableau

• number. Une valeur numérique. Une valeur par défaut doit être définie. Par exemple, depth=number
2.4

• string. Une chaîne de caractères. Comme pour les valeurs numériques, une valeur pas défaut doit être
ajoutée. Par exemple, name=string Victor

• longstring. Comme pour la chaîne de caractères, mais ici une plus large zone de texte sera affichée, ce
qui est mieux adaptée pour les longues chaînes de texte, comme pour un script attendant un petit extrait de
code.

• boolean. Une valeur booléenne. Ajoutez True ou False après avoir défini une valeur par défaut. Par
exemple, verbose=boolean True.

• multiple raster. Une série de couches raster.
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• multiple vector. Un ensemble de couches vectorielles.

• field. Un champ de la table d’attributs d’une couche vectorielle. Le nom de la couche doit être ajoutée
après l’étiquette field. Par exemple, si vous déclarez une couche vectorielle macouche=vector en
entrée, vous pouvez utilisez monchamp=field macouche pour ajouter en paramètre le champ de cette
couche.

• extent. Une emprise spatiale définie par xmin, xmax, ymin, ymax

• folder. Un répertoire

• file. Un nom de fichier

• crs. Système de coordonnées de référence

• selection. Un menu . Par exemple‘‘unités=selection sq_km;sq_miles;sq_degrees‘‘

• name. Le nom du script. Il s’affichera dans la Boîte à outils de traitements. Par exemple Nom de mon
Algorithme=name

• group. Nom du groupe dans lequel le script apparaîtra dans la boîte à outils de traitements. Par exemple,
en ajoutant‘‘Outils=groups‘‘ ajoutera le script dans le groupe Outils des Scripts.

Le nom du paramètre correspond à ce qui sera affiché lorsque l’utilisateur exécutera l’algorithme, ainsi qu’au
nom de variable à utiliser dans le script. La valeur saisie par l’utilisateur pour ce paramètre sera assignée à cette
variable, portant ce nom.

A l’affichage du nom de paramètre, les underscores (‘_’) sont convertis en espaces pour améliorer la lisibilité.
Ainsi, par exemple, si vous souhaitez que l’utilisateur saisisse une valeur appelée ‘Valeur numérique’, vous devez
utiliser une variable nommée Valeur_numérique.

Les valeurs de couches et de tables sont des chaînes de caractères contenant le chemin du fichier
de l’objet correspondant. Pour les transformer en objets QGIS, vous pouvez utiliser la fonction
processing.getObjectFromUri(). Les entrées multiples ont également une valeur de chaîne qui contient
les chemins des fichiers des objets sélectionnés, séparés par des points-virgules (;).

Les sorties sont définies de la même manière, avec les étiquettes suivantes :

• output raster

• output vector

• output table

• output html

• output file

• output number

• output string

• output extent

La valeur attribuée à une variable de sortie est toujours une chaîne de caractères contenant le chemin de l’objet. Si
le nom est vide, un fichier temporaire sera créé.

En complément des étiquettes définissant les paramètres et les sorties, vous pouvez définir la catégorie dans
laquelle l’algorithme apparaîtra, en utilisant l’étiquette group.

La dernière étiquette que vous pouvez utiliser dans votre en-tête de script est ##nomodeler. L’utiliser indique
que vous ne voulez pas que votre algorithme soit affiché dans la fenêtre du modeleur. Elle doit être utilisée pour
les algorithmes qui n’ont pas une syntaxe claire (par exemple su le nombre de couches à créer n’est pas connu à
l’avance au moment de la modélisation), ce qui les rend non disponibles dans le modeleur graphique.
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18.8 Gérer les données produites par l’algorithme

Lorsque vous définissez une sortie de type couche (raster, vecteur ou table), l’algorithme tentera de l’ajouter à
QGIS à l’issue de son exécution. C’est la raison pour laquelle la couche résultat TWI, nommée explicitement par
l’utilisateur, sera chargée, même si la méthode runalg() ne le fait pas.

N’utilisez donc pas la méthode load() dans vos scripts, mais uniquement à partir de la console. Si un algorithme
définit une couche en sortie, celle-ci doit être déclarée ainsi. Dans le cas contraire, vous ne pourriez pas l’utiliser
dans le modeleur parce que sa syntaxe (comme définie par ses étiquettes, exposées précédemment) ne correspond
pas à ce que l’algorithme crée effectivement.

Les sorties masquées (nombres ou chaînes) n’ont pas de valeur. C’est à vous de leur assigner une valeur. Pour
cela, affecter une valeur à la variable pour la déclarer en sortie. Par exemple, vous pourriez utiliser la déclaration
suivante,

##average=output number

l’instruction suivante fixe la valeur de sortie à 5:

average = 5

18.9 Communiquer avec l’utilisateur

Si votre algorithme requiert un temps assez long de calcul, il est conseillé d’informer l’utilisateur de l’avancée
du traitement de l’algorithme. Vous disposez de la variable globale progress, avec deux méthodes,
setText(text) et setPercentage(percent) pour modifier le message et la barre de progression.

Si vous devez fournir de l’information à l’utilisateur sans rapport avec la progression de l’algorithme, vous pouvez
utiliser la méthode setInfo(text) de l’objet progress.

Si votre script rencontre des problèmes, le moyen correct de propager l’erreur est de lever une exception de type
GeoAlgorithmExecutionException(). Vous pouvez y passer un message comme argument dans le con-
structeur de l’exception. Les Traitements tiennent compte de cette exception et communiquent avec l’utilisateur
en fonction de l’endroit où l’algorithme a été exécuté (boîte à outils, modeleur, console Python, etc.).

18.10 Documenter ses scripts

Comme pour les modèles, vous pouvez ajouter des commentaires à votre script, pour expliciter le traitement
effectué et son utilisation. Dans la fenêtre d’édition du script se situe un bouton [Editer l’aide], qui vous amènera
à la fenêtre d’édition de l’aide. Veuillez vous reporter au chapitre Modeleur graphique pour plus d’information
sur cette fenêtre.

Les fichiers d’aide sont sauvegardés dans le même répertoire que les scripts, avec l’extension .help.Veuillez
noter qu’à la première édition de l’aide, la fermeture de la fenêtre ne sauvegarde pas vos modifications. Par
contre, si le fichier a déjà été sauvegardé une fois préalablement, les modifications seront conservées.

18.11 Exemples de scripts:

Plusieurs exemples sont disponibles sur la collection de scripts en ligne dont vous pouvez avoir accès en sélection-
nant l’outil Récupérer un script de la collection de scripts en ligne dans l’entrée Scripts/outils de la boîte à outils.

Veuillez vous y reporter pour visualiser des exemples réels de création d’algorithmes avec les classes de l’API des
Traitements. Cliquez avec le bouton droit sur un script et choisissez Éditer le script pour voir et éditer le code
correspondant.
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18.12 Bonnes pratiques d’écriture de scripts d’algorithmes

Voici un rapide résumé des idées à retenir lorsque vous créez vos scripts d’algorithmes et que vous souhaitez les
partager avec d’autres utilisateurs QGIS. En suivant ces quelques règles, vous vous assurerez de fournir des élé-
ments constants sur toutes les interfaces du menu Traitements telles que la boîte à outils, le modeleur et l’interface
de commande.

• Ne chargez pas les couches de résultat. Laissez les Traitements gérer ces résultats et charger vos couches si
besoin.

• Déclarez toujours les sorties des algorithmes que vous avez créés. Évitez de déclarer une sortie et d’utiliser
le nom de fichier de destination de cette sortie comme un emplacement de collection de fichiers. Cela brise
la syntaxe correcte des algorithmes et empêche un fonctionnement correct dans le modeleur. Si vous devez
écrire un tel algorithme, assurez-vous d’utiliser l’étiquette ##nomodeler.

• N’affichez pas de boîte à messages ou n’utilisez pas d’éléments graphiques depuis le script. Si
vous voulez communiquer avec l’utilisateur, utilisez la méthode setInfo() ou lancez une exception
GeoAlgorithmExecutionException.

• La règle d’or consiste à ne pas oublier que votre algorithme peut être exécuté dans un contexte différent de
la boîte à outils des Traitements.

18.13 Scripts de pré et post-exécution

Des scripts peuvent également être utilisés en amont et en aval de l’exécution d’un algorithme. Ce mécanisme
peut être utilisé pour automatiser des tâches qui doivent être lancées à chaque fois qu’un algorithme est exécuté.

La syntaxe est identique à celle qui est expliquée plus haut mais une variable globale nommée alg est disponible.
Elle représente l’objet algorithme qui vient (ou qui va) être lancé.

Dans le groupe Général de la boîte de dialogue de configuration des traitements, vous trouverez deux entrées
nommées Script de pré-exécution et Script de post-exécution où les noms des scripts à lancer dans chacun des cas
peuvent être saisis.

18.14 Configuration des applications tierces

Le module de Traitements peut être étendu par des applications tierces. Pour l’instant, les logiciels SAGA,
GRASS, OTB (Orfeo Toolbox) et R sont supportés, ainsi que des applications en ligne de commande qui pro-
posent des fonctionnalités d’analyses spatiales. Les algorithmes reposant sur des applications tierces sont gérées
par leur propre fournisseur d’algorithmes.

Cette section vous montrera comment configurer le module de Traitements pour inclure ces applications addition-
nelles et vous expliquera quelques fonctionnalités propres à leurs algorithmes. Une fois le système configuré, vous
pourrez exécuter les algorithmes externes depuis tous les composants du module tels que la boîte à outils ou le
modeleur graphique, comme vous pourriez le faire avec n’importe quel géoalgorithme.

Par défaut, tous les algorithmes qui reposent sur une application tierce non fournie avec QGIS sont désactivés.
Vous pouvez les activer dans la fenêtre de configuration. Vérifiez que l’application correspondante est préalable-
ment installée sur votre ordinateur.
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18.14.1 Note pour les utilisateurs de Windows

Si vous n’êtes pas un utilisateur avancé et que vous utilisez QGIS sur Windows, vous n’allez peut-être pas être
intéressés pas la suite de ce chapitre. Assurez-vous d’avoir installé QGIS sur votre système avec l’installeur
indépendant. Ceci installera automatiquement SAGA, GRASS et OTB sur votre système et les configurera de
manière à ce qu’ils soient accessibles depuis QGIS. Tous les algorithmes qu’ils fournissent sont prêts à être utilisés,
sans aucune configuration supplémentaire. Si vous installez QGIS via l’application OSGeo4W, assurez-vous de
bien sélectionner SAGA, GRASS et OTB pour l’installation.

Si vous voulez en savoir plus sur le fonctionnement de ces fournisseurs ou si vous souhaitez utiliser des algorithmes
non incluses dans la barre d’outils simplifiée (telles que des scripts R), continuez donc à lire.

18.14.2 A propos des formats de fichiers

Le fait d’ouvrir un fichier dans QGIS ne garantit pas que ce fichier pourra être ouvert et traité par l’application
tierce. Dans la plupart des cas, celui-ci pourra lire ce que vous avez ouvert dans QGIS, mais parfois, cela ne sera
pas le cas. C’est particulièrement le cas des connections aux bases de données et les fichiers peu communs, aussi
bien raster que vectoriels, qui pourront présenter des problèmes. Si cela arrivait, essayez de convertir vos données
dans un format usuel reconnu par l’application tierce et vérifiez dans la console (historique et messages) le résultat
du traitement pour analyser l’origine des erreurs.

Si vous utilisez des couches raster GRASS, par exemple, vous allez peut-être rencontrer des problèmes et ne pas
pouvoir mener à bien votre travail si vous appelez des algorithmes externes ayant cette couche comme entrée.
C’est pour cette raison que ces couches ne seront pas disponibles pour les algorithmes.

Pour les couches vectorielles, vous ne devriez pas rencontrer de problème : QGIS les convertit automatiquement
dans un format reconnu par l’application tierce avant de lui transmettre. Cela aboutit à un temps de traitement plus
long, particulièrement si la couche comprend beaucoup d’objets. Ne vous étonnez donc pas si le traitement d’une
couche provenant d’une base de données est plus long que celui d’un Shapefile de taille équivalente.

Les algorithmes n’utilisant pas d’application tierce peuvent traiter toutes les couches qui peuvent s’ouvrir dans
QGIS puisque qu’ils sont lancés depuis QGIS.

Concernant les formats de sortie, tous les formats gérés par QGIS peuvent être utilisés en sortie, à la fois pour
les couches raster et vecteur. Certains formats ne sont pas gérés par certaines applications tierces mais celles-ci
permettent toutes d’exporter dans des formats courants qui peuvent ensuite être convertis automatiquement par
QGIS. Comme pour les couches d’entrée, si une conversion est opérée, le temps de traitement peut être allongé.

18.14.3 A propos des sélections sur les couches vectorielles

Les applications tierces peuvent prendre en compte les sélections qui existent sur les couches vecteur dans QGIS.
Cependant, cela nécessite de réécrire toutes les couches vecteur d’entrée, comme si elles étaient dans un format
non géré par l’application tierce. Une couche peut être passée directement à une application tierce uniquement
lorsqu’il n’y a pas de sélection ou que l’option N’utiliser que les entités sélectionnées n’ pas activée dans les
paramètres de configuration généraux du module de traitement.

Dans les cas où l’export de la sélection est nécessaire cela rallonge les temps d’exécution.

18.14.4 SAGA

Les algorithmes de SAGA peuvent être exécutés depuis QGIS si SAGA est installé sur votre ordinateur et que
le module de traitements QGIS est configuré correctement pour trouver les fichiers nécessaires. En particulier,
l’exécutable en ligne de commande de SAGE est nécessaire pour utiliser les algorithmes.

Si vous utilisez Windows, les installateurs indépendant et OSGeo4W incluent SAGA aux côtés de QGIS, et le
chemin d’accès est automatiquement configuré. Il n’y a donc rien à faire d’autre.

Si vous avez installé vous-même SAGA et que votre installeur QGIS ne l’inclut pas, le chemin vers l’exécutable
SAGA doit être configuré. pour cela, ouvrez la fenêtre de configuration. Dans le bloc SAGA, vous trouverez un
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paramètre nommé Répertoire SAGA. Entrez le chemin du dossier d’installation de SAGA et fermez la fenêtre.
Vous êtes prêts à utiliser les algorithmes de SAGA depuis QGIS.

Si vous êtes sur Linux, les exécutables SAGA ne sont pas inclus dans le module de Traitements. Vous devez donc
télécharger et installer le logiciel vous-même. Référez au site web de SAGA pour plus d’informations.

Dans ce cas, il n’est pas nécessaire de configurer le chemin vers l’exécutable de SAGA et vous ne verrez pas ces
répertoires. Vérifiez que SAGA est correctement installé et que le chemin d’installation figure dans la variable
d’environnement PATH. Pour vérifier que les fichiers binaires de SAGA sont accessibles, ouvrez une console et
tapez saga_cmd.

A propos des limitations du système de grille de SAGA

La plupart des algorithmes SAGA nécessitent habituellement des couches Raster en entrée sur la même emprise et
la même grille, couvrant la même emprise et ayant la même résolution. A l’appel d’un algorithme SAGA depuis
QGIS, vous pouvez cependant utiliser n’importe quelle couche, quelles que soient leur emprise et leur résolution.
Quand plusieurs couches raster son indiquées en entré d’un algorithme SAGA, QGIS les rééchantillonne sur une
grille commune avant de les transmettre à SAGA (à moins que l’algorithme SAGA manipule directement des
couches dans des grilles différentes).

La définition de cette grille commune est contrôlée par l’utilisateur et peut se faire selon plusieurs paramètres,
présents dans le groupe SAGA de la fenêtre de configuration. Deux façons de procéder existent:

• La configuration manuelle. Vous définissez l’emprise à l’aide des paramètres suivants:

– Rééchantillonner la valeur minimum de X

– Rééchantillonner la valeur maximum de X

– Rééchantillonner la valeur minimum de Y

– Rééchantillonner la valeur maximum de Y

– Rééchantillonner la taille de la cellule

Veuillez noter que QGIS rééchantillonnera les couches en entrées sur cette emprise, même si elles ne la
recoupent pas.

• La configuration automatique à partir des couches en entrée. Pour choisir cette option, activez l’option
Utiliser la grille minimale pour le rééchantillonnage. Toutes les autres options seront ignorées et l’emprise
minimum couvrant toutes les couches sera utilisée. La taille de la cellule de la couche cible sera la plus
grande des tailles de cellules des couches en entrée.

Pour les algorithmes qui n’utilisent pas plusieurs couches raster, ou pour ceux qui n’ont pas besoin d’une grille
unique, le rééchantillonnage n’est pas nécessaire et ces paramètres ne seront pas utilisés.

Limitations pour les couches multi-bandes

Contrairement à QGIS, SAGA ne gère pas les couches multi-bande. Si vous utilisez de telles couches (par exemple
une image RVB ou multispectrale), vous devez tout d’abord la séparer en couches mono-bande. Pour ce faire, vous
pouvez utilisez l’algorithme ‘SAGA/Grid - Tools/Split RGB image’ (qui crée trois images à partir d’une image
RVB) ou l’algorithme ‘SAGA/Grid - Tools/Extract band’ (qui extrait une bande en particulier).

Limitations dans la résolution

SAGA suppose que la couche raster possède la même résolution en X et en Y. Si vous travaillez sur une couche
avec des résolutions différentes entre les deux axes, les résultats peuvent être incohérents. Dans ce cas, un message
d’avertissement est ajouté au journal, indiquant que la couche n’est pas adaptée au traitement par SAGA.
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Suivi du journal

Lorsque QGIS appelle SAGA, il le fait par son interface en lignes de commandes pour effectuer l’opération
demandée. SAGA transmet son état d’avancement dans la console ainsi que d’autres informations. Ces messages
sont filtrés et utilisés pour afficher la barre d’avancement pendant l’exécution de l’algorithme.

Les commandes envoyées par QGIS et les informations supplémentaires écrites par SAGA peuvent être consignées
dans le log comme pour tous les algorithmes. Il peut être utile de suivre en détail ce qu’il se passe lorsque QGIS
lance un algorithme SAGA. Vous avez deux options pour activer ce mécanisme : Log console output et Log
execution commands.

La plupart des autres fournisseurs tiers qui sont appelés par la ligne de commandes ont des options similaires, que
vous trouverez dans la rubrique configuration du module.

18.14.5 R. Creating R scripts

L’intégration de R est légèrement différente de celle de SAGA, dans la mesure où il n’y a pas d’ensemble prédéfini
d’algorithmes à exécuter, hormis quelques exemples. Au lieu de cela, c’est à vous d’écrire les scripts à transmettre
à R, comme vous le feriez depuis R. Un peu comme dans le chapitre sur les scripts. Ce chapitre va vous montrer
comment appeler les commandes R à partir de QGIS et comment leur transmettre les objets QGIS (couches et
tables).

La première chose à faire, comme nous l’avons vu pour SAGA, est de dire à QGIS où se situent les fichiers
exécutables de R. Paramétrez l’entrée Répertoire R dans la fenêtre de configuration du module de traitements.
Une fois cela fait, vous pouvez commencer à créer et exécuter vos propres scripts R.

Note: for Windows user, usually the R executable file is in the C:Program FilesRR-3.2 folder. Add just
the folder and NOT the binary!

Une fois encore, pour Linux, cela est légèrement différent : vous n’avez qu’à vérifier que le répertoire R est inclus
dans la variable d’environnement PATH. Si vous pouvez lancer R en tapant R dans un terminal, alors vous êtes
prêt pour la suite.

Pour ajouter un nouvel algorithme qui appelle une fonction R (ou un script R plus complexe que vous auriez
développé et que vous souhaiteriez utiliser dans QGIS), vous devez créer un fichier de script qui va indiquer au
module de traitements comment effectuer l’opération et les commandes R correspondantes.

Les fichiers de scripts R ont l’extension .rsx et leur création est relativement simple si vous connaissez la syntaxe
et le langage de script de R. Ils seront sauvegardés dans le répertoire de scripts de R. Vous pouvez configurer ce
répertoire dans le groupe de configuration de R (dans la fenêtre Options du module de traitements), comme vous
le feriez pour un script ordinaire.

Voyons un simple script, qui appelle la méthode spsample de R, pour créer une grille aléatoire à l’intérieur
de l’emprise d’un ensemble de polygones d’une couche donnée. Cette fonction appartient au paquet maptools.
Comme la plupart des algorithmes que vous aurez à intégrer dans QGIS utilisent ou génèrent des données spatiales,
la connaissance des paquets spatiaux comme maptools et surtout sp est un prérequis.

##polyg=vector
##numpoints=number 10
##output=output vector
##sp=group
pts=spsample(polyg,numpoints,type="random")
output=SpatialPointsDataFrame(pts, as.data.frame(pts))

Les premières lignes, qui commencent avec un double signe de commentaire Python (##), indiquent à QGIS les
entrées de l’algorithme décrit dans le fichier ainsi que les sorties qu’il génère. Ces lignes fonctionnent exactement
avec la même syntaxe que les scripts du module de Traitements que nous avons déjà étudiés et elles ne seront pas
décrites davantage ici.

Please have a look at the R Intro and the R Syntax Training Manual Chapters to have more information on how to
write your own R scripts-
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Quand vous déclarez un paramètre d’entrée, QGIS utilise cette information pour deux choses : créer le formulaire
pour demander à l’utilisateur la valeur de ce paramètre et créer la variable R correspondante qui sera ensuite
utilisée dans les commandes R.

Dans l’exemple ci-dessus, nous avons déclaré une entrée de type vecteur appelée polyg. A l’exécution de
l’algorithme, QGIS ouvrira la couche sélectionnée par l’utilisateur dans R et la stockera dans une variable nommée
polyg. Ainsi le nom du paramètre est également le nom de la variable à utiliser dans R pour accéder à son contenu
(par conséquent, évitez d’utiliser des mots réservés R comme noms de paramètre).

Les éléments spatiaux telles que les couches vecteur et raster sont lues en utilisant les commandes readOGR() et
brick() (n’ajoutez pas ces commandes à votre description de fichier – QGIS s’en chargera). Elles sont stockées
en tant qu’objets Spatial*DataFrame. Les champs des tables sont stockés en tant que chaînes de caractères
contenant le nom du champ sélectionné.

Les tables sont ouvertes par la commande read.csv(). Si la table à charger n’est pas au format CSV, il faudra
la convertir avant de l’importer dans R.

De plus, les couches raster peuvent être lues avec la commande readGDAL() au lieu de brick(), en utilisant
##usereadgdal.

Si vous êtes un utilisateur expert et que vous ne voulez pas que QGIS crée l’objet correspondant à une couche,
vous pouvez utiliser le paramètre ##passfilename qui indique que vous préférez une chaîne de caractères
contenant le nom du fichier à la place. Dans ce cas, c’est à vous d’ouvrir le fichier au préalable.

Avec l’information ci-dessus, nous pouvons maintenant comprendre la première ligne de notre premier exemple
de script (la première ligne qui n’est pas un commentaire Python).

pts=spsample(polyg,numpoints,type="random")

La variable polygon contient déjà un objet SpatialPolygonsDataFrame, l’appel de la méthode
spsample est donc simple. Il en est de même pour la méthode numpoints qui renvoit le nombre de points à
ajouter pour créer la grille.

Comme nous avons déclaré une sortie de type vecteur nommée out, nous devons créer cette variable out et lui
affecter un objet Spatial*DataFrame (dans notre cas, un SpatialPointsDataFrame). Vous pouvez
utiliser n’importe quel nom pour les variables intermédiaires. Assurez-vous simplement que la variable qui stocke
la valeur finale ait le même nom que la variable de sortie définie au début ainsi qu’une valeur compatible.

Dans notre exemple, le résultat de la méthode spsample doit être converti explicitement en objet
SpatialPointsDataFrame, dans la mesure où c’est un objet de la classe ppp qui ne peut être retransmis à
QGIS.

If your algorithm generates raster layers, the way they are saved will depend on whether or not you have used the
##dontuserasterpackage option. If you have used it, layers are saved using the writeGDAL() method.
If not, the writeRaster() method from the raster package will be used.

If you have used the ##passfilenames option, outputs are generated using the raster package (with
writeRaster()), even though it is not used for the inputs.

Si votre algorithme ne renvoie pas de couche mais plutôt un résultat texte dans la console, vous devez préciser
que la console doit s’afficher à la fin de son exécution. Pour cela, commencez les lignes qui doivent renvoyer
les résultats par le signe >. Les sorties des autres lignes seront masquées. Par exemple, voici la description d’un
algorithme qui réalise un test de normalisation sur un champ donné (ou une colonne) de la table d’attributs d’une
couche vectorielle :

##layer=vector
##field=field layer
##nortest=group
library(nortest)
>lillie.test(layer[[field]])

La sortie de la dernière ligne est affichée, mais la sortie de la première ne l’est pas (ni celles des commandes
ajoutées automatiquement par QGIS).

Si votre algorithme crée des graphiques (par la méthode plot()), ajoutez la ligne suivante:
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##showplots

Ceci va indiquer à QGIS de rediriger toutes les sorties graphiques de R vers un fichier temporaire qui sera chargé
une fois l’exécution de R terminée.

Les graphiques et les résultats dans la console seront affichés dans le gestionnaire de résultats.

Pour plus d’informations, veuillez vous référer aux scripts fournis avec le module de Traitements. Tous sont
relativement simples et pourront vous aider à construire vos propres scripts.

Note: rgdal and raster libraries are loaded by default, so you do not have to add the corresponding
library() commands (you just have to make sure that those two packages are installed in your R dis-
tribution). However, other additional libraries that you might need have to be explicitly loaded by typing,
library(ggplot2). If the package is not already installed on your machine, Processing will download and
install it. In this way the package will be also available in R Standalone. Be aware that if the package has to be
downloaded, the first time you run the script it might take a long time.

18.14.6 GRASS

La configuration pour GRASS est similaire à celle de SAGA. Tout d’abord, pour Windows, indiquez le répertoire
d’installation de GRASS ainsi que l’emplacement de l’interpréteur shell (habituellement le fichier msys.exe
fourni avec GRASS).

Par défaut, le module de traitement est configuré de telle sorte qu’il utilise la distribution de GRASS installée avec
QGIS. Cela devrait fonctionner sans problème sur la plupart des systèmes mais, si vous rencontrez des difficultés,
vous allez sans doute devoir configurer la connexion à GRASS manuellement. De même, si vous souhaitez utiliser
une version différente de GRASS, vous pouvez modifier ce paramètre et pointer sur le répertoire qui contient la
version souhaitée. La version 6.4 de GRASS est nécessaire pour que les algorithmes fonctionnent correctement.

Sous Linux, assurez-vous simplement que GRASS est correctement installé et qu’il peut être lancé depuis un
terminal.

Les algorithmes GRASS nécessitent la définition d’une région. Cette région peut être définie manuellement,
en fournissant les valeurs, comme pour la configuration de SAGA, ou de manière automatique, correspondant
à l’emprise minimale des données d’entrée à l’exécution de l’algorithme. Si vous préférez ce dernier réglage,
cochez l’option Utiliser l’emprise minimale dans les paramètres de configuration de GRASS.

18.14.7 GDAL

Les algorithmes GDAL ne nécessitent pas de configuration particulière, dans la mesure où ils sont déjà intégrés
dans QGIS et y récupèrent donc leurs configurations.

18.14.8 La boîte à outils Orfeo (OTB)

Les algorithmes de la boîte à outils Orfeo (Orfeo Toolbox - OTB) peuvent être exécutés depuis QGIS si OTB est
installé sur votre ordinateur et que QGIS est configuré correctement pour trouver les fichiers nécessaires (outils en
ligne de commande et librairies).

Comme pour SAGA, les exécutables d’OTB sont incluses dans l’installateur indépendant de Windows mais pas
sous Linux. Vous devez donc télécharger et installer le logiciel vous-même. Référez au site web d’OTB pour plus
d’informations.

Une fois OTB installé, démarrez QGIS, ouvrez la fenêtre de configuration du module de Traitements et configurez
le fournisseur OTB. Dans le groupe Orfeo Toolbox (analyse d’image), vous retrouverez tous les réglages relatifs à
OTB. Vérifiez que les algorithmes sont activés.

Ensuite, configurez l’emplacement des exécutables et des librairies OTB :
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• habituellement, le répertoire Applications OTB pointe vers /usr/lib/otb/applications et celui
des Outils OTB en ligne de commande est /usr/bin.

• If you use any of the installers that include OTB, such as OSGeo4W, there is no need for further con-
figuration. Processing will detect the path automatically and will not show the corresponding configuration
entries. Otherwise, fill the OTB applications folder and OTB command line tools folder parameters with the
to the corresponding values for your installation.

18.14.9 TauDEM

TauDEM (Terrain Analysis Using Digital Elevation Models) is a tools for the extraction and analysis of hydrolog-
ical information from Digital Elevation Models (DEM). TauDEM can be used from QGIS if you have it installed
in your system and configured QGIS properly, so it can find all necessary files.

There are two versions of TauDEM tools: singlefile (TauDEM 5.0.6 or 5.1.2) and multifile (TauDEM 5.2.0). The
difference between these versions in the supported inputs/outputs. Single files version accepts only single raster
file and write single file as output. Multifile version accepts a directory with rasters and writes directory with
rasters as output. Such directory should contain rasters that will be treated as a single DEM grid.

TauDEM Processing provider supports both single- and multifile versions of TauDEM and even allows to use them
simultaneously.

Note: While TauDEM Processing provider supports TauDEM 5.0.6, 5.1.2 and 5.2.0 we recommend to use 5.1.2
and/or 5.2.0 as this versions have some new tools available, like Gage Watershed and TWI.

Installation de TauDEM sous Windows

Please visit the TauDEM homepage and download desired version of the precompiled binaries for your platform
(32-bit or 64-bit), usually this is “Command Line Executables”. Also you need to download Microsoft HPC Pack
2012 MS-MPI. First install Microsoft HPC Pack 2012 MS-MPI by runing mpi_x64.Msi for 64-bit platforms
and mpi_x86.Msi for 32-bit platforms.

Note: If you want to use TauDEM 5.0.6

Installation de TauDEM sous Linux

Unfortunately there are no packages for most Linux distributions, so you should compile TauDEM by yourself.
As TauDEM uses MPI it is necessary to install first any MPI implementation e.g MPICH or OpenMPI. Use your
favorite package manager to install MPICH or OpenMPI.

Download TauDEM 5.2.0 source code package from GitHub repository and extract archive contents. Open termi-
nal and cd into src directory inside extracted folder. Create build directory and cd into it

mkdir build
cd build

Configure your build (change install prefix if necessary) and compile

CXX=mpicxx cmake -DCMAKE_INSTALL_PREFIX=/usr/local ..
make

When compilation finished install TauDEM tools by running

sudo make install

Note: Executable files will be installed into bin subdirectory inside prefix you specified at the con-
figure stage. For example if you specified prefix /opt/taudem5.2 than binaries will be installed into
/opt/taudem5.2/bin.
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To use singlefile version — download source package here and perform above mentioned steps to compile and
install it.

Old TauDEM 5.0.6 also available. But before compiling this version it is necessary to edit some source files.

Ouvrez le fichier lienarpart.h et, après la ligne

#include "mpi.h"

ajoutez la ligne suivante

#include <stdint.h>

afin d’obtenir ceci

#include "mpi.h"
#include <stdint.h>

Sauvegardez les modifications et fermez le fichier. À présent, ouvrez le fichier tiffIO.h, trouvez la ligne
#include "stdint.h" dans laquelle vous remplacerez les quotes ("") par des <>, pour obtenir ceci

#include <stdint.h>

Save the changes and close the file.

Now configure, compile and install TauDEM 5.0.6 using same commands as described above.

Configuring TauDEM provider

Once TauDEM is installed, start QGIS, open the Processing options dialog from Processing → Options... and
configure the TauDEM algorithm provider. In the Providers group find TauDEM (hydrologic analysis) block, and
expand it. Here you will see all settings related to TauDEM.

First, ensure that algorithms are enabled, and activate provider if necessary.

Next step is to configure MPI. The MPICH/OpenMPI bin directory setting used to define location of the mpiexec
program. In most Linux distributions you can safely leave this empty, as mpiexec available in your PATH.

The Number of MPI parallel processes to use is a second setting related to MPI. It defines number of processes
that will be used to execute TauDEM commands. If you don’t know which value to use, it is better to leave this
value unchanged.

Now we need to configure the path to the folder(s) where TauDEM command-line tools are installed. As we
already mention TauDEM provider supports both single- and multifile TauDEM, so there are two settings for
TauDEM folders:

• TauDEM command line tools folder used to set location of the singlefile tools

• TauDEM multifile command line tools folder used to set location of the multifile tools

If you have both TauDEM versions installed in different directories it is possible to specify both options.

The last step is to define which TauDEM version to use:

• with Enable multifile TauDEM tools option checked you will use multifile TauDEM tools from directory,
specified in the TauDEM multifile command line tools folder. Multifile tools have same name as singlefile
with “(multifile)” suffix added

• with Enable single TauDEM tools option checked you will use multifile TauDEM tools from directory,
specified in the TauDEM command line tools folder.

It is possible to enable both tools simultaneously. In this case you will have two instances of each tool in toolbox
and can use them in your analysis.

Note: Be careful with developing Processing models using TauDEM!
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As single- and multifile versions have different inputs, model created with singlefile algorithms will not work if
only multifile algorithms are available. If you plan to share your model please specify which TauDEM version
should be used or, better, provide two versions of your model: for single- and multifile TauDEM.

18.15 La ligne de commande QGIS

Les outils de traitement intègrent un outil très pratique qui vous permet de lancer des algorithmes sans avoir à
ouvrir la boite à outils. Il suffit juste de saisir le nom de l’algorithme que vous voulez exécuter.

Il s’agit de l’outil Ligne de commande qui se matérialise par une simple zone de texte à complètement automatique
où saisir le nom de la commande à lancer.

Figure 18.32: La ligne de commande QGIS

La Ligne de commande est lancée depuis le menu Traitements ou en appuyant sur Shift + Ctrl + M (vous
pouvez modifier ce raccourci clavier dans la configuration de QGIS si vous en préférez un autre). Pour la fermer,
appuyez sur ESC. En plus d’exécuter des algorithmes de traitement, la Ligne de commande vous donne accès à
la plupart des fonctions de QGIS, il s’agit donc d’un moyen pratique et efficace de lancer des tâches QGIS sans
avoir à passer par les menus et les boutons.

La Ligne de commande est également configurable et vous pouvez y ajouter vos propres commandes et les lancer
en quelques touches, faisant de la ligne de commande un outil puissant vous permettant d’améliorer votre produc-
tivité quotidienne avec QGIS.

18.15.1 Commandes disponibles

Les commandes disponibles sont classées en différentes catégories :

• Algorithmes. Ils apparaissent sous la forme Processing algorithm: <nom de
l’algorithme>.

• Entrées de menu. Elles apparaissent sous la forme Menu item: <nom de l’entrée de menu>.
Toutes les entrées de menu disponibles via l’interface de QGIS y sont listées, même s’il s’agit d’un sous-
menu.

• Fonctions Python. Vous pouvez créer de courtes fonctions Python qui feront ensuite partie de la liste des
commandes disponibles. Elles se présentent sous la forme Function: <nom de la fonction>.

Pour lancer une des commandes ci-dessus, commencez à taper puis sélectionnez la commande depuis la liste qui
apparaît alors, filtrée dynamiquement par le texte que vous tapez.

Dans le cas d’un appel à une fonction Python, vous pouvez sélectionner la fonction par son nom dans la liste,
préfixé de Function: (par exemple : Function: removeall) ou taper directement le nom de la fonction
(removeall dans l’exemple précédent). Il n’est pas nécessaire d’ajouter des guillemets au nom de la fontion.
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18.15.2 Créer des fonctions personnalisées

Les fonctions personnalisées sont ajoutées en insérant le code Python correspondant dans le fichier
commands.py qui se trouve dans .qgis2/processing/commander dans votre répertoire utilisateur. Il
s’agit d’un simple fichier Python dans lequel vous pouvez ajouter les fonctions que vous souhaitez.

Le fichier est créé avec quelques exemples de fonctions la première fois que vous ouvrez la Ligne de commandes.
Si la Ligne de commandes n’a pas été encore lancée, vous pouvez créer le fichier manuellement. Pour l’éditer,
utiliser votre éditeur de texte préféré. Vous pouvez également utiliser l’éditeur intégré en tapant edit dans la
Ligne de commandes. Un éditeur s’ouvrira avec le fichier de commandes que vous pourrez alors modifier puis
enregistrer.

Par exemple, vous pouvez ajouter la fonction suivante, qui supprime toutes les couches :

from qgis.gui import *

def removeall():
mapreg = QgsMapLayerRegistry.instance()
mapreg.removeAllMapLayers()

Une fois la fonction ajoutée, elle sera disponible depuis la Ligne de commandes et vous pourrez l’appeler en tapant
removeall. Il n’y a rien d’autre à faire à part écrire la fonction elle-même.

Les fonctions peuvent recevoir des paramètres. Ajoutez‘‘*args‘‘ à la définition de votre fonction pour accepter
des paramètres. Lors de l’appel à cette fonction depuis la Ligne de commande, les paramètres doivent être passés
en les séparant pas des espaces.

Voici un exemple de fonction qui charge une couche et prend comme paramètre le nom de la couche à charger.

import processing

def load(*args):
processing.load(args[0])

Si vous souhaitez charger la couche /home/myuser/points.shp, tapez dans la Ligne de commandes :

‘‘load /home/myuser/points.shp‘‘
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CHAPTER 19

Composeur d’Impression

Avec le Composeur d’Impression vous pouvez créer de jolies cartes et des atlas qui peuvent être imprimés ou
sauvegardés en tant que fichier PDF, image ou fichier SVG. C’est un moyen puissant de partager de l’information
géographique produite avec QGIS qui peut être incluse dans des rapports ou publiée.

19.1 Aperçu du Composeur d’impression

Le Composeur d’Impression fournit des fonctionnalités de plus en plus riches de mise en page et d’impression.
Il vous permet d’ajouter des éléments tels que le canevas de carte QGIS, des zones de textes, des images, des
légendes, des échelles graphiques, des formes de base, des flèches, des tables attributaires et des cadres HTML.
Vous pouvez modifier la taille, grouper, aligner, positionner, pivoter chaque élément et ajuster leurs propriétés pour
créer votre mise en page. Le résultat peut être imprimé ou exporté dans plusieurs formats d’image, en PostScript,
PDF et SVG (l’export en SVG ne fonctionne pas correctement avec certaines versions récentes de Qt4, vous devez
essayer et vérifier sur votre propre système). Vous pouvez aussi l’enregistrer dans un modèle de mise en page
de carte pour l’utiliser dans d’autres projets. Enfin vous pouvez générer un ensemble de cartes automatiquement
grâce au Générateur d’Atlas.

19.1.1 Exemple d’utilisation

Avant de démarrer le travail avec le Composeur de Cartes, vous devez charger des couches raster ou vecteurs dans
la fenêtre principale de QGIS et adapter leurs propriétés pour qu’elles vous conviennent. Quand tout est rendu

et symbolisé comme souhaité, cliquez sur l’icône Nouveau composeur d’impression ou le menu Projet → Nouveau
composeur d’impression. Une fenêtre va d’abord vous demander un titre à donner au nouveau composeur.

Pour créer une carte, veuillez suivre les instructions suivantes.

1. Sur le côté gauche, sélectionnez le bouton de barre d’outils Ajouter une nouvelle carte et dessinez un rectangle.
A l’intérieur du rectangle dessiné, la carte de la vue QGIS est affichée .

2. Sélectionnez le bouton de la barre d’outils Ajouter une nouvelle échelle graphique et cliquez avec le bouton gauche
de la souris dans le canevas du Composeur d’Impression. Une barre d’échelle sera ajoutée au canevas.

3. Sélectionnez le bouton de la barre d’outils Ajouter une nouvelle légende et dessinez un rectangle dans le canevas
en maintenant enfoncé le bouton gauche de la souris. À l’intérieur du rectangle dessiné, la légende sera
affichée.

4. Sélectionnez l’icône Sélectionner/Déplacer un objet pour sélectionner la carte sur le canevas et déplacez-le un
peu.

5. Tant que l’élément de carte est toujours sélectionné, vous pouvez aussi changer sa taille. Cliquez tout en
maintenant enfoncé le bouton gauche de la souris sur un des coins de l’élément marqué par un petit rectangle
blanc et déplacez-le pour changer la taille de la carte.
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6. Cliquez sur l’onglet Propriétés de l’objet sur le panneau inférieur gauche et trouvez les paramètres pour
l’orientation. Changez la valeur du paramètre Rotation de la carte à ‘15.00° ‘. Vous devriez voir l’orientation
de l’élément de carte changer.

7. Maintenant vous pouvez imprimer ou exporter votre mise en page au format image, PDF ou SVG via les
outils d’export du menu Composeur.

8. Enfin, vous pouvez enregistrer votre mise en page dans le fichier de projet avec le bouton Enregistrer le projet.

Vous pouvez ajouter de nombreux éléments au composeur. Il est également possible d’avoir plusieurs vues d’une
carte, légendes ou échelles graphiques dans le canevas du Composeur d’Impression, sur une ou plusieurs pages.
Chaque élément possède ses propres propriétés et dans le cas d’une carte, sa propre emprise géographique. Si vous
voulez supprimer un élément du canevas du Composeur, vous pouvez le faire en utilisant les touches Suppr. ou
Retour arrière.

19.1.2 Le Gestionnaire de Composeurs

The Composer Manager is the main window to manage print composers in the project. It helps you add new print

composer, duplicate an existing one, rename or delete it. To open the composer manager dialog, click on the
Composer Manager button in the toolbar or choose Composer → Composer Manager. It can also be reached from the
main window of QGIS with Project → Composer Manager.

Figure 19.1: Le Gestionnaire de Composeurs d’Impression

The composer manager lists in its upper part all the available print composers in the project. The bottom part
shows tools that help to:

• show the selected composer(s): you can open multiple print composers in one-click

• duplicate the selected composer (available only if one print composer is selected): it creates a new composer
using the selected composer as template. You’ll be prompted to choose a new title for the new composer

• rename the composer (also available only if one print composer is selected): You’ll be prompted to choose
a new title for the composer. Note that you can also rename the composer by double-clicking on its title in
the upper part

• remove the composer: the selected print composer(s) will be deleted from the project.

With the Composer Manager, it’s also possible to create new print composers as an
empty composer or from a saved template. By default, QGIS will look for tem-
plates in user directory (~/.qgis2/composer_templates) or application’s one
(ApplicationFolder/composer_templates). QGIS will retrieve all the available templates and
propose them in the combobox. The selected template will be used to create a new composer when clicking Add
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button. You can also save composer templates in another folder. Choosing specific in the template list offers the
ability to select such template and use it to create a new print composer.

19.1.3 Menus, outils et panneaux du composeur d’impression

L’ouverture du Composeur d’Impression vous donne un canevas blanc qui représente la surface de papier lorsqu’on
utilise l’option d’impression. Initialement, vous trouvez des boutons sur le côté gauche du canevas pour ajouter
des éléments du composeur de carte; le canevas de carte QGIS courant, les étiquettes de texte, les images, les
légendes, les échelles graphiques, les formes de base, les flèches, les tables attributaires et les cadres HTML.
Dans cette barre d’outils, vous trouver aussi des boutons de barre d’outils pour naviguer, zoomer sur une zone et
déplacer la vue sur le composeur et des boutons de barre d’outils pour sélectionner un élément du composeur de
carte et déplacer le contenu de l’élément carte.

Figure_composer_overview montre la vue initiale du Composeur d’Impression avant qu’aucun élément n’y soit
ajouté.

Figure 19.2: Composeur d’Impression

Sur la droite, à côté du canevas, vous trouverez deux panneaux. Le panneau supérieur contient les onglets Éléments
et Historique des commandes et le panneau inférieur contient les onglets Composition, Propriétés de l’objet et
Génération d’atlas.

• L’onglet Éléments fournit une liste de tous les éléments du Composeur d’Impression ajouté au canevas.
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• L’onglet Historique des commandes affiche un historique des changements effectués dans le Composeur
d’Impression. Avec un clic droit, il est possible de défaire et refaire des actions jusqu’à l’état choisi.

• L’onglet Composition vous permet de définir la taille du papier, l’orientation, l’arrière-plan, le nombre de

pages et la qualité d’impression pour le fichier de sortie en dpi/ppp. De plus vous pouvez activer l’ Im-
pression raster qui permet de convertir tous les éléments en raster avant impression ou export en Postscript
ou PDF. Vous pouvez également personnaliser les paramètres pour la grille et les guides.

• L’onglet Propriétés de l’objet affiche les propriétés pour l’élément sélectionné sur la mise en page. Cliquez

sur l’icône Sélectionner/déplacer un objet pour sélectionner un élément (par exemple l’échelle graphique ou une
étiquette) dans la feuille. Puis cliquez sur l’onglet Propriétés de l’objet et personnalisez les paramètres de
l’élément sélectionné.

• L’onglet Génération d’atlas permet d’activer la création d’un atlas en sortie de composeur et d’en gérer les
paramètres.

In the bottom part of the Print Composer window, you can find a status bar with mouse position, current page
number, a combo box to set the zoom level, the number of selected items if applicable and, in the case of atlas
generation, the number of features.

In the upper part of the Print composer window, you can find menus and other toolbars. All Print Composer tools
are available in menus and as icons in a toolbar. See a list of tools in table_composer_1.

The toolbars and the tabs can be switched off and on using the right mouse button over any toolbar or through
View → Toolbars or View → Panels.
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Outils

Icône Fonction Icône Fonction

Enregistrer le projet Nouveau composeur

Dupliquer le composeur Gestionnaire de composeurs

Ajouter des éléments depuis un modèle Enregistrer comme modèle

Imprimer ou exporter en PostScript Exporter au format image

Exporter au format SVG Exporter au format PDF

Annuler la dernière modification Restaurer la dernière modification

Zoomer sur l’emprise maximale Zoomer à 100%

Zoom avant Zoom arrière

Rafraîchir l’affichage

Se déplacer dans le composeur Zoomer sur une zone spécifique

Sélectionner/déplacer des objets dans le
composeur de cartes

Déplacer le contenu de l’objet

Ajouter une nouvelle carte à partir de la fenêtre
principale de QGIS

Ajouter une image au composeur de
cartes

Ajouter une zone de texte au composeur de
cartes

Ajouter une nouvelle légende au
composeur de cartes

Ajouter une nouvelle échelle au composeur
d’impression

Ajouter une forme basique au composeur
de cartes

Ajouter une flèche au composeur de cartes Ajouter une table d’attributs dans le
composeur de cartes

Ajouter un cadre HTML

Grouper des objets du composeur d’impression Dégrouper des objets du composeur
d’impression

Verrouiller les objets sélectionnés Déverrouiller tous les objets

Envoyer les objets sélectionnés vers l’avant Envoyer les objets sélectionnés vers
l’arrière

Envoyer les objets sélectionnés à l’avant Envoyer les objets sélectionnés à
l’arrière-plan

Aligner les objets sélectionnés à gauche Aligner les objets sélectionnés à droite

Aligner les objets sélectionnés au centre Aligner les objets sélectionnés au centre
verticalement

Aligner les objets sélectionnés en haut Aligner les objets sélectionnés en bas

Aperçu de l’atlas Première entité

Entité précédente Entité suivante

Dernière entité Impression de l’Atlas

Exporter l’Atlas au format image Paramètres de l’Atlas

Table Composeur d’Impression 1 : Outils du Composeur d’Impression
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Composer Menu

With the Composer → Save Project action, you can save the project file directly from the print composer window.
The Composer menu also provides actions to:

• Create a new and blank print composer with New Composer...

• Duplicate Composer... : Create a new print composer by duplicating the current one

• Open the Composer Manager...

• Print Composers... : Open an existing print composer

Once the layout is designed, with Save as template and Add items from template icons, you can save the current state
of a Print Composer session as a .qpt template and load its item again in another session.

In the Composer menu, there are also powerful ways to share geographical information produced with QGIS that

can be included in reports or published. These tools are Export as Image..., Export as PDF..., Export as SVG... and
Print....

Settings Menu

Via le menu Préférences → Options du composeur, vous pouvez définir les paramètres qui seront utilisés par
défaut pour tous les composeurs pendant votre travail.

• Valeurs par défaut pour les compositions permet de spécifier la police de caractère par défaut.

• Dans Apparence de la grille, vous définissez le style et la couleur de la grille. Il y a trois styles de grille :
lignes en Pointillés ou Continues et Croix.

• Grille et guides par défaut définit l’espacement, le décalage et la tolérance de la grille.

Edit Menu

Copier / Coller des éléments

The print composer includes actions to use the common Copy/Cut/Paste functionality for the items in the layout.
As usual first you need to select the items using one of the options seen above; at this point the actions can be
found in the Edit menu. When using the Paste action, the elements will be pasted according to the current mouse
position. Using the Edit → Paste in Place action or pressing Ctrl+Shift+V will paste the items into the current
page, at the same position they were in their initial page. It ensures to copy/paste items at the same place, from
page to page.

Note: Les objets HTML ne peuvent pas être copiés de cette manière. En guise de contournement, utilisez le
bouton [Ajouter un cadre] dans l’onglet Propriétés de l’objet.

View Menu

Navigation Tools

Pour se déplacer sur la mise en page, quelques outils sont proposés :

• Zoom +

• Zoom -
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• Zoom sur l’emprise totale

• Zoomer à 100%

• Rafraîchir la vue pour actualiser l’affichage si nécessaire

• Show Grid behind items.

• Snap Grid to snap items on the grid.

• Show Guides to help user to align items. These are red line that you can click in the rule (above or at the
left side of the layout) and drag and drop to the desired location.

• Snap Guides: allows user to snap items to the guides,

• Smart Guides: uses other composer items as guides to dynamically snap to as user moves or reshapes an
item.

• Clear Guides to remove all current guides.

• Show Bounding box around the items.

• Show Rules around the layout.

• Show Pages or set up pages to transparent. Often composer is used to create non-print layouts, e.g. for
inclusion in presentations or other documents, and it’s desirable to export the composition using a totally
transparent background. It’s sometimes referred to as “infinite canvas” in other editing packages.

• Toggle Full Screen makes the composer window to full screen.

• Hide Panels hides/shows the right panel

• Panels lists all panels available to hide/show them.

• Toolbars same as above for toolbars.

You can change the zoom level also using the mouse wheel or the combo box in the status bar. If you need
to switch to pan mode while working in the Composer area, you can hold the Spacebar or the mouse wheel.
With Ctrl+Spacebar, you can temporarily switch to Zoom In mode, and with Ctrl+Shift+Spacebar, to
Zoom Out mode.

Masquer et afficher les panneaux

Pour maximiser l’espace disponible pour interagir avec une composition, vous pouvez utiliser : menuselection:

Vue -> : guilabel: Masquer les panneaux ou appuyez sur : kbd:‘ F10‘.

Note: It’s also possible to switch to a full screen mode to have more space to interact by pressing F11 or using
View → Toggle full screen.

Composition Tab

Page size and settings

Dans l’onglet Composition, vous pouvez définir les paramètres généraux de votre mise en page.

You can choose one of the Presets formats for your paper sheet, or enter your custom width, height and units. You
can also choose the page Orientation to use.

Composition can be divided into several pages. For instance, a first page can show a map canvas, and a second
page can show the attribute table associated with a layer, while a third one shows an HTML frame linking to your
organization website. Set the Number of pages to the desired value. you can also custom the Page Background
with the color or the symbol you want.
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Figure 19.3: Composition settings in the Print Composer

The Page size options apply to all the pages in the composition. However, you can modify the values using the
data defined override options (see Boutons de Valeurs définies par des données).

A custom page size can also be set, using the Resize page tool. This creates an unique page composition, resizes
the page to fit the current contents of the composition (with optional margins).

Paramètres d’export

You can define a resolution to use for all exported maps in Export resolution. This setting can however be overrid-

den each time you are exporting a map. When checked, print as raster means all elements will be rasterized
before printing or saving as PostScript or PDF.

While exporting to an image file format, you can choose to generate a world file by checking World file on and
select a map item. The world file is created beside the exported map, has same name and contains information to
easily georeference it.

Figure 19.4: Export Settings in the Print Composer
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Grid and guides

You can put some reference marks on your composition paper sheet to help you place some items. These marks
can be:

• simple lines (called Guides) put at the position you want. To do that, ensure that Show Rulers and Show
Guides in View menu are checked. Then, click and drag from within the ruler to the paper sheet. A vertical
or horizontal line is added to the paper and you can set its position following the coordinates displayed at
the left bottom of the composer dialog.

• or regular Grid.

Whether grids or guides should be shown is set in View menu. There, you can also decide if they might be used to
snap composer items. The Grid and guides section lets you customize grid settings like Grid spacing, Grid offset
and Snap tolerance to your need. The tolerance is the maximum distance below which an item is snapped to a
grid or a guide.

Figure 19.5: Snapping to grids in the Print Composer

In the Options → Composer menu in QGIS main canvas, you can also set the spacing, offset and snap tolerance
of the grid as much as its style and color. These options are applied by default to any new print composer.

Command History Tab: Revert and Restore actions

Pendant la mise en page de la carte, il est possible d’annuler et refaire des modifications. Cela peut être réaliser à
l’aide des outils Annuler la dernière modification et Restaurer la dernière modification :

• Annuler la dernière modification

• Restaurer la dernière modification

This can also be done by mouse click within the Command history tab (see figure_composer_1). The History tab
lists the last actions done within the composer. Just select the point you want to revert to and once you do new
action all the actions done after the selected one will be removed.

Figure 19.6: Historique des commandes du Composeur d’Impression

Items Tab

The Items tab offers some options to manage selection and visibility of items. All the items added to the print
composer canvas are shown in a list and selecting an item makes the corresponding row selected in the list as well
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as selecting a row does select the corresponding item in the print composer canvas. This is thus a handy way to
select an item placed behind another one. Note that a selected row is shown as bold.

For any selected item, you can :

• set it visible or not,

• lock or unlock its position,

• order its Z position. You can move up and down each item in the list with a click and drag. The upper item
in the list will be brought to the foreground in the print composer canvas. By default, a newly created item
is placed in the foreground.

• change the name by double-clicking the text.

Once you have found the correct position for an item, you can lock it by ticking the box in column. Locked
items are not selectable on the canvas. Locked items can be unlocked by selecting the item in the Items tab and
unchecking the tickbox or you can use the icons on the toolbar.

19.2 Éléments du composeur

19.2.1 Options communes aux éléments du composeur

Les éléments du composeur disposent d’un ensemble de propriétés générales définies en bas de l’onglet
Propriétés de l’objet : Position et taille, Rotation, Cadre, Fond, Identifiant de l’objet, Rendu (voir fig-
ure_composer_common_1).

• Position et taille permet de définir la taille et la position du cadre contenant l’élément. Vous pouvez égale-
ment choisir le Point de référence dont les coordonnées X et Y sont définies.

• Rotation permet de définir un angle de rotation (en degrés) pour l’élément.

• Cadre permet d’afficher ou de cacher le cadre autour de l’objet. Cliquez sur [Couleur] et [Épaisseur]
pour modifier ces propriétés.

• Utiliser les paramètres de Fond pour afficher ou cacher une couleur de fond. Cliquez sur le bouton
[Couleur] pour ouvrir une fenêtre depuis laquelle vous choisissez une couleur. La transparence se règle
via le paramètre d’opacité.

• Utilisez l’Identifiant de l’objet pour créer une lien avec d’autres éléments du Composeur. Ceci est utilisé
par QGIS Server et autres clients web potentiels. Vous pouvez donner un ID à un élément (par ex. une carte
ou une zone de texte), puis le client web peut envoyer des informations pour spécifier les propriétés de cet
objet. La commande GetProjectSettings listera les éléments et les identifiants disponibles dans la mise en
page.

• Rendu vous permet de choisir un mode de rendu pour préciser si l’élément doit être affiché et comment il
doit l’être.

Note:

• Si vous cochez Fenêtres de choix de couleur avec mise à jour dynamique dans les options générales
de QGIS, le bouton couleur sera mis à jour dès que vous choisissez une nouvelle couleur depuis la fenêtre
Boîte de dialogue Couleur. Sinon, vous devez fermer la Boîte de dialogue Couleur.

• L’icône Défini par des données à côté d’un champ signifie que vous pouvez associer le champ avec des données
dans l’élément de carte ou utiliser des expressions. Elles sont particulièrement utiles avec la génération
d’atlas (Voir Boutons de Valeurs définies par des données).
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Figure 19.7: Fenêtre des Propriétés générales
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Mode de rendu

QGIS propose maintenant des modes de rendu avancés pour les éléments du composeur, comme pour les couches
vecteur et raster.

Figure 19.8: Mode de rendu

• Mode de fusion : avec cet outil vous pouvez donner des effets qui, autrement, ne sont réalisables qu’avec
des logiciels de dessin. Les pixels des éléments situés au-dessous et au-dessus sont fusionnés selon le mode
choisi (voir Modes de fusion pour une description de chaque mode).

• Transparence : Vous permet de rendre visible les couches situées en dessous. Utiliser
le curseur pour adapter la visibilité de la couche vectorielle à vos besoins. Vous pouvez également définir
directement le pourcentage de transparence dans la zone de texte située à côté.

• Exclure cet élément des exports : Vous pouvez décider de rendre un élément invisible dans tous les
exports. Après avoir activé cette option, l’élément ne sera pas inclus dans les exports PDF, impressions, etc.

Taille et position

Chaque élément du Composeur peut être déplacé et redimensionné pour créer une mise en page parfaite. Pour

chacune de ces opérations, la première étape est d’activer l’outil Sélectionner/Déplacer un objet et de cliquer sur
l’élément. Vous pouvez ensuite le déplacer avec la souris en maintenant le bouton gauche. Si vous souhaitez
limiter les mouvements sur les axes horizontaux ou verticaux, pressez la touche Shift du clavier pendant le
déplacement de la souris. Si vous avez besoin de plus de précision, vous pouvez déplacer l’élément sélectionné en
utilisant les flèches du clavier et si les mouvements sont trop lents, utilisez en même temps la touche Shift.

Un élément sélectionné apparait avec des carrés à chaque coin du rectangle englobant. Déplacer un de ces carrés
avec la souris redimensionnera l’élément dans la direction correspondante. Pendant le redimensionnement, presser
la touche Shift permettra de maintenir les proportions. Presser la touche Alt redimensionnera depuis le centre
de l’élément.

La position correcte d’un élément peut être obtenue en utilisant les guides ou l’accrochage à la grille. Les guides
sont créés en cliquant et en dessinant dans la zone où s’affichent les règles. Pour déplacer un guide, cliquez au
niveau de ce guide dans la règle puis glissez le vers sa nouvelle position. Pour supprimer un guide, déplacez-le
en dehors du canevas. Si vous devez désactiver la comportement d’accrochage à la volée, maintenez appuyé la
touche Ctrl lorsque vous déplacez la souris.

Vous pouvez sélectionner plusieurs éléments en même temps avec le bouton Sélectionner/Déplacer un objet. Pressez
simplement la touche Shift et cliquez sur tous les éléments souhaités. Vous pouvez ensuite les redimensionner
ou les déplacer tous en même temps.

Une fois que vous avez trouvé la position correcte pour un élément, vous pouvez le verrouiller en utilisant les
boutons sur la barre d’outils ou en cochant la boîte près de l’élément dans l’onglet Éléments. Les éléments
verrouillés ne sont pas sélectionnables sur le canevas.

Les éléments verrouillés peuvent être déverrouillés en sélectionnant l’élément dans l’onglet Éléments et décochés
dans la case à cocher, ou vous pouvez utiliser les boutons dans la barre d’outils.

Pour désélectionner un objet, cliquez dessus en maintenant la touche Shift appuyée.

Dans le menu Éditer, vous trouverez les actions permettant de sélectionner ou dé-selectionner tous les éléments
ou d’inverser la sélection.
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Alignement

Les fonctionnalités pour monter ou descendre des éléments sont présentes dans le menu déroulant
Relever les objets sélectionnés. Prenez un élément dans le Composeur de carte et sélectionnez la fonction correspondante
pour le monter ou le descendre par rapport aux autres éléments. L’ordre est affiché dans l’onglet Éléments. Vous
pouvez également monter ou descendre des éléments dans l’onglet Éléments par glissé-déposé dans cette liste.

Figure 19.9: Guides pour l’alignement dans le Composeur d’Impression

Plusieurs options d’alignement sont disponibles via le menu déroulant Aligner les objets sélectionnés (voir fig-
ure_composer_common_3). Pour en utiliser une, sélectionnez d’abord les éléments puis cliquez sur l’outil
d’alignement désiré. Tous les éléments sélectionnés seront alors alignés au sein de leur rectangle englobant com-
mun. Lors du déplacement d’éléments dans le Composeur, des guides apparaissent lorsque les bords, les centres
ou les coins sont alignés.

19.2.2 L’élément Carte

Cliquez sur le bouton Ajouter une nouvelle carte de la barre d’outils du composeur pour ajouter la carte telle
qu’affichée dans la fenêtre principale de QGIS. Tracez ensuite un rectangle sur la mise en page avec le bou-
ton gauche de la souris. Concernant l’affichage de la carte, vous pouvez choisir entre trois modes différents depuis
l’onglet Propriétés de l’objet :

• Rectangle est l’option par défaut. Elle n’affiche qu’un cadre vide avec un message ‘La carte sera imprimée
ici’.

19.2. Éléments du composeur 321



QGIS User Guide, Version 2.14

• Cache affiche la carte dans sa résolution d’écran actuelle. Si vous zoomez sur le Composeur, la carte ne
sera pas actualisée, mais l’image sera mise à l’échelle.

• Rendu signifie que, si vous faites un zoom sur le Composeur, la carte sera actualisée, mais pour des raisons
de performances, une résolution maximale a été prédéfinie.

Cache est le mode d’aperçu par défaut pour un Composeur nouvellement créé.

Vous pouvez redimensionner l’élément de carte en cliquant le bouton Sélection/Déplacement élément, sélectionnez
l’élément et faire glisser l’une des attaches bleues dans les coins de la carte. Ce bouton sert aussi à déplacer la
carte à un autre endroit. Sélectionnez l’élément et tout en appuyant sur le bouton gauche de la souris, positionnez
à la nouvelle position et relâchez le bouton. Après avoir trouver le bon endroit pour un élément, vous pouvez
verrouiller sa position dans le canevas du Composeur. Sélectionnez l’élément de carte et utilisez la barre d’outils

Verrouiller éléments sélectionnés ou l’onglet Éléments pour verrouiller l’élément. Un élément verrouillé ne peut être
sélectionné qu’en utilisant l’onglet Éléments. Une fois sélectionné, vous pouvez utiliser l’onglet Éléments pour

déverrouiller des éléments. L’icône Déverrouiller touts les éléments déverrouillera tous les éléments verrouillés du
Composeur. La carte étant sélectionnée, vous pouvez maintenant adapter plus de propriétés dans l’onglet Pro-
priétés éléments de la carte.

Pour déplacer les couches dans l’élément de carte, sélectionner l’élément de carte, cliquer l’icône
Déplacer contenu élément et déplacer les couches dans le cadre de l’élément de carte avec le bouton gauche de la souris.

Propriétés principales

La zone Propriétés principales de l’onglet Propriétés de l’objet de la carte propose les fonctionnalités suivantes
(voir figure_composer_map_1) :

Figure 19.10: Onglet Propriétés d’une carte

• Les options d’Aperçu vous permettent de choisir parmi les modes ‘Cache’, ‘Rendu’ ou ‘Rectangle’ comme
décrits ci-dessus. Si vous changez la vue dans la fenêtre principale de QGIS en modifiant des couches
vecteurs ou raster, vous pouvez mettre à jour le Composeur en sélectionnant l’élément carte puis en cliquant
sur le bouton [Mise à jour de l’aperçu].
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• Le champ Échelle permet de préciser manuellement une valeur d’échelle.

• Le champ Rotation de carte vous permet de définir l’angle de rotation de l’élément de la carte, dans
le sens horaire, en degrés. C’est ici que la rotation de la vue de carte peut être imitée. Notez qu’un cadre
de coordonnées correct ne peut être obtenu que lorsque l’angle de rotation a la valeur par défaut de 0 et que
lorsqu’une Rotation de carte est définie, il ne peut plus être modifié.

• Dessiner les objets du canevas de la carte permet de montrer les annotations placées sur la carte dans la
fenêtre principale de QGIS.

• Vous pouvez choisir de verrouiller les couches affichées sur la carte. Cochez Verrouiller les couches pour
cette carte. Après cela, toute couche qui serait rendue visible ou invisible sur la carte de la fenêtre principale
de QGIS n’apparaîtra ou ne disparaîtra pas de la carte dans le composeur. Mais, le style et l’étiquetage des
couches verrouillées sont toujours mis à jour par la fenêtre principale de QGIS. Vous pouvez éviter ce
comportement en utilisant Verrouiller les styles de couche pour cette carte.

• Le bouton vous permet d’ajouter rapidement toutes les vues prédéfinies que vous avez préparées dans
QGIS. En cliquant sur le bouton , vous pourrez consulter la liste des vues prédéfinies et sélectionner
celle que vous voulez afficher. Le canevas de carte verrouillera automatiquement les couches prédéfinies en

activant la Verrouiller les couches pour cette carte. Si vous voulez désélectionner ce qui est prédéfini,

décochez la et appuyez sur le bouton . Consultez Le panneau Couches pour voir comment créer des
vues prédéfinies.

Les couche verrouillées de la carte peuvent aussi être définies par données, en utilisant l’icône au côté
de l’option. Lorsqu’elle est utilisée, elle passe outre la sélection définie dans la liste déroulante. Vous devez
passer une liste de couches séparées par le caractère |. L’exemple suivant contraint l’élément de carte à
n’utiliser que les couches couche 1 et couche 2 :

concat (’layer 1’, ’|’, ’layer 2’)

Emprise

La zone Aperçus de l’onglet Propriétés de l’objet de la carte propose les fonctionnalités suivantes (voir fig-
ure_composer_map_2) :

Figure 19.11: Définition de l’emprise de la carte

• L’Emprise vous permet de définir l’emprise de la carte en utilisant les valeurs X et Y minimales et max-
imales puis de cliquer sur le bouton [Fixer sur l’emprise courante du canevas de la carte]. Ce bouton
paramètre l’emprise de la carte du composeur avec l’emprise de la vue courante dans l’application QGIS.
Le bouton [Voir l’étendue sur la carte] fait exactement l’inverse : il met à jour l’emprise de la carte dans
l’application QGIS avec l’étendue de la carte dans le composeur.

If you change the view on the QGIS map canvas by changing vector or raster properties, you can update the Print
Composer view by selecting the map element in the Print Composer and clicking the [Update preview] button in
the map Item Properties tab (see figure_composer_map_1).
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Graticules

La boîte de dialogue Graticules de l’onglet Propriétés de l’objet de la carte propose la possibilité d’ajouter
plusieurs graticules à l’élément carte.

• Avec les boutons plus et moins, vous pouvez ajouter ou enlever une grille sélectionnée.

• Avec les boutons haut et bas, vous pouvez déplacer une grille dans la liste et configurer la priorité
d’affichage.

Lorsque vous double-cliquez sur la grille ajoutée, vous pouvez lui donner un autre nom.

Figure 19.12: Fenêtre des Graticules de Carte

Après avoir ajouté un graticule, vous pouvez activer l’option Afficher le graticule pour superposer une grille
sur l’élément carte. Développez cette option pour accéder à de nombreuses options de configuration, voir Fig-
ure_composer_map_4.

Figure 19.13: Paramètres d’affichage des graticules

Comme type de graticule, vous pouvez utiliser ‘Continue’, ‘Croix’, ‘Marqueurs’ ou ‘Cadre et annotation seule-
ment’. ‘Cadre et annotation seulement’ est tout particulièrement utile lorsque vous travaillez avec des cartes qui
ont subi une rotation ou des graticules reprojectés. Dans la section divisions de la boîte de dialogue Cadre du
graticule mentionnée ci-dessous vous avez un tel paramètre. La symbologie du graticule peut être définie. Voir la
section Mode de rendu. De plus, vous pouvez définir l’intervalle dans les directions X et Y, un décalage en X et Y
et l’épaisseur utilisée pour les croix ou les lignes du type de graticule.

• Il y a différentes options pour créer le cadre qui contient la carte. Les options suivantes sont disponibles :
Pas de cadre, Zébré, Marqueurs à l’intérieur, Marqueurs à l’extérieur, Marqueurs à l’intérieur et à l’extérieur
et Cadre simple.
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Figure 19.14: Fenêtre du Cadre du Graticule

• Avec les paramètres Afficher uniquement la latitude / Y et Afficher uniquement la longitude / X dans la
section Afficher les coordonnées, vous avez la possibilité de prévenir la confusion entre les coordonnées de
latitude/y et longitude/x affichées sur le côté lorsque vous travaillez avec des cartes tournées ou des grilles
re-projetées.

• Un mode de rendu avancé est également disponible pour les graticules.

• La Afficher les coordonnées permet d’ajouter les coordonnées au cadre de la carte. Vous pouvez choisir
le format numérique des annotations, les options vont de décimal à degré, minute, seconde, avec ou sans
suffixe, alignés ou non et un formatage personnalisé via le générateur d’expressions. Vous pouvez choisir
quelles annotations afficher. Les options sont : Tout afficher, Afficher uniquement la latitude, Afficher
uniquement la longitude, Désactivé (aucune). Ceci est utile quand une rotation est appliquée à la carte. Les
annotations peuvent être placées à l’intérieur ou à l’extérieur du cadre. L’orientation des annotations peut
être définie par Horizontal, Ascendant vertical ou Descendant vertical. Finalement, vous pouvez définir la
police, la couleur de police, la distance par rapport au cadre et la précision des coordonnées.

Aperçus

La zone Aperçus de l’onglet Propriétés de l’objet de la carte propose les fonctionnalités suivantes :

Vous pouvez choisir de créer un aperçu de carte, qui montre l’étendue des autres carte(s) qui sont disponibles dans
le composeur. Premièrement, vous devez créer la carte(s) que vous voulez inclure dans l’aperçu de carte puis créer
une carte que vous voulez utiliser comme aperçu de carte, simplement comme une carte normale.

Puis ouvrez Aperçus et cliquez sur le bouton-icône plus vert pour ajouter un aperçu. Initialement, cet aperçu est
nommé ‘Aperçu 1’ (voir Figure_composer_map_7). Vous pouvez changer le nom lorsque vous double-cliquez sur
l’élément nommé ‘Aperçu 1’ et ensuite le renommer.

• Avec les boutons plus et moins, vous pouvez ajouter ou enlever un aperçu.

• Avec les boutons haut ou bas, vous pouvez déplacer un aperçu dans la liste et configurer la priorité
d’affichage.

Lorsque vous sélectionnez l’élément aperçu dans la liste, vous pouvez le personnaliser.

• L’option Afficher l’aperçu “<nom_aperçu>” doit être activée pour afficher l’étendue du cadre de la
carte sélectionnée.

• La liste combo Cadre de carte peut être utilisée pour sélectionner l’élément carte dont les extensions seront
affichées sur l’élément carte présent.

• Le Style du cadre vous permet de changer le style du cadre de l’aperçu.
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Figure 19.15: Fenêtre des Coordonnées d’affichage du graticule

Figure 19.16: Paramètres des Aperçus
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• Le Mode de fusion vous permet de définir différents modes de fusion pour créer une transparence.

• La case Inverser l’aperçu crée un masque sur l’emprise de l’autre zone de cart qui apparaît clairement
alors que le reste est mis en transparence en utilisant le mode de fusion choisi.

• La Centrer sur l’aperçu paramètre l’emprise du cadre d’aperçu au centre de la carte d’aperçu. Vous
pouvez activer uniquement un seul élément d’aperçu au centre lorsque vous avez plusieurs aperçus.

19.2.3 L’élément Étiquette

Pour ajouter une zone de texte, cliquez sur le bouton Ajouter une nouvelle étiquette, placez l’élément sur la page par
un clic-gauche et personnalisez son apparence grâce aux Propriétés de l’objet.

L’onglet Propriétés de l’objet d’un élément étiquette propose la fonctionnalité suivante pour l’élément étiquette
(voir Figure_composer_label) :

Figure 19.17: Onglet Propriétés d’une zone de texte

Propriétés principales

• C’est l’endroit où le texte (HTMLou pas) ou l’expression sont à insérer pour être affichés dans le Composeur.

• Le texte saisi peut être interprété comme du code HTML si vous cochez la case Afficher en HTML.
Vous pouvez ainsi insérer une URL, une image cliquable qui renvoie à une page web ou tout autre code plus
complexe.

• Vous pouvez également insérer une expression. Cliquez sur [Insérer une expression...] pour ouvrir une
nouvelle fenêtre. Construisez une expression en choisissant parmi les fonctions disponibles dans la partie
gauche de cette fenêtre. Deux catégories de fonctions sont très utiles, notamment lorsque l’on utilise la
génération d’atlas : les fonctions de géométrie et d’enregistrement. En bas de la fenêtre, un aperçu du
résultat s’affiche.
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Apparence

• Définissez la Police en cliquant sur le bouton [Police...] ou une Couleur de police en sélectionnant une
couleur via l’outil de sélection de couleur.

• Vous pouvez spécifier des marges horizontale et verticale différentes, en millimètres. Il s’agit de la marge
à partir du coin de l’objet. L’étiquette peut être positionnée en dehors de ses limites par exemple lors d’un
alignement avec d’autres objets. Dans ce cas, utilisez des valeurs négatives pour les marges.

• Utiliser Alignement est un autre moyen pour positionner votre étiquette. Notez que par exemple, en utilisant
Alignement horizontal avec Au centre, la Marge horizontale n’est pas prise en compte.

19.2.4 L’élément Légende

Pour ajouter une légende, cliquez sur l’icône Ajouter une nouvelle légende et placez l’élément sur le Composeur avec
le bouton gauche de votre souris. Vous pouvez modifier la position et l’apparence avec l’onglet Propriétés de
l’objet après avoir sélectionné l’élément.

Les Propriétés principales d’une légende proposent les fonctionnalités suivantes (voir figure_composer_legend_1)
:

Figure 19.18: Onglet Propriétés d’une légende

Propriétés principales

La zone Propriétés principales de l’onglet Propriétés de l’objet de la légende propose les fonctionnalités suivantes
(voir figure_composer_legend_2) :

Dans les Propriétés Principales vous pouvez :

• Changer le titre de la légende.

• Définir l’alignement du titre À Gauche, Au centre ou À droite.

• Vous pouvez également choisir à quelle Carte doit correspondre la légende.

• Vous pouvez choisir un caractère qui permet d’insérer des retours à la ligne.
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Figure 19.19: Propriétés principales d’une légende

Objets de légende

La zone Objets de légende de l’onglet Propriétés de l’objet de la légende propose les fonctionnalités suivantes
(voir figure_composer_legend_3) :

Figure 19.20: Modification des objets de légende

• La légende sera automatiquement mise à jour si Mise à jour auto est cochée. Lorsque Mise à jour auto
n’est pas cochée, cela vous donnera plus de contrôle sur les éléments de la légende. Les icônes en-dessous
de la liste des éléments de légende seront activés.

• La fenêtre des éléments de légende répertorie tous les éléments de la légende et vous permet de changer
l’ordre des éléments, de grouper les couches, de supprimer ou de restaurer des éléments de la liste, de
modifier les noms des couche et d’ajouter un filtre.

– L’ordre des éléments peut être changé en utilisant les boutons [Monter] et [Descendre] ou avec la
fonctionnalité ‘glisser-déposer’. L’ordre ne peut pas être changé pour les graphiques de légende WMS.

– Utilisez le bouton [Ajouter un groupe] pour ajouter un groupe de légende.

– Utilisez les boutons [plus] et [moins] pour ajouter ou supprimer des couches.

– Le bouton [Éditer] est utilisé pour modifier le nom de la couche, le nom du groupe ou le titre. Vous
devez d’abord sélectionner l’élément de la légende.

– Le bouton [Sigma] ajoute un nombre d’entités pour chaque couche vectorielle.

– Utilisez le bouton [filtre] pour filtrer la légende avec le contenu de la carte, seuls les éléments de la
légende visibles dans la carte seront listés dans la légende.

Après avoir changé la symbologie dans la fenêtre principale QGIS, vous pouvez cliquer sur [Tout mettre à
jour ] pour adapter les changements dans l’élément légende du Composeur d’impression.

Polices, Colonnes, Symbole et Espacement

Les zones Polices, Colonnes et Symbole de la légende dans l’onglet Propriétés de l’objet fournissent les fonction-
nalités suivantes (voir figure_composer_legend_4) :

• Vous pouvez changer la police du titre de la légende, du groupe, du sous-groupe et de l’élément (de couche)
dans la légende. Cliquez sur la catégorie concernée pour ouvrir la fenêtre Choisir une police.
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Figure 19.21: Fenêtres Polices, Colonnes et Symbole d’une légende

• Vous pouvez choisir une Couleur pour les étiquettes avec le sélecteur de couleur avancé, cependant la
couleur sélectionnée sera donnée à tous les éléments de police dans la légende.

• Les éléments de légende peuvent être organisés sur plusieurs colonnes. Configurez le nombre de colonnes
dans le champ Compter .

– La case Égaliser la largeur des colonnes permet d’ajuster la taille des colonnes de la légende.

– L’option Séparer les couches permet de présenter sur plusieurs colonnes les éléments de légende
d’une couche ayant un style catégorisé ou gradué.

• Vous pouvez changer la largeur et la hauteur du symbole de légende ici. Dans le cas de symboles de légende
pour une couche raster, vous pouvez également modifier la couleur et l’épaisseur du contour du symbole.

Légende Graphique WMS et Espacement

Les zones Légende WMS et Espacement de l’onglet Propriétés de l’objet fournissent les fonctionnalités suivantes
(voir figure_composer_legend_5) :

Lorsque vous avez ajouté une couche WMS et que vous insérez un élément de légende du composeur, une requête
sera envoyée au serveur WMS pour fournir une légende WMS. Cette Légende sera uniquement affichée si le
serveur WMS fournit la capacité GetLegendGraphic. Le contenu de la légende WMS sera fourni comme une
image raster.

La Légende WMS est utilisée pour ajuster la Largeur de la légende et la Hauteur de la légende pour la légende
WMS des images raster.

L’espacement autour du titre, des groupes, sous-groupes, symboles, libellés de légende, colonnes peut se person-
naliser ici.
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Figure 19.22: Fenêtres de Légende Graphique WMS et Espacement

19.2.5 L’ échelle graphique

Pour ajouter une barre d’échelle, cliquez sur l’icône Ajouter une nouvelle échelle graphique, puis placez l’élément sur le
canvas du composeur avec le bouton gauche de votre souris. Vous pourrez modifier sa position et son apparence
avec l’onglet Propriétés de l’objet disponible après avoir sélectionné l’élément.

Les Propriétés de l’objet d’une barre d’échelle proposent les fonctionnalités suivantes (voir fig-
ure_composer_scalebar_1) :

Figure 19.23: Onglet Propriétés d’une barre d’échelle

Propriétés principales

La zone Propriétés principales de l’onglet Propriétés de l’objet de la barre d’échelle propose les fonctionnalités
suivantes (voir figure_composer_scalebar_2) :

• Choisissez tout d’abord à quelle carte la barre d’échelle sera associée.

• Ensuite, choisissez le style de la barre d’échelle. Six sont disponibles :
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Figure 19.24: Propriétés principales d’une barre d’échelle

– Les styles Boîte unique ou Boîte double correspondent à une ou deux lignes de boîtes de couleurs
alternées.

– Repères au milieu, en-dessous ou au-dessus de la ligne.

– Numérique : le ratio d’échelle est affiché (par exemple, 1:50000).

Unités et Segments

Les zones Unités et Segments de l’onglet Propriétés de l’objet de la barre d’échelle proposent les fonctionnalités
suivantes (voir figure_composer_scalebar_3) :

Figure 19.25: Choix des unités et du nombre de segments pour la barre d’échelle

Avec ces deux zones de paramètres, vous pouvez choisir la manière dont la barre d’échelle sera représentée.

• Sélectionnez les unités que vous souhaitez utliser. Vous disposez de quatre choix : Unités de carte - qui
est l’unité sélectionnée par défaut - Mètres, Pied ou Miles Nautiques. Certaines unités peuvent forcer la
conversion des unités.

• Unités de carte par unité de l’échelle graphique indique le nombre d’unités de la barre d’échelle par unités
étiquetées. Par exemple, si votre échelle est en “mètres”, un multiplicateur de 1000 permettra de mettre une
étiquette “kilomètres”.

• Étiquettes permet de définir le texte à utiliser pour étiqueter les unités de la barre d’échelles, par exemple
“m” ou “km”. Celle ci doit être adapté au multiplicateur.

• Vous pouvez définir combien de Segments seront dessinés à gauche et / ou à droite de la barre d’échelle.

• Vous pouvez définir une largeur de segment fixe (Largeur fixée) ou fixer un intervalle de largeur en mm avec
Largeur ajustée au segment. Avec cette dernière option, à chaque fois que l’échelle de la carte est modifiée,
la barre d’échelle est redimensionnée (et les étiquettes modifiées) pour s’adapter à l’intervalle.

• Le champ Hauteur permet de définir la hauteur des barres.
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Affichage

La zone Affichage de l’onglet Propriétés de l’objet de la barre d’échelle propose les fonctionnalités suivantes (voir
figure_composer_scalebar_4) :

Figure 19.26: Affichage de la barre d’échelle

Vous pouvez définir comment l’échelle graphique sera affichée dans son cadre.

• Marge de la boîte : espace entre le texte et les bords du cadre

• Marge des étiquettes : espace entre le texte et l’échelle graphique dessinée

• Largeur de ligne : largeur de ligne de l’échelle graphique dessinée

• Style de jointure : Coins à la fin de l’échelle graphique dans le style Oblique, Rond ou Angle droit (seulement
disponible pour les styles de barre d’échelle Boîte unique & Boîte double)

• guilabel:Style d’extrémités : Fin de toutes les lignes dans le style Carré, Rond ou Plat (seulement disponible
pour les styles Repères en-dessus, en-dessous et au milieu de la ligne)

• Alignement : Met le texte sur la gauche, au milieu ou à droite du cadre (fonctionne uniquement pour le style
Numérique)

Polices et couleurs

La zone Polices et couleurs de l’onglet Propriétés de l’objet de la barre d’échelle propose les fonctionnalités
suivantes (voir figure_composer_scalebar_5) :

Figure 19.27: Paramètres de polices et de couleurs de la barre d’échelle

Vous pouvez définir les polices et couleurs utilisées pour l’échelle graphique.

• Utilisez le bouton [Police] pour configurer la police de l’objet

• Couleur de police: configure la couleur de police

• Couleur de remplissage: configure la première couleur de remplissage

• Couleur de remplissage secondaire : configure la seconde couleur de remplissage
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• Couleur du contour : configure la couleur des lignes de l’Échelle graphique

Les couleurs de remplissage sont uniquement utilisées pour les boîtes de style d’échelle Boîte Unique et Boîte
Double. Pour sélectionner une couleur, vous pouvez utiliser l’option liste en utilisant la flèche descendante pour
ouvrir une option de sélection de couleur simple ou l’option de sélection de couleur avancée, qui s’ouvre lorsque
vous cliquez dans la boîte colorée dans la boîte de dialogue.

19.2.6 L’élément Table Attributaire

It is possible to add parts of a vector attribute table to the Print Composer canvas: Click the Add attribute table

icon, click and drag with the left mouse button on the Print Composer canvas to place and size the item. You can
better position and customize its appearance in the Item Properties tab.

Les Propriétés principales d’une table attributaire proposent les fonctionnalités suivantes (voir fig-
ure_composer_table_1) :

Figure 19.28: Onglet propriétés de la Table Attributaire

Propriétés principales

The Main properties dialog of the attribute table‘ provides the following functionalities (see fig-
ure_composer_table_2):

Figure 19.29: Propriétés principales d’une table attributaire

• Pour Source, vous pouvez normalement sélectionner seulement ‘Entités de la couche’.

• Avec Couche, vous pouvez choisir à partir des couches vecteurs chargées dans le projet.
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• Dans le cas où l’option Générer un atlas de l’onglet Génération d’atlas est activée, il y a deux nouvelles
Source possibles : ‘Entité courante de l’atlas (voir figure_composer_table_2b) ou ‘Relation enfant’ (voir
figure_composer_table_2c). Choisir ‘Entité courante de l’atlas’ implique que vous ne verrez aucune option
pour choisir la couche, et l’objet table affichera seulement une ligne avec les attributs de l’entité courante
de la couche de couverture. Choisir ‘Relation enfant’ affichera une nouvelle option pour spécifier les noms
des relations. L’option ‘Relation enfant’ ne peut être utilisée que si vous avez défini une relation utilisant la
couche de couverture comme parent, et affichera les enregistrements enfants de l’objet courant de la couche
de couverture (pour plus d’informations à propos de la génération d’atlas voir Générer un Atlas).

• Le bouton [Actualiser la table de données] peut être utilisé pour actualiser la table lorsque le contenu
actuel de la table a changé.

Figure 19.30: Propriétés principales de la table attributaire pour ‘Entité courante de l’atlas’

Figure 19.31: Propriétés principales de la table attributaire pour ‘Relation enfant’

• The button [Attributes...] starts the Select attributes menu, see figure_composer_table_3, that can be used
to change the visible contents of the table. After making changes use the [OK] button to apply changes to
the table. The upper part of the window shows the list of the attributes to display and the lower part helps to
set the way the data is sorted.

Dans la section Colonnes, vous pouvez :

– Supprimer un attribut : sélectionnez simplement une ligne d’attribut en cliquant n’importe où sur une
ligne et cliquez sur le bouton moins pour supprimer l’attribut sélectionné.

– Pour ajouter de nouveaux attributs, utilisez le bouton plus. A la fin de la liste des colonnes, une
nouvelle ligne vide apparaît et vous pouvez sélectionner une cellule vide de la colonne Attribut. Vous
pouvez sélectionner un champ attributaire à partir de la liste ou vous pouvez construire un nouvel

attribut en utilisant une expression ( button). Bien sûr vous pouvez modifier tous les attributs
existants par le biais d’une expression régulière.

– Utiliser les flèches monter et descendre pour changer l’ordre des attributs dans la table.

– Sélectionner une cellule dans la colonne En-tête pour changer l’En-tête, en tapant simplement un
nouveau nom.

– set a precise Alignment (mixing vertical and horizontal alignment options) for each column.

– Sélectionner une cellule dans la colonne Largeur et vous changez de Automatique à une largeur en
mm, simplement en tapant un nombre. Lorsque vous voulez la remettre à Automatique, utilisez la
croix.

– Le bouton [Réinitialiser] peut toujours être utilisé pour le restaurer à ses paramètres d’attribut original.

Dans la section Trier, vous pouvez :
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Figure 19.32: Fenêtre de Sélection d’attributs

– Ajouter un attribut pour trier la table avec. Sélectionnez un attribut et Définissez l’ordre de tri en
‘Croissant’ ou ‘Décroissant’ et cliquez sur le bouton plus. Une nouvelle ligne est ajoutée à la liste
d’ordre de tri.

– select a row in the list and use the up and down button to change the sort priority on attribute level.
Selecting a cell in the Sort Order column helps you change the sorting order of the attribute field.

– Utiliser le bouton moins pour supprimer un attribut de la liste de l’ordre de tri.

Filtrage des entités

The Feature filtering dialog of the attribute table provides the following functionalities (see fig-
ure_composer_table_4):

Figure 19.33: Fenêtre de Filtrage des entités de la Table Attributaire

Vous pouvez :

• Définir un nombre de Lignes maximales à afficher.

• Activer Supprimer les lignes en double de la table pour ne montrer que les enregistrements uniques.
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• Activer Ne montrer que les entités visibles sur la carte et sélectionner le Composeur de carte correspon-
dant pour afficher seulement les attributs des entités visibles sur la carte sélectionnée.

• Activer Ne montrer que les entités intersectant l’entité de l’atlas est seulement disponible lorsque
Générer un atlas est activé. Lorsqu’il est activé, il affichera une table avec seulement les entités indiquées
sur la carte de cette page en particulier de l’atlas.

• Activer Filtrer avec et fournir un filtre en tapant dans la ligne d’entrée ou insérer une expression régulière

en utilisant le bouton d’expression . Voici quelques exemples de déclarations de filtrage que vous pouvez
utiliser lorsque vous avez chargé la couche des aéroports à partir du jeu de données exemples :

– ELEV > 500

– NAME = ’ANIAK’

– NAME NOT LIKE ’AN%

– regexp_match( attribute( $currentfeature, ’USE’ ) , ’[i]’)

La dernière expression régulière inclura seulement les aéroports qui ont une lettre ‘i’ dans le champ d’attribut
‘USE’.

Apparence

The Appearance dialog of the attribute table provides the following functionalities (see figure_composer_table_5):

Figure 19.34: Fenêtre d’apparence de la table attributaire

• Click Show empty rows to fill the attribute table with empty cells. This option can also be used to provide
additional empty cells when you have a result to show!

• Avec les Marges de cellule, vous pouvez définir les marges autour du texte dans chaque cellule de la table.

• Avec Afficher l’en-tête, vous pouvez sélectionner à partir d’une liste une des options par défaut ‘Sur le
premier cadre’, ‘Sur tous les cadres’, ou ‘Pas d’en-tête’.

• L’option Tables vides contrôle ce qui sera affiché lorsque la sélection des résultats est vide.

– N’afficher que les en-têtes affichera seulement l’en-tête, excepté si vous avez choisi ‘Pas d’en-tête’
pour Afficher l’en-tête.

– Masquer la table entière affichera seulement le fond de la table. Vous pouvez activer Ne pas
afficher le fond si le cadre est vide dans Cadres pour cacher complètement la table.
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– Afficher le message défini affichera l’en-tête et ajoutera une cellule couvrant toutes les colonnes et
affichera un message comme ‘Pas de résultat’ qui peut être proposé dans l’option Message à afficher

• L’option Message à afficher est seulement activée lorsque vous avez sélectionné Afficher le message défini
pour Table vide. Le message proposé sera affiché dans la table sur la première ligne, lorsque le résultat est
une table vide.

• With Background color you can set the background color of the table. The Advanced customization option
helps you define different background colors for each cell (see figure_composer_table_6)

Figure 19.35: Attribute table Advanced Background Dialog

• With the Wrap text on option, you can define a character on which the cell content will be wraped each time
it is met

• With Oversized text you define the behaviour when the width set for a column is smaller than its content’s
length. It can be Wrap text or Truncate text.

Afficher les bordures

The Show grid dialog of the attribute table provides the following functionalities (see figure_composer_table_7):

Figure 19.36: Fenêtre Afficher les bordures de la table attributaire

• Activer Afficher les bordures lorsque vous voulez afficher les bordures des cellules de la table.

• Avec Épaisseur du trait vous pouvez définir l’épaisseur des lignes utilisées pour les bordures.
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• La Couleur des bordures peut être définie en utilisant la boîte de dialogue de sélection de couleur.

Styles de polices et textes

The Fonts and text styling dialog of the attribute table provides the following functionalities (see fig-
ure_composer_table_8):

Figure 19.37: Fenêtre Styles de polices et de textes de la table attributaire

• Vous pouvez définir la Police et la Couleur pour l’En-tête de table et le Contenu de la table.

• For Table heading you can additionally set the Alignment to Follow column alignment or override this
setting by choosing Left, Center or Right. The column alignment is set using the Select Attributes dialog
(see Figure_composer_table_3 ).

Cadres

The Frames dialog of the attribute table provides the following functionalities (see figure_composer_table_9):

Figure 19.38: Fenêtre Cadres de la table attributaire

• Avec le Mode de redimensionnement vous pouvez sélectionner la façon de rendre le contenu de la table
attributaire :

– Utiliser les cadres existants affiche le résultat seulement dans le premier cadre et les cadres ajoutés.

– Étendre à la page suivante créera autant de cadres (et pages correspondantes) que nécessaire pour
afficher l’intégralité de la sélection de la table attributaire. Chaque cadre peut être déplacé autour de la
couche. Si vous redimensionnez un cadre, la table résultante sera répartie entre les autres cadres. Le
dernier cadre sera rogné pour s’adapter à la table.

– Répéter jusqu’à la fin créera autant de cadre que pour l’option Étendre à la page suivante sauf que
tous les cadres auront la même taille.
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• Utiliser le bouton [Ajouter un cadre] pour ajouter un autre cadre avec la même taille que le cadre sélec-
tionné. Le résultat de la table qui ne rentre pas dans le premier cadre continuera dans le cadre suivant lorsque
vous utilisez le mode Redimensionner Utiliser les cadres existants.

• Activer Ne pas exporter la page si le cadre est vide empêche la page d’être exportée lorsque le cadre
de la table n’a pas de contenu. Cela signifie que tous les autres éléments du composeur, cartes, échelles
graphiques, légendes, etc. ne seront pas visibles dans le résultat.

• Activer Ne pas afficher le fond si le cadre est vide empêche le fond d’être affiché lorsque le cadre de la
table n’a pas de contenu.

19.2.7 L’élément Image

To add an image, click the Add image icon and drag a rectangle onto the Composer canvas with the left mouse
button. You can then position and customize its appearance in the image Item Properties tab.

L’onglet des Propriétés principales d’une image proposent les fonctionnalités suivantes (voir fig-
ure_composer_image_1) :

Figure 19.39: Onglet Propriétés d’une image

Vous devez d’abord sélectionner l’image que vous voulez afficher. Il y a plusieurs moyens de configurez la Source
de l’image dans la zone Propriétés principales.

1. Utilisez le bouton parcourir de la Source de l’image pour sélectionner un fichier sur votre ordinateur
en utilisant la boîte de dialogue de l’explorateur. L’explorateur commencera dans la librairie SVG fournie
avec QGIS. Outre SVG, vous pouvez aussi sélectionner d’autres formats d’image comme .png ou .jpg.

2. Vous pouvez entrer la source directement dans la zone de texte Source de l’image. Vous pouvez même
fournir une adresse URL distante à une image.

3. Depuis la zone Rechercher dans les répertoires, vous pouvez également sélectionner une image depuis
Chargement des aperçus... pour définir l’image source.
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4. Utilisez le bouton Source de définition pour définir l’image source depuis un enregistrement ou en
utilisant une expression régulière.

Avec l’option Mode de redimensionnement, vous pouvez définir comment l’image est affichée lorsque le cadre
change, ou choisir de redimensionner le cadre de l’élément image afin qu’il s’ajuste avec la taille originale de
l’image.

Vous pouvez sélectionner un des modes suivants :

• Zoom : Agrandit l’image au cadre tout en conservant les proportions de l’image.

• Étirement : Étire une image pour l’ajuster à l’intérieur du cadre, ignore les proportions.

• Découper : Utilisez ce mode uniquement pour des images raster, il définit la taille de l’image à la taille de
l’image originale sans mise à l’échelle, et le cadre est utilisé pour découper l’image, donc seule la partie de
l’image à l’intérieur du cadre est visible.

• Zoom et redimensionnement du cadre : Agrandit l’image pour s’ajuster avec le cadre, puis redimensionne
le cadre pour s’ajuster à l’image résultante.

• Redimensionner le cadre à la taille de l’image : Définit la taille du cadre pour correspondre à la taille
originale de l’image sans mise à l’échelle.

Sélectionner un mode de redimensionnement peut désactiver les options de l’élément ‘Placement’ et ‘Rotation de
l’image’. La Rotation de l’image est active pour les modes de redimensionnement ‘Zoom’ et ‘Découper’.

Avec le Position, vous pouvez sélectionner la position de l’image à l’intérieur de son cadre. La zone Rechercher
dans les répertoires vous permet d’ajouter ou de supprimer des répertoires avec des images au format SVG de
la base de données d’images. Un aperçu des images trouvées dans les répertoires sélectionnés est affiché dans un
panneau et peut être utilisé pour sélectionner et configurer la source de l’image.

It is possible to change SVG fill/outline color and outline width when using parameterized SVG files such as
those included with QGIS. If you add a SVG file you should add the following tags in order to add support for
transparency:

• fill-opacity=”param(fill-opacity)”

• stroke-opacity=”param(outline-opacity)”

You can read this blog post to see an example.

Images can be rotated with the Image rotation field. Activating the Sync with map checkbox synchronizes the
rotation of the image (i.e., a rotated north arrow) with the rotation applied to the selected map item.

Il est aussi possible de sélectionner directement une flèche nord. Si vous sélectionnez d’abord une image de

flèche nord depuis Rechercher dans les répertoires et utilisez ensuite le bouton parcourir du champ
Source de l’image, vous pouvez dès lors sélectionner une des flèches nord de la liste comme affiché dans fig-
ure_composer_image_2.

Note: Beaucoup de flèches Nord n’ont pas un ‘N’ ajouté à la flèche Nord, cela est fait exprès pour les langues
qui n’utilisent pas un ‘N’ pour le Nord, de sorte qu’elles puissent utiliser une autre lettre.

19.2.8 L’élément cadre HTML

Il est possible d’ajouter un cadre qui affiche le contenu d’un site web ou même de créer et personnaliser votre
propre page HTML et de l’afficher !

Cliquez sur l’icône Ajouter du HTML, placez l’élément en glissant un rectangle dans le canevas du Composeur
d’Impression en maintenant enfoncé le bouton gauche de la souris et positionnez puis personnalisez l’apparence
dans l’onglet Propriétés de l’élément (voir figure_composer_html_1).
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Figure 19.40: Flèches Nord disponibles pour la sélection dans la bibliothèque SVG fournie

Figure 19.41: Cadre HTML, onglet propriétés de l’objet
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Source du HTML

Comme une source du HTML, vous pouvez soit configurer une URL et activer le bouton radio URL, ou entrer la
source du HTML directement dans la zone de texte fournie et activer le bouton radio Source.

La boîte de dialogue Source du HTML de l’onglet Propriétés de l’objet du cadre HTML propose les fonctionnalités
suivantes (voir figure_composer_html_2) :

Figure 19.42: Cadre HTML, propriétés de la Source du HTML

• Dans URL, vous pouvez entrer l’URL d’une page internet que vous avez copiée depuis votre navigateur

internet ou sélectionner un fichier HTML en utilisant le bouton Parcourir . Il y a aussi la possibilité
d’utiliser le bouton de valeurs définies par les données, pour proposer une URL à partir du contenu d’un
champ d’attribut d’une table ou en utilisant une expression régulière.

• Dans Source, vous pouvez entrer un texte dans la zone de texte avec quelques balises HTML ou proposer
une page HTML entière.

• Le bouton [Insérer une expression] peut être utilisé pour insérer une expression comme
[%Year($now)%] dans la zone de texte Source pour afficher l’année courante. Ce bouton est seule-
ment activé lorsque le bouton radio Source est sélectionné. Après avoir inséré l’expression, cliquez quelque
part dans la zone de texte avant de rafraîchir le cadre HTML, autrement vous perdrez l’expression.

• Activez Évaluer l’expression QGIS dans la source du HTML pour voir le résultat de l’expression que
vous avez incluse, autrement vous verrez l’expression à la place.

• Utilisez le bouton [Mise à jour du HTML] pour voir le résultat des paramètres de la feuille de style.

Cadres

La boîte de dialogue Cadres de l’onglet Propriétés de l’objet du cadre HTML propose les fonctionnalités suivantes
(voir figure_composer_html_3) :

Figure 19.43: Cadre HTML, propriétés des Cadres

• Avec Mode de redimensionnement, vous pouvez sélectionner la façon de rendre le contenu HTML :

– Utiliser les cadres existants affiche le résultat seulement dans le premier cadre et les cadres ajoutés.
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– Étendre à la page suivante créera autant de cadres (et de pages) que nécessaire pour afficher la page
en entier. Chaque cadre peut être déplacé sur la mise en page. Si vous redimensionnez un cadre, la
page web sera à nouveau répartie dans les cadres. Le dernier cadre sera rogné pour s’ajuster à la page
web.

– Répéter sur chaque page répètera la partie supérieure gauche de la page web sur chaque pages du
composeur dans des cadres de taille identique.

– Répéter jusqu’à la fin créera autant de cadre que pour l’option Étendre à la page suivante sauf que
tous les cadres auront la même taille.

• Utilisez le bouton [Ajouter un cadre] pour ajouter un autre cadre avec la même taille que le cadre sélec-
tionné. Si la page HTML ne va pas dans le premier cadre, elle ira dans le cadre suivant lorsque vous utilisez
Mode de redimensionnement ou Utiliser les cadres existants.

• Activez Ne pas exporter la page si le cadre est vide empêche que la carte mise en page soit exportée
lorsque le cadre n’a pas de contenu HTML. Cela signifie que tous les autres éléments du composeur, cartes,
barres d’échelle, légendes etc. ne seront pas visibles dans le résultat.

• Activez Ne pas afficher le fond si le cadre est vide empêche que le cadre HTML soit affiché si le cadre
est vide.

Utiliser des sauts de page intelligents

La boîte de dialogue Utiliser des sauts de page intelligents de l’onglet Propriétés de l’objet du cadre HTML
propose les fonctionnalités suivantes (voir figure_composer_html_4) :

Figure 19.44: Cadre HTML, propriétés de Utiliser des sauts de page intelligents

• Activez Utiliser des sauts de pages intelligents pour empêcher le contenu du cadre html de se casser à
mi-chemin d’une ligne de texte afin qu’il continue bien dans le cadre suivant.

• Paramètre la Distance maximale autorisée lors du calcul de l’emplacement du saut de page dans le
html. Cette distance est la quantité maximale d’espace vide autorisé dans le bas du cadre après cal-
cul de l’emplacement optimal du saut de page. Indiquer une grande valeur permettra de mieux définir
l’emplacement du saut de page mais une plus grande quantité d’espace vide sera présent dans le bas des
cadres. Cette valeur est utilisée uniquement lorsque Utiliser des sauts de page intelligents est activé.

• Activez Feuille de style utilisateur pour appliquer des styles HTML qui sont souvent fournis dans des
feuilles de style en cascade. Un exemple de code de style est fourni ci-dessous pour définir la couleur de
la balise d’en-tête <h1> au vert et définir la police et la taille de police du texte inclu dans les balises de
paragraphe <p>.

h1 {color: #00ff00;
}
p {font-family: "Times New Roman", Times, serif;

font-size: 20px;
}
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• Utilisez le bouton [Mise à jour du HTML] pour voir le résultat des paramètres de la feuille de style.

19.2.9 Les éléments Formes simples

Pour ajouter une forme simple (ellipse, rectangle, triangle), cliquez sur l’icône Ajouter une forme simple, placez
l’élément en maintenant enfoncé le clic gauche de la souris. Personnalisez l’apparence dans l’onglet Propriétés
de l’objet.

Lorsque vous maintenez également enfoncé la touche Shift lors du placement de la forme simple, vous pouvez
créer un carré, un cercle ou un triangle parfait.

Figure 19.45: Onglet Propriétés d’une forme

L’onglet Forme des propriétés de l’objet vous permet de sélectionner si vous voulez dessiner une ellipse, un
rectangle ou un triangle à l’intérieur du cadre donné.

Vous pouvez définir le style de la forme en utilisant la boîte de dialogue avancée du style de symbole avec laque-
lle vous pouvez définir ses couleurs de bordure et de remplissage, son motif de remplissage, son utilisation de
symboles etc.

Pour la forme rectangulaire, vous pouvez configurer la valeur du rayon de coin pour arrondir les coins.

Note: À la différence des autres objets du composeur, vous ne pouvez pas personnaliser le cadre ou la couleur du
fond du cadre.

19.2.10 L’élément Flèche

Pour ajouter une flèche, cliquez sur l’icône Ajouter une flèche, placez l’élément en maintenant enfoncé le bouton
gauche de la souris et tirez une ligne pour dessiner la flèche dans le canevas du Composeur d’Impression et la
positionner, puis personnalisez l’apparence de la flèche dans l’onglet Propriétés de l’objet.

Lorsque vous maintenez également enfoncée la touche Shift lors du placement de la flèche, elle est placée dans
un angle d’exactement 45° .

L’élément flèche peut être utilisé pour ajouter une ligne ou une simple flèche qui peut être ajoutée, par exem-
ple, pour montrer la relation entre les autres éléments du Composeur d’Impression. Pour créer une flèche nord,
l’élément image devrait être considéré d’abord. QGIS a un jeu de flèches Nord en format SVG. De plus, vous
pouvez connecter un élément d’image avec une carte donc elle peut pivoter automatiquement avec la carte (voir
L’élément Image).
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Figure 19.46: Onglet Propriétés d’une flèche

Propriétés de l’objet

L’onglet Flèche des propriétés de l’objet vous permet de configurer un élément flèche.

Le bouton [Style de ligne ...] peut être utilisé pour configurer le style de ligne en utilisant l’éditeur de symbole de
style de ligne.

Dans les Symboles de flèches, vous pouvez sélectionner un des trois boutons radio.

• Défaut : Pour dessiner une flèche régulière, vous donne des options pour personnaliser la tête de flèche

• Aucun : Pour dessiner une ligne sans tête de flèche

• Symbole SVG : Pour dessiner une ligne avec un Symbole de départ SVG et/ou un Symbole de fin SVG

Pour un symbole Flèche par Défaut, vous pouvez utiliser les options suivantes pour personnaliser la tête de flèche.

• Couleur de bordure de la flèche : Configure la couleur de bordure de la tête de flèche

• Couleur de remplissage de la flèche : Configure la couleur de remplissage de la tête de flèche

• Largeur de bordure de la flèche : Configure la largeur de bordure de la tête de flèche

• Largeur de la tête: Configure la taille de la tête de flèche

Pour le Symbole SVG vous pouvez utiliser les options suivantes.

• Marqueur de début : Choisit une image SVG à dessiner au début de la ligne

• Marqueur de fin : Choisit une image SVG à dessiner à la fin de la ligne

• Largeur de la tête de flèche : Configure la taille du départ et/ou d’arrivée du symbole de tête

Les images SVG pivotent automatiquement avec la ligne. La couleur de l’image SVG ne peut pas être changée.
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19.3 Exporter des cartes

Figure_composer_output_1 montre une mise en page incluant un exemple de chaque type d’élément décrit dans
les sections précédentes.

Figure 19.47: Composeur d’Impression avec une carte, une légende, une image, une barre d’échelle, des coordon-
nées, du texte et un cadre HTML

Avant d’imprimer une mise en page vous avez la possibilité de voir votre composition sans les boîtes de

délimitation. Cela peut être activé en décochant Vue –> Afficher les zones d’emprise ou en appuyant sur
Ctrl+Shift+B.

Le Composeur d’Impression vous permet de choisir plusieurs formats de sortie et il est possible de définir la
résolution (qualité d’impression) et le format du papier :

• Le bouton Imprimer vous permet d’imprimer la mise en page sur une imprimante ou dans un fichier
PostScript en fonction des pilotes d’imprimante installés.

• Le bouton Exporter comme image exporte le Composeur dans plusieurs formats d’image tels que PNG, BPM,
TIF, JPG...

• Le bouton Exporter au format SVG sauve le contenu du Composeur en SVG (Scalable Vector Graphic).

• Le bouton Exporter au format PDF enregistre le contenu du composeur directement dans un fichier PDF.

19.3.1 Exporter au format image

Clicking the Export as image icon will ask you to enter the filename to use to export composition: in case of
multi-page composition, each page will be exported to a file with the given name appended with the page number.
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You can then override the print resolution (set in Composition tab) and resize exported image dimensions. By

checking Crop to content option, the images output by composer will include only the area of the composition
with content. There’s also an option for margins to add around the item bounds if required.

Si la composition inclue une seule page, la sortie sera dimensionnée pour inclure l’ensemble de la composition. Si
la composition est à pages multiples, chaque page sera rognée pour inclure uniquement la zone de la page contenu
des objets.

Figure 19.48: Options pour l’export d’images

Si vous devez exporter votre mise en page en tant qu’image géoréférencée (par exemple pour la partager avec

d’autres projets), vous devez activer cette fonctionnalité dans l’onglet Composition. Cochez Générer fichier
World file et choisissez l’objet carte concerné. Avec cette option, ‘Exporter comme image’ créera un world file
qui accompagne l’image.

Note: L’export de gros raster échoue parfois, même s’il semble qu’il y ait assez de ressource mémoire. Il s’agit
d’un problème lié à la gestion des raster par Qt.

19.3.2 Exporter au format SVG

With Export as SVG, you also need to fill the filename (used as a basename for all files in case of multi_page

composition) and then can apply Crop to content option.

Les options d’export SVG vous permettent de :

• Exporter les couches de la carte comme des groupes SVG

• Exporter les étiquettes de la carte en tant que contours

Note: Actuellement le rendu SVG est très basique. Il ne s’agit pas d’un problème lié à QGIS mais à la biblio-
thèque Qt utilisée. Nous pouvons espérer que cela soit corrigé dans les versions futures.

19.3.3 Exporter au format PDF

The Export as PDF exports all the composition into a single PDF file.

If you applied to your composition or any shown layer an advanced effect such as blend modes, transparency
or symbol effects, these cannot be printed as vectors and your effects may be lost. Checking Print as a raster
in Composition tab helps to keep the effects but rasterize the composition. Note that the Force layer to render
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Figure 19.49: Options d’enregistrement SVG

as raster in the Rendering tab of Layer Properties is a layer-level alternative that avoids global composition
rasterization.

19.3.4 Générer un Atlas

Le Composeur d’Impression fournit des outils vous permettant de générer automatiquement un ensemble de cartes.
L’idée est d’utiliser la géométrie et les attributs d’une couche vectorielle. Pour chaque entité de la couche, une
nouvelle carte est générée et son emprise correspond à la géométrie de l’entité. Les attributs de la couche peuvent
être utilisés dans des zones de texte.

Un page est générée par entité de la couche. Pour générer un atlas et le paramétrer, allez sur l’onglet Génération
d’atlas. Cet onglet propose les éléments suivants (voir figure_composer_atlas_1) :

Figure 19.50: Onglet Génération d’atlas

• Générer un atlas, qui permet d’activer ou de désactiver la génération d’atlas.

• La liste déroulante Couche de couverture permet de choisir la couche (vecteur) contenant les entités
à partir desquelles générer chaque planche.

• La case optionnelle Cacher la couche de couverture permet de cacher la couche de couverture sur les
planches en sortie.
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• An optional Page name combo box to give a more explicit name to each feature page(s) when previewing
atlas. You can select an attribute of the coverage layer or set an expression. If this option is empty, QGIS
will use an internal ID, according to the filter and/or the sort order applied to the layer.

• La possibilité de Filtrer avec une expression les entités de la couche de couverture. Si une expression est
rentrée, seules les entités satisfaisant la condition seront utilisées. Le bouton à droite permet d’ouvrir un
constructeur de requête.

• La case optionnelle Trier par vous permet de trier les entités de la couche de couverture. La liste
déroulante associée permet de choisir un champ à utiliser pour le tri. L’ordre de tri (ascendant ou descendant)
est spécifié par le bouton à droite représenté par une flèche ascendante ou descendante.

You also have options to set the output of the atlas:

• Le Nom du fichier en sortie est utilisé pour générer un nom de fichier pour chaque planche. Il est basé sur
une expression. Il n’est utile que lorsque plusieurs fichiers sont produits.

• L’ Export d’un seul fichier (si possible) vous permet de forcer la création d’un unique fichier quand le
format de sortie choisi le permet (par exemple le PDF). Si cette case est cochée, le Nom du fichier en sortie
n’est pas pris en compte.

Vous pouvez utiliser plusieurs objets carte dans la génération d’atlas, chacun sera rendu en fonction de la couche

de couverture. Pour activer la génération d’atlas pour un objet carte, vous devez cocher la case Paramètres
contrôlés par l’Atlas dans les propriétés de l’objet carte. Une fois cochée, vous pouvez définir :

• Un bouton Marge autour des entités vous permet de sélectionner la quantité d’espace ajouté autour
de chaque géométrie dans la carte. Sa valeur n’a de sens que si vous utilisez le mode mise à l’échelle
automatique.

• Echelle prédéfinie (meilleur ajustement). Utilise la meilleure option d’ajustement de la liste des échelles
prédéfinies dans votre projet (voir guilabel:Projet –> Propriétés du projet –> Général –> Echelles du projet
pour configurer ces échelles prédéfinies).

• Une Échelle fixe qui permet de basculer du mode ‘Marge’ au mode ‘Échelle fixe’. En échelle fixe, la
carte est simplement translatée et centrée sur chaque entité. En mode ‘Marge’, l’emprise de la carte est
calculée de telle sorte que l’entité de la couche de couverture apparaisse entièrement.

Zones de texte

In order to adapt labels to the feature the atlas plugin iterates over, you can include expressions. What you should
take care of is to place expression part (including functions, fields or variables) between [% and %]. For example,
for a city layer with fields CITY_NAME and ZIPCODE, you could insert this:

The area of [% upper(CITY_NAME) || ’,’ || ZIPCODE || ’ is ’
format_number($area/1000000,2) %] km2

or, another combination:

The area of [% upper(CITY_NAME)%],[%ZIPCODE%] is
[%format_number($area/1000000,2) %] km2

L’information [% upper(CITY_NAME) || ’,’ || ZIPCODE || ’ is ’
format_number($area/1000000,2) %] est une expression utilisée dans la zone de texte. Cela
sera traduit dans l’atlas généré par :

The area of PARIS,75001 is 1.94 km2

Boutons de Valeurs définies par des données

Il y a plusieurs endroits où vous pouvez utiliser un bouton Valeurs définies par des données pour définir le paramètre
sélectionné. Ces options sont particulièrement utiles avec la Génération d’Atlas.
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Pour les exemples suivants, la couche Regions du jeu de données d’exemple de QGIS est utilisée et sélectionnée
pour la Génération d’Atlas. Nous supposons également que le format de la page A4 (210X297) est sélectionné
dans l’onglet Composition pour le champ Réglages.

Avec un bouton Valeurs définies par des données, vous pouvez définir dynamiquement l’orientation de la page.
Lorsque la hauteur (nord-sud) de l’emprise d’une région est plus grande que sa largeur (est-ouest), vous devriez
plutôt utiliser l’orientation portrait plutôt que paysage pour optimiser l’utilisation de la page.

Dans la Composition, vous pouvez définir le champ Orientation et sélectionner Paysage ou Portrait. Nous voulons
définir l’orientation dynamiquement en utilisant une expression dépendant de la géométrie de la région. Cliquez

sur le bouton du champ Orientation, sélectionnez Éditer afin d’ouvrir la boîte de dialogue Constructeur de
chaîne d’expression. Entrez l’expression suivante :

CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry)
THEN ’Landscape’ ELSE ’Portrait’ END

Maintenant, le papier s’oriente automatiquement. Pour chaque région, vous devez également repositionner

l’élément du composeur. Pour l’élément carte, vous pouvez utiliser le bouton du champ Largeur pour définir
dynamiquement cette dernière en utilisant l’expression suivante :

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry)
THEN 297 ELSE 210 END) - 20

Utilisez le bouton du champ Hauteur pour proposer l’expression suivante :

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry)
THEN 210 ELSE 297 END) - 20

Lorsque vous voulez ajouter un titre au-dessus de la carte au centre de la page, insérez un élément de zone de
texte au-dessus de la carte. Utilisez d’abord les propriétés de l’objet de l’élément zone de texte pour définir un
alignement horizontal à Au centre. Ensuite activez l’option du milieu supérieur à partir du Point de référence.
Vous pouvez proposer l’expression suivante pour le champ X :

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry)
THEN 297 ELSE 210 END) / 2

Pour tous les autres éléments du composeur, vous pouvez définir la position de façon similaire de sorte qu’ils
soient correctement positionnés lorsque la page est automatiquement tournée en portrait ou paysage.

Les informations fournies sont tirées de l’excellent blog (en anglais et portugais) sur les options de Valeurs définies
par des données Multiple_format_map_series_using_QGIS_2.6 .

Ceci est seulement un exemple de comment vous pouvez utiliser les Valeurs de définies par des données.

Preview and generate

Figure 19.51: Atlas Preview toolbar

Once the atlas settings have been configured and composer items (map, table, image...) linked to it, you can create

a preview of all the pages by clicking Atlas → Preview Atlas or Preview Atlas icon. You can then use the arrows
in the same toolbar to navigate through all the features:

• First feature

• Previous feature

• Next feature
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• Last feature

You can also use the combo box to directly select and preview a specific feature. The combo box shows atlas
features name according to the expression set in the atlas Page name option.

As for simple compositions, an atlas can be generated in different ways (see Exporter des cartes for more infor-
mation). Instead of Composer menu, rather use tools from Atlas menu or Atlas toolbar.

This means that you can directly print your compositions with Atlas → Print Atlas. You can also create a PDF
using Atlas → Export Atlas as PDF...: The user will be asked for a directory to save all the generated PDF files,

except if the Single file export when possible has been selected. In that case, you’ll be prompted to give a
filename.

With Atlas → Export Atlas as Images... or Atlas → Export Atlas as SVG... tool, you’re also prompted to select a
folder. Each page of each atlas feature composition is exported to an image or SVG file.

Astuce: Print a specific atlas feature
If you want to print or export the composition of only one feature of the atlas, simply start the preview, select the
desired feature in the drop-down list and click on Composer → Print (or export... to any supported file format).
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CHAPTER 20

Extensions

20.1 Les Extensions de QGIS

QGIS repose sur un système d’extensions. Cela permet d’ajouter facilement de nouvelles fonctions au logiciel.
De nombreuses fonctions de QGIS sont implémentées comme des extensions.

20.1.1 Extensions principales et complémentaires

Les extensions QGIS sont soit des Extensions principales soit des Extensions externes.

Les extensions principales sont maintenues par l’équipe de développement de QGIS et font automatiquement
partie de chaque distribution de QGIS. Elles sont écrites soit en C++ soit en Python.

Actuellement, la plupart des extensions externes sont écrites en Python. Elles sont stockées soit dans le Dépôt
QGIS “officiel” ici : http://plugins.qgis.org/plugins/ soit dans des dépôts externes maintenus par les auteurs. Des
informations détaillées sur l’utilisation, la version minimale de QGIS, la page principale, les auteurs et d’autres
informations importantes sont disponibles pour les extensions du dépôt officiel. Pour les dépôts externes, la
documentation peut être disponible via les extensions elles-mêmes. De manière général, elles ne sont pas incluses
dans ce manuel d’utilisation.

Les extensions python externes installées sont placées dans le répertoire ~/.qgis2/python/plugins.
Le répertoire utilisateur sous Windows (correspondant à ~) est généralement ici : C:\Documents and
Settings\(utilisateur) (sur Windows XP ou précédent) ou là : C:\Users\(utilisateur).

Des chemins pointant sur les extensions C++ supplémentaires peuvent être ajoutés dans le menu Préférences →
Options → Système.

Vous pouvez gérer vos extensions dans la fenêtre qui s’ouvre via le menu Extension > Installer/Gérer les exten-
sions.

Lorsqu’une extension a besoin d’être mise à jour, et si les paramètres des extensions ont été configurés de la sorte,
l’interface principale de QGIS affichera un lien bleu dans la barre d’état signalant que des extensions peuvent être
mises à jour.

20.1.2 La fenêtre des Extensions

Les onglets de la fenêtre des Extensions permettent à l’utilisateur d’installer, désinstaller et de mettre à jour les
extensions de différentes façons. Pour chaque extension, quelques métadonnées s’affichent sur la droite :

• l’information si l’extension est expérimentale

• la description

• les votes (vous pouvez voter pour votre extension préférée !)

• les mots-clé
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• quelques liens utiles tels que la page de l’extension, du suivi de bug et le dépot du code

• le ou les auteurs

• la version disponible

Vous pouvez utilisez un filtre pour trouver une extension spécifique.

Toutes

Ici sont listées toutes les extensions disponibles, principales et complémentaires. Cliquez sur [Tout mettre à jour]
pour chercher les nouvelles versions de chaque extension. Utilisez [Installer l’extension], si une extension est
listée mais pas installée et [Désinstaller] ou [Ré-installer l’extension] si elle est déjà installée. Une extension
installée peut être désactivée temporairement en dé-cochant sa case.

Figure 20.1: Le menu Toutes

Installées

Dans cet onglet, vous trouverez uniquement les extensions installées. Les extensions complémentaires peuvent
être désinstallées ou ré-installées en utilisant les boutons [Désinstaller] et [Ré-installer l’extension]. Vous pouvez
également [Tout mettre à jour] ici.

Non installées

Cet onglet liste toutes les extensions disponibles mais non installées. Vous pouvez utiliser le bouton [Installer
l’extension] pour ajouter une extension à QGIS.

Mises à jour disponibles

Si vous cochez Afficher les extensions expérimentales dans l’onglet Paramètres, vous pouvez utiliser cet
onglet pour chercher des mises à jour à ces extensions. Cela ce fait en cliquant sur les boutons [Mettre à jour

l’extension] ou**[Tout mettre à jour]**. Paramètres

Dans cet onglet, vous pouvez :

• Chercher des mises à jour au démarrage. Lorsqu’une nouvelle extension ou une mise à jour est
disponible, QGIS vous en informera ‘à chaque démarrage de QGIS’, ‘une fois par jour’, ‘tous les trois
jours’, ‘toutes les semaines’, ‘toutes les deux semaines’ ou ‘tous les mois’.
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Figure 20.2: L’onglet Installées

Figure 20.3: L’onglet Non installées
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Figure 20.4: L’onglet Mises à jour disponibles

• Afficher les extensions expérimentales. QGIS vous proposera les extensions encore en développement
qui ne sont généralement pas conseillées pour un usage en production.

• Afficher également les extensions obsolètes. Ces extensions sont dépréciées et déconseillées pour un
usage en production.

Pour ajouter des dépôts de contributeurs, cliquez sur [Ajouter...] dans la zone Dépôts d’extensions. Si vous ne
voulez pas un ou plusieurs dépôts ajoutés, ils peuvent être désactivés via le bouton [Éditer...], ou complètement
supprimés avec le bouton [Supprimer].

Notez que vous pouvez utiliser un système d’authentification (basique, PKI) pour accéder à un dépôt d’extensions.
Le dépôt QGIS par défaut est un dépôt ouvert et vous n’avez pas besoin d’authentification. Si vous déployez votre
propre dépôt d’extensions, vous trouverez plus d’informations sur la gestion de l’authentification dans QGIS dans
le chapitre Authentification.

La fonction Rechercher est disponible depuis tous les onglets (sauf celui des Paramètres). Vous pouvez y
effectuer des recherches d’extensions.
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Figure 20.5: Le menu Paramètres

20.1. Les Extensions de QGIS 357



QGIS User Guide, Version 2.14

20.2 Utiliser les extensions principales de QGIS

Bou-
ton

Extension Description Référence dans le
manuel

Saisie de coordonnées Saisie les coordonnées de la souris dans
des systèmes de coordonnées différents

Extension de Saisie de
Coordonnées

DB Manager Gérer des bases de données depuis QGIS Extension DB Manager

Convertisseur DXF vers
Shapefile

Convertit depuis un fichier DXF vers un
fichier SHP

Extension Convertisseur
Dxf2Shp

eVis Outil de visualisation d’évènements Extension eVis

fTools Ensemble d’outils vectoriels Extension fTools

Outils GDALTools Fonctionnalités GDAL sur des couches
raster

Extension GDALTools

Vérificateur de géométrie Vérifier et réparer les erreurs de
géométrie dans les couches vecteurs

Extension Vérificateur de
géométrie

Accrochage de géométrie Accrocher des géométries à une couche
de référence

Extension Accrochage de
géométrie

Géoréférenceur GDAL Géoréférenceur de couches raster à l’aide
de GDAL

Extension de
géoréférencement

Outils GPS Outils pour charger et importer des
données GPS

Extension GPS

GRASS Fonctionnalités GRASS Intégration du SIG GRASS

Carte de chaleur Crée des cartes raster de chaleur à partir
de couches vectorielles de points

Extension Carte de chaleur

Extension d’interpolation Interpolation sur la base des vertex d’une
couche vectorielle

Extension Interpolation

Client MetaSearch pour
les services de catalogage

Interagir avec des service de catalogage
de métadonnées (CSW)

Client MetaSearch pour
les Services de Catalogage

Edition hors-ligne Edition hors-ligne avec synchronisation
de la base de données

Extension d’Édition
hors-ligne

Géoraster Oracle Spatial Accède aux Géorasters d’Oracle Spatial Extension GeoRaster
Oracle Spatial

Gestionnaire d’Extension Gestion des extensions principales et
complémentaires

La fenêtre des Extensions

Traitement Outils de traitement de données spatiales Outils de traitement QGIS

Analyse des modèles de
terrain

Calcule les caractéristiques
géomorphologiques depuis des MNT

Extension d’Analyse
Raster de Terrain

Extension Graphe Routier Recherche du plus court chemin Extension Graphe routier

Requête spatiale Réalise des requêtes spatiales sur des
couches vectorielles

Extension Requête Spatiale

Vérificateur de topologie Chercher des erreurs de topologie dans les
couches vectorielles

Extension Vérificateur de
topologie

Statistiques de zones Statistiques des pixels contenus dans des
polygones

Extension Statistiques de
zone
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20.3 Extension de Saisie de Coordonnées

L’extension Saisie de Coordonnées est simple d’utilisation et offre la possibilité d’afficher des coordonnées sur la
carte en sélectionnant deux systèmes de coordonnées de référence (SCR) différents.

Figure 20.6: Extension de Saisie de Coordonnées

1. Démarrez QGIS, sélectionnez Propriétés du Projet dans le menu Préférences (KDE, Windows) ou
Fichier (Gnome, OSX) et appuyez sur l’onglet Système de coordonnées de référence (SCR). Vous pou-

vez également appuyer sur le bouton Statut de la projection située dans l’angle inférieur droit de la barre de
statut.

2. Cochez l’option Autoriser la projection ‘à la volée’ et sélectionnez le système de coordonnées de votre
choix (voir également la Section Utiliser les projections).

3. Activez l’extension Saisie de Coordonnées depuis le Gestionnaire d’Extension (voir la Section La fenêtre
des Extensions) puis assurez-vous que l’extension est activée en allant dans Vue > Panneaux pour vérifier

que la fonction Saisie de Coordonnées est cochée. La fenêtre Saisie de Coordonnées apparaît alors
comme indiqué dans la Figure figure_coordinate_capture_1. Vous pouvez également aller dans Vecteur →
Saisie de Coordonnées et vérifier que Saisie de Coordonnées est activé.

4. Appuyez sur le bouton Cliquez pour sélectionner le SCR à utiliser pour l’affichage des coordonnées et sélectionnez un SCR
différent de celui que vous avez choisi plus haut.

5. Pour lancer la capture de coordonnées, appuyez sur [Débuter la capture]. Vous pouvez maintenant cliquer
n’importe où sur la carte et l’extension affichera les coordonnées dans chacun des deux SCR sélectionnés.

6. Pour activer le suivi des coordonnées par le curseur, appuyez sur le bouton Suivi du curseur.

7. Vous pouvez également copier les coordonnées dans le presse-papier.

20.4 Extension DB Manager

L’extension DB Manager fait officiellement partie des extensions principales de QGIS et constitue l’outil principal
permettant d’intégrer et de gérer tous les formats de bases de données reconnus par QGIS (PostGIS, SpatiaLite,

Geopackage, Oracle Spatial, Virtual layers) en une seule et même interface utilisateur. Le bouton DB Manager

propose plusieurs fonctionnalités. Vous pouvez simplement glisser des couches depuis l’explorateur QGIS vers
DB Manager pour les importer dans votre base de données. Vous pouvez également transférer des tables entre
bases de données par un simple glisser-déposer.

Le menu Base de données vous permet de se connecter à une base de données existante, d’ouvrir une fenêtre de
requête SQL et de sortir de l’extension DB manager. Une fois connecté à une base existante, les menus Schéma et
Table apparaissent.

Le menu Schéma inclut des outils pour créer et pour effacer des schémas (vides) et, si la topologie est activée (par
exemple dans PostGIS 2), de lancer le TopoViewer.

Le menu Table vous permet de créer et d’éditer des tables et de supprimer des tables et des vues. Il permet aussi
de vider des tables et de les déplacer d’un schéma à un autre. Vous pouvez également effectuer un VACUUM puis
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Figure 20.7: Fenêtre DB Manager

un ANALYZE sur chacune des tables sélectionnées. Un VACUUM complet requiert juste de l’espace disque mais
facilite la réutilisation de la table et un ANALYZE met à jour les statistiques ce qui permet ensuite de déterminer la
manière la plus efficace pour effectuer une requête. Enfin, vous pouvez importer des couches ou des fichiers, s’ils
sont chargés dans QGIS ou s’ils existent sur l’ordinateur. Vous pouvez exporter les tables d’une base de données
en shapefile avec l’outil Exporter vers un fichier.

La zone Arborescence affiche l’ensemble des bases de données existantes supportées par QGIS. A l’aide d’un
double-clic, vous pouvez vous connecter à une base. Un clic droit permet de renommer ou de supprimer un
schéma ou une table existante. Les tables peuvent être ajoutées au canevas de QGIS à l’aide du menu contextuel.

Si une connexion à une base de données est active, la fenêtre principale de DB Manager présente trois onglets.
L’onglet Info affiche les informations concernant la table et sa géométrie ainsi que mes champs, contraintes et
index existants. Il est également possible d’exécuter un Vacuum Analyse et de créer un index spatial sur une table,
s’il n’existe pas. L’onglet Table affiche les attributs et l’onglet Aperçu génère un aperçu des géométries.

20.4.1 Utilisation de la fenêtre SQL

Vous pouvez utiliser DB Manager pour exécuter une requête SQL sur une base de données et visualiser le résultat
sous forme de couche dans QGIS. Il est maintenant possible de sélectionner une partie de la requête SQL et
d’exécuter uniquement cette partie en appuyant sur F5 ou cliquant sur le bouton Executer (F5).

20.5 Extension Convertisseur Dxf2Shp

L’extension Convertisseur Dxf2Shape permet de convertir des données vectorielles du format DXF au format
shapefile. Avant d’être exécutée, elle requiert les réglages suivants:

• Fichier DXF en entrée : Entrer la localisation du fichier DXF à convertir.

• Fichier SHP en sortie : Entrer le nom souhaité du fichier shapefile à créer.
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Figure 20.8: Exécution de requêtes dans la fenêtre SQL de DB Manager

Figure 20.9: Extension Convertisseur Dxf2Shape
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• Type de fichier de sortie : Spécifier le type géométrique du shapefile créé. Les formats implémentés pour
le moment sont point, polyligne et polygone.

• Exporter les étiquettes : Si cette case est cochée, une couche supplémentaire shapefile de type point sera
créée et la table dbf associée contiendra des informations à propos des champs “TEXT” trouvés dans le
fichier DXF ainsi que les chaînes de caractères elles-mêmes.

20.5.1 Mettre en œuvre l’extension

1. Démarrez QGIS, chargez l’extension Dxf2Shape dans le gestionnaire d’extensions (voir La fenêtre des

Extensions) puis appuyez sur le bouton Convertisseur Dxf2Shape qui apparaît dans la barre d’outils QGIS.
La boîte de dialogue de l’extension Dxf2Shape apparaît alors, comme montrée dans la Figure Fig-
ure_dxf2shape_1.

2. Entrez la localisation du fichier DXF ainsi qu’un nom et un type pour le shapefile à créer.

3. Cochez la case Exporter les étiquettes si vous souhaitez créer une couche point supplémentaire contenant
les étiquettes.

4. Appuyez sur [Ok].

20.6 Extension eVis

(Cette section est issue de l’ouvrage Horning, N., K. Koy, P. Ersts. 2009. eVis (v1.1.0) User’s
Guide. American Museum of Natural History, Center for Biodiversity and Conservation. Disponible sur
http://biodiversityinformatics.amnh.org/ et sortie sous licence GNU FDL.)

Le laboratoire Biodiversity Informatics du Centre pour la Conservation et la Biodiversité (CBC) du Musée améri-
cain d’Histoire Naturelle (AMNH) a développé l’outil de visualisation des évènements (eVis) qui fait partit d’une
suite logicielle destinée à la gestion et la surveillance des zones naturelles protégées. Cette extension permet à
un utilisateur de lier facilement des photographies géocodées (c-à-d avec des coordonnées lat/long ou X/Y ren-
seignées) et d’autres types de documents à des données vectorielles dans QGIS.

eVis est dorénavant installée automatiquement dans les nouvelles versions de QGIS, et comme toutes autres ex-
tensions, elle peut être activée ou désactivée dans le Gestionnaire d’extensions (voir La fenêtre des Extensions).

L’extension consiste en 3 modules : l’outil de ‘Connexion à une base de données’, l’outil ‘ID d’évènements’ et le
‘Navigateur d’évènement’. Ils fonctionnent ensemble pour permettre l’affichage de documents géoéréfrencés qui
sont liés à des entités enregistrées dans des fichiers vectoriels, des bases de données ou des feuilles de tableur.

20.6.1 Navigateur d’évènement

Le navigateur d’évènement fournit la capacité d’afficher des photographies ayant un lien avec les entités vecteurs
affichées dans la fenêtre principale de QGIS. Ces entités doivent avoir des informations attributaires associées
décrivant l’emplacement et le nom du fichier contenant la photographie et, optionnellement, la direction vers
laquelle était pointé l’objectif lors de la prise de vue. Votre couche vectorielle doit être chargée dans QGIS avant
le lancement du navigateur d’évènements.

Afficher le navigateur d’évènement

Pour lancer le Navigateur d’évènement , cliquez sur le menu Base de données > eVis > Navigateur d’évènements
eVis. Ceci ouvrira la fenêtre du Navigateur d’évènements.

La fenêtre de navigateur affiche 3 onglets dans sa partie supérieure. L’onglet Affichage est utilisé pour voir la
photographie et les données attributaires correspondantes. L’onglet des options fournit une série de paramètres
qui peuvent être ajustés pour contrôler le comportement de l’extension eVis. Enfin, l’onglet de configurer les
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applications externes contient une table des extensions de fichiers et des applications qui leur sont associées pour
permettre à eVis d’afficher des documents autre qu’une image.

La fenêtre Affichage

Pour voir la fenêtre Affichage, cliquez sur l’onglet Affichage du navigateur d’évènement. Cette fenêtre est utilisée
pour visualiser les photographies et leurs données attributaires.

Figure 20.10: La fenêtre Affichage d’eVIS

1. Zone d’affichage : emplacement où s’affichera l’image.

2. Bouton Zoom + : Zoomez pour voir plus de détails. Si l’image ne peut être affichée entièrement dans la
fenêtre, des barres de défilement apparaîtront sur les bords gauches et inférieures pour que vous puissiez
bouger l’image.

3. Bouton Zoom - : Zoomez en arrière pour avoir une vue d’ensemble.

4. Bouton Zoomer sur l’emprise : Affiche l’emprise maximale de la photographie.

5. Zone d’informations : Toutes les informations attributaires pour le point associé à la photographie sélec-
tionnée sont affichées ici. Si le type de fichier référencé n’est pas une image, mais d’un type renseigné dans
l’onglet configurer les applications externes (il sera alors affiché en vert), un double clic lancera l’application
désignée.

6. Boutons de navigation : Utilisez les boutons [Suivant] et [Précédent] pour charger une autre entité lorsque
plusieurs sont sélectionnées.
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Figure 20.11: La fenêtre Options d’eVis
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La fenêtre Options

1. Chemin du fichier : Une liste déroulante permet de spécifier quel est l’attribut contenant le chemin d’accès
vers le document devant être affiché. Si l’emplacement est un chemin relatif alors la case située juste en
dessous doit être cochée. Le chemin de base peut être saisi dans la zone de texte. Les informations à propos
des différentes options pour indiquer le chemin sont expliquées dans la section Spécifier un emplacement et
le nom d’une photographie, ci-dessous.

2. Orientation de la boussole : Une liste déroulante pour définir le champ d’attribut qui contient l’orientation
de la boussole associé à la photo affichée. Si des informations d’orientation de la boussole est disponible, il
est nécessaire de cocher la case dessous le titre de menu déroulant.

3. Décalage de la boussole : les décalages de la boussole peuvent être utilisés afin de compenser la déclinaison
(afin d’ajuster l’orientation collectée par orientation magnétique vers le vrai nord). Cliquez le bouton radio

Manuel pour entrer le décalage dans le champ texte ou cliquez le bouton radio À partir d’un
attribut afin de sélectionner le champ contenant les décalages. Pour ces deux options, les déclinations est
doivent entrées en utilisant des valeurs positives et les déclinaisons ouest des valeurs négatives.

4. Chemin de base : C’est le chemin à partir duquel le chemin relatif (A) définit dans la figure Figure_eVis_2
sera établi.

5. Remplacer le chemin : Si cette case est cochée alors seul le nom du fichier sera ajouté au chemin de base.

6. Appliquer la règle à tous les documents : Si cochée, la règle définie pour les photographies sera utilisée
pour les autres documents tels que les fichiers textes, les vidéos et les fichiers audio. Dans le cas contraire,
les règles s’appliqueront seulement aux photographies.

7. Se souvenir de : Si cette case est cochée, les valeurs des paramètres correspondants seront enregistrées pour
la prochaine session au moment de la fermeture de la fenêtre ou quand le bouton [Enregistrer] est cliqué.

8. Réinitialiser : Remet les valeurs par défaut pour ce paramètre.

9. Restaurer les valeurs par défaut : Réinitialise tous les paramètres à leur valeur par défaut. Il équivaut à
cliquer sur tous les boutons [Réinitialiser].

10. Enregistrer : Ceci enregistrera les valeurs sans fermer l’onglet des options.

La fenêtre Configurer les applications externes

Figure 20.12: La fenêtre Configuration des applications externes d’eVis

1. Tableau des références : Une table contient tous les types de fichiers qui peuvent être ouverts par eVis.
Chaque type de fichier doit avoir une extension qui lui est propre et un chemin vers une application pour
l’ouvrir. Ce la permet d’utiliser un large éventail de documents autre que des images.

2. Ajouter un nouveau type de fichier : Ajoute un nouveau type de fichier avec son extension et une appli-
cation dédiée.

3. Effacer la cellule courante : Effacer le type de fichier sélectionné dans la table.
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20.6.2 Spécifier un emplacement et le nom d’une photographie

Le nom et l’emplacement d’une photographie peuvent être enregistrés avec un chemin absolu ou relatif ou une
URL si l’image se trouve sur un serveur Internet. Des exemples de ces différentes approches sont listés dans la
table evis_examples.

X Y FILE BEARING
780596 1784017 C:\Workshop\eVis_Data\groundphotos\DSC_0168.JPG 275
780596 1784017 /groundphotos/DSC_0169.JPG 80
780819 1784015 http://biodiversityinformatics.amnh.org/\

evis_testdata/DSC_0170.JPG 10
780596 1784017 pdf:http://www.testsite.com/attachments.php?\

attachment_id-12 76

20.6.3 Spécifier l’emplacement et le nom d’un document autre qu’une image

Les documents texte, vidéos ou audio peuvent aussi être affichés par eVis. Pour ce faire, il est nécessaire d’ajouter
une entrée dans la table des références fichiers qui pourra être utilisé par l’une des applications externes définies.
Il est aussi nécessaire d’avoir le chemin vers le fichier dans la table attributaire de la couche vectorielle. Une pos-
sibilité supplémentaire est de spécifier l’extension du fichier avant le chemin (par exemple avi:/chemin/du/fichier),
ce qui est très utile pour accéder à des documents placés sur des sites ou des wikis utilisant une base de données
pour la gestion de leurs pages (voir la table evis_examples).

20.6.4 Utiliser le Navigateur d’évènements

Quand la fenêtre du Navigateur d’évènements s’ouvre, une photographie apparaîtra dans l’onglet d’affichage
si le document référencé dans la table attributaire du fichier vectoriel est une image et que les paramètres
d’emplacement sont correctement renseignés. Si la photographie voulue n’apparaît pas, c’est qu’il vous est néces-
saire d’ajuster les paramètres de l’onglet des options.

Si un format de document géré (ou une image n’ayant pas d’extension reconnue par eVis) est référencé dans la
table attributaire, le champ contenant le chemin vers le fichier sera surligné en vert dans la liste des références
fichiers si cette extension a été définie dans la table de configuration des applications externes. Pour l’ouvrir,
faites un double-clic sur la ligne en vert. Si un document est référencé, mais non surligné en vert, il est nécessaire
d’ajouter une entrée pour son extension. Si le chemin est bien surligné en vert, mais qu’un double-clic reste sans
effet, il faudra alors vérifier que l’application associée à l’extension est bien renseignée dans l’onglet Options.

Si aucune indication de boussole n’est fournie dans les options, un astérisque rouge sera affiché au-dessus de
l’entité vectorielle concernée par l’image affichée. Si cette indication est disponible alors une flèche pointant la
direction de l’objectif apparaîtra. La flèche sera centrée sur le point associé à la photographie ou au document.

Pour fermer le Navigateur, cliquez sur le bouton [Fermer] de l’onglet d’Affichage.

20.6.5 Outil ID évènement

L’outil ‘Id évènement’ permet d’afficher une photographie en cliquant sur l’entité affichée dans la fenêtre de QGIS.
La couche vectorielle doit avoir des attributs associés indiquant l’emplacement, le nom du fichier et l’indication
de compas si nécessaire. Cette couche doit être chargée avant d’utiliser cet outil.

Lancement du module ID évènement

Pour lancer l’ ‘outil eVis Id Evenement’, cliquez soit sur outil eVis Id Evenement soit sur Base de données → eVis
→ Outil eVis Id Evenement. Votre curseur se transformera en une flèche avec un ‘i’ au-dessus signifiant par là que
l’outil d’identification est actif.

Pour visionner les photographies liées aux entités de la couche vectorielle active, déplacez le curseur sur l’une
d’elles et faites un clic. La fenêtre du Navigateur d’évènement s’ouvre alors en affichant la photographie du
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point ou proche. Si plus d’une est disponible, vous pouvez faire défiler les différentes entités avec les boutons
[Précédent] et [Suivant]. Les autres boutons sont décrits dans la section Navigateur d’évènement de ce manuel.

20.6.6 Connexion à une base de données

Cet outil permet de se connecter et d’interroger une base de données ou une ressource ODBC telle qu’un tableur.

eVis peut se connecter directement à ces types de bases de données : PostgreSQL, MySQL et SQLite et peut
utiliser des connexions ODBC (par exemple Access). Pour des connexions ODBC (par exemple un fichier Excel),
il est nécessaire de configurer votre driver ODBC en fonction de votre système d’exploitation.

L’outil de connexion à une base de données

Pour lancer le module de ‘Connexion à la base de données’,cliquez soit sur l’icône correspondant
Connexion eVis à une base de données soit sur Base de données → eVis → Connexion eVis à une base de données. Cette
action ouvre la fenêtre Connexion à une base de données. Trois onglets sont disponibles : Requêtes prédéfinies,
Connexion à une base de données, et Requête SQL. La fenêtre Console de sortie en bas de la fenêtre affiche le
statut des actions initiées dans chacun des onglets de ce module.

Se connecter à une base

Cliquez sur l’onglet Connexion à une base puis sur le menu déroulant Type de la base de données pour sélectionner

le type de base à laquelle vous voulez vous connecter. Vous pouvez saisir un nom d’utilisateur et un mot de
passe si nécessaire.

Entrez le nom de l’hôte de la base de données dans la zone de texte Hôte de la base de données. Cette option n’est
pas disponible si vous avez sélectionné ‘MS Access’ comme type de base de données. Si la base de données est
localisée sur votre ordinateur, vous pouvez entrer “localhost”.

Renseignez le nom de la base de données dans la zone de texte Nom de la base de données. Si vous avez sélectionné
‘ODBC’ comme type de base de données, il vous faudra entrer le nom de la source de données.

Quand tous les paramètres sont corrects, cliquez sur le bouton [Connecter]. Si la connexion est réussie, un
message sera affiché dans la console de sortie. En cas d’échec, il vous faudra vérifier les paramètres.

1. Type de base de données : Une liste déroulante pour spécifier le type de base de données qui sera utilisée.

2. Hôte de la base de données : le nom de l’hôte de la base.

3. Port : Le numéro du port dans le cas d’une base de données MySQL ou PostGreSQL.

4. Nom de la base de données : Le nom de la base de données.

5. Connecter : Ce bouton établit la connexion avec les paramètres définis ci-dessus.

6. Console de sortie : Console où sont affichés les messages relatifs au déroulement des processus.

7. Nom d’utilisateur : Nécessaire quand la base est protégée en accès.

8. Mot de passe : Nécessaire quand la base est protégée en accès.

9. Requêtes Prédéfinies : Onglet ouvrant la fenêtre de Requêtes Prédéfinies.

10. Connexion à une base de données : Onglet ouvrant la fenêtre de Connexion à une base de données.

11. Requête SQL : Onglet ouvrant la fenêtre de Requête SQL.

12. Aide : Affiche l’aide en ligne.

13. OK : Ferme la fenêtre principale.
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Figure 20.13: La fenêtre Connexion à une base de données d’ eVIS

Faire une requête SQL

Les requêtes SQL sont utilisées pour extraire des informations depuis une base de données ou une source ODBC.
Dans eVis, le résultat de ces requêtes est une couche vectorielle ajoutée à QGIS. cliquez sur l’onglet Requête
SQL pour afficher l’interface. Les commandes SQL peuvent être saisies depuis cette fenêtre de texte. Un tutoriel
bien pratique sur les commandes SQL est disponible à http://www.w3schools.com/sql. Par exemple, pour extraire
toutes les données d’un fichier Excel, faites select * from [sheet1$] où sheet1 est le nom de la feuille
concernée.

Cliquez sur le bouton [Exécuter la requête] pour exécuter la commande. Si la requête est fructueuse, une fenêtre
de sélection sera affichée. Dans le cas contraire, un message d’erreur apparaîtra dans la console de sortie.

Dans cette nouvelle fenêtre, entrez le nom de la couche qui sera créée à partir des résultats dans la zone de texte
Nom de la Nouvelle Couche.

1. Zone de texte de requête SQL : Une zone poursaisir vos requêtes.

2. Exécuter la requête : Ce bouton exécute la requête écrite.

3. Console : Console où sont affichés les messages relatifs au déroulement de la connexion.

4. Aide : Affiche l’aide en ligne.

5. OK : Ferme la fenêtre Connexion à une base de données.

Utilisez les menus déroulants Coordonnée X et Coordonnée Y pour choisir les champs stockant les
coordonnées en X (ou longitude) et Y (ou latitude). Cliquez sur [Ok] pour créer la couche vectorielle qui sera
affichée sur la carte de QGIS.

Pour enregistrer ce fichier pour une utilisation ultérieure, vous pouvez utiliser la fonction de QGIS ‘Sauvegarder
sous’ accessible via un clic droit sur la couche listée dans la zone de légende

Astuce: Créer une couche vectorielle depuis un fichier Microsoft Excel
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Figure 20.14: L’onglet Requête SQL d’eVis

Lorsque vous créer une couche vectorielle depuis un fichier Excel, vous risquez peut être de voir des zéros (“0”)
insérés dans les lignes de la table attributaire à la suite de données valides. Cela peut être résolu par l’utilisation de
la touche Retour arrière dans une cellule. Pour cela, vous devez ouvrir le fichier (après avoir fermé QGIS
si vous y êtes connecté) et utiliser le menu Édition > Effacer le contenu pour supprimer les lignes vides.

Exécuter des requête prédéfinies

Avec les requêtes prédéfinies, vous pouvez sélectionner des requêtes déjà écrites et stockées au format XML. Cela
peut être utile si vous n’êtes pas familier avec les commandes SQL. Cliquez sur l’onglet Requêtes prédéfinies pour
afficher l’interface.

Pour charger un jeu de requêtes prédéfinies, cliquez sur le bouton Ouvrir. Une fenêtre s’ouvre pour sélectionner
le fichier. Lorsque les requêtes sont chargées, leurs titres définis au format XML apparaîtront dans le menu
déroulant situé en dessous du bouton Ouvrir. La description complète de la requête est affichée dans la zone en
dessous de la liste.

Sélectionnez la requête que vous voulez exécuter depuis la liste déroulante et ensuite cliquez sur l’onglet de
requête SQL pour observer la requête qui vient d’être chargée. Si c’est la première fois que vous exécutez une
requête prédéfinie ou que vous changez de base de travail, vous devrez vous connecter à la base de données.

Cliquez sur le bouton [Exécuter la requête] dans l’onglet Requête SQL pour lancer la commande. Si la requête
est fructueuse, une fenêtre de sélection sera affichée. Dans le cas contraire, un message d’erreur apparaîtra dans la
console de sortie.

1. Ouvrir le fichier: lance l’explorateur de fichier “ouvrir le fichier” afin de charger le fichier XML contenant
les requêtes prédéfinies.

2. Requêtes prédéfinies : Une liste déroulante affichant toutes les requêtes prédéfinies dans le fichier XML.

3. Description de la requête : Une courte description de la requête.
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Figure 20.15: L’onglet Requêtes prédéfinies d’eVis

4. Console : Console où sont affichés les messages relatifs au déroulement de la connexion.

5. Aide : Affiche l’aide en ligne.

6. OK : Ferme la fenêtre principale.

Le format XML pour les requêtes d’eVis

Les balises XML reconnues par eVis
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Balise Description
query Définit le début et la fin d’une requête.
shortde-
scription

Une courte description qui apparaît dans le menu déroulant.

descrip-
tion

Une description plus détaillée.

database-
type

Le type de base de données, défini dans la liste déroulante de l’onglet de connexion.

database-
port

Le port tel que défini dans la liste déroulante de l’onglet de connexion.

database-
name

Le nom de la base de données tel que défini dans la liste déroulante de l’onglet de connexion.

databaseuser-
name

Le nom d’utilisateur tel que défini dans la liste déroulante de l’onglet de connexion.

databasep-
assword

Le mot de passe tel que défini dans la liste déroulante de l’onglet de connexion.

sqlstate-
ment

La commande SQL.

autocon-
nect

Un interrupteur (“vrai” or “faux”) pour spécifier si les balises précédentes doivent être utilisées
pour se connecter automatiquement à une base de données sans passer par les routines de
connexion de l’onglet.

Voici un exemple complet avec 3 requêtes:

<?xml version="1.0"?>
<doc>
<query>
<shortdescription>Import all photograph points</shortdescription>
<description>This command will import all of the data in the SQLite database to QGIS

</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\textbackslash Workshop/textbackslash

eVis\_Data\textbackslash PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID</sqlstatement>
<autoconnect>false</autoconnect>

</query>
<query>
<shortdescription>Import photograph points "looking across Valley"</shortdescription>
<description>This command will import only points that have photographs "looking across

a valley" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS=’Looking across
valley’</sqlstatement>

<autoconnect>false</autoconnect>
</query>
<query>

<shortdescription>Import photograph points that mention "limestone"</shortdescription>
<description>This command will import only points that have photographs that mention

"limestone" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
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<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS like ’%limestone%’
</sqlstatement>

<autoconnect>false</autoconnect>
</query>

</doc>

20.7 Extension fTools

Le but de l’extension Python fTools est de fournir un outil unique pour un certain nombre de traitements SIG
vectoriels, sans avoir recours à des logiciels, des bibliothèques ou des constructions complexes supplémentaires.
Elle fournit un ensemble grandissant de fonctions de gestion et d’analyse des données spatiales qui sont à la fois
rapides et fonctionnelles.

fTools est maintenant installé automatiquement et est disponible dans les dernières versions de QGIS et, comme
toutes les extensions, peut être activée et désactivée via le Gestionnaire d’extensions (voir La fenêtre des Exten-
sions). Lorsqu’elle est activée, l’extension fTools ajoute une entrée au menu Vecteur de QGIS, et propose des
outils d’Analyse et de Recherche, de Géométrie et de Géotraitement ainsi que de Gestion des données.

20.7.1 Outils d’analyse

Bou-
ton

Outil Fonction

Matrice des
distances

Mesure les distances entre deux couches de points et renvoie les résultats sous la
forme de a) Matrice de distance standard, b) Matrice des distances en ligne, ou c)
Résumé des distances (moyenne, min, max, écart type). Il est possible de limiter les
distances aux k entités les plus proches.

Total des
longueurs de
lignes

Calcule la somme totale des longueurs de lignes présentes dans chaque entité d’une
couche de polygones.

Points dans un
polygone

Compte le nombre de points inclus dans chaque entité d’une couche de polygones.

Liste les
valeurs
uniques

Liste toutes les valeurs uniques d’un champ d’une couche vecteur.

Statistiques
basiques

Calcule des statistiques de base (moyenne, écart type, max, min, nombre, somme,
CV) sur un champ donné.

Analyse du
plus proche
voisin

Calcule des statistiques sur le plus proche voisin pour évaluer le niveau de
clustering dans une couche vecteur de points.

Coordonnée(s)
moyenne(s)

Calcule le centre moyen normal ou pondéré soit d’une couche vecteur entière, soit
des entités partageant un même identifiant.

Intersections
de lignes

Localise les intersections entre lignes et renvoie les résultats sous la forme d’un
shapefile de points. Utile pour localiser les croisements de route ou de rivières.
Ignore les intersections de ligne d’une longueur supérieure à zéro.

Table fTools 1 : Outils d’analyse fTools
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20.7.2 Outils de recherche

Bou-
ton

Outil Fonction

Sélection aléatoire Sélectionne aléatoirement un nombre ou un pourcentage n d’entités.

Sélectionne aléatoirement
des entités au sein de
sous-ensemble

Sélectionne aléatoirement des entités au sein d’un sous-ensemble défini
par un champ identifiant.

Points aléatoires Génère des points pseudo-aléatoires sur une couche de données.

Points réguliers Génère une grille régulière de points sur une zone spécifiée et les
exporte dans un shapefile de points.

Grille vecteur Génère une grille formée par des lignes ou des polygones à partir d’un
espacement défini par l’utilisateur.

Sélection par localisation Sélectionne des entités en fonction de leur localisation par rapport à
une autre couche puis crée une nouvelle sélection, ajoute ou retire de la
sélection courante.

Créer un polygone à partir
de l’étendue de la couche

Crée une couche polygone contenant un unique rectangle couvrant
l’étendue d’une couche raster ou vecteur.

Table fTools 2: Outils de recherche fTools

20.7.3 Outils de géotraitement

Bou-
ton

Outil Fonction

Enveloppe(s)
convexe(s)

Crée l’enveloppe(s) minimale(s) convexe(s) pour une couche données ou des
sous-ensembles définis par un champ identifiant.

Tampon(s) Crée une(des) zone(s) tampon(s) autour des entités, basée(s) soit sur la distance soit
sur la valeur d’un champ donné.

Intersection Intersecte deux couches de sorte que la couche renvoyée contienne uniquement les
aires appartenant aux deux couches entrées.

Union Intersecte deux couches de sorte que la couche renvoyée contienne à la fois les aires
appartenant aux deux couches et celles n’appartenant qu’à l’une des deux.

Différencia-
tion
symétrique

Superpose les couches de sorte que la couche renvoyée ne contienne que les aires
des deux couches ne s’intersectant pas.

Couper Superpose deux couches de sorte que la couche renvoyée contienne les aires de la
couche d’entrée qui intersectent celles de la couche de découpage.

Différencia-
tion

Superpose deux couches de sorte que la couche renvoyée contienne les aires de la
couche d’entrée qui n’intersectent pas celles de la couche de découpage.

Regroupement Regroupe les entités selon un champ. Toutes les entités ayant des valeurs identiques
de ce champ sont combinées pour former une seule entité.

Supprimer les
débordements

Fusionner les entités sélectionnées avec le polygone voisin de plus grande surface
ou de plus grande frontière commune.

Table fTools 3: Outils de géotraitement fTools
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20.7.4 Outils de géométrie

Bou-
ton

Outil Fonction

Vérifier la validité
géométrique

Vérifie les polygones pour les intersections, les trous fermés et corrige l’ordre
des nœuds. Vous pouvez choisir le moteur utilisé pour la validation
géométrique dans la boîte de dialogue Options, onglet Numérisation, Valider
les géométries. Il y a deux moteurs : QGIS et GEOS qui ont un comportement
très différent. D’autres outils existent qui proposent des résultats différents tels
que l’extension Topology Checker et la règle ‘ne doit pas avoir de géométries
invalides’.

Exporter/ajouter des
colonnes de
géométrie

Ajoute des informations de géométrie sur une couche vecteur de points
(XCOORD, YCOORD), de lignes (LENGTH - longueur), ou de polygones
(AREA - aire, PERIMETER - périmètre).

Centroïdes de
polygones

Calcule le centroïde réel de chaque entité d’une couche de polygones.

Triangulation de
Delaunay

Calcule et renvoie (sous forme de couche de polygones) la triangulation de
Delaunay d’une couche vecteur de points.

Polygones de
Voronoï

Calcule les polygones de Voronoï d’une couche vecteur de points.

Simplifier la
géométrie

Généralise les lignes ou les polygones avec l’algorithme modifié de
Douglas-Peucker.

Densification de
géométrie

Ajoute des vertex aux lignes et aux polygones.

Morceaux multiples
vers morceaux
uniques

Convertit des entités constituées de plusieurs parties en des entités en une seule
partie. Crée des polygones et des lignes simples.

Morceaux uniques
vers morceaux
multiples

Fusionne plusieurs entités possédant le même identifiant sur un champ donné
en des entités multipartites.

Polygones vers
lignes

Convertit des polygones en lignes, des polygones multipartites en lignes
multipartites.

Lignes vers
polygones

Convertit les lignes en polygones, les lignes multi-partie en plusieurs
polygones mono-parties.

Extraction de
noeuds

Extrait les noeuds d’une couche de ligne ou de polygone et renvoie une couche
de points.

Table fTools 4: Outils de géométrie fTools

Note: L’outil Simplifier la géométrie permet de retirer les noeuds en double de lignes ou de polygones. L’astuce
consiste à mettre la Tolérance de simplification à 0.
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20.7.5 Outils de gestion de données

Bou-
ton

Outil Fonction

Définir la
projection
courante

Définit le système de coordonnées pour les shapefiles qui n’en ont pas.

Joindre les
attributs par
localisation

Joint des attributs supplémentaires à une couche vecteur en fonction de la
localisation. Les attributs d’une couche vecteur sont ajoutés à ceux d’une autre
couche et exportés en shapefile.

Séparer une
couche
vectorielle

Sépare une couche en plusieures couches distinctes selon un identifiant spécifié.

Fusionner les
shapefiles

Fusionne les shapefiles présents dans un répertoire en un nouveau shapefile de
même type (point, ligne ou polygone).

Créer un index
spatial

Crée un index spatial pour les formats gérés par OGR.

Table fTools 5: Outils de gestion de données

20.8 Extension GDALTools

20.8.1 Qu’est-ce que GDALTools ?

Les outils GDALTools offrent une interface graphique aux outils de la bibliothèque Geospatial Data Abstraction
Library, (http://gdal.osgeo.org). Ce sont des outils de gestion de raster qui permettent d’interroger, de reprojeter
et de manipuler une large palette de formats. Il y a également des outils pour créer des contours vectoriels ou un
relief ombré à partir d’un MNT, pour produire un VRT (Virtual Raster Tile au format XML) depuis un ensemble
de rasters. Tous ces outils sont disponibles lorsque l’extension GDALTools est activée.

La bibliothèque GDAL

La bibliothèque GDAL regroupe plusieurs programmes en ligne de commande, chacun possédant une longue liste
d’options. Les utilisateurs habitués aux consoles préfèreront la ligne de commande qui donne accès à toutes les
options tandis que l’extension offre une interface graphique plus abordable et ne liste que les options les plus
courantes.

20.8.2 Liste des outils GDAL

Figure 20.16: Le menu GDALTools
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Projections

Projection Cet outil permet de déformer et de reprojeter des images. Le programme peut reprojeter
dans n’importe quelles projections supportées, et appliquer les points d’amer stockés avec
l’image si l’image est fournie « brute ». Pour plus d’informations, se reporter au site web
GDAL http://www.gdal.org/gdalwarp.html.

Assigner
une projection

Cet utilitaire vous permet de définir la projection d’un raster qui aurait déjà été
géoréférencé mais dont il manque les informations de projection. Il permet également de
modifier la projection définie. Le traitement peut s’effectue sur un ou plusieurs fichiers
simultanément. Pour plus d’informations, se reporter au site web GDAL
http://www.gdal.org/gdalwarp.html.

Extraction
de projection

Cet utilitaire permet d’extraire les informations de projection d’un fichier en entrée. Il peut
être utilisé en mode par lot pour extraire les projections des fichiers de tout un répertoire. Il
crée des fichiers .prj et .wld.

Conversion

Rastériser
Ce programme marque des géométries vecteur (points, lignes et polygones) dans une ou
plusieurs bandes raster d’une image. Les vecteurs utilisés sont dans des formats utilisés par
OGR. Notez que les données vecteur doivent être dans le même système de coordonnées; la
projection à la volée n’est pas possible. Pour plus d’informations voir
http://www.gdal.org/gdal_rasterize.html.

Poly-
goniser

Cet utilitaire crée des polygones vectoriels à partir des zones de pixels connectés partageant la
même valeur de cellule. Chaque polygone est créé avec un attribut indiquant la valeur du pixel
sous-jacent. Il créera la couche de données vectorielles en sortie si elle n’existe pas encore, le
format par défaut étant le ESRI shapefile. Pour plus d’informations, se reporter à
http://www.gdal.org/gdal_polygonize.html.

Convertir
L’utilitaire de conversion permet de traduire un raster dans un autre format raster, ainsi que
d’appliquer d’autres opérations telles que le rééchantillonnage, le changement de taille des
pixels ou l’extraction d’un sous-secteur. Pour plus d’informations, se reporter à
http://www.gdal.org/gdal_translate.html.

RVB
vers PCT

Ce programme va calculer une table de pseudo-couleurs (PCT) optimale à partir d’une image
RVB en utilisant un algorithme médian sur un histogramme RVB réduit. L’image sera convertie
en une image dotée de pseudo-couleurs tirées de la table de couleurs créée. Cette conversion
utilise la correction Floyd-Steinberg afin d’améliorer la qualité visuelle. Pour plus
d’informations, se reporter à http://www.gdal.org/rgb2pct.html.

PCT
vers RVB

Ce programme convertit une bande de couleurs indexées en RVB. Pour plus d’informations, se
reporter à http://www.gdal.org/pct2rgb.html.

Extraction

Création
de contours

Ce programme génère un fichier de contours vectoriels à partir d’un raster d’élévation
(DEM/MNE/MNT). Pour plus d’informations, se reporter à
http://www.gdal.org/gdal_contour.html.

Découper
Cet utilitaire vous permet d’extraire une zone d’une ou plusieurs images selon une emprise
de coordonnées ou selon une couche de masquage. Pour plus d’informations, se reporter à
http://www.gdal.org/gdal_translate.html.
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Analyse

Tamiser Cet utilitaire efface les surfaces rasters plus petites que la taille donnée (en pixel) et les
remplace par la valeur de la surface voisine la plus importante. Le résultat peut être
appliqué à la bande raster existante ou être sauvegardé dans un nouveau fichier. Pour plus
d’informations, se reporter à http://www.gdal.org/gdal_sieve.html.

Presque
Noir

Cet utilitaire scanne une image et essaye de convertir les pixels qui sont dans une couleur
presque noire (ou presque blanche) dans une couleur noire totale (ou blanche). Cela
permet de corriger des images compressés afin de pouvoir spécifier une couleur comme
transparente. Pour plus d’informations, se reporter à http://www.gdal.org/nearblack.html.

Remplir la
valeur nulle

Cet utilitaire remplit des zones sélectionnées d’un raster (le plus souvent des pixels
‘no-data’) en interpolant les valeurs des pixels valides en bordure de zone. Pour plus
d’informations, se reporter à http://www.gdal.org/gdal_fillnodata.html.

Proximité Cet utilitaire génère une carte raster de proximité qui indique la distance entre le centre de
chaque pixel et le centre du pixel le plus proche qui est désigné comme un pixel cible. Les
cibles sont les pixels qui correspondent à une valeur de pixel précise. Pour plus
d’informations, se reporter à http://www.gdal.org/gdal_proximity.html.

Interpolation
Ce programme créé une grille régulière (raster) depuis les données sources. Les données
sources peuvent être interpolées afin de remplir les nœuds de la grille avec des valeurs et
vous pouvez choisir parmi plusieurs méthodes d’interpolation. Pour plus d’informations,
se reporter à http://www.gdal.org/gdal_grid.html.

MNE
(Modèles de
terrain)

Outils pour l’analyse et la visualisation de MNT. Il est possible de créer un raster
d’ombrage, de pente, d’aspect, de relief coloré, d’Indice de Rugosité du terrain (TRI),
d’Indice de Position Topographique (TPI) et de rugosité depuis tous les types de format
raster supportés par GDAL. Pour plus d’informations, voir
http://www.gdal.org/gdaldem.html.

Divers

Construire un
Raster Virtuel
(Catalogue VRT)

Ce programme construit un VRT (un fichier virtuel) qui affiche en mosaïque une
liste de rasters GDAL. Pour plus d’informations, se reporter à
http://www.gdal.org/gdalbuildvrt.html.

Fusionner Ce programme fusionnera automatiquement une série d’images. Toutes les images
doivent avoir le même système de coordonnées et posséder le même nombre de
bandes, elles peuvent se superposer ou être de résolutions différentes. Dans les
zones de superposition, la dernière image de la liste sera copiée sur les autres.
Pour plus d’informations, se reporter à http://www.gdal.org/gdal_merge.html.

Information Ce programme liste les diverses informations d’un raster supporté par GDAL.
Pour plus d’informations, se reporter à http://www.gdal.org/gdalinfo.html.

Construire des
aperçus

Ce programme permet de construire ou de reconstruire des aperçus (pyramides)
pour une image selon plusieurs algorithmes. Pour plus d’informations, se reporter
à http://www.gdal.org/gdaladdo.html.

Index des tuiles Ce programme construit un shapefile où chaque entité correspond à un fichier
raster, avec un champ attribut contenant le nom du fichier et une géométrie de type
polygone correspondant à l’emprise du raster. Pour plus d’informations, se
reporter à http://www.gdal.org/gdaltindex.html.

Paramètres de GDALTools

Cette fenêtre permet de définir vos propres variables GDAL.
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20.9 Extension Vérificateur de géométrie

Le Vérificateur de géométrie fait partie des extensions principales et permet de vérifier et réparer la validité d’une
géométrie d’une couche. La fenêtre Vérifier les géométries propose différents paramètres de vérification dans le
premier onglet (Paramètres) :

• Couche vectorielle en entrée : pour sélectionner la couche à vérifier. La case à cocher Uniquement les
entités sélectionnées permet de filtrer la géométrie et ne vérifier que celles sélectionnées.

• Validité de géométrie : permet à l’utilisateur de choisir entre Auto-intersections, Noeuds dupliqués et Poly-
gones avec moins de 3 noeuds.

• Autoriser les types de géométrie : pour n’autoriser que certains types de géométrie, point, multi-point, ligne,
multi-ligne, polygone et multi-polygone.

• Propriétés de la géométrie propose deux options : Les polygones et les polygones multiples ne doivent

pas avoir de trous et Les objets en plusieurs parties doivent disposer de plus d’une partie.

• Conditions géométriques : l’utilisateur peut ajouter des conditions pour valider les géométrie en précisant
une longueur minimale de segments, un angle minimal entre les segments, une superficie minimale de
polygones et la détection de polygones fins.

• Topology checks: checks for duplicates, for features within other features, overlaps smaller than a number,
for gaps smaller than a number.

• Tolerance: you can define here the tolerance for the check.

• Output vector layer gives the choice to the user how get the result between modifiy the current layer and
create a new layer.

After you are happy with the configuration, you can click on the [Run] button.

The results appear in the second tab and as an overview layer of the errors in the canvas (its name is checker). A
table list the geometry check result with one error by row: the first row is an ID, the second the reason of the error,
then the coordinates of the error, a value (depending on the type of the error) and finally the resolution column
which indicates the resolution of the error. At the bottom of this table, you can export the error into a shapefile.
At the left, you have the number of the errors and the fixed errors.

The Geometry Checker Plugin can find the following errors:

• Self intersections: a polygon with a self intersection,

• Duplicate nodes: two duplicates nodes in a segment

• Holes: hole in a polygon,

• Segment length: a segment length lower than a threshold,

• Minimum angle: two segments with an angle lower than a threshold,

• Minimum area: polygon area lower than a treshold,

• Silver polygon: this error come from very small polygon (with small area) with a large perimeter,

• Duplicates features,

• Feature within feature,

• Overlaps: polygon overlapping,

• Gaps: gaps between polygons

The following figure shows the different checks made by the plugin.

You can select a row to see the localisation of the error. You can change this behaviour by selecting another action

between error (default), Feature, Don’t move, and Highlight contour of selected features.

378 Chapter 20. Extensions



QGIS User Guide, Version 2.14

Figure 20.17: L’extension de vérification de géométrie
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Figure 20.18: The Differents checks supported by the plugin
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Below the zoom action when clicking on the table row, you can Show the selected features in attribute table, Fix
selected errors using default resolution and Fix selected errors, prompt for resolution method. In the latter, you
will see a window to choose the resolution’s method among which:

• fusionner avec le polygone voisin ayant la plus longue limite commune,

• fusionner avec le polygone voisin ayant la plus grande superficie,

• fusionner avec le polygone voisin ayant la même valeur attributaire, si présente, ou ne rien modifier,

• supprimer l’entité,

• aucune action.

Astuce: Fix multiple errors
CTRL + clic vous permet de sélectionner plusieurs lignes dans la table afin de corriger toutes ces erreurs en même
temps.

The default action could be changed with the last icon Error resolution settings. For some type of errors, you can
change the default action between some specific action or No action.

Finally, you can choose which attribute to use when merging features by attribute value.

20.10 Extension Accrochage de géométrie

L’extension Accrochage de géométrie, permet d’aligner les lignes et sommets d’une couche vecteur à celles et
ceux d’une autre couche vecteur selon une tolérance pouvant être personalisée.

L’interface ci-dessous montre les différents paramètres de cette extension. L’utilisateur doit sélectionner la couche
à modifier (Couche vectorielle en entrée) et la couche de référence à la quelle s’accrocher. Une Distance maximale
d’accrochage (en unités de la carte) permet d’ajuster la tolérance d’accrochage.

Vous pouvez choisir de n’accrocher que les entités sélectionnées en cochant Uniquement les entités sélection-
nées.

La Couche vecteur en sortie permet de choisir entre Modifier la couche en entrée ou Créer une nouvelle couche.

Figure 20.19: L’extension Accrochage de géométrie
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20.11 Extension de géoréférencement

L’extension de géoréférencement est un outil permettant de renseigner les coordonnées de rasters en générant les
fichiers “world” (fichiers de référence indiquant les paramètres de translation, rotation et mise à l’échelle) ou de les
transformer dans un nouveau système. La première étape pour le géoréférencement d’une image est de localiser,
sur le raster, des points dont vous pouvez déterminer les coordonnées avec précision.

Fonctionnalités

Bouton Description Bouton Description

Ouvrir un raster Commencer le géoréférencement

Générer le script GDAL Charger les points de contrôle

Sauvegarder les points de contrôle Paramètres de transformation

Ajouter un point Effacer un point

Déplacer un point Se déplacer

Zoom + Zoom -

Zoom sur la couche Zoom précédent

Zoom suivant Lier le géoréférenceur à QGIS

Lier QGIS au géoréférenceur Histogramme complet

Histogramme de l’emprise locale

Table Géoréférenceur 1: Outils de géoréférencement

20.11.1 Procédures courantes

Pour déterminer des coordonnées X et Y (notées en DMS (dd mm ss.ss), DD (dd.dd) ou en coordonnées projetées
(mmmm.mm)) qui correspondent au point sélectionné sur l’image, deux procédures peuvent être suivies :

• Par le raster lui-même : quelquefois les coordonnées sont littéralement écrites (p. ex., les graticules). Dans
ce cas, vous pouvez les saisir manuellement.

• Par des données déjà géoréférencées. Il peut d’agir de données vecteur ou raster où figurent les mêmes
objets/entités que sur le raster que vous désirez géoréférencer et dans le même système de projection. Dans
ce cas, vous pouvez renseigner les coordonnées en cliquant sur les données de référence chargées dans la
carte principale de QGIS.

La procédure standard pour le géoréférencement d’une image implique la sélection de plusieurs points sur le raster,
en spécifiant leurs coordonnées et en choisissant la transformation appropriée. En se basant sur les paramètres
entrés et les données, l’extension calculera les paramètres du fichier “world”. Plus il y a de coordonnées fournies,
meilleur sera le résultat.

La première étape consiste à lancer QGIS, charger l’extension de Géoréférencement (voir La fenêtre des Ex-
tensions) puis cliquer sur Raster → Géoreferencer qui apparaît dans la barre de menu de QGIS. La fenêtre de
géoréférencement se présente sous la forme montrée dans la figure figure_georeferencer_1.

En guise d’exemple, nous allons utiliser une carte topographique du Dakota du Sud publiée par le SDGS. Elle
pourra par la suite être affichée avec les données du secteur GRASS spearfish60. Cette carte topographique peut
être téléchargée à l’adresse suivante : http://grass.osgeo.org/sampledata/spearfish_toposheet.tar.gz.

Saisir des points de contrôle (GCP)

1. Pour commencer le géoréférencement d’un raster, nous devons le charger via le bouton . Le raster
apparaît alors dans la surface principale de travail de la fenêtre. Une fois qu’il est chargé, nous pouvons
commencer à entrer des points de contrôles.
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Figure 20.20: Fenêtre de Géoréférencement

2. En utilisant le bouton Ajouter des Points, ajoutez par un clic des points dans la surface de travail et saisissez
leurs coordonnées (voir figure figure_georeferencer_2). Pour ce faire, il y a trois manières de procéder :

• En cliquant en un point de la carte raster et entrant les coordonnées X et Y manuellement.

• En cliquant en un point de la carte raster puis sur le bouton Depuis le canevas pour ajouter les coordon-
nées X et Y à l’aide d’une carte géoréférencée déjà chargée dans le canevas principal de QGIS.

• Avec le bouton , vous pouvez déplacer les points de contrôle dans les deux fenêtres au cas où ils
seraient mal placés.

3. Continuez d’entrer des points jusqu’à en avoir au moins quatre. Des outils additionnels situés dans la partie
supérieure de cette fenêtre permettent de zoomer et de se déplacer dans l’espace de travail.

Figure 20.21: Ajout de points de contrôle à l’image raster

Les points qui sont ajoutés sur la carte sont enregistrés dans un fichier texte distinct
([nomdufichier].points) qui est stocké avec le fichier raster. Il permet de rouvrir l’extension à
une date ultérieure et de rajouter de nouveaux points ou d’effacer ceux existants pour améliorer le résultat
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sans devoir tout refaire. Le fichier de points contient les valeurs suivantes : mapX, mapY, pixelX,

pixelY (soit les coordonnées cartographiques et les coordonnées du pixel). Vous pouvez aussi utiliser
Charger des points de contrôle et Sauvegarder des points de contrôle dans des répertoires différents si vous le désirez.

Configurer la transformation

Après avoir ajouté vos points de contrôle, vous devez sélectionner la méthode de transformation qui sera utilisée
pour le géoréférencement.

Figure 20.22: Définition des paramètres de la transformation pour le géoréférencement

Algorithmes de transformation disponibles

Selon le nombre de points que vous saisissez, vous aurez à utiliser différents algorithmes de transformation. Le
choix d’un algorithme dépend aussi du type et de la qualité de vos sources de données et du niveau de distorsion
géométrique que vous êtes prêt à accepter dans le résultat final.

Actuellement les types de transformation suivants sont disponibles :

• L’algorithme Linéaire est utilisé pour créer un fichier world. Il est différent des autres algorithmes en ce sens
qu’il ne transforme pas le raster. Cet algorithme ne sera vraisemblablement pas suffisant pour géoréférencer
des données scannées.

• L’algorithme Helmert applique de simples translation, rotation et mise à l’échelle.

• Les algorithmes Polynomiaux de degré 1 à 3 sont parmi les algorithmes les plus utilisés pour le
géoréférencement et chacun diffère par le degré de distorsion qu’il introduit pour faire correspondre au
mieux la source aux points de contrôles. La transformation polynomiale la plus utilisée est celle d’ordre
deux qui autorise quelques courbes. La transformation polynomiale d’ordre un (aussi appelée transforma-
tion affine) préserve la colinéarité et permet seulement les translation, rotation et mise à l’échelle (comme
la transformation de Helmert).
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• L’algorithme Thin Plate Spline (TPS) est une méthode plus moderne qui est capable d’introduire des dé-
formations sur des secteurs précis de l’image. Il est très pratique quand des sources de faible qualité sont
utilisées.

• L’algorithme Projective est une rotation linéaire puis une translation des coordonnées.

Définir la méthode de rééchantillonage

Le type de ré-échantillonnage à effectuer dépendra de votre donnée en entrée et de l’objectif de l’exercice. Si
vous ne voulez pas changer les statistiques de l’image, vous devriez sélectionner la méthode du plus proche voisin
tandis que le ré-échantillonnage cubique produira un résultat plus lisse.

Il est possible de choisir entre 5 méthodes de ré-échantillonnage :

1. Au plus proche voisin

2. Linéaire

3. Cubique

4. Cubic Spline

5. Lanczos

Définir les paramètres de transformation

Plusieurs paramètres doivent être renseignés afin de créer un raster géoréférencé.

• La case Créer un fichier de coordonnées est uniquement disponible lorsque la méthode de transformation
linéaire est choisie, et ce, parce que votre image ne sera alors pas transformée en sortie. Dans ce cas précis,
le champ raster de sortie ne sera pas activé, car seul le fichier de coordonnées sera créé.

• Pour tous les autres types de transformations, vous pouvez saisir un Raster de sortie. Par défaut, le nouveau
fichier s’intitulera ([nomdefichier]_georef) et sera enregistré dans le même répertoire que le raster original.

• L’étape suivante est la définition du SCR cible pour le raster géoréférencé (lire Utiliser les projections).

• Si vous le désirez, vous pouvez demander à générer une carte PDF ou générer un rapport PDF qui inclut
tous les paramètres définis ainsi qu’une image avec tous les résidus et une liste des points de contrôles et
leurs erreurs RMS.

• Vous pouvez cocher la case Définir la résolution de la cible et préciser la résolution de pixel du raster
généré. La résolution horizontale et verticale par défaut est de 1.

• Lorsque la case Employer 0 pour la transparence si nécessaire est cochée, cela indique que la valeur 0
sera transparente lors de la visualisation. Dans notre exemple, toutes les zones blanches seront transparentes.

• Pour finir, la case Charger dans QGIS lorsque terminé assure le chargement automatique du raster quand
la transformation est achevée.

Afficher et modifier les propriétés raster

En cliquant sur Propriétés du raster dans le menu Paramètres s’ouvre la fenêtre des propriétés du raster que vous
voulez géoréférencer.

Configurer le géoreferenceur

• Vous pouvez choisir d’afficher les coordonnées des points ou leur identifiant.

• Les résidus peuvent être exprimés en unités de la carte ou en pixel.

• Vous pouvez modifier les marges et la taille de papier du rapport PDF.
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• Enfin, vous pouvez aussi activer la case Afficher la fenêtre de géoréférencement dans la fenêtre princi-
pale.

Lancer la transformation

Lorsque tous les points de contrôle ont été posés et les paramètres de transformation saisis, appuyez sur le bouton
Commencer le géoréférencement pour créer le raster final.

20.12 Extension Carte de chaleur

Le plugin Heatmap utilise l’estimation de densité de noyau pour créer un raster de densité (carte de chaleur)
d’une couche de point vecteur en entrée. La densité est calculée en fonction du nombre de point dans un endroit
dans lequel plus le nombre est important plus la valeur est grande. Les cartes de chaleur permettent d’identifier
facilement les “points chauds” et les grappes de points.

20.12.1 Activer l’extension Carte de chaleur

D’abord, cette extension principale doit être activée en utilisant le Gestionnaire d’Extensions (consultez La fenêtre

des Extensions). Après activation, l’icône de carte de chaleur est disponible dans la barre d’outil Raster et
sous le menu Raster → Heatmap.

Sélectionnez le menu Vue → Barre d’outils → Raster pour afficher la barre d’outils Raster si elle n’est pas visible.

20.12.2 Utiliser l’extension Carte de chaleur

En cliquant sur le bouton Carte de chaleur vous ouvrez la fenêtre de l’extension Carte de chaleur (voir
figure_heatmap_2).

Cette fenêtre a les options suivantes:

• Couche de points de saisie : liste toutes les couches ponctuelles chargées dans le projet actuel et permet de
sélectionner la couche à analyser.

• Raster en sortie : utilisez le bouton pour sélectionner le répertoire et le nom du fichier raster qui sera
créé par l’outil Carte de chaleur. L’extension du fichier n’est pas nécessaire.

• Format en sortie : sélectionne le format de sortie. Bien que tous les formats gérés par GDAL peuvent être
choisis, dans la plupart des cas GeoTIFF constitue le meilleur choix.

• Rayon : utilisé pour définir le rayon de recherche de la carte de chaleur (ou bande passante du noyau) en
mètre ou en unité de carte. Le rayon définit la distance autour d’un point au delà de laquelle l’influence d’un
point sera nul. Les valeurs les plus grandes résultent en un plus grand lissage, mais des valeurs plus petites
génèrent plus de détails et de variations en densité de points.

Lorsque la case Avancé est cochée, des options supplémentaires sont disponibles :

• Lignes et Colonnes : utilisé pour modifier les dimensions du raster en sortie. Ces valeurs sont aussi liées
aux valeurs Taille en X et Taille en Y. Augmenter le nombre de lignes ou de colonnes diminuera la taille
de la cellule et augmentera la taille du fichier en sortie. Les valeurs de lignes et de colonnes sont aussi
liées, donc, doubler le nombre de lignes doublera automatiquement le nombre de colonnes et les tailles des
cellules seront aussi diminuées de moitié. La zone géographique du raster en sortie restera la même !

• Taille en X et Taille en Y : contrôle la taille géographique de chaque pixel dans le raster sortie. Changer
ces valeurs changera le nombre de lignes et de colonnes dans le raster en sortie.
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• Forme du noyau : la forme du noyau contrôle le taux à laquelle l’influence d’un point diminue à mesure que
la distance du point augmente. Différents noyaux diminuent à des taux différents, donc un noyau triweight
donne des entités de plus grand poids pour des distances plus proche du point que le noyau Epanechnikov.
Par conséquent, le noyau triweight donne des résultats dans les points chauds “nets” et les noyau Epanech-
nikov donne des résultats dans les points chauds “en douceur”. Un certain nombre de fonctions du noyau
standard qui sont disponibles dans QGIS sont décrites et illustrées sur Wikipedia.

• Taux de décroissance: peut être utilisé avec les noyaux triangulaires afin de mieux contrôler comment la
chaleur à partir d’une entité diminue avec la distance à partir de l’entité.

– Une valeur de 0 ( = minimum) indique que la chaleur sera concentrée au centre du rayon donné et
complètement nulle au bord.

– Une valeur de 0.5 indique que les pixels au bord du rayon seront à la moitié de la chaleur des pixels
au centre du rayon de recherche.

– Une valeur de 1 indique que la chaleur sera répartie uniformément sur tout le cercle formé par le rayon
de recherche. (C’est l’équivalent du noyau ‘Uniforme’.)

– Une valeur supérieure à 1 indique que la chaleur sera plus importante au bord du cercle formé par le
rayon de recherche qu’au centre.

Les champs attributaires de la couche de points en entrée peuvent permettre de paramétrer la carte de chaleur :

• Utiliser le rayon depuis : permet de définir le champ de la table d’attributs à partir duquel le rayon de
recherche sera défini.

• Utiliser le poids depuis : identifie le champ de la table d’attributs indiquant la pondération à utiliser. Ce
paramètre permet d’augmenter l’importance de certaines entités sur le résultat.

Quand la couche raster de sortie est renseignée, le bouton [OK] est actionné pour créer la carte de chaleur.

20.12.3 Tutorial : Créer une carte de chaleur

Pour l’exemple suivant, nous utiliserons la couche de points airports fournie dans l’échantillon de jeux de
données de QGIS (voir Échantillon de données). Un excellent tutoriel sur les cartes de chaleur est également
disponible à l’adresse http://qgis.spatialthoughts.com.

La figure Figure_Heatmap_1 montre les aéroports de l’Alaska.

1. Sélectionnez le bouton Carte de chaleur pour ouvrir la fenêtre de l’extension (voir Figure_Heatmap_2).

2. Dans le champs Couche de points en entrée , sélectionnez airports à partir de la liste déroulante
des couches de points présentes dans le projet.

3. Choisissez le nom du fichier à créer en cliquant sur le bouton situé à droite de Raster en sortie. Entrez
par exemple carte_chaleur_aeroports. Il n’est pas nécessaire de préciser l’extension du fichier.

4. Laissez la valeur par défaut, GeoTIFF, dans le champ Format en sortie.

5. Changez le Rayon à 1000000 mètres.

6. Cliquez sur [OK] pour créer et charger la carte de chaleur des aéroports (voir Figure_Heatmap_3).

QGIS va générer une carte de chaleur et l’ajouter au projet courant. Par défaut, le raster est représenté en dégradé
de gris, les zones les plus claires indiquent des concentrations d’aéroports plus élevées. Le rendu du raster peut
ensuite être amélioré via QGIS.

1. Ouvrez les propriétés de la couche chaleur_aéroports (sélectionnez la couche
chaleur_aeroports, faites un clic-droit et dans le menu qui apparaît, sélectionnez Propriétés).

2. Sélectionner l’onglet Style.

3. Choisissez le Type de rendu ‘Pseudo-Couleurs à bande unique’.

4. Sélectionnez une Palette de couleur adaptée, par exemple, YlOrRed.
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Figure 20.23: Aéroports d’Alaska

Figure 20.24: La boîte de dialogue Heatmap
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Figure 20.25: La carte de chaleur après chargement est une surface grise

5. Cliquez sur le bouton [Charger] pour récupérer les valeurs minimale et maximale du raster puis cliquez sur
le bouton [Classer].

6. Pressez [OK] pour mettre à jour la couche.

La figure Figure_Heatmap_4 montre le résultat obtenu.

20.13 Extension Interpolation

L’extension Interpolation permet de générer une interpolation TIN ou IDW depuis une couche vectorielle de
points. Cette extension est très simple à manipuler et fournit à l’utilisateur une interface graphique intuitive
pour la création de couches matricielles interpolées (voir la Figure Figure_interpolation_1). Avant son exécution,
l’extension nécessite les réglages suivants :

• Couche vecteur d’entrée : spécifier une (ou plusieurs) couche(s) vectorielle(s) de points parmi la liste
de couches vectorielles de points chargées. Si plusieurs couches sont sélectionnées, alors l’ensemble des
données de toutes les couches est utilisé pour l’interpolation. Note : il est possible d’insérer des lignes
ou des polygones comme contrainte pour la triangulation en spécifiant “lignes de structure” ou “ligne de

failles” dans la liste déroulante du sous-menu Type.

• Attribut d’interpolation : sélectionner la colonne attributaire à utiliser pour l’interpolation ou cocher la

case Utiliser les coordonnées Z pour l’interpolation afin d’utiliser une couche contenant des valeurs Z.

• Méthode d’Interpolation : sélectionne la méthode d’interpolation. Elle peut être soit ‘Réseau Irrégulier
Triangulé (TIN)’, soit ‘Distance Inverse Pondérée (IDW)’. Avec la méthode TIN vous pouvez créer une
surface formées par des triangles de points les plus proches. Pour ce faire, des cercles concentriques autour
de points échantillonnés sont créés et leur intersections sont connectés à un réseau de triangles qui ne se
chevauchent pas et qui sont aussi compacts que possible. Les surfaces qui en résultent ne sont pas lisses.
Lors de l’utilisation de la méthode IDW les points échantillonnés sont pondérés lors de l’interpolation
telle que l’influence d’un point relativement à un autre diminue avec la distance qui le sépare du point
que vous voulez créer. La méthode d’interpolation IDW a aussi des désavantages : la qualité du résultat
d’interpolation peut diminuer si la distribution des points de données échantillonnées est irrégulière. De
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Figure 20.26: Carte de chaleur stylée des aéroports d’Alaska

plus, les valeurs maximales et minimales de la surface interpolée ne peuvent se produire qu’aux points
de données échantillonnées. Il en résulte souvent des petits pics et creux autour des points de données
échantillonnées.

• Configure Interpolation Method: Configure the interpolation method you have chosen. For the TIN
method you can choose between Linear and Clough Toucher (cubic) interpolation methods. You can also
save the triangulation in shapefile format. For IDW interpolation you can set the distance coefficient.

• Nombre de colonnes/cellules : définir le nombre de colonnes et de lignes du raster de sortie.

• Fichier en sortie : attribuer un nom au fichier raster en sortie.

• Ajouter le résultat au projet chargera automatiquement le raster de résultat dans la légende du projet en
courant.

Notez que vous pouvez utiliser des lignes comme contraintes pour l’interpolation par triangulation (méthode
TIN). Vous pouvez utiliser soit des ‘lignes de structure’, soit des ‘lignes de faille’. Lors de l’emploi de ‘ligne de
faille’ vous produisez des cassures franches dans la surface alors qu’en employant des ‘lignes de structure’ vous
produisez des coupures continues. La triangulation est modifiée par ces deux méthodes de telle sorte qu’aucun
segment ne traverse une ligne de structure ou une ligne de faille.

20.13.1 Mettre en œuvre l’extension

1. Lancez QGIS et chargez une couche vectorielle de points (par exemple, elevp.csv).

2. Activez l’extension Interpolation via le Gestionnaire d’Extensions (voir La fenêtre des Extensions) puis

cliquez sur Raster → Interpolation → Interpolation présent dans la barre de menu QGIS. La boîte de
dialogue de l’extension Interpolation s’ouvre comme montrée dans la Figure Figure_interpolation_1.

3. Sélectionnez une couche vectorielle de départ (par exemple, elevp ) ainsi qu’une colonne attributaire
pour l’interpolation (par exemple, ELEV).

4. Sélectionnez une méthode d’interpolation (par exemple, ‘Interpolation Triangulaire (TIN)’), puis définissez
le nombre de colonnes et de cellules, par exemple, 5000 ainsi qu’un nom pour le fichier raster de sortie (par
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Figure 20.27: Extension Interpolation

exemple, elevation_tin).

5. Appuyez sur [Ok].

20.14 Client MetaSearch pour les Services de Catalogage

20.14.1 Introduction

MetaSearch est une extension QGIS permettant d’interagir avec des services de catalogage de données.
MetaSearch supporte le standard OGC CSW (Catalogue Service for the Web)

MetaSearch fournit une approche simple et intuitive ainsi qu’une interface conviviale pour la recherche de cata-
logues de métadonnées depuis QGIS.

20.14.2 Installation

MetaSearch est intégré par défaut à QGIS 2.0 et ses versions plus récentes. Toutes les dépendances sont incluses
dans MetaSearch.

Installer MetaSearch depuis le gestionnaire d’extensions QGIS, ou manuellement depuis
http://plugins.qgis.org/plugins/MetaSearch.

20.14.3 Travailler avec des Catalogues de Métadonnées dans QGIS

CSW (Catalogue Service for the Web)

CSW (Catalogue Service for the Web) est une spécification de l’OGC (Open Geospatial Consortium) qui définit
des interfaces communes pour découvrir, parcourir et rechercher des métadonnées sur les données, services et
autres ressources liées.

Démarrage

To start MetaSearch, click icon or select Web → MetaSearch → MetaSearch via the QGIS main menu. The
MetaSearch dialog will appear. The main GUI consists of three tabs: Services, Search and Settings.
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Gérer les Services de Catalogage

L’onglet Services permet à l’utilisateur de gérer tous les services de catalogage disponibles. MetaSearch dispose
d’une liste de Services de Catalogage par défaut, qui peut être ajoutée en pressant le bouton [Ajouter des services
par défaut].

Pour la liste complète des Services de Catalogage, cliquer sur la liste déroulante.

Pour ajouter une nouvelle entrée de type Service de Catalogage, cliquer sur le bouton [Nouveau], et saisir un
Nom pour le service, ainsi que l’URL (endpoint). Seule l’URL basique est requise (et non l’URL complète du
GetCapabilities). Cliquer sur [OK] permet d’ajouter le service à la liste d’entrées existante.

Pour modifier une entrée existante de type Service de Catalogage, sélectionner l’entrée à modifier, cliquer sur le
bouton [Modifier], modifier le Nom ou l’URL et cliquer sur [OK].

Pour supprimer une entrée existante de type Service de Catalogage, sélectionner l’entrée à supprimer et cliquer
sur le bouton [Supprimer]. Il sera demandé de confirmer la suppression.

MetaSearch permet de charger et de sauvegarder des connexions vers un fichier XML. Cette option est utile pour
partager des paramètres avec d’autres applications. Ci-après un exemple de format de fichier XML.

<?xml version="1.0" encoding="UTF-8"?>
<qgsCSWConnections version="1.0">

<csw name="Data.gov CSW" url="http://catalog.data.gov/csw-all"/>
<csw name="Geonorge - National CSW service for Norway" url="http://www.geonorge.no/geonetwork/srv/eng/csw"/>
<csw name="Geoportale Nazionale - Servizio di ricerca Italiano" url="http://www.pcn.minambiente.it/geoportal/csw"/>
<csw name="LINZ Data Service" url="http://data.linz.govt.nz/feeds/csw"/>
<csw name="Nationaal Georegister (Nederland)" url="http://www.nationaalgeoregister.nl/geonetwork/srv/eng/csw"/>
<csw name="RNDT - Repertorio Nazionale dei Dati Territoriali - Servizio di ricerca" url="http://www.rndt.gov.it/RNDT/CSW"/>
<csw name="UK Location Catalogue Publishing Service" url="http://csw.data.gov.uk/geonetwork/srv/en/csw"/>
<csw name="UNEP/GRID-Geneva Metadata Catalog" url="http://metadata.grid.unep.ch:8080/geonetwork/srv/eng/csw"/>

</qgsCSWConnections>
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Figure 20.28: Gérer les Services de Catalogage

To load a list of entries, click the [Load] button. A new window will appear; click the [Browse] button and
navigate to the XML file of entries you wish to load and click [Open]. The list of entries will be displayed. Select
the entries you wish to add from the list and click [Load].

Cliquez le bouton [Information sur le Service] pour afficher des informations sur le Service de Catalogage,
par exemple : identification du service, fournisseur du service et coordonnées du fournisseur. Pour visualiser la
réponse en format XML brut, cliquez sur le bouton [GetCapabilities]. Une fenêtre distincte va s’ouvrir avec le
XML contenant les Capabilities.

Recherche de Services de Catalogage

L’onglet Rechercher permet à l’utilisateur de rechercher des Services de Catalogage de données et de services, de
spécifier différents paramètres de recherche et de visualiser les résultats de la recherche.

Les paramètres de recherche suivants sont disponibles :

• Mots-clés : recherche de texte libre par mots-clés

• Depuis : le Service de Catalogage à partir duquel effectuer la recherche

• Bounding box: the spatial area of interest to filter on defined by Xmax, Xmin, guilabel:Ymax, and guil-
abel:Ymin. Click [Set global] to do a global search, click [Map extent] to do a search on the visible area
only or manually enter custom values as desired

Cliquer sur le bouton [Rechercher] va effectuer une recherche dans le Catalogue de Métadonnées sélectionné.
Les résultats de la recherche sont affichés dans une liste et peuvent être triés en cliquant sur le titre de la colonne.
Il est possible de naviguer dans les résultats de la recherche au moyen des boutons directionnels situés juste en
dessous. Cliquer sur le bouton [Voir les résultats de la recherche en XML] ouvre une fenêtre avec la réponse du
service en code XML brut.

Clicking a result will provides the following options:
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Figure 20.29: Recherche de services de catalogage

• si l’élément de métadonnée a une zone géographique associée, l’empreinte de cette zone géographique sera
visible sur la carte

• double-cliquer sur l’enregistrement affiche l’élément de métadonnée ainsi que les hyperliens associés. Cli-
quer sur un lien l’ouvre dans le navigateur internet de l’utilisateur

• si l’enregistrement est un service web OGC (WMS/WMTS, WFS, WCS), les boutons [Ajouter une
couche WMS/WMTS|WFS|WCS] seront activés et l’utilisateur pourra ajouter des couches dans QGIS.
Lorsque l’utilisateur clique sur un de ces boutons, MetaSearch vérifie la validité du service web OGC.
Celui-ci est alors ajouté à la liste de connexions QGIS correspondante et la fenêtre de connexion
WMS/WMTS|WFS|WCS correspondante apparaît

Paramètres

Les paramètres suivants permettent de régler MetaSearch de manière fine :

• Nommer la connexion : lors de l’ajout d’une connexion OWS (WMS/WMTS|WFS|WCS), la connexion est
enregistrée avec les différents pilotes de couches QGIS. Utilisez ce paramètre pour renseigner si le nom
provient de MetaSearch ou s’il doit être écrasé ou s’il doit avoir un nom temporaire

• Pagination des résultats : lors de la recherche dans des catalogues de métadonnées, le nombre de résultats
à montrer par page. La valeur par défaut est 10.

• Délai : lors de la recherche dans des catalogues de métadonnées, le nombre de secondes pour bloquer la
tentative de connexion. La valeur par défaut est 10
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Figure 20.30: Metadata record display

Figure 20.31: Metasearch setting
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20.15 Extension d’Édition hors-ligne

Pour les collectes de données, il est commun d’aller sur le terrain avec un ordinateur ou un téléphone portable. De
retour sur le réseau, les modifications doivent être synchronisées avec la source de données initiale (par exemple
une base de données PostGIS). Si plusieurs personnes travaillent ensembles sur les mêmes jeux de données, il est
difficile de fusionner les éditions à la main, même si les utilisateurs ne changent pas les mêmes entités.

L’extension Édition offline automatise la synchronisation en copiant le contenu d’une source de données
(habituellement PostGIS or WFS-T) vers une base Spatialite et en stockant les éditions offlines dans des tables
dédiées. Après s’être connecté de nouveau au réseau, il est possible d’appliquer les éditions offline aux jeux de
données sources.

20.15.1 Utiliser l’extension

• Ouvrez des couches vecteurs (par exemple d’une source de données PostGIS ou WFS-T).

• Sauvez-les dans un projet.

• Allez dans Base de données → Édition hors connexion → Convertir en projet hors-connexion et sélec-
tionnez les couches à sauver. Le contenu des couches est sauvé dans des tables SpatiaLite.

• Éditez les couches hors-ligne.

• Après vous être connecté de nouveau au réseau, envoyez vos modifications avec Base de données → Édition

hors connexion → Synchroniser.

Figure 20.32: Crée un projet hors ligne depuis PostGIS ou des couches WFS
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20.16 Extension GeoRaster Oracle Spatial

Dans les bases de données Oracle, les données raster peuvent être stockés dans des objets SDO_GEORASTER,

disponibles dans l’extension Oracle Spatial. Dans QGIS, l’extension GeoRasterOracle Spatial est supporté par GDAL
et dépend de la version d’Oracle installée sur votre machine. Bien que ce soit un outil propriétaire, Oracle fournit
un logiciel gratuit à des fins de tests ou de développement. Voici un exemple simple de comment charger des
images raster dans Georaster :

$ gdal_translate -of georaster input_file.tif geor:scott/tiger@orcl

Le raster va être chargé dans la table par défaut, GDAL_IMPORT, en tant que colonne nommée RASTER.

20.16.1 Gérer les connexions

Tout d’abord, l’extension GeoRaster Oracle doit être activé dans le gestionnaire d’extensions (voir La fenêtre
des Extensions). La première fois que vous chargez un GeoRaster dans QGIS, vous devez créer une connex-

ion à la base de données Oracle contenant la donnée. Pour ce faire, commencez par cliquer sur le bouton
Ajouter une couche GeoRaster Oracle de la barre d’outils – ceci va ouvrir la boîte de dialogue Sélectionnez un GeoRaster
Oracle Spatial. Cliquez sur [Nouveau] pour ouvrir la boîte de dialogue et indiquez les paramètres de connexion
(voir Figure_oracle_raster_1) :

• Nom : Entrez un nom pour la connexion.

• Instance de base de données : Entrez le nom de la base de données à laquelle vous voulez vous connecter.

• Nom d’utilisateur : Indiquez le nom d’utilisateur permettant de se connecter à la base de données.

• Mot de passe : Saisissez le mot de passe associé au nom d’utilisateur.

Figure 20.33: Créer une boite de dialogue de connexion Oracle

Dans la fenêtre principale GeoRaster Oracle Spatial (voir Figure_oracle_raster_2), utilisez la liste déroulante
pour choisir une connexion, et cliquez sur [Connecter] pour accéder à la base de données. Vous pouvez égale-
ment éditer les paramètres de connexion en cliquant sur [Éditer], ou supprimer la connexion en choisissant [Sup-
primer].

20.16.2 Sélection d’un GeoRaster

Une fois connecté, les noms des tables de la base contenant des colonnes GeoRaster compatibles au format GDAL
vont s’afficher dans la fenêtre des sous-jeux de données.

Cliquez sur l’un de ces sous-jeux de données puis sur [Sélectionner] pour choisir la table. Une nouvelle liste
affiche maintenant les noms des colonnes GeoRaster dans cette table, il s’agit généralement d’une courte liste car
la plupart des utilisateurs n’ont pas plus d’une ou deux colonnes GeoRaster dans une même table.
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Cliquez sur l’une des sous-jeux puis sur [Sélectionner] pour choisir une combinaison d’une table et d’une colonne
La fenêtre montrera alors toutes les lignes contenant un objet GeoRaster Vous remarquerez que la liste affichera
la table de données raster et les identifiants Raster.

A tout moment la sélection peut être éditée manuellement pour pointer directement le GeoRaster voulu ou re-
tourner au début pour prendre une autre table.

Figure 20.34: Sélectionner la boîte de dialogue GeoRaster d’Oracle

L’entrée de sélection de données peut également être utilisée pour définir une clause WHERE à la fin de la
chaîne d’identification (par exemple geor:scott/tiger@orcl,gdal_import,raster,geoid=). Voir
la page http://www.gdal.org/frmt_georaster.html pour plus d’information.

20.16.3 Afficher un GeoRaster

En sélectionnant un GeoRaster depuis la liste, cette image sera chargée dans QGIS.

La fenêtre de Sélection de GeoRaster Oracle Spatial peut maintenant être fermée, la connexion sera conservée
pour une prochaine ouverture, la même liste de sous-jeux de données sera ainsi disponible, ce qui facilitera
l’affichage de nouvelles images dans le même contexte.

Note: Les GeoRasters qui contiennent des tuiles/pyramides s’afficheront plus rapidement mais elles devront être
générées hors de QGIS en utilisant Oracle PL/SQL ou gdaladdo.

L’exemple suivant utilise gdaladdo:

gdaladdo georaster:scott/tiger@orcl,georaster\_table,georaster,georid=6 -r
nearest 2 4 6 8 16 32

Cet exemple utilise PL/SQL:

$ sqlplus scott/tiger
SQL> DECLARE
gr sdo_georaster;

BEGIN
SELECT image INTO gr FROM cities WHERE id = 1 FOR UPDATE;
sdo_geor.generatePyramid(gr, ’rLevel=5, resampling=NN’);
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UPDATE cities SET image = gr WHERE id = 1;
COMMIT;

END;

20.17 Extension d’Analyse Raster de Terrain

L’extension d’analyse de terrain basée sur les rasters peut être utilisée pour calculer la pente, l’aspect,
l’ombrage, le relief et la rugosité d’un modèle numérique d’élévation (DEM). Sa facilité d’utilisation et son inter-
face graphique intuitive permettent de créer de nouvelles couches raster (voir figure Figure_raster_terrain_1).

Description de l’analyse:

• Pente : Calcule l’angle de la pente pour chaque cellule (en degrés, en se basant sur une estimation dérivée
de 1er ordre).

• Aspect: Calcule l’exposition (en degrés dans le sens horaire inverse et en commençant par 0 pour une
direction nord).

• Ombrage : crée une carte ombragée en utilisant la lumière et les ombres pour fournir un apparence plus
tri-dimensionnelle à une carte de relief ombragé. La carte produite est mono-bande en dégradé de gris
correspondant aux valeurs de gris des pixels.

• Facteur de rugosité : Une mesure quantitative de l’hétérogénéité du terrain, tel que décrit par Riley et al.
(1999). Elle est calculée en tout point en mesurant les changements d’élévation dans une grille de 3 par 3
pixels.

• Relief : crée une carte de relief ombragé à partir de données numériques d’élévation. La méthode implé-
mentée permet de choisir les couleurs des élévations par l’analyse de la distribution des fréquences. La carte
produite est multibandes en couleur ayant trois bandes correspondant aux valeurs RVB du relief ombragé.

Figure 20.35: Extension d’Analyse Raster de Terrain (calcul de pente)

20.17.1 Mettre en oeuvre l’extension

1. Démarrez QGIS et charger un fichier raster gtopo30 depuis la zone exemple de GRASS.

2. Chargez l’extension via le Gestionnaire d’Extension (voir La fenêtre des Extensions).

3. Sélectionnez une méthode d’analyse (par exemple, Raster → Analyse de Terrain → Pente). La fenêtre Pente
apparaît comme indiqué sur Figure_raster_terrain_1.

4. Spécifiez un chemin de sortie et le type de fichier produit.

5. Cliquez sur le bouton [OK].
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20.18 Extension Graphe routier

L’extension Graphe routier est une extension C++ pour QGIS, qui calcule le chemin le plus court entre deux points
sur n’importe quelle couche de polylignes et trace ce chemin au-dessus du réseau routier.

Figure 20.36: Extension Graphe routier

Fonctionnalités principales:

• Calcule le chemin, sa longueur et le temps de trajet.

• Optimise par la longueur ou par le temps de trajet.

• Exporte le chemin en couche vectorielle.

• Met en couleur les directions de la route (cette option est lente et surtout utile pour déboguer et pour tester
le paramétrage).

Vous pouvez utiliser n’importe quelle couche polylignes comme couche route dans n’importe quel format géré
par QGIS. Deux lignes avec un point commun sont considérées comme connectées. Notez qu’il est obligatoire
d’utiliser la projection de la couche comme projection du projet lors de l’édition de la couche route. Cela est dû au
fait que le calcul de transformation des coordonnées entre différentes projections introduit des erreurs qui peuvent
créer des discontinuités, même quand l’accrochage est utilisé.

Dans la table attributaire de la couche, les champs suivants peuvent être utilisés:

• Vitesse sur la section de route (champ numérique).

• Direction (n’importe quel type qui peut être écrit en chaîne de caractères). Les directions avant et arrière de
la géométrie correspondent à une route à sens unique, les deux directions à une route à double sens.

Si des champs n’ont pas de valeur ou n’existent pas, les valeurs par défaut sont utilisées. Vous pouvez modifier
ces valeurs par défaut ainsi que d’autres options dans la fenêtre de paramétrage de l’extension.
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20.18.1 Usage

Après activation de l’extension, vous verrez un panneau supplémentaire sur la gauche de la fenêtre principale
de QGIS. Maintenant, configurez l’extension dans la fenêtre Paramétrage du menu Extension -> Graphe routier
(voir figure_road_graph_2).

Figure 20.37: Paramètres de l’extension de graphes routiers

Après avoir configuré Unité de temps, Unité de distance et Tolérance topologique, vous pouvez choisir la couche
vectorielle dans l’onglet Couche de transport. Là, vous pouvez aussi indiquer le Champ de direction et le Champ
de vitesse. Dans l’onglet Paramètres par défaut, vous pouvez indiquer la Direction pour les calculs.

Enfin, dans le panneau Chemin le plus court, sélectionnez un point d’origine et un point de destination sur la
couche du réseau routier et cliquez sur bouton [Calculer].

20.19 Extension Requête Spatiale

L’extension Requête Spatiale vous permet de réaliser une requête spatiale (par exemple sélectionner des entités)
sur une couche cible en fonction d’une autre couche. Cette fonctionnalité est basée sur la bibliothèque GEOS, les
opérations possibles dépendent de la couche source choisie.

Les opérateurs disponibles sont :

• Contient

• Egale

• Recouvre

• Croise

• Intersecte

• Est disjoint

• Touche

• Est à l’intérieur
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20.19.1 Mettre en oeuvre l’extension

Nous souhaitons par exemple trouver les régions dans le jeu de données Alaska qui ont des aéroports. Les étapes
suivantes sont à effectuer :

1. Lancez QGIS et chargez les couches vectorielles regions.shp et airports.shp.

2. Activez l’extension Requête Spatiale dans le Gestionnaire d’extensions (voir La fenêtre des Extensions)

et cliquez sur le bouton Requête Spatiale qui apparait dans la barre d’outils Extensions. La fenêtre de
l’extension s’affiche.

3. Sélectionnez la couche régions comme couche source et aéroports comme couche de référence.

4. Sélectionnez ‘A l’intérieur’ comme opérateur et cliquez sur [Appliquer].

Vous obtenez alors une liste d’identifiants des entités satisfaisant la requête. Vous avez ensuite plusieurs options
comme indiqué en figure figure_spatial_query_1.

• Cliquez sur Créer une couche avec la liste des objets.

• Sélectionner un identifiant de la liste et cliquer sur Créer une couche depuis la sélection.

• Sélectionnez ‘Enlever de la sélection actuelle’ dans le champ Et utiliser le résultat pour .

• Vous pouvez Zoom sur l’objet ou Enregistrer les messages.

• De plus, vous pouvez examiner les entités qui ont des erreurs de géométrie dans : ID de l’entité résultante
avec les options ‘Source invalide’ et ‘Référence invalide’. Ces entités ne sont pas utilisées dans la requête.

Figure 20.38: Analyse de requête spatiale - les régions contiennent des aéroports
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Figure 20.39: Extension Vérificateur de topologie

20.20 Extension Vérificateur de topologie

La topologie décrit les relations entre les points, lignes et polygones qui représentent des entités dans une région
géographique. Avec l’extension Vérificateur de topologie vous pouvez analyser vos couches vectorielles et leur
topologie en testant différentes règles de topologie. Ces règles permettent de vérifier les relations spatiales entre
entités, si elles ‘se superposent’, ‘se contiennent’, ‘se recouvrent’, ‘sont disjointes’, ‘se touchent’, etc. La règle à
vérifier dépend de votre problématique (par exemple, en temps normal, les lignes d’une même couche ne doivent
pas se terminer en croisant une autre ligne mais elles peuvent représenter des impasses et avoir un sens dans votre
couche).

QGIS dispose d’un outil d’édition topologique qui permet de créer de nouvelles entités sans erreur. Mais des
erreurs sur la géométrie de données existantes sont difficiles à identifier. Cette extension permet de les trouver en
établissant une liste de règles.

Il est très simple de créer des règles de topologie avec l’extension de vérification de topologie.

Sur les couches de points, les règles suivantes sont disponibles :

• doit être recouvert par : Ici, vous pouvez choisir une couche vecteur de votre projet. Chaque point non
couvert par la couche choisie est signalé comme ‘Erreur’.

• doivent être recouverts par les points terminaux : Ici, vous pouvez sélectionner un point d’une couche
de votre projet.

• doit être à l’intérieur : Ici, vous pouvez choisir une couche de polygone de votre projet. Chaque point doit
être contenu dans un des polygones de la couche. Sinon une ‘Erreur’ est signalée pour le point.

• ne doit pas avoir de doublons : Une ‘erreur’ est signalée à chaque fois qu’un point est présent plus d’une
fois.

• ne doit pas avoir de géométrie invalide : Vérifie si les géométries sont valides.

• ne doit pas avoir de géométrie multi-partie : Une ‘erreur’ est signalée à chaque fois qu’une entité est
multi-partie.
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Sur les couches de lignes, les règles suivantes sont disponibles :

• les points terminaux doivent être recouverts par : Ici, vous pouvez sélectionner une couche de points de
votre projet.

• ne doivent pas avoir de nœud isolé : Cela permet de voir les mauvaises connexions entre lignes d’une
même couche.

• ne doit pas avoir de doublons : Une ‘erreur’ est signalée à chaque fois qu’une ligne est présente plus d’une
fois.

• ne doit pas avoir de géométrie invalide : Vérifie si les géométries sont valides.

• ne doit pas avoir d’entité multi-parties : Parfois une entité correspond à une collection d’éléments
géométriques simples. Une telle géométrie est appelée multi-partie. S’il n’y a qu’un seul type de géométrie,
il s’agit de multi-points, polyligne ou multi-polygones. Toutes les entités composées de plusieurs lignes
sont signalées comme ‘Erreur’.

• ne doit pas avoir de pseudo-nœud : Le dernier sommet d’une ligne doit être connecté aux derniers sommets
de deux autres lignes. Si le dernier sommet n’est connecté qu’au sommet terminal d’une seule autre ligne,
il s’agit d’un peudo-nœud.

Sur les couches de polygones, les règles suivantes sont disponibles :

• doit contenir : Chacun des polygones de la couche doit contenir au moins un point d’une autre couche.

• ne doit pas avoir de doublons : Une ‘erreur’ est signalée à chaque fois qu’un polygone est présent plus
d’une fois.

• ne doit pas avoir de trou : Aucun trou ne doit être présent entre des polygones adjacents. Comme c’est
le cas par exemple pour des limites administratives (il n’y a pas de trous entre les polygones des départe-
ments...).

• ne doit pas avoir de géométrie invalide : Vérifie si les géométries sont valides. Les principales règles qui
définissent si la géométrie est valide sont :

– Les anneaux formant des trous dans des polygones doivent être fermés.

– Les anneaux formant des trous doivent être entièrement inclus dans des polygones.

– Les anneaux ne doivent pas s’intersecter (ni se toucher ni se croiser).

– Les anneaux ne doivent pas toucher d’autres anneaux, sauf en un unique sommet.

• ne doit pas avoir d’entité multi-parties : Parfois une entité correspond à une collection d’éléments
géométriques simples. Une telle géométrie est appelée multi-partie. S’il n’y a qu’un seul type de géométrie,
il s’agit de multi-points, polyligne ou multi-polygones. Par exemple, un pays constitué de plusieurs îles peut
être représenté par un multi-polygone.

• ne doit pas se superposer : Des polygones adjacents ne doivent pas présenter de partie commune.

• ne doit pas se superposer à : Chacun des polygones de la couche ne doit pas intersecter un seul des
polygones d’une autre couche.

20.21 Extension Statistiques de zone

Avec l’extension Statistiques de zone, il est possible d’analyser les résultats d’une classification thématique.
Elle vous permet de calculer la valeur des pixels d’une couche raster à partir d’une couche vectorielle de polygones
(voir figure figure_zonal_statistics). En choisissant une bande raster, l’extension génère les colonnes de résultats
dans la table de la couche vectorielle avec un préfixe personnalisé et calcule, pour chaque polygone, les statistiques
sur les pixels qu’ils contiennent. Les différentes méthodes statistiques disponibles sont :

• Compte : pour compter le nombre de pixels

• Somme : pour faire la somme des valeurs des pixels
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• Moyenne : pour faire la moyenne des valeurs de pixels

• Médiane : pour calculer la médiane des valeurs des pixels

• Ecart-type : pour calculer l’écart-type des valeurs des pixels

• Minimum : pour calculer la valeur minimale des valeurs des pixels

• Maximum : pour calculer la valeur maximale des valeurs des pixels

• Plage : pour calculer la plage de valeurs (max - min) des pixels

• Minorité : pour extraire la valeur de pixel la moins représentée

• Majorité : pour extraire la valeur de pixel la plus représentée

• Variété : pour compter le nombre de valeurs de pixel différentes

Figure 20.40: Fenêtre de l’extension Statistiques de zone
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CHAPTER 21

Aide et support

21.1 Listes de diffusion

QGIS est en cours de développement, par conséquent il ne fonctionne pas toujours comme prévu. La meilleure
manière d’obtenir de l’aide est de rejoindre la liste de diffusion qgis-users, vos questions toucheront une plus large
audience et les réponses profiteront à tous.

21.1.1 qgis-users

Cette liste est utilisée pour les discussions généralistes ainsi que pour des questions spécifiques en rapport avec
l’installation et l’utilisation de QGIS. Vous pouvez vous inscrire à la liste de diffusion qgis-users en allant sur la
page suivante : http://lists.osgeo.org/mailman/listinfo/qgis-user

21.1.2 fossgis-talk-liste

Pour les germanophones, le FOSSGIS e.V allemand met à disposition la liste fossgis-talk-liste pour discuter
des SIG libres de manière générale, QGIS inclus. Vous pouvez vous y inscrire en allant sur la page suivante :
https://lists.fossgis.de/mailman/listinfo/fossgis-talk-liste

21.1.3 qgis-developer

Si vous êtes un développeur et que vous êtes face à un problème plus technique, il est préférable de rejoindre la
liste de diffusion qgis-developer : http://lists.osgeo.org/mailman/listinfo/qgis-developer

21.1.4 qgis-ux

Une liste de diffusion dédiée où les gens peuvent discuter et commenter les questions liées à l’expérience utilisateur
dans QGIS (QGIS UX).

http://lists.osgeo.org/mailman/listinfo/qgis-ux

21.1.5 qgis-commit

À chaque fois qu’un commit est réalisé sur le dépôt du code de QGIS un email est envoyé à cette liste. Si
vous voulez être à jour de chaque changement au code en cours, vous pouvez vous inscrire à cette liste :
http://lists.osgeo.org/mailman/listinfo/qgis-commit
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21.1.6 qgis-trac

Cette liste envoie une notification par courriel liée à la gestion du projet, incluant les rapports de bugs, tâches et de-
mandes de fonctionnalités. Vous pouvez vous inscrire à cette liste ici : http://lists.osgeo.org/mailman/listinfo/qgis-
trac

21.1.7 qgis-community-team

Cette liste reçoit les courriels des thématiques liés à la documentation, aux aides contextuelles, au guide util-
isateur, aux listes de diffusion, forums et efforts de traduction. Si vous voulez travailler sur le guide utilisateur,
cette liste est un bon point de départ pour poser vos questions. Vous pouvez vous inscrire à cette liste ici :
http://lists.osgeo.org/mailman/listinfo/qgis-community-team

21.1.8 qgis-release-team

Cette liste reçoit les courriels concernant les procédures de publication de versions, paquetages binaires pour
différents systèmes d’exploitation et annonce les nouvelles versions à une plus large audience. Vous pouvez vous
inscrire à cette liste ici : http://lists.osgeo.org/mailman/listinfo/qgis-release-team

21.1.9 qgis-tr

Cette liste se concentre sur l’effort de traduction. Si vous voulez travailler à la traduction du site web,
du manuel ou de l’interface, c’est un bon point de départ. Vous pouvez vous inscrire à cette liste ici :
http://lists.osgeo.org/mailman/listinfo/qgis-tr

21.1.10 qgis-edu

Cette liste regroupe les travaux concernant l’apprentissage de QGIS (formations, cours). Vous pouvez vous inscrire
à cette liste ici : http://lists.osgeo.org/mailman/listinfo/qgis-edu

21.1.11 qgis-psc

Cette liste est utilisée pour les discussions du Steering Committee concernant la gestion générale et
la direction du projet QGIS. Vous pouvez vous inscrire à cette liste de diffusion en allant sur :
http://lists.osgeo.org/mailman/listinfo/qgis-psc

Vous êtes le bienvenue sur chacune de ces listes. Contribuez à la liste en répondant à des questions et en partageant
vos expériences. Remarquez que les listes qgis-commit et qgis-trac ont été configurées pour notification seulement
et n’acceptent pas d’email d’utilisateurs.

21.2 IRC

Nous maintenons une présence sur IRC - rejoignez-nous sur le canal #qgis sur irc.freenode.net. Faites preuve de
patience avant d’obtenir une réponse puisque la plupart des personnes font autre chose et cela peut leur prendre
un peu de temps avant de remarquer votre question. Si vous avez raté une discussion sur IRC, pas de soucis, nous
archivons tous les échanges ! Rendez-vous sur http://qgis.org/irclogs pour lire les logs IRC.

Un support commercial pour QGIS est disponible. Regardez la page du site http://qgis.org/en/commercial-
support.html pour plus d’informations.
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21.3 BugTracker

Bien que la liste de diffusion utilisateur est utile pour des questions générales du type ‘Comment je fais ceci et
cela dans QGIS ?’, vous pouvez vouloir nous avertir de bugs dans QGIS. Vous pouvez soumettre un rapport de
bug en utilisant le suivi de bug sur http://hub.qgis.org/projects/quantum-gis/issues. Lors de la création d’un ticket
pour un bug, veillez à fournir une adresse email valide via laquelle nous pouvons vous demander des informations
supplémentaires.

Garder en mémoire que votre bug peut ne pas avoir la priorité à laquelle vous vous attendiez (cela dépendra de sa
sévérité). Certains bugs peuvent nécessiter du travail supplémentaire de la part des développeurs pour y remédier
et la personne compétente n’est pas forcément disponible.

Les demandes de fonctionnalités supplémentaires peuvent être soumises également en utilisant le même système
de ticket que pour les bugs. Assurez-vous de sélectionner le type Feature.

Si vous avez trouvé un bug et l’avez corrigé vous même, vous pouvez soumettre une Pull Request sur le dépôt
GitHub du projet QGIS (option préférée) ou un patch. Encore une fois, le système de ticket redmine sur
http://hub.qgis.org/projects/quantum-gis/issues dispose de cette fonctionnalité. Cochez Patch supplied dans
le formulaire et joignez votre patch avant de soumettre le rapport. Un des développeurs le vérifiera et l’appliquera
à QGIS. Ne vous alarmez pas si votre correctif n’est pas appliqué directement – les développeurs peuvent être
occupés sur d’autres tâches.

Notez que si vous soumettez une Pull Request, votre modification a plus de chances d’être rapidement intégrée
dans le code source!

21.4 Blog

La communauté QGIS tient également un blog sur http://planet.qgis.org/planet/ qui publie d’intéressants articles
à la fois pour les utilisateurs et les développeurs. Vos contributions sont les bienvenues !

21.5 Extensions

Le site internet http://plugins.qgis.org sert de portail officiel pour les extensions QGIS. Il liste les extensions
officielles, stables et expérimentales, de QGIS disponibles depuis le dépôt ‘Official QGIS Plugin Repository’.

21.6 Wiki

Enfin, nous maintenons un site web wiki sur http://hub.qgis.org/projects/quantum-gis/wiki où vous pouvez trou-
ver diverses informations utiles liées au développement de QGIS, planning des versions, liens vers les sites de
téléchargement, astuces de traduction des messages et bien plus. Parcourez le, on y trouve mille choses intéres-
santes !
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CHAPTER 22

Annexe

22.1 licence GNU General Public License

Version 2, Juin 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place - Suite 330, Boston, MA 02111-1307,
USA

La copie et la distribution de copies exactes de ce document sont autorisées, mais aucune modification n’est
permise.

Préambule

Les licences d’utilisation de la plupart des programmes sont définies pour limiter ou supprimer toute liberté à
l’utilisateur. À l’inverse, la GNU General Public License est destinée à vous garantir la liberté de partager et de
modifier les logiciels libres, et de s’assurer que ces logiciels sont effectivement accessibles à tout utilisateur. Cette
Licence Publique Générale s’applique à la plupart des programmes de la Free Software Foundation, comme à
tout autre programme dont l’auteur l’aura décidé (d’autres logiciels de la FSF sont couverts pour leur part par la
Licence Publique Générale pour Bibliothèques GNU (LGPL)). Vous pouvez aussi appliquer les termes de cette
Licence à vos propres programmes, si vous le désirez.

Liberté des logiciels ne signifie pas nécessairement gratuité. Notre Licence est conçue pour vous assurer la liberté
de distribuer des copies des programmes, gratuitement ou non, de recevoir le code source ou de pouvoir l’obtenir,
de modifier les programmes ou d’en utiliser des éléments dans de nouveaux programmes libres, en sachant que
vous y êtes autorisé.

Afin de garantir ces droits, nous avons dû introduire des restrictions interdisant à quiconque de vous les refuser ou
de vous demander d’y renoncer. Ces restrictions vous imposent en retour certaines obligations si vous distribuez
ou modifiez des copies de programmes protégés par la Licence.

Par exemple, si vous distribuez des copies de ce programme, soit gratuitement, soit contre une certaine somme
d’argent, vous devez transmettre aux destinataires tous les droits que vous possédez. Vous devez vous assurer
d’expédier aux destinataires le code source ou bien tenir celui-ci à leur disposition. Enfin, vous devez leur remettre
cette Licence afin qu’ils prennent connaissance de leurs droits.

Nous protégeons vos droits de deux façons : d’abord par le copyright du logiciel, ensuite par la remise de cette
Licence qui vous autorise légalement à copier, distribuer et/ou modifier le logiciel.

En outre, pour protéger chaque auteur ainsi que la FSF, nous affirmons solennellement que le programme concerné
ne fait l’objet d’aucune garantie. Si un tiers le modifie puis le redistribue, tous ceux qui en recevront une copie
doivent savoir qu’il ne s’agit pas de l’original afin qu’une copie défectueuse n’entache pas la réputation de l’auteur
du logiciel.

Enfin, tout programme libre est sans cesse menacé par des dépôts de brevets. Nous souhaitons à tout prix éviter
que des distributeurs puissent déposer des brevets sur les Logiciels Libres pour leur propre compte. Pour éviter
cela, nous stipulons bien que tout dépôt éventuel de brevet doit accorder expressément à tout un chacun le libre
usage du produit.
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Les dispositions précises et les conditions de copie, de distribution et de modification de nos logiciels sont les
suivantes : STIPULATIONS ET CONDITIONS RELATIVES A LA COPIE, LA DISTRIBUTION ET LA MOD-
IFICATION

0. La présente Licence s’applique à tout Programme (ou autre travail) où figure une note, placée par le déten-
teur des droits, stipulant que ledit Programme ou travail peut être distribué selon les termes de la présente
Licence. Le terme Programme désigne aussi bien le Programme lui-même que tout travail qui en est dérivé
selon la loi, c’est-à-dire tout ouvrage reproduisant le Programme ou une partie de celui-ci, à l’identique ou
bien modifié, et/ou traduit dans une autre langue (la traduction est considérée comme une modification).
Chaque personne concernée par la Licence Publique Générale sera désignée par le terme Vous.

Les activités autres que copie, distribution et modification ne sont pas couvertes par la présente Licence et
sortent de son cadre. Rien ne restreint l’utilisation du Programme et les données issues de celui-ci ne sont
couvertes que si leur contenu constitue un travail basé sur le logiciel (indépendemment du fait d’avoir été
réalisé en lançant le Programme). Tout dépend de ce que le Programme est censé produire.

1. Vous pouvez copier et distribuer des copies conformes du code source du Programme, tel que Vous l’avez
reçu, sur n’importe quel support, à condition de placer sur chaque copie un copyright approprié et une
restriction de garantie, de ne pas modifier ou omettre toutes les stipulations se référant à la présente Licence
et à la limitation de garantie, et de fournir avec toute copie du Programme un exemplaire de la Licence.

Vous pouvez demander une rétribution financière pour la réalisation de la copie et demeurez libre de pro-
poser une garantie assurée par vos soins, moyennant finances.

2. Vous pouvez modifier votre copie ou vos copies du Programme ou partie de celui-ci, ou d’un travail basé
sur ce Programme, et copier et distribuer ces modifications selon les termes de l’article 1, à condition de
Vous conformer également aux conditions suivantes :

(a) Ajouter aux fichiers modifiés l’indication très claire des modifications effectuées, ainsi que la date de
chaque changement.

(b) Distribuer sous les termes de la Licence Publique Générale l’ensemble de toute réalisation contenant
tout ou partie du Programme, avec ou sans modifications.

(c) Si le Programme modifié lit des commandes de manière interactive lors de son exécution, faire en
sorte qu’il affiche, lors d’une invocation ordinaire, le copyright approprié en indiquant clairement la
limitation de garantie (ou la garantie que Vous Vous engagez à fournir Vous-même), qu’il stipule que
tout utilisateur peut librement redistribuer le Programme selon les conditions de la Licence Publique
Générale GNU, et qu’il montre à tout utilisateur comment lire une copie de celle-ci (exception : si
le Programme original est interactif mais n’affiche pas un tel message en temps normal, tout travail
dérivé de ce Programme ne sera pas non plus contraint de l’afficher).

Toutes ces conditions s’appliquent à l’ensemble des modifications. Si des éléments identifiables de ce travail
ne sont pas dérivés du Programme et peuvent être raisonnablement considérés comme indépendants, la
présente Licence ne s’applique pas à ces éléments lorsque Vous les distribuez seuls. Mais, si Vous distribuez
ces mêmes éléments comme partie d’un ensemble cohérent dont le reste est basé sur un Programme soumis
à la Licence, ils lui sont également soumis, et la Licence s’étend ainsi à l’ensemble du produit, quel qu’en
soit l’auteur.

Cet article n’a pas pour but de s’approprier ou de contester vos droits sur un travail entièrement réalisé par
Vous, mais plutôt d’ouvrir droit à un contrôle de la libre distribution de tout travail dérivé ou collectif basé
sur le Programme.

En outre, toute fusion d’un autre travail, non basé sur le Programme, avec le Programme (ou avec un travail
dérivé de ce dernier), effectuée sur un support de stockage ou de distribution, ne fait pas tomber cet autre
travail sous le contrôle de la Licence.

3. Vous pouvez copier et distribuer le Programme (ou tout travail dérivé selon les conditions énoncées dans
l’article 1) sous forme de code objet ou exécutable, selon les termes des articles 0 et 1, à condition de
respecter l’une des clauses suivantes :

(a) Fournir le code source complet du Programme, sous une forme lisible par un ordinateur et selon les
termes des articles 0 et 1, sur un support habituellement utilisé pour l’échange de données ; ou,
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(b) Faire une offre écrite, valable pendant au moins trois ans, prévoyant de donner à tout tiers qui en fera
la demande une copie, sous forme lisible par un ordinateur, du code source correspondant, pour un
tarif n’excédant pas le coût de la copie, selon les termes des articles 0 et 1, sur un support couramment
utilisé pour l’échange de données informatiques ; ou,

(c) Informer le destinataire de l’endroit où le code source peut être obtenu (cette solution n’est recevable
que dans le cas d’une distribution non commerciale, et uniquement si Vous avez reçu le Programme
sous forme de code objet ou exécutable avec l’offre prévue à l’alinéa b ci-dessus).

Le code source d’un travail désigne la forme de cet ouvrage sous laquelle les modifications sont les plus
aisées. Sont ainsi désignés la totalité du code source de tous les modules composant un Programme exé-
cutable, de même que tout fichier de définition associé, ainsi que les scripts utilisés pour effectuer la com-
pilation et l’installation du Programme exécutable. Toutefois, l’environnement standard de développement
du système d’exploitation mis en oeuvre (source ou binaire) – compilateurs, bibliothèques, noyau, etc. –
constitue une exception, sauf si ces éléments sont diffusés en même temps que le Programme exécutable.

Si la distribution de l’exécutable ou du code objet consiste à offrir un accès permettant de copier le Pro-
gramme depuis un endroit particulier, l’offre d’un accès équivalent pour se procurer le code source au
même endroit est considéré comme une distribution de ce code source, même si l’utilisateur choisit de ne
pas profiter de cette offre.

4. Vous ne pouvez pas copier, modifier, céder, déposer ou distribuer le Programme d’une autre manière que
l’autorise la Licence Publique Générale. Toute tentative de ce type annule immédiatement vos droits
d’utilisation du Programme sous cette Licence. Toutefois, les tiers ayant reçu de Vous des copies du Pro-
gramme ou le droit d’utiliser ces copies continueront à bénéficier de leur droit d’utilisation tant qu’ils re-
specteront pleinement les conditions de la Licence.

5. Ne l’ayant pas signée, Vous n’êtes pas obligé d’accepter cette Licence. Cependant, rien d’autre ne Vous
autorise à modifier ou distribuer le Programme ou quelque travaux dérivés : la loi l’interdit tant que Vous
n’acceptez pas les termes de cette Licence. En conséquence, en modifiant ou en distribuant le Programme
(ou tout travail basé sur lui), Vous acceptez implicitement tous les termes et conditions de cette Licence.

6. La diffusion d’un Programme (ou de tout travail dérivé) suppose l’envoi simultané d’une licence autorisant
la copie, la distribution ou la modification du Programme, aux termes et conditions de la Licence. Vous
n’avez pas le droit d’imposer de restrictions supplémentaires aux droits transmis au destinataire. Vous
n’êtes pas responsable du respect de la Licence par un tiers.

7. Si, à la suite d’une décision de Justice, d’une plainte en contrefaçon ou pour toute autre raison (liée ou non
à la contrefaçon), des conditions Vous sont imposées (que ce soit par ordonnance, accord amiable ou autre)
qui se révèlent incompatibles avec les termes de la présente Licence, Vous n’êtes pas pour autant dégagé des
obligations liées à celle-ci : si Vous ne pouvez concilier vos obligations légales ou autres avec les conditions
de cette Licence, Vous ne devez pas distribuer le Programme.

Si une partie quelconque de cet article est invalidée ou inapplicable pour quelque raison que ce soit, le reste
de l’article continue de s’appliquer et l’intégralité de l’article s’appliquera en toute autre circonstance.

Le présent article n’a pas pour but de Vous pousser à enfreindre des droits ou des dispositions légales ni en
contester la validité ; son seul objectif est de protéger l’intégrité du système de distribution du Logiciel Libre.
De nombreuses personnes ont généreusement contribué à la large gamme de Programmes distribuée de cette
façon en toute confiance ; il appartient à chaque auteur/donateur de décider de diffuser ses Programmes selon
les critères de son choix.

Cette section a pour but de rendre totalement limpide ce que l’on pense être une conséquence du reste de la
présente Licence.

8. Si la distribution et/ou l’utilisation du Programme est limitée dans certains pays par des brevets ou des
droits sur des interfaces, le détenteur original des droits qui place le Programme sous la Licence Publique
Générale peut ajouter explicitement une clause de limitation géographique excluant ces pays. Dans ce cas,
cette clause devient une partie intégrante de la Licence.

9. La Free Software Foundation se réserve le droit de publier périodiquement des mises à jour ou de nou-
velles versions de la Licence. Rédigées dans le même esprit que la présente version, elles seront cependant
susceptibles d’en modifier certains détails à mesure que de nouveaux problèmes se font jour.
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Chaque version possède un numéro distinct. Si le Programme précise un numéro de version de cette Licence
et « toute version ultérieure », Vous avez le choix de suivre les termes et conditions de cette version ou de
toute autre version plus récente publiée par la Free Software Foundation. Si le Programme ne spécifie aucun
numéro de version, Vous pouvez alors choisir l’une quelconque des versions publiées par la Free Software
Foundation.

10. Si vous désirez incorporer des éléments du Programme dans d’autres Programmes libres dont les conditions
de distribution diffèrent, vous devez écrire à l’auteur pour lui en demander la permission. Pour ce qui est des
programmes directement déposés par la Free Software Foundation, écrivez-nous : une exception est toujours
envisageable. Notre décision sera basée sur notre volonté de préserver la liberté de notre Programme ou de
ses dérivés et celle de promouvoir le partage et la réutilisation du logiciel en général.

LIMITATION DE GARANTIE

11. Parce que l’utilisation de ce Programme est libre et gratuite, aucune garantie n’est fournie, comme le permet
la loi. Sauf mention écrite, les détenteurs du copyright et/ou les tiers fournissent le Programme en l’état, sans
aucune sorte de garantie explicite ou implicite, y compris les garanties de commercialisation ou d’adaptation
dans un but particulier. Vous assumez tous les risques quant à la qualité et aux effets du Programme. Si le
Programme est défectueux, Vous assumez le coût de tous les services, corrections ou réparations nécessaires.

12. Sauf lorsqu’explicitement prévu par la Loi ou accepté par écrit, ni le détenteur des droits, ni quiconque
autorisé à modifier et/ou redistribuer le Programme comme il est permis ci-dessus ne pourra être tenu pour
responsable de tout dommage direct, indirect, secondaire ou accessoire (pertes financières dues au manque
à gagner, à l’interruption d’activités ou à la perte de données, etc., découlant de l’utilisation du Programme
ou de l’impossibilité d’utiliser celui-ci).

Exception Qt à la GPL pour QGIS

De plus, l’équipe de développement de QGIS vous donne la permission, à titre d’exception spéciale, de lier le
code de ce programme avec la bibliothèque Qt, incluant sans limite les versions suivantes (à la fois libres et
commerciales): Qt/Non-commerical Windows, Qt/Windows, Qt/X11, Qt/Mac, and Qt/Embedded (ou avec des
versions modifiées de Qt qui utilisent la même licence que Qt) et de distribuer des combinaisons liées incluant les
deux. Vous devez respecter la GNU General Public Licence pour tout le code qui ne concerne pas Qt. Si vous
modifiez ce fichier, vous pouvez étendre cette exception à votre version de ce fichier mais vous n’êtes pas obligé
de le faire. Si vous ne voulez pas le faire, supprimez cette déclaration d’exception de votre version.

22.2 Licence GNU de documentation libre

Version 1.3, 3 Novembre 2008

Copyright 2000, 2001, 2002, 2007, 2008 Free Software Foundation, Inc

http://fsf.org/

Tout le monde est autorisé à copier et redistribuer à l’identique le texte de cette licence, mais le modifier n’est pas
autorisé.

Préambule

Le but de cette Licence est de rendre un manuel, un livre, ou un autre document fonctionnel et utile “libre” :
d’assurer à tout le monde la liberté effective de le copier et de le redistribuer, en le modifiant ou non, commer-
cialement ou bénévolement. Accessoirement, cette Licence donne la possibilité à l’auteur et à l’éditeur d’être
crédités de leur travail, sans être considérés comme responsables des modifications faites par d’autres.

Cette Licence est une sorte de “gauche d’auteur” (“copyleft”), ce qui signifie que les œuvres dérivées du document
doivent elles aussi être libres. Elle est le complément de la licence publique générale GNU, qui est une licence de
type gauche d’auteur conçue pour les logiciels libres.

Nous avons conçu cette Licence pour l’utiliser dans les manuels de logiciel libre, parce que les logiciels libres
nécessitent de la documentation libre : un programme libre doit être fourni avec des manuels assurant des libertés
identiques à celles qu’assure le logiciel. Mais cette Licence n’est pas limitée aux manuels de logiciels ; elle peut
être utilisée pour n’importe quelle œuvre textuelle, quel que soit le sujet traité, que cette œuvre soit publiée en tant
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que livre imprimé, ou non. Nous recommandons cette Licence principalement pour les œuvres à but éducatif ou
pour les manuels de référence.

1. APPLICABILITÉ ET DÉFINITIONS

Cette Licence s’applique à tout manuel ou autre œuvre, sur n’importe quel support, qui contient une mention,
placée par le détenteur des droits d’auteur, disant que le manuel ou l’œuvre peut être distribuée selon les termes
de cette Licence. Une telle mention accorde une autorisation valable dans le monde entier, gratuite, sans limite
de durée, d’utiliser l’œuvre selon les conditions établies ici. Le terme “Document”, utilisé ci-après désigne tout
manuel ou œuvre contenant une telle mention. Tout membre du public est un licencié, et est désigné par “vous”.
Vous acceptez la licence si vous copiez, modifiez ou distribuez l’œuvre d’une façon qui requiert une permission
selon la loi sur le droit d’auteur.

Une “Version Modifiée” du Document désigne toute œuvre contenant le Document ou une portion du Document,
copié à l’identique, ou copié avec des modifications ou traduit dans une autre langue.

Une “Section Secondaire” est une annexe portant un nom spécifique ou une section préliminaire du Document
qui traite exclusivement de la relation des éditeurs ou des auteurs du Document au thème général du Document
(ou à des thèmes liés) et ne contient rien qui pourrait relever directement de ce thème général. (Ainsi, si le
Document est en partie un manuel de mathématiques, une Section Secondaire ne peut donner aucune explication
en mathématiques.) La relation peut être une connexion historique avec le sujet ou avec des sujets liés, ou elle
peut être un point de vue juridique, commercial, philosophique, éthique ou politique sur ces sujets.

Les “Sections Invariantes” sont certaines Sections Secondaires, dont les titres sont désignés comme étant des
Sections Invariantes dans la mention disant que le Document est publié selon les termes de cette Licence. Si
une section ne correspond pas à la définition de Section Secondaire établie ci-dessus, alors il n’est pas permis de
la désigner comme Invariante. Le Document peut contenir zéro Section Invariante. Si le Document n’identifie
aucune Section Invariante, alors il n’y en a aucune.

Les “Textes De Couverture” sont certains courts passages de texte qui sont mentionnés comme Textes De Pre-
mière De Couverture ou Textes De Quatrième De Couverture dans la mention disant que le Document est publié
selon les termes de cette Licence. Un Texte De Première De Couverture peut contenir 5 mots au maximum, et un
Texte De Quatrième De Couverture peut contenir 25 mots au maximum.

Une copie “Transparente” du Document désigne une copie lisible par une machine, représentée dans un format
dont les spécifications sont disponibles pour le grand public, qui permet de corriger facilement le document avec
des éditeurs de texte génériques ou (pour les images composées de pixels) avec des éditeurs d’image génériques
ou (pour les dessins) avec des éditeurs de dessin largement disponibles, et qui est approprié pour servir de données
d’entrée aux formateurs de texte ou pour être traduit automatiquement dans une variété de formats appropriés
pour servir de données d’entrée aux formateurs de texte. Une copie faite dans un format de fichier par ailleurs
Transparent, mais dont le marquage, ou l’absence de marquage, a été conçu de façon à empêcher ou décourager les
lecteurs de faire des modifications ultérieurement n’est pas Transparente. Un format d’image n’est pas Transparent
s’il est utilisé pour afficher toute quantité substantielle de texte. Une copie qui n’est pas “Transparente” est appelée
“Opaque”.

Voici des exemples de formats appropriés pour faire des copies Transparentes : du texte brut ASCII sans marquage
; le format d’entrée de Texinfo ; le format d’entrée de LaTeX ; le format SGML ou XML en utilisant une DTD
disponible publiquement ; du HTML simple et conforme aux standards ; du PostScript ou du PDF conçu pour
être modifié par des humains. Voici des exemple de formats d’image transparents : PNG, XCF et JPG. Voici des
exemples de formats opaques : les formats privateurs qui ne peuvent être lus et modifiés que par des logiciels
de traitement de texte privateurs ; du SGML ou du XML dont la DTD ou les outils de traitement ne sont pas
largement disponibles ; le HTML généré par une machine ; du PostScript ou du PDF produit par un logiciel de
traitement de texte dans un but d’affichage seulement.

La “Page De Titre” désigne, pour un livre imprimé, la page de titre elle-même, plus les pages suivantes nécessaires
pour contenir, lisiblement, les mentions que cette Licence oblige à inscrire dans la page de titre. Pour les œuvres
dont le format ne possède pas de page de titre en tant que telle, “Page De Titre” désigne le texte placé à côté de
l’inscription la plus en vue du titre de l’œuvre, qui précède le début du corps du texte.

L’ “éditeur” désigne toute personne ou entité qui distribue des copies du Document au public.

Une section “Intitulée XYZ” désigne soit une sous-unité du Document dont le titre est exactement XYZ, soit une
sous-unité du Document dont le titre contient XYZ entre parenthèses après le texte traduisant XYZ dans une autre
langue. (Ici XYZ représente un nom de section spécifique mentionné ci-après, tel que “Acknowledgements”

22.2. Licence GNU de documentation libre 415



QGIS User Guide, Version 2.14

[Remerciements], “Dedications” [Dédicaces], “Endorsements” [Approbations], ou “History” [Historique]).
“Conserver le Titre” d’une telle section, quand vous modifiez le Document, signifie que cette section reste une
section “Intitulée XYZ” selon la présente définition.

Le Document peut inclure des Mentions De Limitation De Garantie à côté de la mention indiquant que cette
Licence s’applique au Document. Ces Mentions De Limitation De Garantie sont considérées comme incluses
par référence dans cette Licence, mais elles ne peuvent que limiter des garanties : toute autre implication que
ces Mentions De Limitation De Garantie pourraient avoir est nulle et n’a aucun effet sur la signification de cette
Licence.

2. COPIE À L’IDENTIQUE

Vous pouvez copier et distribuer le Document sur tout support, commercialement ou bénévolement, à condition
que cette Licence, les mentions de droit d’auteur, et la mention disant que cette Licence s’applique au Document
soient reproduites dans toutes les copies, et que vous n’ajoutiez absolument aucune autre condition aux conditions
de cette Licence. Vous ne pouvez pas utiliser de mesures techniques pour entraver ou contrôler la lecture ou la
copie des copies que vous faites ou distribuez. Toutefois, vous pouvez accepter une rémunération en échange de
copies. Si vous distribuez un nombre de copies suffisamment important, vous devez aussi vous conformer aux
conditions de la section 3.

Vous pouvez aussi prêter des copies, selon les mêmes conditions que ci-dessus, et vous pouvez afficher publique-
ment des copies.

3. COPIE EN GRANDE QUANTITÉ

Si vous publiez plus de 100 copies imprimées (ou 100 copies dans un média qui a communément une couverture
imprimée) du Document, et que la mention de licence du Document indique qu’il y a des Textes De Couverture,
vous devez insérer chaque copie dans une couverture qui porte, clairement et lisiblement, tous ces Textes De
Couverture : les Textes De Première De Couverture sur la première de couverture, et les Textes De Quatrième De
Couverture sur la quatrième de couverture. Ces deux pages de couvertures doivent aussi vous identifier clairement
et lisiblement comme l’éditeur de ces copies. La première de couverture doit présenter le titre complet, et tous
les mots du titre doivent avoir la même importance et la même visibilité. Vous pouvez ajouter d’autres choses
en supplément sur la couverture. Faire des copies avec des changements uniquement sur la couverture, tant que
les copies conservent le titre du Document et satisfont ces conditions, est considéré comme faire des copies à
l’identique.

Si les textes requis pour l’une ou l’autre des pages de couverture sont trop volumineux pour y figurer lisiblement,
vous devez mettre les premiers de la liste (autant qu’il est possible d’en mettre de façon lisible) sur la page de
couverture elle-même, et mettre le reste sur les pages adjacentes.

Si vous publiez ou distribuez plus de 100 copies Opaques du Document, vous devez soit inclure une copie Trans-
parente et lisible par une machine avec chaque copie Opaque, soit indiquer dans chaque copie Opaque (ou dans
une notice accompagnant chaque copie opaque) un emplacement sur le réseau informatique à partir duquel le
grand public utilisant le réseau peut accéder au téléchargement, en utilisant des protocoles réseau publics et stan-
dards, d’une copie complète et Transparente du Document, sans aucun ajout. Si vous utilisez cette dernière option,
vous devez prendre des précautions raisonnablement prudentes, quand vous commencez la distribution de copies
Opaques en grande quantité, pour garantir que cette copie Transparente restera accessible par les moyens et à
l’emplacement indiqués pendant au moins un an après la dernière distribution de copie Opaque (directement ou
par l’intermédiaire de vos agents ou de vos revendeurs au détail) de cette édition au public.

Il est demandé, sans que cela soit une obligation, que vous contactiez les auteurs du Document bien avant de
redistribuer tout nombre important de copies, pour leur donner une chance de vous fournir une version mise à jour
du Document.

4. MODIFICATIONS

Vous pouvez copier et distribuer une Version Modifiée du Document selon les conditions des sections 2 et 3 ci-
dessus, à condition que vous accordiez le droit à tous ceux à qui vous distribuez la Version Modifiée de copier
et de distribuer la Version Modifiée selon les termes de cette Licence, avec la Version Modifiée jouant le rôle
du Document, autorisant ainsi la distribution et la modification de la Version Modifiée à toute personne qui en
possède une copie. De plus, vous devez faire les choses suivantes dans la Version Modifiée :

1. Utiliser dans la Page De Titre (et sur la couverture, s’il y en a) un titre distinct de celui du Document et
de ceux des précédentes versions (qui devraient, s’il y en a, être énumérées dans la section History de ce
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Document). Vous pouvez utiliser le même titre que celui d’une version précédente si l’éditeur original de
cette version vous en donne la permission.

2. Citer sur la Page De Titre, en tant qu’auteurs, une ou plusieurs personnes ou entités responsables des modi-
fications faites dans la Version Modifiée, ainsi qu’au moins cinq des auteurs principaux du Document (tous
les auteurs principaux, s’il y en a moins de cinq), sauf s’ils vous dispensent de cette obligation.

3. Spécifier sur la Page de titre le nom de l’éditeur de la Version Modifiée, en précisant que c’est lui l’éditeur.

4. Conserver toutes les mentions de droit d’auteur du Document.

5. Ajouter une mention appropriée indiquant vos droits d’auteur pour les modifications que vous avez faites ;
cette mention doit être adjacente aux autres mentions de droit d’auteur.

6. Inclure, immédiatement après les mentions de droit d’auteur, une mention de licence donnant la permission
au public d’utiliser la Version Modifiée selon les termes de cette Licence, en respectant la forme indiquée
dans la section Addendum ci-dessous.

7. Conserver dans cette mention de licence les listes complètes des Sections Invariantes et des Textes De
Couverture inscrites dans la mention de licence du Document.

8. Inclure une copie non modifiée de cette Licence.

9. Conserver la section Intitulée “History”, Conserver son Titre, et ajouter à cette section un paragraphe indi-
quant au minimum le titre, l’année, les nouveaux auteurs, et l’éditeur de la Version Modifiée comme cela
est fait sur la Page De Titre. S’il n’y a pas de section Intitulée “History” dans le Document, en créer une qui
indique le titre, l’année, les auteurs, et l’éditeur du Document comme cela est fait sur la Page De Titre, et
ensuite ajouter un paragraphe décrivant la Version Modifiée comme indiqué dans la phrase précédente.

10. Conserver l’indication d’emplacement sur le réseau, s’il y en a une, donnée dans le Document pour
l’accès public à une copie Transparente du Document, et Conserver de la même manière les indications
d’emplacement sur le réseau données dans le Document pour les versions précédentes sur lesquelles il
est basé. Celles-ci peuvent être placées dans la section “History”. Vous pouvez omettre une indication
d’emplacement sur le réseau pour une œuvre qui a été publiée au moins quatre ans avant le Document
lui-même, ou si l’éditeur original de la version à laquelle elle réfère vous en donne la permission.

11. Pour toute section Intitulée “Acknowledgements” ou “Dedications”, Conserver le Titre de la section et, à
l’intérieur de la section, toute la substance et le ton de chacun des remerciements aux contributeurs ou de
chacune des dédicaces qui y figure.

12. Conserver toutes les Sections Invariantes du Document, non modifiées dans leurs textes et dans leurs titres.
Les numéros de sections ou leurs équivalents ne sont pas considérés comme faisant partie des titres de
section.

13. Supprimer toute section Intitulée “Endorsements”. Une telle section ne peut pas être incluse dans la Version
Modifiée.

14. Ne pas modifier le titre d’une section existante en lui donnant le titre “Endorsements” ou en lui donnant un
titre qui entre en conflit avec le titre d’une Section Invariante.

15. Conserver toute Mention De Limitation De Garantie.

Si la Version Modifiée inclut de nouvelles sections préliminaires ou de nouvelles annexes qui répondent à la
définition de Sections Secondaires et ne contiennent rien qui soit copié du Document, vous pouvez si vous le
souhaitez désigner certaines ou toutes ces sections comme invariantes. Pour faire cela, ajoutez leurs titres à la liste
des Sections Invariantes dans la mention de licence de la Version Modifiée. Ces titres doivent être distincts de tout
autre titre de section.

Vous pouvez ajouter une section Intitulée “Endorsements”, à condition qu’elle ne contienne que des marques de
soutien pour votre Version Modifiée faites par d’autres parties—par exemple, des déclarations d’évaluation par les
pairs ou des déclarations stipulant que votre texte a été approuvé par une organisation comme définition officielle
d’un standard.

Vous pouvez ajouter un passage de cinq mots au maximum comme Texte De Première De Couverture, et un
passage de 25 mots au maximum comme Texte De Quatrième De Couverture, à la fin de la liste des Textes De
Couverture dans la Version Modifiée. Un seul passage de Texte De Première De Couverture et un seul passage
de Texte De Quatrième De Couverture peut être ajouté par (ou par l’intermédiaire d’arrangements faits par) une
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même entité. Si le Document inclut déjà un texte pour la même page de couverture, précédemment ajouté par
vous ou par arrangement fait par la même entité que celle au nom de laquelle vous agissez, vous ne pouvez pas
en ajouter d’autre ; mais vous pouvez remplacer l’ancien à condition que l’éditeur précédent ayant placé l’ancien
texte vous en donne la permission explicite.

Par cette Licence, l’auteur (ou les auteurs) et l’éditeur (ou les éditeurs) du Document ne donnent pas la permission
d’utiliser leurs noms pour un usage publicitaire ou pour exprimer explicitement ou implicitement leur soutien à
une Version Modifiée.

5. COMBINAISON DE DOCUMENTS

Vous pouvez combiner le Document avec d’autres documents publiés selon les termes de cette Licence, à condition
de respecter les termes définis dans la section 4 ci-dessus pour les Versions Modifiées, et à condition que vous
incluiez dans la combinaison toutes les Sections Invariantes de tous les documents originaux, non modifiées, et
que vous les énumériez toutes comme Sections Invariantes de votre œuvre combinée dans sa mention de licence,
et que de plus vous conserviez toutes les Mentions De Limitation De Garantie de tous les documents originaux.

L’œuvre combinée n’a besoin de contenir qu’une seule copie de cette Licence, et de multiples Sections Invariantes
identiques peuvent être remplacées par une seule d’entre elles. S’il y a plusieurs Sections Invariantes avec le même
nom mais avec des contenus différents, rendez unique le titre de chaque section en question en ajoutant à la fin de
celui-ci, entre parenthèses, le nom de l’auteur ou de l’éditeur original de cette section s’il est connu, ou, à défaut,
un nombre unique. Faites le même ajustement aux titres de section dans la liste des Sections Invariantes figurant
dans la mention de licence de l’œuvre combinée.

Dans la combinaison, vous devez combiner toutes les sections Intitulées “History” de tous les documents orig-
inaux, en formant une unique section Intitulée “History” ; de la même manière, combinez toutes les sections
Intitulées “Acknowledgements”, puis toutes les sections Intitulées “Dedications”. Vous devez supprimer toutes les
sections Intitulées “Endorsements”.

6. COLLECTIONS DE DOCUMENTS

Vous pouvez faire une collection composée du Document et d’autres documents publiés selon les termes de cette
Licence, et remplacer les copies individuelles de cette Licence dans les divers documents par une unique copie
incluse dans la collection, à condition qu’à tous les autres égards et pour chacun des documents vous vous con-
formiez aux règles de cette Licence régissant la copie à l’identique.

Vous pouvez extraire un document d’une telle collection, et le distribuer individuellement selon les termes de cette
Licence, à condition que vous insériez une copie de cette Licence dans le document extrait, et que vous vous
conformiez à cette Licence à tous les autres égards, en ce qui concerne la copie du document extrait.

7. AGRÉGATION AVEC DES ŒUVRES INDÉPENDANTES

Une compilation du Document ou de ses dérivés avec d’autres documents ou œuvres séparés et indépendants, dans
une unité de stockage ou sur un support de distribution, est appelée “agrégat” si le droit d’auteur résultant de la
compilation n’est pas utilisé pour limiter les droits légaux des utilisateurs de la compilation au-delà de ce que les
œuvres individuelles permettent. Quand le Document est inclus dans un agrégat, cette Licence ne s’applique pas
aux autres œuvres de l’agrégat qui ne sont pas elles-mêmes des œuvres dérivées du Document.

Si l’obligation de Texte De Couverture de la section 3 est applicable à ces copies du Document, alors si le Doc-
ument correspond à moins de la moitié de l’agrégat entier, les Textes De Couverture du Document peuvent être
placés sur la couverture qui contient le Document à l’intérieur de l’agrégat, ou l’équivalent électronique de cette
couverture si le Document est sous forme électronique. Dans le cas contraire, elles doivent apparaître sur la
couverture imprimée qui contient l’agrégat entier.

8. TRADUCTION

Une compilation du Document ou de ses dérivés avec d’autres documents ou œuvres séparés et indépendants, dans
une unité de stockage ou sur un support de distribution, est appelée “agrégat” si le droit d’auteur résultant de la
compilation n’est pas utilisé pour limiter les droits légaux des utilisateurs de la compilation au-delà de ce que les
œuvres individuelles permettent. Quand le Document est inclus dans un agrégat, cette Licence ne s’applique pas
aux autres œuvres de l’agrégat qui ne sont pas elles-mêmes des œuvres dérivées du Document.

Si une section du Document est Intitulée “Acknowledgements”, “Dedications”, ou “History”, l’obligation (section
4) de Conserver son Titre (section 1) nécessitera typiquement un ajustement du titre traduit.

9. EXPIRATION
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Vous ne pouvez pas copier, modifier, sous-licencier, ou distribuer le Document sauf aux conditions expressément
prévues par la présente Licence. Toute tentative de le copier, le modifier, le sous-licencier ou le distribuer d’une
autre manière est nulle, et entrainera automatiquement l’expiration des droits qui vous ont été conférés par cette
Licence.

Toutefois, si vous cessez toute violation de cette Licence, alors la licence qui vous a été octroyée par un détenteur
particulier des droits d’auteur est rétablie (a) provisoirement, sauf si et jusqu’à ce que le détenteur des droits
d’auteur annule votre licence de manière explicite et définitive, et (b) définitivement, si le détenteur des droits
d’auteur ne parvient pas à vous notifier la violation par des moyens raisonnables dans un délai de 60 jours après
la cessation de la violation.

De plus, la licence qui vous a été octroyée par un détenteur particulier des droits d’auteur est rétablie définitivement
si ce détenteur des droits d’auteur vous notifie de la violation par des moyens raisonnables, si c’est la première
fois que vous avez reçu une notification de violation de cette Licence (pour toute œuvre) de la part de ce même
détenteur des droits d’auteur, et si vous remédiez à la violation dans un délai de 30 jours après avoir reçu la
notification.

L’expiration de vos droits engendrée par cette section n’entraine pas l’expiration des licences des parties
auxquelles vous avez envoyé des copies en les autorisant à utiliser les copies selon les termes de cette Licence. Si
vos droits ont expirés et n’ont pas été rétablis définitivement, le fait de recevoir une copie de la même œuvre ou
une copie d’une partie de la même œuvre ne vous donne aucun droit de l’utiliser.

10. RÉVISIONS FUTURES DE CETTE LICENCE

Il se peut que de temps en temps la Fondation pour le logiciel libre publie une nouvelle version, révisée,
de la licence GNU de documentation libre. Ces nouvelles versions seront dans le même esprit, mais elles
pourront différer dans les détails, pour répondre à de nouveaux problèmes ou inquiétudes. Référez-vous à
http://www.gnu.org/copyleft/.

Chaque version de la Licence possède un numéro de version distinct. Si le Document spécifie qu’il peut être
utilisé selon les termes d’une version numérotée particulière de cette Licence “ou toute version ultérieure”, vous
avez le choix de vous conformer aux termes et aux conditions de la version spécifiée ou de toute version ultérieure
qui a été publiée (pas en tant que brouillon) par la Fondation pour le logiciel libre. Si le Document ne spécifie
pas de numéro de version, vous pouvez choisir n’importe quelle version publiée (pas en tant que brouillon) par la
Fondation pour le logiciel libre. Si le Document spécifie qu’un serveur mandataire peut décider quelles versions
futures de cette Licence peuvent être utilisées, la déclaration publique d’acceptation d’une version de la part de ce
serveur mandataire vous autorise de manière permanente à choisir cette version pour utiliser le Document.

11. RELICENCIER

“Site de Collaboration Massive Multi-auteur” (ou “Site CMM”) désigne tout serveur du World Wide Web qui
publie des œuvres auxquelles le droit d’auteur est applicable et qui fournit aussi une infrastructure conséquente
permettant à n’importe qui de modifier ces œuvres. Un wiki public que tout le monde peut modifier est un
exemple d’un tel serveur. Une “Collaboration Massive Multi-auteur” (ou “CMM”) contenue dans ce site désigne
tout ensemble d’œuvres concernées par le droit d’auteur ainsi publiées sur le site CMM.

“CC-BY-SA” désigne la licence Creative Commons attribution de paternité, partage à l’identique, 3.0, publiée par
l’organisation Creative Commons, une organisation à but non lucratif basée à San Francisco, en Californie, ainsi
que toute version future de type gauche d’auteur de cette licence, publiée par la même organisation.

“Incorporer” signifie publier ou republier un Document, en entier ou en partie, comme partie d’un autre Document.

Une CMM est “éligible pour relicencier” si elle est licenciée sous cette Licence, et si toutes les œuvres qui ont été
publiées antérieurement sous cette Licence ailleurs que sur cette CMM, et incorporées ensuite en totalité ou en
partie dans la CMM, (1) n’ont pas de textes de couverture ou de sections invariantes, et (2) ont été ainsi incorporées
avant le premier novembre 2008.

L’opérateur d’un Site CMM peut republier une CMM contenue dans le site sous licence CC-BY-SA sur le même
site, à n’importe quelle date avant le premier août 2009, à condition que la CMM soit éligible pour relicencier.

ADDENDUM : Comment utiliser cette Licence dans vos documents

Pour utiliser cette Licence dans un document que vous avez écrit, incluez une copie de cette Licence dans le
document et inscrivez les mentions de droit d’auteur et de licence suivantes juste après la page de titre :
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Copyright © YEAR YOUR NAME.
Permission is granted to copy, distribute and/or modify this document
under the terms of the GNU Free Documentation License, Version 1.3
or any later version published by the Free Software Foundation;
with no Invariant Sections, no Front-Cover Texts, and no Back-Cover Texts.
A copy of the license is included in the section entitled "GNU
Free Documentation License".

Si vous avez des Sections Invariantes, des Textes De Première de Couverture et des Textes De Quatrième De
Couverture, remplacez les lignes “sans Texte . . . ” par :

with the Invariant Sections being LIST THEIR TITLES, with the
Front-Cover Texts being LIST, and with the Back-Cover Texts being LIST.

Si vous avez des Sections Invariantes mais pas de Texte De Couverture, ou une autre combinaison des trois,
fusionner les deux possibilités pour que cela convienne à la situation.

Si votre document contient des exemples non triviaux de code source de logiciel, nous recommandons de publier
ces exemples en parallèle sous une licence de logiciel libre de votre choix, telle que la licence publique générale
GNU, pour permettre leur utilisation dans des logiciels libres.
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